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About This Guide and Related Documentation

This document is intended for MOTOTRBO radio network administrators as
well as dispatchers responsible for the TRBOnet dispatch console operations. It
provides guidance on the installation, configuration, and maintenance of the
TRBOnNet Server and Dispatch Console applications.

About TRBOnet

TRBOnet is a suite of professional applications for MOTOTRBO digital two-way
radio networks. TRBOnet manages voice and data communication paths across
network endpoints. It provides a unified graphical dispatcher workbench
interface for the entire range of workforce fleet management tasks.

Email & Support

info@trbonet.com — general and

commercial inquiries
support@trbonet.com — technical

Contacts
Region
EMEA +44 203 608 0598
Americas +1 872 222 8726
APAC +61 28 607 8325

support
http://trbonet.com/kb/ — online

knowledge base
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2 Hardware and Software Requirements

TRBOnNet Server/Agent with IP connection only

Voice Channels | 4 8 16 24 24+

CPU Fntel Core .Intel Core Intel Core i7, 4 Cores Intel Corei7, 6 Contact
i5 i5 Cores technical

Memory 2 GB 4GB 4GB 8 GB support

HDD 2 GB for installation files, +1 MB per 1 minute of voice recording

Sound Card No

Windows 10 (x64)/11, Windows Server 2016/2019/2022 (x64)

Supported OS Note: Windows Server 2016/2019/2022 requires Desktop Experience
Role/Feature installed.

Software .NET Framework 4.8, MS SQL Server 2016 or higher

TRBOnNet Server [Agent with Control Stations

Control Stations 1 2+

CPU Intel Core i5

Memory 2GB

HDD 2 GB for installation files, +1 MB per 1 minute of voice recording

Multi-channel Sound Card required;
Recommended:

Sound Card Integrated sound card can be used. 1. M-Audio Delta 1010 LT

2. Roland OCTA CAPTURE Hi-SPEED USB
Audio Capture

Additional

Devices Cable connector Motorola PMKN4016

Supported OS Windows 10 (x64)/11

Software .NET Framework 4.8, MS SQL Server 2016 or higher

CPU Intel Core i5

Memory 4GB

HDD 2 GB for installation files

Sound Card Yes

Display 1600x900 minimum resolution, 1920x1080 and higher resolution is recommended

Additional Devices | Speakers and microphone, or headset; Imtradex devices are recommended

Supported OS Windows 10 (x64)/11

Software .NET Framework 4.8

2 2 Hardware and Software Requirements
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3  System Architecture Overview

3.1  TRBOnet Server, Agent and Console

The TRBOnet software is designed as a client-server architecture,

where TRBOnet Server is PC-based and runs as a Windows service on a
network computer, stores data in an MS SQL database, and allows client
connections from Web Consoles, Dispatch Consoles, and Mobile Clients. The
TRBOnNet service can be located on a dedicated remote PC, a local PC (along
with the Dispatch Console), or on a virtual machine.

In addition, remote software agents, such as TRBOnet Agent, and/or hardware
agents, such as TRBOnet Swift A200, can be connected to TRBOnet Server
providing additional voice and data communications paths to and from remote
sites. Such configurations can be used when radio equipment can't be
connected directly to TRBOnet Server due to IP network limitations (see section
3.3, IP Backend Network Requirements).

TRBOnNet Dispatch Console is a PC-based voice dispatch and data application
for MOTOTRBO professional digital two-way radio systems.

TRBOnet Server

— IR

Local
Radio Infrastructure

WAN/LAN

T
EEE
.

Radio Infrastructure

= Web Console

LE

TRBOnet
Dispatch Console

3.1 TRBOnet Server, Agent and Console 3
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3.2 MOTOTRBO Radio Systems

3.2.1 Single Site conventional system

A Single Site conventional system is a digital conventional two-way MOTOTRBO
system that includes one digital repeater and allows you to transmit voice and

data via two conventional channels. Radio groups and radio units are assigned
to these conventional radio channels.

3.2.2 IP Site Connect

An IP Site Connect (IPSC) system is a digital conventional two-way MOTOTRBO
system that provides two wide-area channels to increase your communications
RF coverage area. It is possible to connect up to 15 repeaters (each
geographical location of a repeater is called a "site") into one system using an
IP connection, which allows increasing the coverage area for voice and data
transmissions. The main objective of an IPSC system is to provide a stable
connection between the radio units and control centers regardless of the
distance.

1% 2% 3%
L & o L & @ ? o
L & R ®

Master Repeater 1 Peer Repeater 2 Peer Repeater 3

TRBOnet
Server

=

LAN/WAN

L\ LE\ LB\

Dispatcher 1 Dispatcher 2 Dispatcher 3

4 3 System Architecture Overview
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3.2.3 Capacity Plus

Capacity Plus (also known as Capacity Plus Single Site) is a digital trunked two-
way MOTOTRBO system that is designed for high volume communications at a
single site location. The system is designed to provide communications among
a large number of users within a building, a set of buildings, or a single
geographical region. This system type allows you to effortlessly increase the
number of channels for both voice and data transmission between the radio
units and control centers. As this system type is trunked instead of standard
conventional, radio units are always automatically forwarded to a free channel
rather than being programmed to remain on a single slot, thereby
utilizing/sharing the available unused/free RF resources (channels) among
different users. The main objective of Capacity Plus is to support more
simultaneous voice and data transmissions within one capacious system.

[

LTS
Dispatcher 1

[

P Voice Repeater 2
Dispatcher 2

E Voice Repeater 3

LEEESN
Dispatcher 3

E Data Repeater 5
[ ]
LFEN

TRBOnet
Server

Master Voice Repeater 1

Data Repeater 4

3.2.4 Linked Capacity Plus (LCP)

Linked Capacity Plus (also known as Capacity Plus Multi Site) is a digital trunked
multisite two-way MOTOTRBO system that enables you to accommodate both
high volume and wide area communications. This system design allows you to
connect via IP up to 15 Linked Capacity Plus sites located in one geographical
region (for example, City of Charlotte) or in larger geographically separated
territories (for example, covering the Florida Keys from Miami to Key West).
This system type allows you to increase the RF coverage area and the number
of channels for voice and data transmission between the radio units and
control centers. The main objective of Linked Capacity Plus is to support more
simultaneous voice and data transmissions regardless of the distance.

3.2 MOTOTRBO Radio Systems 5
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Voice Repeater 1  Voice Repeater 2 Data Repeater 3 Data Repeater 4

L\

Dispatcher 1

E Router + Switch

Dispatcher 2

LAN/WAN

Router + Switch
LS
Dispatcher 3

m] Router + Switch
L]

Server E E E
Voice Repeater 5 Voice Repeater 6 Data Repeater 7 Data Repeater 8

Control Control Control
Station 1 Station 2 Station N

Site 2 :q}

it
-
-
Ll

"
&

3.2.5 Connect Plus

Connect Plus is a digital trunked multisite two-way MOTOTRBO system that
enables you to accommodate high volume, wide area communication that’s
required for your business allowing you to connect via IP multiple sites located
in one geographical region or in larger geographically separated territories.
This system type allows you to increase the RF coverage area and the number
of channels for voice and data transmission between the radio units and
control centers. Radio units are always automatically forwarded to the control
channel. The main objective of Connect Plus is to support more simultaneous
voice and data transmissions regardless of the distance as well as to provide a
more structural addressing of the transmissions provided by XRC controller
and XRT gateway.

6 3 System Architecture Overview
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Dispatcher 1 XRC 9000 XRC 9000

) ' Voice Repeater 3 )

Voice Repeater 1 Talk Group 1 Talk Group 3

N =0
y--20- N

Dispatcher 2

Data Repeater 2 @ Data Repeater 4

E m Talk Group 2 Talk Group 4
- e

LR\

Dispatcher 3 XRT 9000

B m 5

f_/__—\—

EEW
[ ]

Pace=——uN

TRBOnet
Server*

* TRBOnet Server requires connections to only one XRT 9000 Controller and one XRC 9000 Controller in the system

3.2.6 Capacity Max

Capacity Max is MOTOTRBO's next-generation trunking solution. Built on the
DMR Tier III Mode of Operation, it delivers smooth scalability, low cost of
ownership and reliable operation.

Il Capacity MAX companents I TRECnet components

Application Server Capacity MAX System Server

Dispatch Position TRBOnet Server with Built-in

Software Agent
I

MNIS Data Gateway MNIS VRC Gateway

Trunked Controller

TRBOnet Dispatch
Console

Application network CMSS network

. . Router
Dispatch position

TRBOnet Dispatch
Console

| 3" party network

3.2 MOTOTRBO Radio Systems
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3.3 IP Backend Network Requirements

Before planning any IP connected MOTOTRBO system, read the MOTOTRBO
System Planner (Back-End Network Considerations).

e Delay/Latency
The amount of time it takes for voice to leave the source repeater and
arrive at the destination repeater. The delay should be less than 60 ms. It
can be up to 90 ms, but requires changes in CPS for both radio units and
repeaters.

o Jitter
The variation of the packet inter-arrival time. It should be less than 60 ms.

e Packet Loss
In the case of voice, the ongoing call ends if six consecutive packets do
not arrive within 60 ms of their expected arrival time. In the case of data,
the repeater waits for the expected number of packets (as per the data
header) before ending the call.

e Bandwidth
Refer to the MOTOTRBO System Planner for bandwidth calculations, but
roughly, it requires 96 kbps for each repeater connection and should be
summed up for all repeaters.

If the IP backend network does not satisfy MOTOTRBO requirements, it will
degrade audio quality significantly, including dropped voice calls.

3.3.1 Linked Capacity Plus Specific Requirements

e Addresses and Ports
A static IP Address and UDP Port for the master repeater must be made
available to all peer devices on the Linked Capacity Plus system.

= When a peer device registers with the master repeater, the network
supplies the return IP address and UDP port of the peer device to the
master repeater. The IP address and UDP port must then be made
available to all other MOTOTRBO™ LCP devices on the system.

8 3 System Architecture Overview
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4 TRBOnet Enterprise and Dependencies
Installation

TRBOnNet runs on Microsoft Windows-based PCs. For the TRBOnet Enterprise
Compatibility Table, see

https://trbonet.com/kb/trbonet-enterprise-plus-compatibility-table/

4.1 Installing Microsoft SQL Server

Download and install Microsoft SQL Server 2016 or higher.

You can download and install either a full-featured MS SQL Server or an
Express edition of MS SQL Server. The Express edition of MS SQL Server is free;
however, it has some technical restrictions (maximum database size of 10 GB,
RAM usage, and other restrictions).

For example, Microsoft SQL Server 2016 SP2 - Express Edition (which is free) is
available at:
https://www.microsoft.com/en-us/download/details.aspx?id=56840

Note: We recommend that you download a version of SQL Server
with Tools.

Select the 32-bit or 64-bit version depending on the underlying OS. Accept the
defaults for the setup.

See also section 5.2.1.1, Windows Authentication on page 15.

4.2 Installing .NET Components

The .NET Framework installer is available at:
https://support.microsoft.com/en-us/topic/microsoft-net-framework-4-8-
offline-installer-for-windows-9d23f658-3b97-68ab-d013-aa3c3e7495e0

4.3 Installing TRBOnet Enterprise

e Contact Neocom Software to obtain the latest installation package of the
TRBOnet Enterprise software, unzip, and run the setup file as a local
administrator.

e When the TRBOnet Enterprise Setup wizard appears, click Next.

e On the End User License Agreement page, accept the terms of the
license, and then click Next.

4.3 Installing TRBOnet Enterprise 9
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Choose Setup Type .
Choose the setup type that best suits your needs

TRBOnet Dispatch Console
This is @ dispatcher computer and only Dispatch Console must be installed

TRBOnet Server and Dispatch Console

This is a Server computer and you need to install Server software and
Dispatch Console

= Custom
E Allows users to choose which program features will be installed and where
i they will be installed.

Neocom Software

< Back Next > Cancel

e On the Choose Setup Type page, click one of the following options:

= TRBOnet Dispatch Console
Choose this option to install only TRBOnet Dispatch Console on your
computer.
= TRBOnet Server and Dispatch Console
Choose this option to install both TRBOnet Server and
TRBOnet Dispatch Console at once on your computer.
= Custom
Choose this option to select from the list one or more components to

be installed.
Custom Setup "]
Select the way you want features to be installed.

Click on the icons in the tree below to change the way features will be installed.

=2~ | Dispatch Console TREONet Enterprise 5.2 Agent
=) ~ | Server Instance
-g hd _Agel t Instance|
This feature requires 199MB on
your hard drive.

Location:  C:'Program Files (x85)\Neocom Software{TREOnet

Browse...
Enterprise}

Meocom Software

Reset Disk Usage <Back Cancel

For example, you may install only TRBOnet Server Instance:

Custom Setup r
Select the way you want features to be installed.

Click on the icons in the tree below to change the way features will be installed.

- X_v | Dispatch Console TRBOnet Enterprise 5.2 Server
(=B serverstanc]
X

- | Agent Instance

This feature requires 209MB on
your hard drive.

Location: C:\Program Files (x86)Neocom Software\TREOnet

Browse...
Enterprise

Neocom Software

Reset Disk Usage < Back Cancel

e Accept the defaults for the rest of the setup and complete the installation.

4 TRBOnet Enterprise and Dependencies Installation
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5 TRBOnet Server

To start TRBOnet Server, click the corresponding shortcut on the desktop,
or click Start > All Programs > Neocom Software > TRBOnet Server x.x
5.1 License Information

The TRBOnet software requires a valid license in order to operate. Depending
on the License Type (see next section), the license can be obtained via
TRBOnet's website or from a Neocom representative.

5.1.1 License Types

There are three license types available for TRBOnet Enterprise:

License . .

Type Demo Trial Commercial
Validity 60 days By Request Permanent (non-expiring)
Quantlfy of Up to 2 control stations
Conjcro or 1IP repeater .

Stations connection By Request According to Customer order
and Radio di .
Units 10 Radio Units
Features Limited functionality By Request According to Customer order
Assigned to server's Assigned to server’s Hardware
g ID.
Hardware ID.
For more details on Assigned to the serial numbers
How to It can be downloaded Hardware ID, see of master repeaFers anq iontrol
obtain from the web page. the article at stations. To retrieve seria '
https://trbonet.com/k numbers, use Control Station's
b/hO\;v-to-qet-tf.]e- codeplug (do not rely on a serial
hardware-id/ number printed on the device's
’ label).
For more information on the license and renewals, contact our technical support at
info@trbonet.com

To see how the Hardware ID and control stations and/or repeaters are
assigned in your license, open the INFO file delivered with the license file (for
example, in Notepad):

5.1 License Information 11
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License ID: aada3405-4e5f-4254-843f-a2balleTc475
License generated by: John Smith

License generation date: T7/20/2016

TRBOnet Support is active up to: T7/20/2017
Product: TRECnet Enterprise (4.0.0.138

License for: Neocom Software Ltd

Licensed instance: [Default]

Server limitations

FEIVEI hardware kKeys: |,". 1
42B1-BA64-D473-D6ES-DFAC

Remote Agent connections: 5

System types: Unlimited

Agent limitations ]

Agent hardware keys: Any -

Number of master radios or master repeaters: 5

Haster radios master repeaters serial numbers: 484TNLIS887; 484TNLIESE; 484TNL28E8S; 484TNLIES90; 484TNLZES])
Total number of peers in IP Site Connect or Capacity Plus systems: 10

Serial numbers of peers used in IP Site Connect or Capacity Plus systems: Unlimited

Limitation for Client connections
Remote Dispatch connections: 10
Number of Remote Dispatch accounts: 10

Subscriber radios limitatioms
Humber of subscriber radios: 10

1. Your license is assigned to the Hardware ID.

2. Your license is assigned to the serial numbers of master repeaters and
control stations.

5.1.2 Moving TRBOnet Server to a Different Server PC
If there is a need to use TRBOnNet Server on a different server PC, please contact
your Neocom sales representative for further instructions.

5.1.3 Using Spare Repeaters

If the plan is to use spare repeaters, for example, as replacement for damaged
ones, communicate the total number of repeaters when ordering a license.

For example, 3 repeaters will be actively used with TRBOnet Server and 1 spare
repeater. Communicate the following repeaters limitation: 3 active 1 spare and
provide the serial numbers of all 4 repeaters when placing an order (also
include the spare repeater’s serial number).

5.1.4 License Manager

¢ Inthe Configuration pane on the left, select License.
In the right pane, you can see the text of your current license.

5 TRBOnet Server
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Configuration

:3 Pl

Advanced Settings

Privacy
DOMS service
Advanced Setting
MMIS data service
. Advanced Setking
3 Audio Paths
B PTT over Cellular

,’_ Advanced Settings

l TRECNet. Mobile gateway
5= Remaote Agents

52| Friendy Servers
28 Phore Connect
" Data Sources

4 Email
m" Incoming Mail Server
L Cukgoing Mail Server
o 3M3 Motifications

[ Push Motifications

St Defaults

To apply the new license:

1. Click the License Manager link in the right pane.

License

License is valid

License I0: 9558%aaf-7714-4380-9540-r48e30eTrd6a
Hardware ID: 42B1-BAG4-D473-DEES-DFAC

License generated by: Eugene Balvabin (4100504
License generation date: 23 March 2021

TREORet Suppart is active up to: 23 March 2022
Product: TREOnet_Enterprise

Licensed to: demo (Wwalt)

Active instance: [Default]

Licensed instance: [Default]

Demo License
Expiry dake: 23 March 2022

Server limitations

Server hardware keys:
42B1-BA64-D473-DEES-DFAC

Remote Agent connections: 2

System bypes: Unlimited

Agent limitations
Agent hardware keys: Any
Mumber of master radios or master repeaters: 10

Master radios | master repeaters serial numbers: Unlimited
Tokal number of peers in IP Sike Connect or Capacity Plus syskems: 10
Serial numbers of peers used in IP Sike Connect or Capacity Flus systems:

Unlimited

License Manager Send Ernail

The License Manager wizard appears.
2. Click Next.

3. Click the ellipsis (...) button on the right-hand side of the License file box.
The Open dialog box appears.

heocom
SOftware

4. Locate the license file you received from our technical support and click

Open.
The full path of the license file appears in the License file box.

5. Click Next.

6. Click Finish to close the wizard.

7. Click Apply and then confirm to restart TRBOnet Server.

Note: To use a single license for multiple TRBOnet software
instances, you need TRBOnet License Server. For
detailed instructions on how to use TRBOnet License
Server, refer to TRBOnet License Server Configuration

5.1 License Information

Guide.

13
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5.2 TRBOnet Server Database

¢ Inthe Configuration pane, select Database.

Configuration Database

q Service
O Metwork
# Redundancy
= Remote Access Restriction
(@ Reports
£} Service Management
}’ Advanced Settings
N Geocoding Servers
IR Radio Systems
Bf PTT over Cellular
I Teltonika
[l Remote Agents

SQL Server: (local)\SQLEXFRESS

Database: TRBOnet11

Authentication: Windows

| Save database backups to
Folder: D:\Temp{TRECnet

+| Save audio recordings to
: Folder: D:VAudio
[ Friendly Servers
‘R Phone Connect
)’_ Advanced Settings
.8 Internal PBX Server

| Save attachments to

Folder: D:\TempiAttach

| Data Sources

X4 Emai Test Connection
{55 5MS Notifications
[ Push Notifications

E License

Set Defaults Apply

Upgrade Databaze
Create Database

e Inthe Database pane, specify the following database-related settings:

SQL Server
Enter the location of the Microsoft SQL Server name and instance. For
example, in the screenshot above, the default instance name of

Microsoft SQL Server Express installed on the local computer is shown.

Database
Enter the name of the TRBOnet database.

Authentication

Select the authentication method for the TRBOnet database. The
default method is Windows Authentication. See also section 5.2.1
Database Authentication Methods (page 15).

Login and Password
Enter a valid SQL Server login and password if the SQL Server
Authentication is selected for the database.

Save database backups to

Select this option, and in the corresponding Path box enter the full
path of the custom folder for database backups. Or, click the ellipsis
(...) button and in the Browse For Folder dialog box locate the
appropriate path.

Save audio recordings to

Select this option, and in the corresponding Path box enter the full
path of the custom folder for audio recordings of the voice
calls/sessions. Or, click the ellipsis (...) button.
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Path to Audio Files X
Root Folder:
D:VAudio

File Path Template:
YYEAR % %MONTHY: DAY %|

Channel Name System ID System Mame Call Tvpe Source Source Tvpe
Source ID Recipient Recipient Type Recipient [D

Example:
D:\Audio\20221025_xxx.tna

Conce

¢ Inthe Path to Audio Files dialog box, select the Root Folder, and in
the File Path Template box enter the information (by clicking the
appropriate links below: Year, Month, Day, etc.) that will be used to
generate the file/path name.

Note: If you don't specify folder paths for the database
archives and audio files, TRBOnet Server will use the
following default paths:

%ProgrambData%\Neocom Software\TRBOnet Enterprise\Backu
ps - for database archives.

%ProgramData%\Neocom Software\TRBOnet Enterprise\Audio
- for audio.

Also note that older backups are not deleted
automatically. It is recommended that you regularly
delete the files you no longer need to avoid running out
of storage space.

= Save attachments to
Select this option, and in the corresponding Path box enter the full
path of the custom folder where text message attachments will be
stored. Or, click the ellipsis (...) button and in the Browse For Folder
dialog box locate the appropriate path.

e When you finish configuring the required database parameters, click
Create Database.

o After you create or upgrade a database, click Apply and then confirm to
restart TRBOnet Server.

5.2.1 Database Authentication Methods
5.2.1.1 Windows Authentication

e From the Authentication drop-down list, select Windows.

5.2 TRBOnet Server Database
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Configuration

o service
O MNetwork

@& Redundancy

5 Remote Access Restriction

Database

(@ Reports

[} Service Management
)’_ Advanced Settings
(N Geocoding Servers
IR Radio Systems

B PTT over Celular

I Teltorika
5l Remote Agents
5l Friendly Servers
‘T Phone Connect

E Internal PEX Server
'} Data Sources
=4 Email
[ 5MS Motifications
[ Push Notifications

[ License

Set Defaults

Database
S0L Server: (local)\SQLEXPRESS
Database: TRECnet11
Authentication: Windows
Username: Windows
SQL Server
Password:

| Save database backups to

Folder: D:\TempY{TRECNnet
| Save audio recordings to

Folder: D:\Audio
| Save attachments to

Folder: D:\TemplAttach

Test Connection
Upgrade Database
Create Database

Apply

Cancel

To provide access permissions for TRBOnet Server to connect to MS SQL Server,
create an account with sysadmin privileges.

During the installation process, MS SQL Server 2008 automatically grants

sysadmin privileges to the NT Authority\SYSTEM account.

In the case of MS SQL Server 2012 and higher versions, add the

NT Authority\SYSTEM account to the Administrators group during the
installation process. If the database owner privileges are required to work with
TRBOnet Database, you need to assign the sysadmin role to the Local System
account. For instructions on how to install and configure MS SQL Server 2012,

see

Appendix B: Configuring SQL Server 2012 for Local System Account.

5.2.1.2 SQL Server Authentication

e From the Authentication drop-down list, select SQL Server.

Configuration

ﬂ Service
0 Network

& Redundancy
/5 Remate Access Restriction
Database
(@ Reports
L} Service Management
)’_ Advanced Settings
(N Geocoding Servers
IR Radio Systems
B PTT over Celular
o Teltonika
=l Remote Agents
| Friendly Servers
‘& Phone Connect
)’_ Advanced Settings
-G& Internal PBX Server
I Data Sources
24 Email
[ SMS Motifications
[ Push Notifications

E License

Set Defaults

Database
SQL Server: {local)\SQLEXPRESS
Database: TREOnet11
Authentication: SOL Server
Username: sa
Password: sssssssss

| Save database backups to

Faolder: D:\TempTRECNet
+| Save audio recordings to

Falder: D:\audio
+| Save attachments to

Folder: D:\Temp\Attach

Test Connection
Upgrade Database -
Create Database =

Apply

Cancel
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To connect to SQL Server using SQL Server Authentication, create a SQL login
with sysadmin privileges in the SQL Server in use. For detailed instructions on
how to create a SQL login, see
http://technet.microsoft.com/en-us/library/aa337562.aspx

5.3 TRBOnet Server Service

¢ Inthe Configuration pane, select Service.

$) TRBOnet Enterprise 6.2 / Server

Configuration

@
G Network
@ Redundancy
= Remote Access Restriction
Database
_5‘ Reports
£} Service Management
): Advanced Settings
ikl Geocoding Servers
IR Radio Systems
Ef PTT over Cellular
I Teltonika
EiE Remote Agents
| Friendly Servers
ER Phone Connect
f Advanced Settings
~/ZR Internal PBX Server
,’_ Advanced Settings
| Data Sources
4 Email
s 5MS Notifications
[ Push Notifications

E License

Service

The TREOnet Server service is not installed. Itis recommended to run TRECnet
Server as a Windows service: it wil start automatically after a reboot and run even
when no user is logged on. Click the Install Service button below to install the
TREOnet Server service,
Service logon type:
#) Logon as Local System (Recommended)
Logon as User

User name: TREGNET\. kulinichev

Password:

Install Service

Server password:

Set password Turn off password

E\u’iew Log Entries Export Configuration Import Configuration

e Inthe Service pane, specify the following service-related parameters:

= Choose the required logon type:

Logon as Local System
Choose this option to use an account with local system administrator
privileges to run the service as a Windows service (Recommended);

Logon as User

Choose this option to use a different account to run the service as a
Windows service. This account must allow the user to run services in
Windows, have read and write access to the Neocom Software folder
and subfolders in the "%ProgramFiles%" (or,
"%ProgramFiles(x86)%" for 64-bit OS) and "%ProgrambData%"
folders. For example, using such an account may be required in the

following cases:

1. An Active Directory domain network is used, and the current

Windows user is not allowed to use a Local System account to
launch services on the local PC due to domain policy restrictions.

2. MS SQL Server is installed on a remote PC, and Windows

Authentication (see section 5.2.1.1, page 15) has been selected to
connect to the database.

= (lick the Install Service button.

5.3 TRBOnet Server Service
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= Click the Start Service link that appears in the right pane.

= Server password
Click the Set password link and enter a password if you want to
password-protect the server configuration. Once the configuration
password is set, the user will be prompted to enter it when opening
and exiting the TRBOnet Server application.
To remove the password, click the Turn off password link.

5.4 Network Parameters

¢ Inthe Configuration pane, select Network.

Configuration Network
u Service ~
0 Network. Network interface: System Default -
@ Redundancy Command port: 4021

5 Remote Access Restriction

Database Watch PM port: 4017

(@ Reports First VoIP port: 4022
Service Management VoIPprotocol: UDP
,f: Advanced Settings

(N Geocoding Servers Dataprotocol: Loe
! Radio Systems Use broadcast mode for audio

L} Services Broadcastport:
Bf PTT over Cellular

1" Teltorika | Use proxy server
5l Remote Agents Configure

:| Friendly Servers

2 i Encrypt data traffic between server and dients
‘T Phone Connect

)’_ Advanced Settings

/@ Internal PBX Server

I Data Sources

=4 Email
[ 5M5 Notifications
[ Push Notifications
.. N

Set Defaults Apply Cancel

¢ In the Network pane, specify the following network-related parameters:

= Network interface
From the drop-down list, select the network interface that will be used

to communicate between the Server and Dispatch Consoles. Click ® to
refresh the list of network interfaces available on your PC.

Note: If both TRBOnet Server and Dispatch Console are
installed on the same PC, then select 127.0.0.1
(Loopback Pseudo-Interface).

= Command port
Enter the port number to be used by a Dispatch Console to connect to
the Server (4021, by default).

= Watch PM port
Enter the port number that will be used by Watch Performance
Monitor to monitor the computer where TRBOnet Server is running.
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= First VoIP port
Enter the number of the first VoIP port for audio communications
between the Server and Dispatch Consoles (4022, by default). Each
additional Dispatch Console will establish a connection on the next
available port number.

= VoIP protocol
From the drop-down list, select the VoIP protocol type for
communications between the Server and Dispatch Consoles:

e All - UDP will be used first; if unavailable, TCP will be used;
e TCP - slower but more reliable (set by default);

e UDP - faster but data packets can be lost; some routers may drop
UDP packets.

= Data protocol
From the drop-down list, select the protocol to exchange data other
than voice between the Server and Dispatch Consoles (TCP, by default).

= Use broadcast mode for audio
Selecting this option will help to optimize network load and minimize
transmission delays. The "load" on the network will be reduced as the
Server will utilize a single audio transmission to a group of Dispatch
Consoles instead of sending multiple audio streams to each individual
Dispatch Console. This method of transmission will also minimize the
transmission delays if there's a large number of Dispatch Consoles or
the Server is busy processing other features.

Note: When the broadcast mode is set, a Dispatch Console
cannot run on the same machine as TRBOnet Server,
and a warning message will appear when you select this
option.

e Broadcast port
Enter the port number to be used to broadcast audio (5000, by
default).

= Use proxy server
Select this option to enable an alternative proxy server for TRBOnet
Dispatch Software to access Internet.

¢ Click the Configure link to specify the alternative server settings:
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Configure the proxy server X

Use an alternative server

Settings

Address: |177.71.134.70

Port: 20

Authentication
Use authentication

Username: |User

Password:

==

¢ Use an alternative server
Select this option to enable an alternative proxy server.

v Address
Enter the proxy server IP address.
v Port
Enter the proxy server port number.
¢ Use authentication
Select this option to use authentication to connect to the alternative
proxy server.
v Username
Enter the username for the authentication, if needed.

v Password
Enter the password for the authentication, if needed.

o After you configure the proxy server settings, click OK.

= Encrypt data traffic between server and clients
Select this option to guarantee the security of data transfer between
TRBOnNet Server and Dispatch Console, and/or TRBOnet Agent. It is
recommended that this option be used when a connection between
system components is established via the Internet or other public
networks.

5.5 Redundancy

TRBOnet Server supports a redundant (secondary/backup) configuration which
allows automatic switching from the primary to the redundant
(secondary/backup) server in case of failure of the primary server. Dispatch
Console operation will not be interrupted.

¢ Inthe Configuration pane, select Redundancy.
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Configuration Redundancy
o service
0 Network + | Redundant server mode

5‘ Redundancy Mode: Passive

/= Remote Access Restriction )

Database Primary servers:

(2 Reports IP Address Port
£} Service Management 1 |[v] 172.20.90.25 4021

)’ Advanced Settings
[N Geocoding Servers

IR Radio Systems

B PTT over Celular

5 Teltonika

5l Remote Agents

il Friendly Servers

‘T Phone Connect
Advanced Settings
E& Internal PEX Server
I Data Sources

24 Email

i 5MS Motifications

[@ Push Notifications . .
5 License ] Add ] Edit Delete Test A Y

Set Defaulks Apply a4 Cancel

¢ Inthe Redundancy pane, select this option to enable the
Redundant server mode option.

¢ Redundancy Mode
Select a mode for the redundant server (Active or Passive) from the
drop-down list.

e To add a primary server, click Add.

Server Properties X

IP Address: 172.20,40,24

Port: 4021 -

o IP Address
Type the IP address of the primary server.

e Port
Enter the same port number as specified for the Command port.

Note: For more details on Redundant Server configuration, see
Appendix G: Redundant Server (page 419).

5.6 Remote Access Restriction

This section describes how to restrict remote access to TRBOnet Server.
e Inthe Configuration pane, select Remote Access Restriction.
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Configuration

o service

O Network

& Redundancy

EJRemote Access Restriction

Database
_5\ Reports
£} Service Management
/ Advanced Settings
)\ Geocoding Servers
IR Radio Systems
L LF Services
] system 21
Lo TPsC 1

)’ Advanced Settings

-L17 Local Slots

pll CP1

}’ Advanced Settings
et Privacy

4.3 DDMS service

>

v

Remote Access Restriction

| Use restricted access
Allowed connections:
IP Address Password
+| 10.10.201.99
+| | 10,10, 109,203

Add Delete

Apply

e Inthe Remote Access Restriction pane, select the Use restricted access

checkbox and add allowed connections to the table below:
Click the Add button.

Note:

5.7

IP Address

Enter the IP address of the PC that will be allowed to connect.

Password

Enter the password that will be used for a connection from this

IP address.

If the Use restricted access checkbox is selected and the list

of allowed connections is empty or no connections are

selected in the list, the TRBOnet Server won't be able to be
remotely accessed at all.

Reports

Perform the following steps to select the option to save scheduled reports and
enter the appropriate information.

Note: The selection of the type of scheduled reports is

configured in the Dispatch Console (see section 6.4.5.16,
Scheduled Report)

¢ In the Configuration pane, select Reports.
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Configuration Reports

o service

O Network +| Save scheduled reports

ﬁs Redundancy Folder: D:'\Reports
= Ezzifs:ccess Restriction o o0F

[ reports|

L3 Service Management ke

)’ Advanced Settings neocom
Lk Geocoding Servers SDFtWa re

IR Radio Systems

B PTT over Cellular
7 Teltonika

55| Remote Agents

5l Friendly Servers

‘& Phone Connect

Select... Default

E Internal PBX Server
} Data Sources
24 Email
[ 5MS MNotifications
[@ Push Notifications

[ vicense
Set Defaults Apply Cancel

¢ Inthe Reports pane, select the Save scheduled reports checkbox and
specify the following parameters:

* Folder
Click the ellipsis (...) button and locate the folder on the PC where you
want to save reports generated by the TRBOnet software.

= Format
From the drop-down list, select the format for the reports (PDF or
Excel).

* Logo
Click the Select button, and in the 'Open’ dialog box, navigate to the
desired logo file (.BMP, .PNG, .JPG, etc.) and click 'Open'.
To revert to the default logo file, click the Default button.

5.8 Service Management

The Service Management pane allows you to specify various parameters for the
Presence, Location, and Indoor services.

¢ Inthe Configuration pane, select Service Management.
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Configuration Service Management
@ Service
G Metwork Presence service
* Redundancy Auto request presence timeout: l:l minutes
Remote A Restricti =
E’ Emate Access Restricton ARS refresh interval: minutes
Database
f_a Reports [ 1gnore unregistered Radios
. Location service
X Advanced Settings
A Geocoding Servers Dispatch Console update interval: seconds
B Radio Systems [ send last known locations of radios in alarm
B PTT over Cellular )
77 Teltonika Far the last: 10 minutes
E Remote Agents GPS points: 10
E Friendly Servers 1Indoor service
Fh C ct
Q! Phone Cone X [«] Remave offine radio from beacon
Advanced Settings
ﬁ Internal PEX Server [ Don't use beacon location if radio in alarm has GPS fix (K-TERM only)
\l—f Data Sources
A Email
[0} SMS Notifications
[ Push Notifications
E License
Set Defaults | Apply | | OK | | Cancel |

¢ Inthe Service Management pane, specify the following service-related
parameters:

5.8.1 Presence service

The Presence service group includes the following registration-related
parameters:

e Auto request presence timeout
Enter the time interval that will be used by the server to regularly check
the online subscriber radios if there has been no activity. The server
considers a radio to be inactive (or, offline) if the radio does not send any
GPS, Text, ARS, or Voice messages.

If you do not have a dedicated channel for data revert, use the following

table:
Number of Presence timeout
radio units (minutes) radio units (minutes)
up to 10 5 30 to 40 17
10to 20 9 40 to 50 21
20 to 30 13 over 50 120

If there is a dedicated data revert channel in the system, you may set this
parameter to a somewhat lower value than indicated in the table.

Note: If the DDMS service is enabled, set the value of this
parameter to the value of the DeviceRefreshTime
parameter in MOTOTRBO DDMS.

e ARS refresh interval
Enter the value of the parameter that determines how often a radio unit
will send ARS packets. It is recommended that a value of 30 minutes be
used for this interval. This value may be changed depending on the
system load.
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Notes: For all radio systems (except for Connect PLUS and
Capacity MAX), the ARS service must be enabled on the
subscriber radio channels (MOTOTRBO CPS,
Channels>Channel>ARS).

If the DDMS service is enabled, set the value of this
parameter to the value of the PersistenceTO
parameter in MOTOTRBO DDMS.

See also Appendix F: NAI VOICE & DATA Support.

Ignore unregistered radios
Select this option so that unregistered radio units will be ignored and
thus won't appear in Dispatch Console.

5.8.2 Location service

The Location service group includes the following location-related
parameters:

Dispatch Console update interval

Enter the time interval that will be used to send GPS data packages from
the Server to Dispatch Consoles. The lower the value, the more data
traffic will be present on the network. Adjust this value based on the
network bandwidth. The lower the bandwidth, the higher the update
interval.

Send last known locations of radios in alarm
Select this option so that dispatchers receive the latest locations when an
alarm occurs. Then choose one of the following options:

= For the last X minutes
Choose this option and enter the time, in minutes, to be used as the
last time period for the latest GPS data.

= GPS points
Choose this option and enter the number of GPS points to be used for
the latest GPS data.

5.8.3 Indoor service

The Indoor service group includes the following indoor-related parameters:

Remove offline radio from beacon
Select this option so that an offline radio is not shown on its associated
beacon.

Don't use beacon location if radio in alarm has GPS fix (K-TERM only)
Select this option so that beacon positioning is ignored in case of alarm
when a radio transmits valid GPS data.

Note: This feature relates only to K-TERM beacons.
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5.9 Advanced Settings

e Inthe Configuration pane, select Advanced Settings.

Configuration Advanced Settings
& Service
0 Network Language: English
# Recundancy Logging level: MNormal
= Remote Access Restriction .
Administrator account: Enabled -
Database Reset o
3 Reports eset passwo
£} Service Management Audio recording format: WAV - Waveform Audio File
2 [ ings:
Advanced Settings Audio recording codec: G.711 p-Law/3000

i\ Geocoding Servers

B Radio Systems Text-to-speech voice: Default
! PTT over Cellular Measurement system: Metric
o Teltonika " q
. oordinate format: i
5 Remote Agents Degrees, Minutes, Seconds
| Friendly Servers T Passive timeout: Unlimited < | hours
‘B Phone Connect . - _— =
T a . Voice message expiry time: Unlimited = | hours
)f_ Advanced Settings
E Internal PBX Server Number of messages: Unlimited -
I’ Data Sources Text message expiry time: Unlimited < | hours
{ Email
- mat Number of messages: Unlimited -
[l 5M5 Notifications
[@ Push Notifications
[ License
Set Defaults Apply Cancel

¢ Inthe Advanced Settings pane, specify the following advanced

parameters:

= Language
From the drop-down list, select the interface language for TRBOnet
Server.

* Logging level
From the drop-down list, select the logging level that determines the
granularity of log messages in the System Log. The choices are: None,
Low, Normal, and High.

Note: This information is used by technical support for
troubleshooting purposes, so it is recommended that
this value be kept unchanged (Normal).

= Administrator account
From the drop-down list, select either Enabled or Disabled. If you select
Disabled, the administrator won't be able to log in to the Dispatch
Console.

e Reset password
Click this link to reset the administrator password to the default
value.

= Audio recording format
From the drop-down list, select the format to be used to store audio
recordings. The available formats are WAV, TNA, and OGG.
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Note: The TNA format is a proprietary audio format that
contains additional information about radio calls, such
as radio ID, start time, end time, and other parameters.
This format provides more details about call
participants and allows easy navigation within recorded
audio files.

= Audio recording codec
From the drop-down list, select the audio codec to be used to
compress the audio files.

= Text-to-speech voice
From the drop-down list, select the voice that will be used for Text-to-
Speech messages.

= Measurement system
From the drop-down list, select either Metric or US units.

= Coordinate format
From the drop-down list, select a format for displaying coordinates.

= TX Passive timeout
Enter the time period during which text and voice messages will be
stored and later sent when the channel becomes available (no longer
busy). "Unlimited" is recommended.

= Voice message expiry time
Enter the time period during which TRBOnet Server will continue to try

to send Voice messages to a recipient while they are offline.
"Unlimited" is recommended.

¢ Number of messages
Enter the maximum number of Voice messages that will be stored in
the queue before being sent.

= Text message expiry time
Enter the time period during which TRBOnet Server will continue to try
to send Text messages to a recipient while they are offline. "Unlimited"
is recommended.

¢ Number of messages
Enter the maximum number of text messages that will be stored in
the queue before being sent.

5.9.1 Geocoding Servers

Geocoding servers resolve GPS coordinates to street addresses for reporting
purposes and other needs, for example, 'GPS activity for period’ reports. Online
geocoding services, such as Google or Nominatim, can be used and are the
standard default services in TRBOnet. However, their use may be limited by the
number of requests. Furthermore, you can add custom geocoding servers to
the system.

5.9 Advanced Settings
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You can configure geocoding servers in three ways depending on whether the
Server and/or Dispatch Console have Internet access and on your local
geocoding server settings:

1. The Dispatch Console has Internet access and the Server has no Internet
access. The Server can connect to preconfigured (Google and
Nominatim) and/or local corporate geocoding servers via the Dispatch
Console.

2. The Server has Internet access and Dispatch Console has no Internet
access. The Dispatch Console can connect to preconfigured (Google and
Nominatim) and/or local corporate geocoding servers via the Server
(follow the instructions below).

3. You have your own Geocoding server in the local network. In this case,
you can configure data resolving in both the Server and the Dispatch
Console.

5.9.1.1 Configuring Geocoding Servers

¢ Inthe Configuration pane, select Geocoding Servers.

Configuration Geocoding Servers
o service
O Metwork Server Name
& Redundancy
Database
_-D\ Reports

/| Google

| | Mominatim

£} Service Management
# advanced Settings

[PNY :cocoding Servers

I8 Radio Systems
‘. L} services

B PTT over Celular

=l Remote Agents

[ Friendly Servers

@@ Phore Connect
} Data Sources

4 Email

5 5MS Motifications

[ Push Notifications

[ License
Add Delete A \J

D Request a place name upon receiving GPS coordinates

Set Defaults Apply Cancel

¢ Inthe Geocoding Servers pane, specify the following geocoding-related
parameters:

= Google and Nominatim
These are pre-configured geocoding servers, which allow resolving
GPS coordinates to street addresses and street addresses to GPS
coordinates.

Note: These geocoding servers can't be deleted from the
system.

= Click Add to add a geocoding server to the system.
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Map Server for Geocoding X

Server Name: |MyGaocodingServer |

Get address by coordinates

‘Hl‘lp -//127.0.0.1/reverse Format =aml &t ={at }lon={on }ézoom=184adressdetails=1 |

Test

Get coordinates by address
‘I‘Mp:f’f‘IZ?.D 0.1/search?q={address }&format=xml

Test

Concel

e Server Name
Enter the name of your geocoding server.

¢ Get address by coordinates
Select this option to resolve GPS coordinates to street addresses.
In the box below, enter the server address with the appropriate
parameters.

Note: Keep in mind that the {lat} and {lon} variables are
mandatory to allow TRBOnet Dispatch Console to
retrieve GPS coordinates from the radio unit.

Click Test to check the connection to the geocoding server. Enter a
pair of GPS coordinates and see if the resolved street address
appears.

e Get coordinates by address
Select this option to resolve street addresses to GPS coordinates (for
example, for the Search by Address feature).
In the box below, enter the server address with the appropriate
parameters.

Note: Keep in mind that the {address} variable is mandatory
to allow TRBOnet Dispatch Console to search map
objects by address.

Click Test to check the connection to the geocoding server. Enter an
address and see if you get the list of map objects corresponding to
the address entered.

= UsetheUp( % )and Down ( ¥ ) buttons to move the selected
geocoding server up and down in the priority list of geocoding servers.
When requesting GPS data via the geocoding servers configured in
TRBOnet Server, GPS data is requested from the geocoding servers
according to the priority level. The geocoding server at the top of the
list has the highest priority level. In case the first geocoding server is
unavailable, data will be requested from the second geocoding server
in the list, and so forth down the list of geocoding servers.
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The administrator must ensure that the geocoding servers in the list
are able to resolve GPS data.

= Request a place name upon receiving GPS coordinates
Select this option to resolve GPS coordinates to street addresses
immediately by a GPS event. Note that street addresses and GPS
coordinates are automatically (without user intervention) stored in the
TRBOnet database to optimize the response time for street address
requests (for example, GPS reports) and to reduce geocoding server
load. These street addresses and GPS coordinates will be stored
without user intervention whenever GPS are resolved to street
addresses via a request to a Geocoding Server.

5.10 Radio Systems

By enabling the Radio Systems feature, the TRBOnet Server is able to be
connected to a radio system. Otherwise, you should use Remote agents (see
section 5.13, Remote Agents).

e Inthe Configuration pane, select Radio Systems.

¢ Inthe Radio Systems pane, select or make sure that the Enable Radio
Systems option is selected.

Configuration Radio Systems
qf Service ~
O Network | Enable Radio Systems
@ Redundancy
Database CAT Network: 12
2
@0 Reports CAI Group Network: 225
£F Service Management
)’ Advanced Settings Registered Radio Systems
LA Geocoding Servers . | vame Address Radio ID
l Radio Systems - .
s . Capacity MAX 2020
L} Services
]ﬁ Capacity MAX ~| IP5SC 1 10.10.101.139 54250
I:B PSC 1 +|| CP1 10.10.188.35 654250
,’_ Advanced Settings
=L Privacy
: I Slot #1
b Slot #2
L1 Local Slots
I:B cP1
/’_ Advanced Settings
Privacy
L} DDMS service v
P as .. [ Add Delete Test
€ >
Set Defaults Apply Cancel

¢ In the Radio Systems pane, specify the following parameters:

= CAI Network
The CAI (Common Air Interface) Network is a value that is combined
with the Radio ID to produce the individual radio’s air interface
network IP address. All radios must use the same CAI Network ID to be
able to exchange data. It is recommended that the default value of 12
is used.

5 TRBOnet Server



TRBOnet Enterprise — User Manual

All radio systems based on MOTOTRBO services are represented in the

= CAI Group Network

heocom
SOftware

The CAI Group Network is a value that is combined with the Group ID
to produce the group's air interface network IP address. The CAI
Group Network ID forms the first or most significant byte of each
group's network IP address. All radios must use the same CAI Group

Network ID to be able to exchange data (225, by default).

Note: The values of these two parameters must match those
configured for the radio units via the MOTOTRBO CPS.

Configuration

& Service
G Netwark

# Redundancy
[ Remote Access Restriction
Database
a Reports
£} Service Management
)f_ Advanced Settings
N Geocoding Servers
' Radio Systems
-4} Services
-pl PSC 1
,!, Advanced Settings
-5} Privacy

DDMS service

)’, Advanced Settings
MNIS data service

)’_ Advanced Settings
Slot #1

I Slot #2

Local Slots

off LEP Ent
e .

Set Defaults

Radio Systems

+| Enable Radio Systems

CAI Network: 12
CAI Group Network: 225

Registered Radio Systems

Name Address Radio ID
~| IPSC 1 10.12.110.28 64250
«|| LCP Ent 192.168.0.100 64250
Control Station #1 192.168.10.1 54250

Selex #1 127.0.0.1 54250
Delete Test
Add MOTOTRBO System
oK Cancel

Add Capacity Max

Add DIMETRA Express

Add TREOnet Swift Agent
Add Control Station

Add ECOS-D Repeater

Add KAIROS Repeater

Add WAVE OnCloud Gateway
Add ED137 Station

Add Zenitel Station

Add Analog Station

Add Friendly F5-1000 Station
Add XRC-8000 Controller
Add XRT-2000 Controller
Add WAVE 5000 Controller

L R N I SR SIS e

Registered Radio Systems table, including their Name, IP Address, and Radio

ID (1)

e To add a radio system, click Add and select the appropriate system type
from the drop-down menu (2).

5.10.1 Services

¢ Inthe Configuration pane, under Radio Systems, select Services:

e Inthe Services pane, specify the following Radio System Services-related

5.10 Radio Systems

parameters:
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Automatic Registration Service (ARS)

Select this option to enable the ARS service for the radios. When the
radio powers up, it automatically registers with the server. This feature
is used with data applications, that is, any data traffic on this channel is
associated with an application server such as MOTOTRBO Text
Messaging or MOTOTRBO Location Services.

e Port
Enter the local port number for the ARS service (4005, by default).

e RSSI
Select this option so that the RSSI level will be sent in ARS messages.

Telemetry service (TLM)

Select this option to enable the Telemetry service, which is the wireless
transmission and reception of measured quantities for remotely
monitoring environmental conditions or equipment parameters.

e Port
Enter the local port number for the Telemetry service (4008, by
default).

Text Messaging service (TMS)

Select this option to enable the Text Messaging service (Motorola
Solutions proprietary) which is used to exchange text messages
between the radios and the dispatchers.

e Port
Enter the local port number for the Text Messaging service (4007, by
default).

Location service (LRRP / Indoor)

Select this option to enable the Location service. The radio can send its
coordinates when it is in Global Positioning (via LRRP Protocol) or
iBeacon coverage area.

e Port
This is the local port number for the Location service (4001), which
cannot be modified.

Location service (LIP / Indoor)

Select this option to enable the Location service. The radio can send its
coordinates when it is in Global Positioning (via LIP Protocol) or
iBeacon coverage area.

e Port
This is the local port number for the Location service (5017, by
default).

Job Ticketing service (JTS)
Select this option to enable the Job Ticketing service.
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e Port
This is the local port number for the Job Ticketing service (4013, by
default).

Text Messaging service DMR
Select this option to enable the DMR-based Text Messaging service.

e Port
Enter the local port number for the DMR-based Text Messaging
service (5016, by default).

Indoor service (K-TERM)
Select this option to enable the Indoor Location service.

e Port

Enter the local port number for the Indoor service (3022, by default).

Indoor LAN Service (K-TERM)
Select this option to enable the Indoor LAN service.

e Port
Enter the local port number for the Indoor LAN service (3001, by
default).

Tallysman Sprite service

Select this option to enable the service for autonomous event and
aggregated event reporting to provide significant reduction in GPS
data overhead.

e Port
Enter the local port number for the Tallysman Sprite service (4004,
by default).

FS 5000 location service (GPS)

Select this option to enable the FS 5000 location service, which is a
service for transmitting GPS data packages. This service uses FS 5000
Option Board.

e Port
Enter the local port number for the FS 5000 location service (4004,
by default).

Swift.Tracker v.1 service
Select this option to enable the service to transmit coordinates and

data packages via a radio channel using the Swift.Tracker TR001 device.

e Port
Enter the local port number for the Swift.Tracker v.1 service (4004,
by default).

Swift.Tracker v.1 service (IP channel)

Select this option to enable the service to transmit coordinates and
data packages via a radio channel and a reserved IP channel using the
Swift.Tracker TR001 device.
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e Port
Enter the local port number for the Swift.Tracker v.1 service with an
IP channel (4080, by default).

Swift.Tracker v.2 service

Select this option to enable the service to transmit coordinates and
data packages via a radio channel using the Swift.Tracker TR001 device
(version 2).

e Port
Enter the local port number for the Swift.Tracker v.2 service (4104,
by default).

Swift.Tracker v.2 service (IP channel)

Select this option to enable the service to transmit coordinates and
data packages via a radio channel and a reserved IP channel using the
Swift.Tracker TROO1 device (version 2).

e Port
Enter the local port number for the Swift.Tracker v.2 service with an
IP channel (4180, by default).

Extended Text Messaging service

Select this option to enable the Extended Text Messaging service to
include sending detailed preconfigured templates with the help of
TRBOnNet Dispatch Software.

e Port
Enter the local port number for the Extended Text Messaging
service (4010, by default).

Extended Data service
Select this option to enable the Extended Data service that will be used
for communication with TRBOnet Communicator.

e Port
Enter the local port number for the Extended Data service (4106, by
default).

Telemetry service Novox
Select this option to enable the Telemetry service based on NOVOX
devices.

¢ Requests port
Enter the local port number to listen for requests (8090, by default).

e Events port
Enter the local port number to listen for events (8091, by default).

G4S RS232 service
Select this option to enable the custom developed G4S RS232 service.

e Port
Enter the local port number for the G4S RS232 service (4004, by
default).
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= Zebra printer service
Select this option to enable the service for printing Job Tickets. A Zebra
printer is connected to a radio via Bluetooth. The radios should be
Bluetooth-enabled.

e Port
Enter the local port number for Zebra printer service (4072, by
default).

= Forward Data service
Select this option to enable the Forward Data service. This feature is
used to forward "raw data" via the COM port from one device to
another.

e Port
Enter the local port number for Forward Data service (4011, by
default).

5.10.2 Adding a MOTOTRBO Repeater

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ Inthe drop-down menu, click Add MOTOTRBO System.

¢ Inthe Repeater pane, specify the connection parameters.
To ensure your connection parameters match the actual configuration of
your radio network, you may need to use Motorola CPS or Config Advisor
tools to determine the values. Contact your radio network administrator,
if you do not have this information.

Configuration Repeater #1
u‘ Service ~
0 Metwork System Name: Repeater #1
@ Redundancy TREOnet Peer ID: 100
4 Remote Access Restriction
— TRBOnet Radio ID: 64250
Database

'E\ Reports TREOnet Local Port: 50000

L} Service Management Master Repeater Connection Information:

}t Advanced Settings IP Address: 10.10.133.5
i.2A. Geocoding Servers

I Recio Systems LDP Port: 50501 - Test
.I'F Services Authentication Key: 951
System #1 System Type: IP Site Connect
Repeater #1 §
- ){ Advenced Settings System Identifier: Department 1
& Privacy Use NAI Voice
-0 Slot #1
Use NAI Data (MMIS and DDMS)
... Slot #2 M
Use RCM to monitor radio activity
-..C11 Local Slots
B PTT over Cellular
/ Advanced Settings
... | TREONet.Mobile gateway v
< o >
Set Defaults Apply Cancel

= System Name
Enter a name for the repeater. This name will be displayed in the
Dispatch Console.

5.10 Radio Systems
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= TRBOnet Peer ID
Enter a Peer ID for TRBOnet Server. The Peer ID must be unique
among the repeaters in the radio system.

Note: Motorola recommends that this value be less than 200.

= TRBOnet Radio ID
Enter the Radio ID, which is a gateway for voice and data. The Radio ID
must be unique in the radio system (for Capacity Plus and Linked
Capacity Plus systems, the maximum value is 65535).

= TRBOnet Local Port
Enter the local port number that will be used by TRBOnet Server to
establish a connection to the repeater. Use unique port numbers for
each repeater connection if there are several repeaters connected.

Master Repeater Connection Information

= IP Address
Enter the Ethernet IP address of the master repeater.

Note: This value is programmed for a repeater via
MOTOTRBO CPS, in Link Establishment>Master IP.

= UDP Port
Enter the UDP port number of the master repeater.

Note: This value is programmed for a repeater via
MOTOTRBO CPS, in Link Establishment>Master UDP Port.

= Authentication Key
Enter the repeater's authentication key (if any).

Note: This value is programmed for a repeater via
MOTOTRBO CPS, in
Link Establishment>Authentication Key.

= System Type
From the drop-down list, select the type of the radio system
('IP Site Connect', 'Capacity Plus’, 'Linked Capacity Plus', or
'Extended Range Direct Mode").

*= Test
Click this button to check the connection to your master repeater. If
the test is successful, you'll see the information on the repeater you
are connected to, such as the serial number, firmware version, and
other relevant information.
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= System Identifier
Enter the system identifier if a Capacity Plus/Linked Capacity Plus or
Capacity MAX system is used with one or more control stations. Use
the same system identifier as you have specified for the corresponding
control stations.

= Use NAI Voice
Select this option to connect to the repeater via NAI (Network
Application Interface) for Voice transfer. For more details about NAI,
see Appendix F: NAI VOICE & DATA Support (page 409).

= Use NAI Data (MNIS and DDMS)
Select this option to connect to the repeater via NAI (Network
Application Interface) for Data transfer. For more details about NAI,
see Appendix F: NAI VOICE & DATA Support (page 409).

¢ MNIS
MOTOTRBO Network Interface Service is a Windows application
which acts as a data gateway between the data applications and the
radio system. Data messages are routed through the MNIS.

e DDMS
Device Discovery and Mobility Service is a service for tracking the
presence of radio subscribers in the radio network and transmitting
the data to the server.

5.10.2.1 Advanced Settings

¢ In the Configuration pane, under the corresponding Repeater, select
Advanced settings.

Configuration Advanced Settings
¢ Service ~
0 Network Call Hangtime (ms):
"i! Redundancy Group Call: 3000
=, Remote Access Restriction Erat 2000
Database ’
}9 Reports Emergency Call: 4000
£} Service Management
3 X TX Preamble: 120
){ Advanced Settings
LA Geocoding Servers TX Timeout: 60 - | seconds
IR Radio Systems
LT Services Phone System: Motorola Phone System
:3 Repeater #1 TX Interrupt Mode: MSI Proprietary

0 Privacy Allow CSBK Data
-0 Audio Paths

Ef PTT over Cellular

/ Advanced Settings

[ TRBONet.Mobile gateway
i Teltonika
55 Remote Agents
5| Friendly Servers

=
< >

Set Defaults Apply Cancel

¢ Inthe Advanced Settings pane, specify the following repeater-related
advanced settings:

Call Hangtime (ms):
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Group Call

This value sets the duration the repeater reserves the channel after the
end of a group call transmission. During this time, only members of
the group that the channel is reserved for can transmit.

Private Call

This value sets the duration a radio keeps the private call setup after a
user releases the PTT button. This is to avoid setting up the call again
each time a user presses the PTT button to transmit. During this time,
other radios can still transmit since the channel is essentially idle. After
the hang timer expires, the radio transmits using the TX Contact Name
parameter specified for this channel in MOTOTRBO CPS.

Emergency Call

This value sets the duration the repeater reserves the channel after the
end of an emergency call transmission. During this time, only
members of the Group that the channel is reserved for can transmit.

Note: The values of the above three parameters must be
taken from the corresponding parameter values
programmed for the repeater via MOTOTRBO CPS in
General Settings.

TX Preamble

Enter the value of the TX Preamble. The TX Preamble is a string of bits
added in front of a data or control message (Text Messaging, Location
Messaging, Registration, Radio Check, Private Call, and other message
types) before transmission. The acceptable range is 0 - 8640 ms. The
recommended value is 120 ms.

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When
the dispatcher starts any voice session in the Dispatch Console,
transmission will be interrupted after this TX Timeout expires.

Phone system
From the drop-down list, select the system for phone calls:

¢ Motorola Phone System
This system uses a special call type with the parameters specified for
a radio unitin MOTOTRBO CPS. The Motorola Phone System is
recommended for IP Site Connect mode to minimize Radio response
time. For more details on programming Motorola Radios, see
Appendix E: SIP Setup for Motorola Phone System (page 406).

e TRBOnet Phone System (TX Interrupt)
This is a phone call system based on the private call type using TX
Interrupt feature. This phone system is available for radio systems
with control stations.
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= TXInterrupt Mode
Use the default value MSI Proprietary.
The 'DMR Standard' mode is selected when non-Motorola radios are
used that support TX Interrupt and require to be additionally
configured.

= Allow CSBK Data
Select this option so that GPS data is sent in a single CSBK.

Note: This feature is available only when the MNIS Data
Service is enabled for the repeater.

5.10.2.2 Privacy

¢ Inthe Configuration pane, under the corresponding Repeater, select

.
Privacy.
Configuration Privacy
u Service -
& Network Privacy Type: Enhanced
@ Redundancy Basic Privacy Key ID:
3 Remote Access Restriction X
— Enhanced Privacy Keys:
Database
(9 Reports D alue
L} Service Management [ARC4 (40bit) [=i1

)’_ Advanced Settings
i\ Geocoding Servers
l Radio Systems

Services

ARC4 (40 bit)
AES (256 bit)
AES (256 bit) Legacy

Repeater #1

/ Advanced Settings
Privacy

Audio Paths

B PTT over Cellular

75 Teltonika

5l Remote Agents
il Friendly Servers
- .

- Add Remave @ File
< >

set Defaults Apply Cancel

¢ Inthe Privacy pane, specify the following privacy-related settings:
= Privacy Type
From the drop-down list, select one of the privacy types: None, Basic,
or Enhanced.
= Basic Privacy Key ID
Enter the Privacy Key ID available for the Basic privacy type.

= Enhanced Privacy Keys
Here you add enhanced privacy keys when the Enhanced privacy type
is selected.

e Click Add and specify the required Algorithm, ID, Name, and Value
for the privacy key being added.
v Algorithm
From the drop-down list, select one of the enhanced algorithms if
you are going to use additional encryption.
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5.10.2.3 DDMS Service

The DDMS, or Device Discovery and Mobility Service is a service for tracking the
presence of radio subscribers in the radio network and transmitting the data to
the server.

¢ Inthe Configuration pane, under the corresponding Repeater, select
DDMS service.

Configuration DDMS service
o Service ~
0 Network +| Use DDMS service
& Redundancy
=, Remote Access Restriction
Database
_53 Reports Service port: 3000
£} Service Management
\)’: Advanced Settings
A Geocoding Servers
I Radio Systems Service IP Address | Service port Local part
LF Services 1 |[v| 10.10.101.207 3000 o
ﬁ System #1
I:ﬂ Repeater #1
/ Advanced Settings
2 Privacy
,’ Advanced Setting
i MNIS data service
.10 Audio Paths
B PTT over Cellular
12 Teltonika

Local port: 1]

Service IP Address: 127.0.0.1 - Test

Authentication Port: | 5055

Redundant services:

. Add Delete Test AT
< >

Set Defaults Apply Cancel

e Inthe DDMS service pane, specify the following DDMS service-related
settings:

Use DDMS service
Select this option to enable the DDMS service for the server.

Local Port
Enter the number of the local port to be used on a PC with TRBOnet
Dispatch Software for DDMS service.

Service IP Address

Enter the IP Address of the PC with the DDMS service installed and
running.

Service port

Enter the service port number.

Note: This value is programmed for a DDMS service via
MOTOTRBO DDMS Administrative Client, in
Interfaces>Watcher Settings>PortWatcher.

Authentication Port
Enter the authentication server port number.

Note: This value is programmed for a DDMS service via
MOTOTRBO DDMS Administrative Client, in
Interfaces>Authentication Server Settings>
AuthenticationServerPort.

5 TRBOnet Server



TRBOnet Enterprise — User Manual

= Redundant services

heocom
SOftware

Here you see the list of redundant DDMS services for failover

purposes.

¢ Click Add and specify the required parameters for the DDMS service

being added.

e C(Click Test to test if the selected DDMS service is available.

e UsetheUp( # )and Down ( ¥ ) buttons to move a selected DDMS
service up and down in the priority list of DDMS services.

Advanced Settings

¢ Inthe Configuration pane, under DDMS service, select Advanced

Settings.
Configuration Advanced Settings
U Service -
0 Network Radio ID range: 1-200

@ Redundancy
=, Remote Access Restriction
Database
}} Reports
£} Service Management <] 251 o
‘)f: Advanced Settings
i...A Geocoding Servers
IR Radio Systems
L} Services
:B System %1
. epeater 1
Advanced Settings
ivacy
¥ DOMS service
Jvced serng
& MNIS data service
.00 Audio Paths
Bf PTT over Cellular
7 Teltonika

Events: Al

External sites:

. Add Delete
< >

Set Defaults Apply

Cancel

e Inthe Advanced settings pane, you can specify settings that relate to the

connected DDMS service:
= Radio ID range

Enter the range of the radios to receive data from according to the

following rules:

e To receive data from all radios in the system, leave this box blank.

e To receive data from multiple radios and also from a range of
radios, separate each Radio ID by a comma and also enter the

range. For example: 12, 35, 105-111, 249.

Note: In the Radio ID list, enter Radio IDs only, without
mentioning Radio Names and/or the word "Radio".

= Events

In the drop-down list, select the events to be monitored.

5.10 Radio Systems
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= Specify external sites
This is the list of sites that is used when the corresponding system has
a MOTOROLA System Bridge to the current Capacity MAX system.

e Click the Add button and add a site by specifying its Site ID and

selecting the appropriate data types (Presence, Voice, and/or
Data).

5.10.2.4 MNIS Data Service

The MNIS, or Motorola Network Interface Service, is a Windows application
which acts as a data gateway between the data applications and the radio
system. Data messages are routed through the MNIS.

¢ In the Configuration pane, under the corresponding Repeater, select
MNIS data service.

Configuration MNIS data service
H‘ Service -
o Network | Use Data Gateway
@ Redundancy | Service is on a local host
= Remote Access Restriction
Database IP Address: 172.16.10.2 - @
(@ Reports | Control port: 55000 - Test
Service Management MMIS Service: MOTOTREO Metwork Interface Service &2
Ad d Setti
}t vanced Setings Redundant services:
)\ Geocoding Servers
IP Address Control port Local port
IR Radio Systems
.4} Services 1 |v| 10.10.102.103 55000 1]
:B System #1
:ﬂ Repeater #1
. Advanced Settings
] Privacy
F DDMS service
3 .. Advanced Setting
INIS data service
: - Advanced Setting
.. Audio Paths
B PTT over Cellular v
S Add Delete Test A | Y
< >
Set Defaults Apply Cancel

e Inthe MNIS data service pane, specify the following MNIS data service-
related settings:
= Use Data Gateway
Select this option to enable the MNIS data service for the server.
= Service is on a local host
Select this option if the MNIS data service will be used on the local PC.
= IP Address
Enter the IP Address used by the MNIS to communicate with the PC.

Note: This value is programmed for a MNIS data service via
MOTOTRBO MNIS Configuration Utility, and can be
retrieved from
General>Tunnel Network>Tunnel IP Address.

= Control port
Select this option and enter the number for the MNIS control port.
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Note: This value is programmed for a MNIS data service via
MOTOTRBO MNIS Configuration Utility, in
Advanced>Network>MNIS Control Interface TCP Port.

MNIS Service
Select this option, and from the drop-down list select the available
MNIS service.

Redundant services
Here you see the list of redundant MNIS data services for failover
purposes.

e Click Add and specify the required parameters for the MNIS data
service being added.

e Click Test to test if the selected MNIS data service is available.

e UsetheUp( 4 )and Down ( ¥ ) buttons to move a selected MNIS
data service up and down in the priority list of MNIS data services.

Advanced Settings

¢ In the Configuration pane, under MNIS data service, select

Advanced Settings.

Configuration Advanced Settings
ﬂ-" Service -
0 Metwork | Send data over control port
¥ Redundancy
= Remote Access Restriction
Database Add port forwar the r IS service
(@ Reports Quewe Limit: None
£} Service Management
f Advanced Settings
)\ Geocoding Servers
IR Radio Systems
L LF Services
pf} System #1
:3 Repeater #1
L pdvanced Settings

Radio Range: 1 - | - |16777215

Privacy

DDMS service

)’_ Advanced Setting
MNIS data service
.00 Audio Paths

Ej PTT over Cellular v

€ >

Set Defaults Apply Cancel

¢ Inthe Advanced settings pane, you can specify settings that relate to the

5.10 Radio Systems

remote MNIS data service:
= Send data over control port

Select this option so that data will be sent via the specified control port.

Or, do not select this option, and instead select one or both of the
following two options:

= Add network routes to the local Windows routing table

Select this option to allow TRBOnet Server to add network routes to the
local Windows routing table so that data can be sent to the remote
MNIS data service.
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= Add port forwarding rules to the remote MNIS service

Select this option to allow TRBOnet Server to add forwarding rules to
the remote MNIS data service.

= Radio Range

Specify the range of radios to be monitored by the MNIS service.

5.10.2.5 Slots

Note: The slots are available only when IP Site Connect is selected in

the Repeater pane.

¢ In the Configuration pane, under the corresponding Repeater, select
Slot #1 or Slot #2.

Configuration Slot #1
o Service ~
9 Network v| Slot #1
@ Redundancy MName:
5 Remote Access Restriction Messaging Delay: Normal
Database X
— Use slot for RX data only (GPS Revert or Data Revert)
@ Reports

L} Service Management
\)’: Advanced Settings

Lkl Geocoding Servers Allow interruption
! Radio Systems Always transmit when the PTT is pressed ("Impolite” channel access)
L} Services | Data Call Confirmed
o System #1 Private call confirmed
E :3 Repeater #1

i | Emergency Alarm Ack
,’_ Advanced Settings gency

o Privacy
(e ciot =1
.07 Slot 52
: Local Slots
Bj PTT over Cellular
7 Teltonika
3 Remote Agents

| Emergency CallfAlarm Indication

Fd Friendly Servers
—_ _

Set Defaults Apply Cancel

¢ Inthe Slot pane, specify the following slot-related parameters:

Slot #1 (or Slot #2)
Select this option to enable Slot #1 (or Slot #2) for the Repeater.
Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.
Messaging Delay
From the drop-down list, select the inter-repeater messaging delay
based on the IP network configuration.
e Normal
The inter-repeater messaging delay is 60 ms.
e High
The inter-repeater messaging delay is 90 ms.
Use slot for RX data only (GPS Revert or Data Revert)

Select this option to configure the slot so that it will only receive data,
thus having no transmission capability.
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= Use Privacy
Select this option to use Privacy for the slot.

Note: This option is available only if the Basic or Enhanced
Privacy Type have been selected in Repeater's Privacy
settings.

= Privacy Key
From the drop-down list, select the privacy key.

Note: This option is available only if the Enhanced Privacy
Type has been selected in Repeater's Privacy settings).

= Allow interruption
Select this option to allow interrupting dispatcher transmissions by
radios that are Transmit Interrupt capable.

= Always transmit when the PTT is pressed ("Impolite" channel
access)
Select this option so that when the PTT button is pressed, the
dispatcher will start transmitting regardless of whether the channel is
free or not (that is any transmission in progress will be interrupted).

= Data Call confirmed
Select this option to enable data packets in data calls (ARS, GPS, and
Text Message) on the current slot to be confirmed.

Note: This feature is available only when both the Use NAI
Voice and Use NAI Data (MNIS and DDMS) options are
not selected in the Repeater pane.

= Private call confirmed
Select this option to set Private calls on the current slot as confirmed.
By default, Private calls are unconfirmed.

= Emergency Alarm Ack
Select this option so that the Dispatch Console is allowed to
acknowledge an emergency alarm received via this slot.

= Emergency Call/Alarm Indication
Select this option so that audio and visual indication is given for an
emergency call/emergency alarm received via this slot.

5.10.2.6 Local Slots

While on a local slot, voice or data are not transmitted between sites in IPSC
systems. Due to MOTOTRBO limitations TRBOnet Server can only receive
information from local slots, but cannot transmit by IP connection to such slots.
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Note:

Local slots are available only when IP Site Connect is selected,
and the Use NAI Voice option is selected in the Repeater
pane.

If the Use NAI Voice option is not selected, local slots will be
available only through dedicated control stations.

¢ Inthe Configuration pane, under the corresponding Repeater, select
Local Slots.

Configuration Local Slots

1§ Service -
G Netwaork
¢ Redundancy lame Peer ID
=, Remote Access Restriction
Database
7,3'3 Reports

Load Peers Map

| Local Brine's 1002 Slot #1 -

£} Service Management
94 Advanced Settings
)\ Geocoding Servers
IR Radio Systems
L} Services
:B System #1
:ﬂ Repeater #1
,’_ Advanced Settings

Privacy
Slot #1
i1 Slot #2

(] ocal Slots
Bf PTT aver Cellular
o Teltonika

[l Remote Agents

i Friendly Servers Add Remove Configure
—_ - .

Set Defaults Apply Cancel

¢ Inthe Local Slots pane, specify the following Local Slot-related settings:

To add a Local Slot to the system, click Add.
Select the option in the first column to enable the selected local slot.

Enter a Name for the local slot. This name will be displayed in the
Dispatch Console.

Enter the Peer ID of the repeater.

Note: This value can be taken from the repeater's
configuration in MOTOTRBO CPS, in General
Settings>Radio ID.

From the drop-down list, select the Peer Slot.

To configure the selected local slot, click Configure.
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TX Configuration x
Mame:
Messaging Delay: MNormal

Use slot for RX data only (GPS Revert or Data Revert)
Use Privacy
Privacy Key:
Allow interruption
Always transmit when the PTT is pressed {"Impalite” channel access)
Data Call Confirmed
Private call confirmed
+ | Emergency Alarm Adk

+ | Emergency CallfAlarm Indication

= Specify the desired local slot settings similar to those for a common
repeater slot.

5.10.2.7 Audio Paths

The Audio Paths are talk paths of the system to make and receive Voice Calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a
Capacity Plus system be registered in its configuration. If an audio path is not
registered, the TRBOnet operator will not be able to receive and transmit to the
corresponding talk group.

Note: Audio paths are available only when Capacity Plus or Linked
Capacity Plus are selected.

¢ Inthe Configuration pane, under the corresponding Repeater, select
Audio Paths.

Configuration Audio Paths
& Service -
0 Network Load Groups Map
‘g! Redundancy Call Type Group ID Site 1D
=, Remote Access Restriction || Group Call 10 Wide
Database )
o || Group Call 20 Wide
[ Reports
[} Service Management || Private Call
)’_ Advanced Settings « || Al Call
[N Geocoding Servers
IR Radio Systems
A’} Services
Repeater #1
}t Advanced Settings
| Privacy
DMS service
)’: Advanced Setting
INIS data service
/’_ Advanced Setting
Bf PTT aver Cellular
7 Teltonika v
= I TR — Add Delete Configure
< >
Set Defaults Apply Cancel

¢ Inthe Audio Paths pane, specify the following Audio Path-related
settings:

= To add an audio path to the system, click Add.

= Make sure the checkbox in the first column is selected to make and
receive voice calls on the selected talk path.
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= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is an ID of the talk group the dispatcher can
make calls to. The Group ID is not applicable for Private Calls and All
Calls.

= Enter the Site ID of the site the audio path will belong to in a Linked
Capacity Plus system. Or, leave zero value in this column. In this case,
the Site ID will be displayed as Wide, meaning that the audio path will
belong to all sites in the system.

= To configure the selected audio path, click Configure.

= Specify the desired audio path settings similar to those for a common
repeater slot.

5.10.3 Adding a Capacity MAX System

e Inthe Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

e Inthe drop-down menu, click Add Capacity MAX.

Note that a Capacity Max system can only be integrated with TRBOnet PLUS
software. For more information on how to configure and deploy a Capacity
MAX system, see TRBOnet PLUS MOTOTRBO Capacity MAX Deployment Guide.

5.10.4 Adding a DIMETRA Express System

¢ Inthe Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

e In the drop-down menu, click Add DIMETRA Express.

For more information on how to configure and deploy a DIMETRA Express
system, see TRBOnet DIMETRA Express Deployment Guide.

5.10.5 Adding a TRBOnet Swift Agent
The TRBOnet Swift Agent functions as a gateway to receive and transmit voice
and data.

e In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

e Inthe drop-down menu, click Add TRBOnet Swift Agent.
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5.10 Radio Systems

Configuration TRBOnet Swift Agent #1
& service -
& Network Name: TRECnet Swift Agent %1
# Redundancy Radio ID: 64250
; Remote Access Restriction
=] Database IP Address: 10.10.110.191
(2 Reports Port: 8002 : Test

£F Service Management
# advanced Settings
N Geocoding Servers
I8 Radio Systems System Identifier: Department 2
L} Services
- - Use radio for R datz only (GPS Revert or Data Revert)
.o
/ Advanced Settings VolIP port: 4000 -
@ Redundancy Audio Format: PCM 8 kiiz 16 bit
B§ PTT over Celular
I Teltonika
5| Remote Agents

TRBOnet Local Port: 50001
Mode: Single Control Station

5| Friendly Servers
T Phone Connect
- /’ Advanced Settings
- ﬁ Internal PBX Server
| Data Sources

Set Defaults Apply Cancel

In the TRBOnet Swift Agent pane, specify the following Swift Agent-
related parameters:

Name
Enter a name for the Swift Agent. This name will be displayed in the
Dispatch Console.

Radio ID

This is the Radio ID of the control station connected to the Swift Agent.

(for Capacity Plus and Linked Capacity Plus systems, the maximum
value is 65535).

Note: This box is populated automatically once you have
successfully tested the Swift Agent by clicking the Test
button.

IP Address
Enter the IP Address of the Swift Agent network interface.

Port

Enter the port number of the Swift Agent connection (8002, by default).

TRBOnet Local Port

Enter the local port number that will be used by TRBOnet Server to
establish a connection to the Swift Agent. The value 0 (default) means
that a random port will be used.

Test

Click this button to check the connection to the Swift Agent. If the test
is successful, you'll see the information on the Swift Agent you are
connected to, such as Serial number, Firmware version, and other
relevant information.
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* Mode
From the drop-down list, select the connection mode for the Swift
Agent being configured. For more details, see section 5.10.6.1, Control
Station Connection Modes (page 54).

= System Identifier
Enter the system identifier if the control station is used with a Capacity
Plus or Linked Capacity Plus system. Note that the system identifier
should be the same for all control stations used in the radio system.

= Use radio for RX data only (GPS Revert or Data Revert)
Select this option to configure the radio channel so that it will only
receive data, thus having no transmission capability.

= VoIP port
Enter the port number for audio communications (4000, by default).

Note: This setting is used for older firmware versions of
TRBOnet Swift Agent.

= Audio Format
From the drop-down list, select the format to transmit audio data.

5.10.5.1 Advanced Settings

¢ In the Configuration pane, under the corresponding TRBOnet Swift
Agent, select Advanced Settings.

Configuration Advanced Settings
o service ”
O Metwork +| Automatically reset alarm mode
ﬁﬁ Redundancy | Emergency Callfalarm Indication
= Remote Access Restriction Always transmit when the PTT is pressed {"Impolite” channel access)
Database TX Timeout: 60 = | seconds

'g Reports
L} Service Management v | Mic delay time: 600 = | miliseconds
)f Advanced Settings

A Geocoding Servers
IR Radio Systems PTT Mode: KeyUp | DeKey

| Roger beep: Ct'\Desktop\RingMabile, wav K owe

L} Services Signaling System: Mong ~ | Configure
- TRBOnet Swift Agent #1

@& Redundancy

5§ PTT over Cellular
7. Teltonka
33 Remote Agents
[ Friendly Servers
‘R Phone Connect

- )!' Advanced Settings

- ﬁ Internal PEX Server
I Data Sources

Set Defaults Apply Cancel

¢ Inthe Advanced Settings pane, specify the following Swift Agent-related
advanced settings:

= Automatically reset alarm mode
Select this option to reset alarm mode on the control station radio
automatically. It is recommended to enable this option.
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5.10 Radio Systems

Emergency Call/Alarm indication

Select this option so that audio and visual indication is given by the
Control Station radio when an Emergency Call/Emergency Alarm is
received.

Always transmit when the PTT is pressed ("Impolite" channel
access)

Select this option so that that when the PTT button is pressed, the
radio will start transmitting regardless of whether the channel is free
or not (that is any transmission in progress will be interrupted).

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
dispatcher starts any voice session in the Dispatch Console,
transmission will be interrupted after this TX Timeout expires.

Mic delay time

Select this option and specify the time, in milliseconds, to be used as a
delay time interval between pushing the PTT and enabling the
microphone.

e Roger beep
Select this option to play a beep sound for the time interval until the
microphone is enabled. Click the ellipsis button (...) on the right and
locate the desired sound file (WAV).

PTT Mode

From the drop-down list, select the mode of pressing the PTT on the

radio.

Signaling system

From the drop-down list, select the signaling system.

¢ MDC-1200 signaling is a Motorola data system using audio
frequency shift keying (ASFK) using a 1,200 baud data rate. A
general option is to enable or disable an acknowledgement (ACK)
data packet.

e SELECT-5 (5 Tone Signaling System). In the 5 Tone Signaling
Systems, each radio has a unique numeric identity (for example,
12345). To signal the number 12345, a sequence of 5 tones is sent.
Sequences of audible tones of a very short duration are sent
between radios. Most 5 tone sequences take less than half a second
to send. Available for Voice Calls, Radio Check, Call Alert, and
Enable/Disable Radio.

Click the Configure link and specify desired SELECT 5 settings.

¢ Quick Call I. Using this signaling system, the radio sends a pair of
tones followed by 50 to 1,000 milliseconds of silence and then a
second pair of tones.
Click the Configure link and specify desired Quick Call I settings.
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¢ Quick Call II. Using this signaling system, the radio sends a single
tone followed by 50 to 1,000 milliseconds of silence and then a
second tone.
Click the Configure link and specify desired Quick Call II settings.

¢ Quick Call II MOTOTRBO
When this system is selected, the parameters are configured for the
radio units via the MOTOTRBO CPS.

5.10.5.2 Redundancy

A Redundant TRBOnet Swift Agent will be used when a connection to the Main
TRBOnet Swift Agent is lost.

¢ In the Configuration pane, under the corresponding TRBOnet Swift
Agent, select Redundancy.

Configuration Redundancy
u Service ~
0 Network Redundant agents:

# Redundancy IP Address Port Local Port
/= Remote Access Restriction 1 [v] 10.10.1.210 3002 2

Database
_[é Reports
L3 Service Management
)f Advanced Settings
N Geocoding Servers
IR Radio Systems
~LF Services
..om TRECNet Swift Agent #1
,If Advanced Settings
EJ PTT over Cellular
. Teltorika
5| Remote Agents
2 Friendly Servers
‘R Phone Connect

./J@ Internal PEX Server

| Data Sources Add Delete Test AllY
; v
Set Defaults Apply Cancel

¢ Inthe Redundancy pane, specify the following Redundant Agent-related
settings:
= Click Add and specify the desired parameters for the Redundant Agent
being added.

o IP Address
Enter the IP Address of the Swift Agent that will be used as a
Redundant Swift Agent.

e Port
Enter the port number that will be used for connections between
the server and the Redundant Swift Agent (8002, by default).

o Click Test to check the connection to the Redundant Swift Agent.
If the test is successful, you'll see the information on the Swift Agent
you are connected to, such as Serial number, Firmware version, and
other relevant information.
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e Local Port
Enter the port number that will be used for connections from the
Redundant Swift Agent. The value 0 (default) means that a random
port will be used.

5.10.6 Adding a Control Station

e Inthe Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

e Inthe drop-down menu, click Add Control Station.

‘Configuration Control Station #1
o Service )
O Network Name: Control Station #1
@ Redundancy Rado ID: 64250 :
4 Remote Access Restriction
= Database IP Address: 192.168.10.2 - @ Test
(3 Reports Mode: Single Control Station

£} Service Management
\){ Advanced Settings
LA Geocoding Servers Use radio for RX data only (GPS Revert or Data Revert)
I Radio Systems
L} Services
i b Recording device: Microphone (2- Logitech USB Headset) -
/’_ Advanced Settings
B PTT over Cellular
1% Teltonika
B2l Remote Agents

System Identifier: Department 1

Playback device: Speakers (2- Logitech USE Headset) -

5l Friendly Servers
‘R Phone Connect
/’_ Advanced Settings
E Internal PEX Server
‘}' Data Sources
4 Email

Set Defaults Apply Cancel

¢ Inthe Control Station pane, specify the following control station-related
parameters:

5.10 Radio Systems

Name

Enter a name for the control station. This name will be displayed in the
Dispatch Console in the Voice Dispatch Radio Interface pane. It will be
the name at the top of the PTT box.

Radio ID
This is the Radio ID of the radio unit connected as a control station.

(for Capacity Plus and Linked Capacity Plus systems, the maximum
value is 65535).

Note: This box is populated automatically once you have
successfully tested the control station by clicking the
Test button.

IP Address
Enter, or select from the list, the IP Address of the control station
network interface.

Note: This value can be taken from the radio's configuration
in MOTOTRBO CPS, in Network>Accessory IP.
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Test

Click this button to check the connection to the control station. If the
test is successful, you'll see the information on the control station you
are connected to, such as radio ID, serial number, firmware version,
and other relevant information.

Mode
From the drop-down list, select the connection mode for the control

station being configured. For more details, see section 5.10.6.1, Control
Station Connection Modes (page 54).

System Identifier

Enter the system identifier with which the control station is used within
a Capacity Plus or Linked Capacity Plus system. Note that the system
identifier should be the same for all control stations used in a (Linked)
Capacity Plus system.

Use radio for RX data only (GPS Revert or Data Revert)
Select this option to configure the radio channel so that it will only
receive data, thus having no transmission capability.

Playback device
From the drop-down list, select the playback device on the PC that will
be used to transfer audio data to the connected control station.

Recording device

From the drop-down list, select the recording device on the PC that will
be used to receive audio data from the control station connected via a
line-in jack.

5.10.6.1 Control Station Connection Modes

Single Control Station

The Single Station mode is the simplest connection mode for receiving and
transmitting voice and data through a conventional channel using one control
station at this particular frequency.

\\/
Subscriber #2 \
1
Control Station / 5 S \
!
\\\ Subscriber #1 Subscriber #N/
x \ /
N\ A\ /
\ %

\
N\

D [ LAN/WAN—) j

ST RS

TRBOnet Dispatch Console
Server
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IP Site Connect

The IPSC is a digital conventional two-way MOTOTRBO system that allows you
to extend the area of your communications by providing 2 wide area channels
per repeater. It is possible to connect up to 15 repeaters in one system using IP
connection.

The Server Connection Modes are as follows:

1. TRBOnet Server is connected to a repeater with two time slots in the
"IP Site Connect" mode. The Server can transmit and receive over IP.

2. TRBOnet Server has no IP connection to a repeater. Two control
stations are required to transmit and receive voice and data, that is,
one control station per time slot.

Site 1 Site 2 Site 3

% @
2 2 N

Common Channel

The Common Channel is a mode where it is possible to use multiple simplex
base stations operating at the same frequency with overlapping
communication zones.

This mode allows the customer to provide radio coverage to large areas when
there is only one frequency and additional frequencies are unavailable. While in
this mode, the coverage area is being extended only for the dispatcher, and
specifically when operating at one and the same frequency. When a radio unit
initiates a call, the signal that can potentially be received by several base
stations will be filtered on the server side so that repeated audio playback and
recording is prohibited.

The signal filtering is performed based on the "first packet"”, that is, only the
signal coming first to the server is played back and recorded, while the
remaining signals are discarded.

When a dispatcher initiates a call to a specific base station, the signals received
by the neighboring base stations will be discarded to prevent dispatchers from
listening to their own call at the time of transmission. The dispatcher is not
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recommended to place a simultaneous call to all base stations to avoid
interference to the subscribers.

The recommended way to use this mode is as follows: each base station is
configured with its own color code, and radio units are equipped with option
boards having a Geo-roaming feature, and each geographic area is assigned its
own radio channel with the corresponding color code.

.
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: N\ Hoseriber ! . Subscrlber % \
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; {@() #2 Subscr\ber. TRBOnet
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\\ Subscriber % i ,l server D
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v #l

\\\ //

\. Control Station #1* ,*

N Dispatch Consol
> - All control stations in the system P nsole

~~ - operating the same frequency.

Capacity Plus/Linked Capacity Plus

Capacity Plus is a digital trunked two-way MOTOTRBO system that allows you
to accommodate high volume communication. It is designed to organize stable
connection in a few groups within one building or a set of buildings. This
system type allows you to increase the number of channels for voice and data
transmission between the subscribers and control centers. The subscribers are
always automatically forwarded to a free channel. The main objective of
Capacity Plus is to support more simultaneous voice and data transmissions
within one capacious system.

In the Capacity Plus mode you can configure voice and data control stations to
transmit and receive data over the air as it is described in the MOTOTRBO
System Planner. Keep in mind that two data control stations are required per
each data repeater - one per time slot. TRBOnet Dispatch Software provides
you an option to utilize an IP connection to receive voice and data.

5 TRBOnet Server



TRBOnet Enterprise — User Manual

Pz
Dispatcher 1

LR
Dispatcher 2

Master Voice Repeater 1

- 8 AN
/"4‘.

Y v

LR
Dispatcher 3

Voice Repeater 2 o

]

TRBOnet
Server

usB UsB
+

Voice Control Station(s)
1 Voice CS per 1 talk
group

5.10.6.2

Advanced Settings

LAN/WAN

Voice Repeater 3 L % E

% Data Repeater 4
Data Control Station(s) E

1 Data CS per 1 data
repeater time slot

Data Repeater 5

¢ Inthe Configuration pane, under the corresponding Control Station,
select Advanced Settings.

Configuration

& Service
G Network.

@& Redundancy
|2 Remote Access Restriction
= Database
@ Reports
£} Service Management
X Advanced Settings
2\ Geocoding Servers
I8 Radio Systems
{:} Services
gy Control Station #1
Wy 4 dvanced Settings
B PTT over Cellular
T Teltonika
E Remote Agents
E Friendly Servers
' Phone Connect
X Advanced Settings
ﬁ Internal PBX Server
L-' Data Sources
4 Email

| Set Defaults

Advanced Settings

[#] Automatically reset alarm mode

[+] Automatically handle call alert

["] Emergency Call/Alarm indication

[ use front microphone

l__ Always transmit when the PTT is pressed ("Impolite™ channel access)
["] Use serial port for PTT device

-

‘ C:\Desktop\RingMobile. wav X e

Serial port:

TX Timeout:

[«] Mic delay time:

|7_ Roger beep:

Signaling System:

[ ] Allow CSBK Data

| Apply | | OK || Cancel |

¢ Inthe Advanced Settings pane, specify the following control station-
related advanced settings:

= Automatically reset alarm mode
Select this option to reset alarm mode on the control station radio
automatically. It is recommended to enable this option.
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= Automatically handle call alert
Select this option to automatically redirect call alerts from the control
station radio to the Dispatch Console.
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Emergency Call/Alarm indication

Select this option so that audio and visual indication is given by the
control station radio when an Emergency Call/Emergency Alarm is
received.

Use front microphone
Select this option to use a remote control of the PTT button via a
remote speaker microphone on the radio.

Always transmit when the PTT is pressed ("Impolite" channel
access)

Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that
is any transmission in progress will be interrupted).

Use serial port for PTT device
Select this option to use a remote control of the PTT button via the
serial port of the PC, and select the serial port from the drop-down list.

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
dispatcher starts any voice session in the Dispatch Console, the
ongoing transmission will be interrupted after this TX Timeout expires.

Mic delay time

Select this option and specify the time, in milliseconds, to be used as a
delay time interval between pushing the PTT and enabling the
microphone.

e Roger beep
Select this option to play a beep sound for the time interval until the
microphone is enabled. Click the ellipsis button (...) on the right and
locate the desired sound file (WAV).

Signaling system

From the drop-down list, select the signaling system.

e MDC-1200 signaling is a Motorola data system using audio
frequency-shift keying (AFSK) using a 1,200 baud data rate. A
general option setting for the system is to enable or disable an
acknowledgement (ACK) data packet.

e SELECT-5 (5 Tone Signaling System). In the 5 Tone Signaling
Systems, each radio has a unique numeric identity (for example,
12345). To signal the number 12345, a sequence of 5 tones is sent.
Sequences of audible tones of a very short duration are sent
between radios. Most 5 tone sequences take less than half a second
to send. Available for Voice Calls, Radio Check, Call Alert, and
Enable/Disable Radio.

Click the Configure link and specify desired SELECT 5 settings.
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Al Call

/= ME e

Check Radio
call Alert
Enable Radio

Disable Radio

¢ Quick Call I. Using this signaling system, the radio sends a pair of
tones followed by 50 to 1,000 milliseconds of silence and then a
second pair of tones.
Click the Configure link and specify desired Quick Call I settings.

Quick Call | x

eamble: o]

ne 1: 1000

g g F

ne 2: 1000
ong Tone: 4000

IERLERLEREEN

o

200

Defaults oK Cancel

¢ Quick Call II. Using this signaling system, the radio sends a single
tone followed by 50 to 1,000 milliseconds of silence and then a
second tone.
Click the Configure link and specify desired Quick Call II settings.

¢ Quick Call II MOTOTRBO
When this system is selected, the parameters are configured on the
radio unit via the MOTOTRBO CPS.

= Allow CSBK Data
Select this option so that GPS data is sent in a single CSBK.

5.10.6.3 Audio Paths

The Audio Paths are talk paths of the system to make and receive Voice Calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a
radio system be registered in its configuration. If an audio path is not
registered, the TRBOnet operator will not be able to receive and transmit to the
corresponding talk group.

Note: Audio paths are available only when one of the following
modes is selected: Capacity Plus, Linked Capacity Plus,
Connect Plus, or Capacity MAX.

¢ Inthe Configuration pane, under the corresponding Control Station,
select Audio Paths.
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Configuration Audio Paths
& Service
O Metwork Site ID: 1

@ Redundancy
Database

_b\ Reports

£} Service Management || Group Call 20 Wide
/ Advanced Settings 1| Private call

* Geocoding Servers
l Radio Systems

L LF Services

all Type Group ID

|| Group Call 10 Wide

|| all Cal

gk Control Station #1
- )’_ Advanced Settings

-
B PTT over Celular
55| Remote Agents
5z Friendly Servers
’E Phone Conneck
}' Data Sources
4 Email
[i5 SMs Notifications
[ Push Notifications
[ License add Delete

Set Defaults Apply Cancel

¢ Inthe Audio Paths pane, specify the following Audio Path-related
settings:

= To add an audio path to the system, click Add.

= Make sure the checkbox in the first column is selected to make and
receive voice calls from the selected subscriber.

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is an ID of the talk group the dispatcher can
make calls to. The Group ID is not applicable for Private Calls and All
Calls.

= In the Site column, select either Local or Wide. The value Wide means
that the audio path will be to all sites in the system and not just to the
local site.

5.10.7 Adding an ECOS-D Repeater

The ECOS-D repeater is configured as a stand-alone repeater which supports
connections to MOTOTRBO™ radios to transmit voice and data in digital,
analog, and mixed modes.

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

e Inthe drop-down menu, click Add ECOS-D Repeater.
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Configuration ECOS-D #1
&‘ Service ~
) Network Name: ECOS-D #1
@ Redundancy Radio ID: 54250
[z Remote Access Restriction
Database
(@ Reports

Repeater Mode: Digital

L} Service Management
/{ Advanced Settings
[N Geocoding Servers
I8 Radio Systems
i--LF Services
Advanced Settings
-1 slot #1
LT Slot #2
B PTT over cellular
1L Teltonka
I35l Remote Agents
[ Friendly Servers
‘B Phone Connect
)’_ Advanced Settings
.4 Internal PBX Server

w

Set Defaults Apply Cancel

e Inthe ECOS-D pane, specify the following ECOS-D Repeater-related
parameters:

= Name
Enter a name for the ECOS-D Repeater. This name will be displayed in
the Dispatch Console.

= Radio ID
Enter the Radio ID for the ECOS-D Repeater (for Capacity Plus systems,
the maximum value is 65535).
The Radio ID is an individual ID that uniquely identifies the radio. This
ID is used by other calling radios when addressing the radio, for
instance, when making a private call or sending a text message.

= Repeater Mode
From the drop-down list, select the mode. The available modes are
Digital, Analog, Mixed, and Tier III.

5.10.7.1 Advanced Settings

e Inthe Configuration pane, under the corresponding ECOS-D, select
Advanced Settings.
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Configuration Advanced Settings
ﬂ Service -~
0 Metwork Keep Alive Interval: 10
;5 Redundancy TX Timeout: &0
= Remote Access Restriction
Audio Frame Size: 20

Database
_B‘ Reports
[ ¥ Service Management
)’_ Advanced Settings
N Geocoding Servers
I8 Radio Systems
i} Services
pgiy ECOSD #1
'
[ Slot #1
L. Slot #2
B PTT over Cellular
7 Teltonika
il Remote Agents

il Friendly Servers
‘T Phone Connect

L /’_ Advanced Settings
E Internal PEX Server

Set Defaults

| seconds
* | seconds

> ms

e Inthe Advanced Settings pane, specify the following ECOS-D Repeater-
related advanced settings:

= Keep Alive Interval

Enter the time interval, in seconds, for TRBOnet Server to check the
connection to the ECOS-D repeater (10, by default).

TX Timeout
Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any Voice Session in the Dispatch Console,
transmission will be interrupted after this TX Timeout expires (60, by
default).

Audio Frame Size
Set the audio frame size, in milliseconds.

5.10.7.2 Slots

The ECOS-D repeater has two available slots (in Digital or Mixed mode) to
transmit voice and data.

e Inthe Configuration pane, under the corresponding ECOS-D, select Slot
#1 or Slot #2.
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Configuration
& Service
0 Network
# Redundancy
5 Remote Access Restriction
Database
_,3\ Reports
£} Service Management
)’ Advanced Settings
N Geocoding Servers
IR Radio Systems
L} Services
gy ECOSD #1
Advanced Settings

Slot #1

+| Slot #1
Name: Slot 1

TRBOnet IP Address: 10.10.100.59 - @ |Port: |e032

ECOS-D IP Address: 10.10.9.30 ~|Port: 6082

Test

Use gateway for RX data only (GPS Revert or Data Revert)

Use Encryption

Always transmit when the PTT is pressed {"Impolite™ channel access)
| Data Call Confirmed

| Private call confirmed
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.17 Slot #2
Ef PTT over Celular
1. Teltonika
3l Remote Agents
il Friendly Servers
‘& Phone Connect
/’_ Advanced Settings

E Internal PBX Server o

Set Defaults Apply

In the Slot #1 (or Slot #2) pane, specify the following slot-related
parameters:

Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

TRBOnet IP Address
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter
the Port number (6080, by default).

ECOS-D IP Address
Enter the IP Address of the ECOS-D Repeater (refer to the repeater
configuration). Enter the Port number (6080, by default).

Click Test to check the connection to the repeater.

Use gateway for RX data only (GPS Revert or Data Revert)
Select this option to configure the channel so that it will only receive
data, thus having no transmission capability.

Use Encryption
Select this option to encrypt voice and data traffic over IP.

Always transmit when the PTT is pressed ("Impolite" channel
access)

Select this option so that that when the PTT button is pressed, the
radio will start transmitting regardless of whether the channel is free
or not (that is any transmission in progress will be interrupted).

Data Call Confirmed
Select this option to enable individual packets in data calls (ARS, GPS,
and Text Message) on the current slot to be confirmed.

Private call confirmed
Select this option to set Private calls on the current slot as confirmed.
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5.10.7.3

Tier III and Audio Paths

The ECOS-D repeater can be used in a Tier III mode. To configure this mode,

do the following:

e While in the ECOS-D pane, select Tier III from the Repeater Mode drop-

down list.

¢ In the Configuration pane, under the corresponding ECOS-D, select

Tier III.

Configuration
U‘ Service
0 MNetwork
@ Redundancy
= Remote Access Restriction
Database
(@ Reparts
L} Service Management
4 advanced Settings
.\, Geocoding Servers
IR Radio Systems
L LF Services
ECOSD #1
)!' Advanced Settings
L. Audio Paths
B PTT over Cellular
7 Teltonika
5l Remote Agents

5l Friendly Servers

B Phone Connect
,’_ Advanced Settings
ﬁ Internal PBX Server

Set Defaults

Tier IIT

Tier ITT

MName:
TRBOnet IP Address: 10.10.100.93 - g |Port: 5082

ECOS-D IP Address: 10.10.9.30 - |Port: @082 -
Test

Use gateway for RX data only (GPS Revert or Data Revert)
Use Encryption

Always transmit when the PTT is pressed ("Impolite™ channel access)

| Private call confirmed

e Inthe Tier III pane, specify the following Tier Ill-related parameters:

= Use Encryption

Select this option to encrypt voice and data traffic over IP.

= Always transmit when the PTT is pressed ("Impolite" channel

access)

Select this option so that that when the PTT button is pressed, the
radio will start transmitting regardless of whether the channel is free
or not (that is any transmission in progress will be interrupted).

= Private call confirmed

Select this option to set Private calls on the current slot as confirmed.

To configure Audio Paths:

¢ In the Configuration pane, under the corresponding ECOS-D, select

Audio Paths.

Note: Make sure the Tier III mode has been selected as a
Repeater Mode for the ECOS-D repeater.
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e In the Audio Paths pane, specify the following Audio Path-related

5.10.7.4

Configuration

& Service
0 MNetwark

@ Redundancy

|5 Remote Access Restriction

Database

(@ Reports

L} Service Management
‘){ Advanced Settings

N Geocoding Servers
IR Radio Systems

LF Services

.y ECOS D #1
W Advanced Settings
Tier IIT
BEf PTT over Cellular

15 Teltonika
5l Remote Agents

5l Friendly Servers
‘T Phone Connect
)’_ Advanced Settings

ﬁ Internal PBX Server

Set Defaults

Audio Paths
Call Type Group ID
|| Group Call 10
|| Group Call 20
|| Private Cal
|| allcal
Add Delete

o

settings:

= To add an Audio Path to the system, click Add.

= Make sure the checkbox in the first column is selected to make and
receive Voice Calls from the selected subscriber.

heocom
SOftware

= From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

= Enter the Group ID, which is a radio ID of the talk group to make a call
to. The Group ID is not applicable for Private Calls and All Calls.

Analog channel

The ECOS-D repeater can also use the Analog channel.

¢ Inthe Configuration pane, under the corresponding ECOS-D, select

5.10 Radio Systems

Analog.

Note: Make sure the Analog or Mixed mode have been

selected as a Repeater Mode for the ECOS-D repeater.
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Configuration Analog

u Service -~

0 Metwork oY

& Redundancy MName:

[£) Remote Access Restriction TRBOnet IP Address: 10.10.100.93 - #|Port 6082 1
Database

= ECOS-D IP Address: 10.10.2.30 - |Port: |s0B2 2

o Reports

£} Service Management Test
% advanced Settings

)\ Geocoding Servers
IR Radio Systams

L} Services
P

j ECOSD #1

)’_ Advanced Settings
[ a] Analog

I PTT over Cellular

T Teltonika

il Remote Agents

[ Friendly Servers

‘B Phone Cornect
}t Advanced Settings
'E Internal PBX Server
I’ Data Sources

Set Defaults Apply Cancel

¢ Inthe Analog pane, specify the following Analog channel-related
settings:
* Name
Enter a name for the ECOS-D repeater in the analog mode. This name
will be displayed in the Dispatch Console.

= TRBOnet IP Address
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter
the Port number (6080, by default).

= ECOS-D IP Address
Enter the IP Address of the ECOS-D Repeater (refer to the repeater
configuration). Enter the Port number (6080, by default).

= Click Test to check the connection to the repeater.

= Always transmit when the PTT is pressed ("Impolite" channel
access)
Select this option so that when the PTT button is pressed, the radio will
start transmitting regardless of whether the channel is free or not (that
is any transmission in progress will be interrupted).

5.10.8 Adding a KAIROS Repeater

The Radio Activity Kairos repeater is configured as a stand-alone repeater
which supports connections to MOTOTRBO™ radios to transmit voice and data
in digital, analog, and mixed modes.

Note: When the Kairos repeater is connected, the following
TRBOnet Dispatch features are not supported: Remote
Monitor, Radio Enable/Disable, Kill Radio, and Telemetry.

¢ Inthe Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.
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e Inthe drop-down menu, click Add KAIROS Repeater.

‘Configuration Repeater #1
& Service -~
0 Network Name: Kairos #1
@ Redundancy IP Address: 10.10.155.130
5 Remote Access Restriction — -
Database ser Name: kairos
(@ Reports Password: senene

£} Service Management
4 Advanced Settings
...\ Georoding Servers Radio ID: 64250

Test

B Radio Systems Repeater Mode: Mixed (Analog and Digital)
-} Services

/ Advanced Settings

1 Slot #1
[ Slot £2
Lo Analog

B PTT over Celular

T Teltonika

2l Remote Agents

[ Friendly Servers

‘& Phone Connect

)’_ Advanced Settings v
P e PP

Set Defaults Apply Cancel

¢ Inthe Kairos pane, specify the following repeater-related parameters:

Name
Enter a name for the Kairos repeater. This name will be displayed in
the Dispatch Console.

IP Address
Enter the IP Address of the Kairos repeater network interface.

User Name
Enter the user name. For the user name, refer to the Kairos repeater
configuration.

Password
Enter the password for the user. For the password, refer to the Kairos
repeater configuration.

Radio ID
Enter the Radio ID, which is a gateway for voice and data. The Radio ID
must be unique in the radio system.

Repeater Mode
From the drop-down list, select the mode. The available modes are
Digital, Analog, and Mixed.

5.10.8.1 Advanced Settings

¢ Inthe Configuration pane, under the corresponding Kairos, select
Advanced Settings.

5.10 Radio Systems
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Configuration Advanced Settings
o service ~
O Metwark Keep Alive Interval: 10 | seconds
¥ Redundancy TX Timeout: &0 = | seconds

/= Remote Access Restriction
Database

7-,_}‘ Reports

£} Service Management
/ Advanced Settings

(N Geocoding Servers
IR Radio Systems

LI Services

Call Hangtime (ms):
Group Call: 3000
Private Call: 4000

Emergency Call: 4000

Kairos #1
P03 e setng)
I Slot #1
LI Slot £2
rrh Analog
B PTT over Celular
o Teltonika
5l Remote Agents
il Friendly Servers
‘T Phone Connect
)’, Advanced Settings ”
S e

Cancel

Set Defaults Apply

¢ Inthe Advanced Settings pane, specify the following Kairos Repeater-

related advanced settings:
= Keep Alive Interval

Enter the time interval, in seconds, for TRBOnet Server to check the
connection to the Kairos repeater (10, be default).

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any Voice Session in the Dispatch Console,
transmission will be interrupted after this TX Timeout expires (60, be
default).

Call Hangtime (ms):
= Group Call

This value sets the duration the repeater reserves the channel after the
end of a group call transmission. During this time, only members of
the group that the channel is reserved for can transmit.

Private Call

This value sets the duration a radio keeps the private call setup after a
user releases the PTT button. This is to avoid setting up the call again
each time a user presses the PTT button to transmit. During this time,
other radios can still transmit since the channel is essentially idle. After
the hang timer expires, the radio transmits using the TX Contact Name
parameter specified for this channel in MOTOTRBO CPS.

Emergency Call

This value sets the duration the repeater reserves the channel after the
end of an emergency call transmission. During this time, only
members of the Group that the channel is reserved for can transmit.

5 TRBOnet Server



TRBOnet Enterprise — User Manual @ Software

5.10.8.2 Slots

The Kairos repeater has two digital slots (in Digital mode) and one analog slot
(in Mixed or Analog mode) to transmit voice and data.

¢ Inthe Configuration pane, under the corresponding Kairos, select Slot
#1 or Slot #2 (or Analog, if you have selected Mixed or Analog mode).

Configuration Slot #1
W Service ~
& Network | Slot #1
# Redundancy Mame: Slot 1
=, Remote Access Restriction Audio Codec: 711 pLanfa000
Database
(@ Reports Audio port KAIROS: 40000

£} Service Management Audio port TREOnet: 40000

)’ Advanced Settings
Lk Geocoding Servers

IR Radio Systems Data port TREOnet: 40001
: Services

g Kairos #1

Advanced Settings

g

Data port KAIROS: 40001

E
LI Slot #2
rr Analog

B PTT over Celular

o Teltonika

55l Remote Agents

5l Friendly Servers

‘& Phone Connect

)’_ Advanced Settings

HP= .

Set Defaults Apply Cancel

w

e In the Slot #1 (or Slot #2) pane, specify the following slot-related
parameters:

= Name
Enter a name for the slot. This name will be displayed in the Dispatch
Console.

* Audio Codec
From the drop-down list, select the audio codec to be used to
compress the audio files.

= Audio port KAIROS/ Audio port TRBOnet
Enter the port numbers to be used for KAIROS/TRBOnet audio ports.

= Data port KAIROS/ Data port TRBOnet
Enter the port numbers to be used for KAIROS/TRBOnet data ports.

Note: Use the matching port numbers for KAIROS and
TRBOnet. The default audio and data port numbers are
40000 and 40001 for Digital slot 1, 40002 and 40003 for
Digital slot 2, and 40004 and 40005 for the Analog slot.

5.10.9 Adding a WAVE OnCloud Gateway

WAVE OnCloud is a Push-to-Talk (PTT) service that connects phones, computers
and radios together.

e Inthe Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.
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e Inthe drop-down menu, click Add WAVE OnCloud Gateway.

e Inthe Wave OnCloud Gateway pane, specify the following Wave
gateway-related parameters:

* Name
Enter a name for the Wave OnCloud gateway. This name will be
displayed in the Dispatch Console.

= Authentication FQDN
Enter the fully-qualified domain name of the authentication server.

= ClientID
Enter the Client ID that will be used for authentication.

= Client Secret
Enter the Client Secret that will be used for authentication.

= Agency
Enter the name of the agency that will be used.

= Test
Click this button and see the list of all available agencies.

5.10.10 Adding an ED137 / Jotron Station
This section describes how to connect an ED137-compatible radio station (for
example, the Jotron 7000 series Multimode Digital Radio).

e In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

e Inthe drop-down menu, click Add ED137 Station.

Configuration ED137 Station #1
' service ~
5 Network Name: ED137 Station #1

# Redundancy Local Interface: 10.10.100.99 -

5 Remote Access Restriction

Database Local Port: 0

(@ Reports Station Radio User: 300

I3 Service Management

. i + | Use Control Port: 3008
){ Advanced Settings

[N Geocoding Servers /| Separate receiver and transmitter

Radio Syste:

! j 0 systems Receiver:

L} Services

H ED137 Station £1 1P Address: 10.10.123.145

L2 advanced Settings Part: 5080 : Test

B PTT over Celular

7 Teltonika Transmitter:
53 Remote Agents 1P Address: 10.10.123.158
| Friendly Servers Port: 5080 - Test
‘& Phone Connect

/’_ Advanced Settings

J@ Internal PBX Server

|' Data Sources

el v

Set Defaults Apply Cancel

e Inthe ED137 Station pane, specify the following ED137 Station-related
settings:
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5.10.11

= Name
Enter a name for the control station. This name will be displayed in the
Dispatch Console.

= Local Interface
Enter the IP address of the PC with TRBOnet Server.

* Local Port
Enter the local UDP port number.

= Station Radio User
Enter the SIP ID of the radio station.

= Use Control Port
Select this option and enter the control port number.

= Separated receiver and transmitter
Select this option if the receiver and transmitter are separate devices
with different IP addresses.

= IP Address
Enter the IP Address of the receiver/transmitter (or transceiver).

= Port
Enter the port number (5060, by default).

Adding a Zenitel Station

This section describes how to connect a Zenitel station.

5.10 Radio Systems

In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

In the drop-down menu, click Add Zenitel Station.
In the Zenitel Station pane, specify the following Zenitel-related settings:

= Name
Enter a name for the Zenitel station. This name will be displayed in the
Dispatch Console.
= RadioID
This is the Radio ID of the Zenitel station.
The maximum value is 65535.
= Local Interface
Enter the IP address of the PC with TRBOnet Server.

= Local Port
Enter the local UDP port number.

= Station IP Address
Enter the IP address of the Zenitel station.

= Station Control Port
Enter the control port on the Zenitel station.
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= Station SIP Port
Enter SIP port on the Zenitel station (5060, by default).

5.10.12 Adding an Analog Station

TRBOnNet Dispatch Software allows using analog radios as control stations.

¢ In the Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ Inthe drop-down menu, click Add Analog Station.

Configuration Analog Control Station
¢ Service -~
& network MName: Analog Control Station
# Redundancy
it ice: Digital Audio (S/PDIF) (High Definition Audio... -
2 Remote Access Restriction Playback device igi udio (S/PDIF) (High Definition Audio &
Database Recording device: Microphone (2- Logitech USB Headset) -
(2 Reports
LF Service Management Serial port: COM1

}' Advanced Settings

Lk Geocoding Servers Always transmit when the PTT is pressed ("Impolite”™ channel access)

l Radio Systems TX Timeout: &0 | seconds
L} Services < :
= +| Mic delay time: 600 = | milliseconds
=N Analog Control Station
! PTT over Cellular +| Roger beep: C:'\Desktop'RingMabile. wav W
T Teltonika
8 Remote Agents Extended protocol: MNone
F5 Friendly Servers
B Phone Connect Signaling System: Quick Call I
/’_ Advanced Settings Confiqure
./ Internal PBX Server
| Data Sources
24 Email
L) SMS Motifications v
= e
Set Defaults Apply Cancel

e Inthe Control Station pane, specify the following Analog Control Station-
related settings:

* Name
Enter a name for the analog control station. This name will be
displayed in the Dispatch Console.

= Playback device
From the drop-down list, select the playback device on the PC that the
control station is connected to.

= Recording device
From the drop-down list, select the recording device on the PC that the
control station is connected to.

= Serial port
From the drop-down list, select the serial port the control station is
connected to on the PC.

= Always transmit when the PTT is pressed ("Impolite" channel
access) - Select this option so that when the PTT button is pressed, the
radio will start transmitting regardless of whether the channel is free
or not (that is any transmission in progress will be interrupted).
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5.10.12.1

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When a
Dispatcher starts any voice session in the Dispatch Console,
transmission will be interrupted after this TX Timeout expires.

Mic delay time

Select this option and specify the time, in milliseconds, to be used as a
delay time interval between pushing the PTT and enabling the
microphone.

¢ Roger beep
Select this option to play a beep sound for the time interval until the
microphone is enabled. Click the ellipsis button (...) on the right and
locate the desired sound file (WAV).

Extended protocol

From the drop-down-list, select either None, if your radio does not
support the extended protocol, or IC-F1721D v1.01 if the radio
supports the extended protocol.

Signaling System

From the drop-down-list, select the signaling system (Quick Call I or
Quick Call II). Click the Configure link and specify desired Quick Call
settings. Selecting the signaling system is available only if None is
selected in the Extended Protocol list.

Serial Port

Note: The serial port settings are available only when the
extended protocol IC-F1721D v1.01 is selected for the
analog control station.

¢ In the Configuration pane, under the corresponding Control Station,
select Serial Port.

5.10 Radio Systems

Configuration Serial Port
q Service -~
G Metwork Baud Rate: 19200
# Redundancy Data Bits: a

[ Remote Access Restriction

Database Parity: Mone

(@ Reports

& Repor Stop Bits: 1

L4 Service Management
)f Advanced Settings Handshake: Mane

(N Geocoding Servers
IR Radio Systems
¥ Services
Analog Control Station
B PTT over Cellular
T Teltonika
55 Remote Agents

| Friendly Servers

ER Phone Connect
)’_ Advanced Settings
E Internal PBX Server
|* Data Sources

4 Email

Set Defaultz Apply Cancel
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e Inthe Serial Port pane, specify the same serial port settings as those on
the radio device connected to the serial port.

5.10.13 Adding an XRC-9000 Controller

The XRC Controller is a site controller that provides a channel for transferring
data between sites and managing data flow.

e Inthe Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ Inthe drop-down menu, click Add XRC-9000 Controller.

Configuration Controller #1
U Service ~
O Network Mame: Controller #1
& Redundancy

=, Remote Access Restriction
Database System Identifier: Conmect Plus 1

1P Address: 10.10.100. 100 - Test

_53 Reports

LF Service Management

\)’: Advanced Settings
N Geocoding Servers

IR Radio Systems

L} Services

- Controller #1

Services

- Advanced Settings
.. i Redundancy
I PTT over Cellular
. Teltonika
35 Remote Agents
3 Friendly Servers
& Phone Connect
/ Advanced Settings

/38 Internal PEX Server v

Set Defaults Apply Cancel

¢ Inthe Controller pane, specify the following XRC controller-related
parameters:

* Name
Enter a name for the XRC controller. This name will be displayed in the
Dispatch Console.

= IP Address
Enter the IP Address of the XRC controller network interface.

= Click Test to check the connection to the controller.

= System Identifier
Enter the system identifier. Note that the system identifier should be
the same through all the controllers in a Connect Plus system.

5.10.13.1 Services

¢ Inthe Configuration pane, under the corresponding XRC Controller,
select Services.
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Configuration Services

¥ Service A

O Network Automatic Registration service (ARS)
& Redundancy _— . T
=, Remote Access Restriction ontraller part
Database Local port: 0
(9 Reports | Location service (GPS / Indoor)
LF Service Management
Controller port: 4001

\)’: Advanced Settings
k. Geocoding Servers Local port: 4001

IR Radio Systems
-4} Services

S Contraller #1 | Text Messages service (TMS)

e
Controller port: 4007

- Advanced Settings

Use adaptive location trigger

Local part: 4007

I PTT over Cellular Dispatcher ID: 54230
7 Teltonika
35 Remote Agents
3 Friendly Servers Subscribe ID:
T Phone Connect
/ Advanced Settings
/38 Internal PEX Server

Multi Gate connection

w

Set Defaults Apply Cancel

¢ Inthe Services pane, specify the following XRC controller-related

5.10 Radio Systems

services:

= Automatic Registration service (ARS) provides an automated data

application registration for the radio. When the radio powers up, it
automatically registers with the server. This feature is used with data
applications, that is any data traffic on this channel is associated with
an application server, such as MOTOTRBO Text Messaging or
MOTOTRBO Location Service. This option is selected by default and
cannot be cleared.

e Controller port
Enter the controller's port number for ARS service (4005, by default).

e Local port
Enter the local port of the PC with TRBOnet Dispatch Software. The
value 0 (default) means that a random port will be used.

Location service (GPS / Indoor)

Select this option to enable Location service on the controller. The
radio can send its coordinates when it is in Global Positioning coverage
area. GPS settings can be configured in the Service Management
pane (see section 5.8.2, Location service).

e Controller port
Enter the controller's port number for Location service (4001, by
default).

e Local port
Enter the local port of the PC with TRBOnet Dispatch Software (4001,
by default).

e Use adaptive location trigger
Select this option to use the adaptive GPS polling interval.

75



neocom
SOofFtware

Text Messaging service (TMS)
Select this option to enable text message transmission on the
controller.

e Port
Enter the controller's port number for Text Messaging service (4007,
by default).

e Local port
Enter the local port of the PC with TRBOnet Dispatch Software (4007,
by default).

e Dispatcher ID
Enter the Dispatcher ID. The Dispatcher ID should belong to
TRBOnNet Server account in a Connect Plus system.

Multi Gate connection
Select this option to use a multi-gate connection and enter the
corresponding Subscribe ID.

5.10.13.2 Advanced Settings

¢ In the Configuration pane, under the corresponding XRC Controller,
select Advanced Settings.

Configuration Advanced Settings
¢ Service -
5 Network Radio ID range: 100-200 ?

& Redundancy
/= Remote Access Restriction

External sites:

Site ID Presence Voice Data

Database
(@ Reports || 251 a4 g <
LF Service Management +| 252 v v
\)f: Advanced Settings
N Geocoding Servers
IR Radio Systems
¥ Services

- g5 Controller #1

Services
Jicisncea setoncs
i@ Redundancy
EJ PTT over cellular

I Teltonika
5=l Remote Agents

5l Friendly Servers
& Phone Connect
)’ Advanced Settings
& Internal PEX Server v Add Delete

Set Defaults Apply Cancel

e Inthe Advanced Settings pane, specify the following XRC controller-
related services:

76

Radio ID list
Enter a list of the radios to receive data from according to the following
rules:

e To receive data from all radios in the system, leave this box blank.

e To receive data from multiple radios, separate each Radio ID by a
comma, for example, 105,106,111, and so on.
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e To receive data from a range of radios, enter the range using the
following example: 105-111.

Note: In the Radio ID list, enter Radio IDs only, without
mentioning Radio Names and/or the word "Radio".

External sites

This is the list of Connect Plus sites that is used when the
corresponding Connect Plus system has a MOTOROLA System Bridge
to the current Capacity MAX system.

e Click the Add button and add a site by specifying its Site ID and
selecting the appropriate data types (Presence, Voice, and/or
Data).

5.10.13.3 Redundancy

A redundant XRC controller will be used when a connection to the main XRC

controller is lost.

¢ Inthe Configuration pane, under the corresponding XRC Controller,

select Redundancy.

Configuration Redundancy

& Service ~

€ Network Redundant controllers:

@& Redundancy
5 Remote Access Restriction
Database

(@ Reports

L} Service Management
)!' Advanced Settings

N Geocoding Servers
IR Radio Systems

L} Services

% Controller #1
: Services
Advanced Settings
"

B PTT over Cellular

1% Teltonika
E:l Remote Agents

5l Friendly Servers
' Phone Connect
/’_ Advanced Settings

ﬁ Internal PBX Server o

Set Defaults

1 ' |~| 10.10.101.100

¥

¢ Inthe Redundancy pane, specify the following redundant XRC controller-

related settings:

= Click Add and specify the desired parameters for the redundant XRC

controller being added.
e IP Address

Enter the IP Address of the XRC controller that will be used as a

redundant XRC controller.

e Controller port

Enter the port number of the redundant XRC controller for incoming

connections (4005, by default).

5.10 Radio Systems
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5.10.14

e Click Test to check the connection to the redundant XRC Controller.
If the test is successful, you'll see the information on the XRC
controller you are connected to, such as serial number, firmware

version, and other relevant information.

e Local port

Enter the port number that will be used for incoming connections
from the redundant XRC controller. The value 0 (default) means that
a random port will be used.

Adding an XRT-9000 Controller

The XRT controller functions as a voice gateway connected to each XRC
controller in a Connect Plus system.

¢ Inthe Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

¢ Inthe drop-down menu, click Add XRT-9000 Controller.

Configuration
& Service
& Network
& Redundancy
= Remote Access Restriction
Database
(@ Reports
L¥ Service Management
)f Advanced Settings
)\ Geocoding Servers
IR Radio Systems
' Services

% Controller #1

Services
[ Advanced Settings
¢ @ Redundancy
P Controller #1
tL Privacy
L3 DataPath
I Audio Paths
@ Redundancy
BEj PTT over Cellular
o Teltonika

Set Defaults

Controller #1

System Name: Controller #1

Radio ID: 54250
Start Local Port: i}
XRT-5000 Controller Info:
Controller IP Address: 10.10.111.102
Controller TCP Port: 10001
User MName: Admin
Password: sesne

System Identifier: Connect Plus 1

Monitor voice calls {no audio recordings)

Apply

Test

Cancel

¢ Inthe Controller pane, specify the following XRT Controller-related
parameters:

System Name

Enter a name for the XRT Controller. This name will be displayed in the

Dispatch Console.
Radio ID

Enter the individual virtual radio ID. The virtual Radio ID is required to

do the following:

e Make all types of voice calls from XRT Controller to radios,
dispatchers and groups.

e Send commands (for example, Remote Monitor).
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5.10 Radio Systems

= Start Local Port
Enter the local port of the PC with TRBOnet Server. The value 0
(default) means that a random port will be used.

XRT Controller Info:

= Controller IP Address
Enter the IP Address of the XRT controller network interface.

= Controller TCP Port
Enter the port number of the XRT controller to be used for connections
via TCP (10001, by default).

= Click Test to check the connection to the XRT controller.

= User Name
Enter the user name. For the user name, refer to the XRT controller
configuration.

= Password
Enter the password for the user. For the password, refer to the XRT
controller configuration.

Note: The user name and password must belong to the same
TRBOnNet Connect Plus account and be appropriately
configured.

= System Identifier
Enter the system identifier. Note that the system identifier should be
the same through all the controllers in a Connect Plus system.

= Monitor voice calls (no audio recordings)
This is the Billing feature. Select this option to monitor only PTT press
events.

Privacy

In the Configuration pane, under the corresponding XRT Controller,
select Privacy.
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e In

Configuration

Privacy
qf Service
0 Metwork Privacy Type: Enhanced
@& Redundancy Basic Privacy Key ID:
4 Remote Access Restriction .
- Enhanced Privacy Keys:
Database

(@ Reports

£} Service Management

/ Advanced Settings
N Geocoding Servers

IR Radio Systems

(L} Services

: 5 Controller #1

ARC4 (40 bit)

ARC4 (40 bit)
AES (256 bit)
AES (256 bit) Legacy

)ﬂ Advanced Settings
& Redundancy
Controller #1

i Data Path
-3 Audio Paths

----- @ Redundancy
Ej PTT over cCelular

*** Teltonika Add Remove

@ File
W

Set Defaults

Apply Cancel

the Privacy pane, specify the following Privacy-related settings:
Privacy Type

From the drop-down list, select one of the privacy types: None, Basic,
or Enhanced.

Basic Privacy Key ID
Enter the Privacy Key ID available for the Basic privacy type.
Enhanced Privacy Keys

Here you add enhanced privacy keys when the Enhanced privacy type
is selected.

e Click Add and specify the required Algorithm, ID, Name, and Value

for the privacy key being added.
v Algorithm

From the drop-down list, select one of the enhanced algorithms if
you are going to use additional encryption.

Data Path

The Data Paths are used to transmit data in a Connect Plus system.

e Int

he Configuration pane, under the corresponding XRT Controller,

select Data Path.
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5.10.14.3

Configuration

ﬂ Service
0 Network

@& Redundancy
= Remote Access Restriction
Database
(@ Reports
£} Service Management
/ Advanced Settings
N Geocoding Servers
IR Radio Systems
Services

5 Controller #1

Services

- Advanced Settings
- Redundancy

e Controller #1
-1< Privacy

184 Data Path

Audio Paths

----- @ Redundancy
Ej PTT over cCelular
o Teltonika

Set Defaults

Data Path

Data Service:

Radio 1D:

SOftware

Extended Data service -

54251

In the Data Path pane, specify the following data path-related settings:
Data Service

From the drop-down list, select the data service to be used to transfer
data.

Radio ID
Enter the Radio ID of the data service.

Audio Paths

The Audio Paths are talk paths of the system to make and receive voice calls; in
general, they are talk groups. TRBOnet Server requires that all audio paths of a
Connect Plus system be registered in its configuration. If an audio path is not

registered, the TRBOnet operator will not be able to receive and transmit to the
corresponding talk group.

¢ Inthe Configuration pane, under the corresponding XRT Controller,

5.10 Radio Systems

select Audio Paths.

Configuration
ﬂ Service
0 Netwark

@& Redundancy

|5 Remote Access Restriction

Database

i'_@ Reports

£} Service Management
}' Advanced Settings

L.\ Geocoding Servers
IR Radio Systems
' Services

5 Controller #1

Services

)’_ Advanced Settings
- Redundancy

5 Controller #1
Privacy
Data Path

# Redundancy

BJ FTT over Cellular

o Teltonika

SetDefaults

Audio Paths

call Type
|| Group Cal
|| Group Cal
|| Private Call
|| allcal

Add

Source ID Target ID
10
20
~ 64250

Delete Configure
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¢ Inthe Audio Paths pane, specify the following Audio Path-related
settings:

5.10.14.4

To add an Audio Path to the system, click Add.

Make sure the checkbox in the first column is selected to make and
receive Voice Calls from the selected subscriber.

From the drop-down list, select the Call Type for the audio path. The
available call types are All Call, Group Call, and Private Call.

Enter the Source ID for Private Calls. In general, this is TRBOnet's
Radio ID. If more than one Radio ID is specified in a Connect Plus
system (for example, for different dispatchers), the corresponding talk
paths should be added for all of them.

Enter the Target ID for Group Calls. This is the Radio ID of the talk
group to make a call to. The Target ID is not applicable for Private Calls
and All Calls.

Redundancy

A Redundant XRT Controller will be used when a connection to the Main XRT
Controller is lost.

¢ Inthe Configuration pane, under the corresponding XRT Controller,
select Redundancy.

Configuration
& Service "
O Network
@ Redundancy
= Remote Access Restriction
Database
(@ Reports
£F Service Management
/ Advanced Settings
)\ Geocoding Servers
I8 Radio Systems
L L3 Services

Redundancy

Redundant controllers:

sddress | Controller TCP Po rt

1 ||v| 10.10.112.99 10001 0

Controller #1

Services

){ Advanced Settings
- @ Redundancy
troller #1

Privacy

Data Path

Audio Paths

N - cundancy
BEj PTT over Cellular
1% Teltonika i beete = L

Set Defaults Apply

¢ Inthe Redundancy pane, specify the following Redundant XRT
Controller-related settings:

Click Add and specify the desired parameters for the Redundant XRT
Controller being added.

Controller IP Address
Enter the IP Address of the XRT Controller that will be used as a
Redundant XRT Controller.
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5.10.15

Controller TCP Port
Enter the port number of the Redundant XRT Controller to be used for
connections via TCP (10001, by default).

Start Local Port
Enter the local port of the PC with TRBOnet Dispatch Software. The
value 0 (default) means that a random port will be used.

Click Test to check the connection to the Redundant XRT Controller.

If the test is successful, you'll see the information on the XRT Controller
you are connected to, such as Serial number, Firmware version, and
other relevant information.

Adding a WAVE 5000 Controller

Before creating a connection to the Wave controller, make sure the Wave
server is configured to allow 3rd party applications to connect with a
Neocom Software-specified license key.

e Inthe Radio Systems pane, click Add.
Or, in the Configuration pane, right-click Radio Systems.

e In the drop-down menu, click Add WAVE 5000 Controller.

Configuration WAVE 5000 controller #1
W Service ~
O Metwork Name: WAVE 5000 controller #1
@ Redundancy Connection:
=, Remote Access Restriction v [ it
Database
(@ Reports Controller IP Address: 10.10.150. 110

£} Service Management

)’ Advanced Settings
i\ Geocoding Servers

l Radio Systems User Mame: test4

L.} Services Password: = | esssssssss

TREOnet Local Port: 0

o [ E ST i Profile: all-channels
B PTT over Celular
1. Teltonika Test

il Remote Agents

[ Friendly Servers

‘B Phone Connect
)’_ Advanced Settings
@@ Tnternal PEX Server
I’ Data Sources

=4 Email

{55 SMS Notifications

=
Set Defaults Apply Cancel

¢ In the Wave 5000 controller pane, specify the following Wave controller-
related parameters:

5.10 Radio Systems

Name
Enter a name for the Wave controller. This name will be displayed in
the Dispatch Console.

Use proxy for connection
Select this option to use a proxy server to connect to the Wave
controller.

Controller IP Address
Enter, or select from the list, the IP Address of the Wave controller.
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5.11

Controller Port
Enter the port number of the Wave controller.

TRBOnNet Local Port
Enter the local port number that will be used by TRBOnet Server to
establish a connection to the Wave controller.

User Name
Enter the user name. For the user name, refer to the Wave server
configuration.

Password
Enter the password for the user. For the password, refer to the Wave
server configuration.

Profile
From the drop-down list, select the profile to be used on the Wave
server.

Test
Click this button to check the connection to the Wave controller.

PTT over Cellular

To enable connections of Mobile Client applications to TRBOnet Server, you
must configure at least one dedicated gateway.

¢ In the Configuration pane, select PTT over Cellular.

e Inthe PTT over Cellular pane, select Enable PoC service.

Configuration PTT over Cellular
Lk Geocoding Servers -
IR Radio Systems

Services
ﬁ System #1 Registered PoC Gateways

A PsC 1 .. | Name

1:3 FPI | TRBOnet.Mobile gateway #1
W Advanced Settings

| Enable PoC service

5070

/’: Advanced Setting
MNIS data service
}: Advanced Setting
1 Audio Paths
=
)’_ Advanced Settings
... Il TRBOnet.Mobie gateway
1. Teltonika
35 Remote Agents
5 Friendly Servers
R Phone Connect
/’_ Advanced Settings
T

e Add Delete

£ >

Set Defaults Apply Cancel

5.11.1 Advanced Settings

¢ Inthe Configuration pane, select PTT over Cellular > Advanced
Settings.

¢ Inthe Advanced Settings pane, specify the following parameters:

5 TRBOnet Server



TRBOnet Enterprise — User Manual @ Software

= Max Call Duration
Specify the maximum duration of a call, in minutes.

= Registration Interval
Enter the time interval, in seconds, to check the registration status of
mobile subscribers.

Call Hangtime

= Private Call
This value sets the duration, in ms, during which the private call setup
is kept after a Mobile Client user releases the PTT button.

= TX Timeout
Enter the time, in seconds, to be used as a limit for PTT calls. When a
Mobile Client user starts a PTT session, transmission will be interrupted
after this TX Timeout expires.

5.11.2 Adding a Mobile Gateway

¢ Inthe PTT over Cellular pane, click Add.
¢ Inthe Mobile Gateway pane, specify the following parameters:

Configuration TRBOnet.Mobile gateway #1
\.; A Geocoding Servers -
I Radio Systems Mame: TRBOnet. Mobile gateway #1
L} Services System Identifier: Mobile 1
ﬁ System #1
tﬁ IPSC1 Local Interface: 127.0.0.1 -
1:3 crl Local Port: 5070

H ,’_ Advanced Settings
1 Privacy

LF DDMS service First VoI port: Default
)’: Advanced Setting

MNIS data service

Public Address/Domain: | 84.52.107.217

: )’ Advanced Setting
.01 Audio Paths
B PTT over Cellular
)’_ Advanced Settings
3
% Teltonika
53 Remote Agents
5 Friendly Servers
B Phone Connect
/’_ Advanced Settings

Do . [
£ >

Set Defaults Apply Cancel

W

* Name
Enter a name for the mobile gateway.

= System Identifier
Enter the name of the mobile system to which the gateway will belong.

= Local Interface
Enter the IP address of the PC with TRBOnet Server.

= Local Port
Enter the local UDP port number for the Mobile service (5070, by
default).
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= Public Address/Domain
This is the public IP address of your PC. Enter the Public Address if your
TRBOnet Server is behind a router. To detect the public address, click
the ellipsis (...) button.

Public IP Address X

Detect public IP Address over STUN server
STUN Server: stun.ekiga.net
Port: 3475

TP Address detected:  80.246.253.115

e STUN Server
From the drop-down list, select the STUN Server.

e Detect
Click this button to detect your public IP address.

= First VoIP port
Enter the number of the first VoIP port for audio communications. The

default value is specified in Network Parameters.

5.12 Teltonika

To integrate Teltonika devices into TRBOnet software:
¢ In the Configuration pane, select Teltonika.

Configuration Teltonika

f ) Privacy Fy

DDMS service | Enable Teltonika service
)!: Advanced Setting
MNIS data service
\/’: Advanced Setting Local Port: 5010
.11 Audio Paths

& PTT over Cellular

)!' Advanced Settings

B TREOnet.Mabile gateway

oM Teltonika
5l Remote Agents

Local Interface: 10.10.100.99 - @

[ Friendly Servers
‘B Phone Connect

j’ Advanced Settings
: Internal PBX Server
)’: Advanced Settings
External PBX Server
,’_ Advanced Settings

I Data Sources
{ Email

< >

Set Defaults Apply Cancel

¢ Inthe Teltonika pane:

= Enable Teltonika service
Select this checkbox and specify the following Teltonika-related
parameters.
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* Local Interface
From the drop-down list, select the local network interface that will be
used to communicate between TRBOnet Server and Teltonika devices.
= Local port
Enter the UDP port number to be used.

5.13 Remote Agents

The Remote Agent is TRBOnet Agent installed on a remote PC.

¢ Inthe Configuration pane, select Remote Agents.

Configuration Remote Agents
L advanced Setting ~
MNIS data service Registered remote Agents:
/’_ Advanced Setting
+.00 Audio Paths
EJ PTT over Cellular
i 4 Advanced Settings

Agent Name IP Address Paort Redundancy

|| Agent #1 10.10.110.190 4020 Mo

TREONet.Mobile gateway
T Teltonika
=
9 Agent #1
# Redundancy
i Friendly Servers
TR Phone Connect
)f Advanced Settings
Internal PEX Server
.24 advanced Settings
|¢ Data Sources
{ Email
|55 5MS Motifications
[@ Push Notifications

E License

< >

Add Delete Test

Set Defaults

e Inthe Remote Agents pane, click Add.

Configuration Agent #1
L2 advanced Setting ~
MMIS data service

/’_ Advanced Setting

..[T1 Audio Paths

EJ PTT over Cellular Port: 020
[ - Advanced Settings
TREONet.Mobile gateway
# Teltorika #) Use all services

Agent Name: Agent #1

1P Address: 10.10.110.190

Password: Test

5| Remote Agents Use selected services
5] 2cent =1
& Redundancy
3 Friendly Servers
TR Phone Connect
. Advanced Settings
Internal PEX Server
}’ Advanced Settings
| Data Sources
4 Email
[\ 5MS Notifications
[ Push Notifications

E License

< > Load services from agent

Set Defaults Apply Cancel

= In the Agent pane, specify the following parameters:
e Agent Name

Enter a name for the remote agent. This name will be displayed in
the Dispatch Console.
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o IP Address
Enter the IP address of the remote agent.

e Port
Enter the local port number that will be used by TRBOnet Server to
accept connections from the remote agent.

e Password
Enter the password, if the connection to the remote agent is
password-protected.

¢ Click Test to check the connection to the remote agent.

e Use all services
Choose this option so that all available services will be used on the
remote agent.

e Use selected services
Choose this option and click the Load services from agent link to
load services available on the remote agent.

5.13.1 Redundancy

A Redundant remote agent will be used when a connection to the Main remote

agent fails.
¢ Inthe Configuration pane, under the corresponding Agent, select
Redundancy.
Cnn.ﬁguratinn Redundancy

Lo ,’_ Advanced Setting »
J MMIS data service
,I: Advanced Setting Hame [P Address
Audio Paths 1 | |v| Backup Agent 1 10,10, 110,192 4020
Bf PTT over Cellular 2
)’_ Advanced Settings

B TRECNet.Mabile gateway

I Teltonika
53 Remote Agents

Redundant agents:

| Backup Agent 2 10.10.110.101 4020

9 Agent #1
e
F5 Friendly Servers
B Phone Connect
/’_ Advanced Settings
B Internal PBX Server
/ Advanced Settings

|* Data Sources

24 Email
) SMS Notifications
[& Push Notifications

[ License

£ >

Set Defaults Apply Cancel

Add Edit Delete Test AV

¢ Inthe Redundancy pane, click Add.
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Remote Agent *

Agent Name: Backup Agent 2
IP Address: 10.10.110.101
Port: 4020

Password: Test

Load services from agent

In the Remote Agent dialog box, specify the following parameters:

Agent Name
Enter a name for the redundant remote agent.

IP Address

Enter the IP address of the redundant remote agent.

Port

Enter the local port number that will be used by TRBOnet Server to
accept connections from the redundant remote agent.

Password

Enter the password, if the connection to the remote agent is
password-protected.

Click Test to check the connection to the redundant remote agent.

Use all services
Choose this option so that all available services will be used on the
redundant remote agent.

Use selected services
Choose this option and click the Load services from agent link to
load services available on redundant the remote agent.

Click OK to add a redundant remote agent to the system.

5.14 Friendly Servers

The Friendly Servers are used to transmit voice over IP between dispatchers
connected to different servers.

¢ Inthe Configuration pane, select Friendly Servers.

5.14 Friendly Servers
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Configuration Friendly Servers
[ Privacy ~

L F DDMS service Registered Friendly Servers:

. hdvanced Setting Mame IP Address Part

L} MNIS data service

/ Advanced Setting
- Audio Paths

Bf PTT over Cellular
. Advanced Settings

B TREOnet.Mobile gateway
7 Teltonika

2| Remote Agents

+ || Region Server 1 10.10.101. 167 4021
+ || Region Server 2 10.10.101,198 4022

|32]Friendly Servers

‘& Phone Connect
f Advanced Settings
ﬂ Internal PBX Server

}t Advanced Settings

V' Data Sources

24 Email

[55 5MS Notifications

[ Push Notifications

[ License

Add Edit Delete Test

Set Defaults Apply Cancel

¢ Inthe Friendly Servers pane, click Add.

Server »
Name: Region Server 1
TP Address: 10.10.101.167]
Port: 4021
Password: Test

= In the Server dialog box, specify the following parameters:

Name
Enter a name for the friendly server. This name will be displayed in
the Dispatch Console.

IP Address
Enter the IP Address of the server.

Port
Enter the local port number on the PC to connect to the friendly
server.

Password
Enter the password, if the connection to the friendly server is
password-protected.

Click Test button to check the connection to the friendly server.
Click OK to add the friendly server to the system.

5.15 Phone Connect

TRBOnet Server has its own built-in SIP server to support VoIP communications
between the radios as well as other SIP-compliant clients. In addition, you can
add multiple external PBX servers to the TRBOnet Server configuration.

¢ Inthe Configuration pane, select Phone Connect.
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Configuration Phone Connect

ol CP1 "
[, . Advanced Settings SIP Server
Privacy 1 [~ Internal PBX Server
DDMS service
- Advanced Setting
MMNIS data service
)’_ Advanced Setting
L. Audio Paths

BEj PTT over Cellular

Advanced Settings

B TRECHet.Mabile gateway
. Teltonika
5l Remote Agents
5l Friendly Servers
a
Advanced Settings
Internal PEX Server
j’ Advanced Settings
I Data Sources

24 Email
|8 5MS Notifications

e .

< >

Set Defaults Apply Cancel

hd Add Delete Test AT

5.15.1 Advanced Settings

¢ Inthe Configuration pane, under Phone Connect, select
Advanced Settings.

Configuration Advanced Settings

.- ~
)’_ Advanced Settings SIP Ringing Timeout: 30 < | seconds
- Privacy Max Call Duration: 10 < | minutes

4L} DDMS service
)’ Advanced Setting
L} MNIS data service Phone Owner Address: Take from database -
)!' Advanced Setting Configure
-3 Audio Paths
Bf PTT over Cellular
)’_ Advanced Settings
B TREOnet.Mabile gateway
1T Teltonika
[l Remote Agents
I Friendly Servers
‘L Phone Connect
ﬂ Internal PBX Server
}t Advanced Settings
|’ Data Sources
4 Email
[} SMS Notifications
e e e

< >

Set Defaults Apply Cancel

Public Address: 84.52.107.217

heocom
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¢ Inthe Advanced Settings pane, specify the following parameters:

= SIP Ringing Timeout
Specify the maximum ringing time, in seconds.

= Max Call Duration
Specify the maximum call time, in minutes.

= Public Address

This is the public IP address of your PC. Enter the Public Address if your
TRBOnet Server is behind a router and an External PBX Server will be

used. To detect the public address, click the ellipsis (...) button.

5.15 Phone Connect
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Public IP Address >

Detect public IP Address over STUN server

STUN Server: stun.ekiga, net
Port: 3478 z

IP Address detected:  §0.246.253.115

e STUN Server
From the drop-down list, select the STUN Server.

e Detect
Click this button to detect your public IP address.

* Phone Owner Address
From the drop-down list, select 'Take from database’. This will enable
determining the street address of a caller.
Click the Configure link.

Address format X

Address format:

, %eHOUSE_NUMBER %, %STREET_NAMEY:| -
Availablefields:

%HOUSE NUMBER%Y: %FLAT MUMBER%Y Z%%STREET NAME% S6COMMUNITY NAME%:
YSTATE MAME% SPOSTCODEY SCOUNTRY NAMES: ZGEXTRA INFO%

oK Cancel

e Add the required fields to the address information.

5.15.2 Internal PBX Server

e Make sure the Internal PBX Server option is selected in the
Phone Connect pane.

¢ In the Configuration pane, select Internal PBX Server.

Configuration Internal PBX Server

pll CP1 "
i A& Advanced Settings | Use Internal PBX Server
Privacy

B 10.10..89 - : |5060
DM service Local IP | Port
)’, Advanced Setting E———
MMIS data service e
)’_ Advanced Setting User's Extension: | 1234
L. Audio Paths
User Name: 1234

B PTT over Celular

)’_ Advanced Settings

... [l TREOnet.Mabile gateway
T Teltonika
5=l Remote Agents
5 Friendly Servers
‘& Phone Connect

Advanced Settings

/ Advanced Settings

I Data Sources

4 Email
[\ 5MS Motifications
FL o~ 1w e e

< >

Set Defaults Apply Cancel
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e Inthe Internal PBX Server pane, specify the following parameters:

Local IP
Enter the IP address of the PC with TRBOnet Server.

Port
Enter the local UDP port number for the SIP service (5060, by default).

Dispatch Center

User’s Extension
Enter the user’s extension number that will be used by the Dispatch
Center.

User Name
Enter the user name that will be used by the Dispatch Center.

5.15.2.1 Advanced Settings

¢ Inthe Configuration pane, under Internal PBX Server, select
Advanced Settings.

‘Configuration Advanced Settings
R CP1 ~
: ,’ Advanced Settings Packet time (ms): &0

o Privacy
F DDMS service
. Advanced Setting
INIS data service DTMF Send Mode: RFC 2833
. Advanced Setting
[0 Audio Paths
] PTT over Celular Use VoIP ports: Al
}t Advanced Settings
b l TREONet.Mobile gateway
7 Teltonika
3 Remote Agents
52| Friendly Servers
‘B Phone Connect
}t Advanced Settings
-ZR Internal PBX Server
[ Data Sources
4 Email
) 5MS Notifications
PR s
<

Codecs: 6711,G711a,0PUS, OPUS, G729

Registration Interval (sec): 3600

First VoIP port: Default

Set Defaults Apply Cancel

¢ In the Advanced Settings pane, specify the following Internal PBX Server-
related advanced settings:

5.15 Phone Connect

Packet time
Enter the packet length, in milliseconds.

Codecs
In the drop-down list, select/deselect the codec(s) to be used for audio
compression.

Registration Interval (sec)
Enter the time interval, in seconds, to check the SIP registration status
of subscribers.

DTMF Send Mode
Enter mode for sending DTMF tones. The available modes are
RFC 2833, SIP INFO (DTMF relay), and SIP INFO (DTMF).
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First VoIP port

Enter the number of the first VoIP port for audio communications. The
default value is specified in Network Parameters.

Use VoIP ports

From the drop-down list, select which VoIP ports will be used (all, even,

or odd).

5.15.3 External PBX Server

You can enable multiple external PBX servers to use the SIP Interconnect
feature. This feature enables calls from the radio to the phone and vice versa.
The dispatcher can make a call from the Dispatch Console to a phone as well as
redirect a phone call to a subscriber radio.

¢ Inthe Phone Connect pane, click Add.
Or, in the Configuration pane, right-click Phone Connect and choose
Add PBX Server.

‘Configuration
o cP1
[ . Advanced Settings
11 Privacy
£} DDMS service
/’: Advanced Setting
MMIS data service
: ,’_ Advanced Setting
L3 Audio Paths
B PTT over Celular
,’_ Advanced Settings
‘... [l TREOnet.Mobile gateway
o Teltonika
il Remote Agents

[ Friendly Servers

‘B Phone Connect

,’_ Advanced Settings

LR Internal PEX Server
)’ Advanced Settings

3 External PBX Server
)’ Advanced Settings
i @ Redundancy

Foi oo
€ >

Set Defaults

External PBX Server

+| Use External PBX Server

Provider options

Address: yourprovider.com upP -
Port: 5080 - Test
Local IP: 10.10.100.99 - & Port: 5061 7

Dispatch Center

User's Extension: | 57068
User Name: Dispatcher 1
UserPassword: |eessssssss

Test Call

¢ Inthe External PBX Server pane, specify the following parameters:

Use External PBX Server
Select this option to enable an external PBX server.

Provider options

Address

Enter your SIP provider address, and select the protocol from the drop-
down list on the right of the address (for more details, contact your SIP

provider).
Port

Enter the port number of the SIP provider (5060, by default).

= Click Test to check the connection to the provider.

e LocalIP
Enter the IP address of the PC with TRBOnet Server.
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e Port
Enter the local port number to make connections from.

Dispatch Center
Note: This information is provided by the SIP provider.

= User’s Extension
Enter the extension number that will be associated with TRBOnet
Server to make and receive calls.

= User Name
Enter the user name for the login.

= User Password
Enter the user password for the login.

= Test Call
Click this button to make a test call.

Note: To make a test call, make sure that the TRBOnet Server
service is not running.

5.15.3.1 Advanced Settings

¢ Inthe Configuration pane, under the corresponding External PBX
Server, select Advanced Settings.

Configuration Advanced Settings
- -
}! Advanced Settings Packet time (ms): 50
- Privacy Erites G7114,G711a,0PUS, G729

L} DDM5 service
: j’ Advanced Setting
L} MNIS data service

Registration Interval (sec): 3600

DTMF Send Mode: RFC 2833

/ Advanced Setting
- Audio Paths
EJ PTT over Cellular
- Advanced Settings
‘. [l TRBONet Mobile gateway
T Teltonika
55| Remote Agents
[l Friendly Servers
‘@ Phone Connect
,f Advanced Settings
T Internal PEX Server
i /f_ Advanced Settings
& External PBX Server

"’,{q Advanced Settings

- @ Redundancy

£ >

Set Defaults

Do not register users with PBEX server (SIP trunk)
Do not register internal users with PBX server
Change User Authentication settings
First VoIP port: Default
Use VoIF ports: All
| Allow outgoing SIP calls

Available SIP numbers: 5555-6666

¢ Inthe Advanced Settings pane, specify the following External PBX
Server-related advanced settings:

= Packet time
Enter the same value as specified in the phone system;

= Codecs
In the drop-down list, select/deselect the codecs specified in the phone
system.

5.15 Phone Connect 95



neocom
software

Note: For more details on Phone System configuration, see
Appendix E: SIP Setup for Motorola Phone System
(page 406).

= Registration Interval (sec)
Enter the time interval, in seconds, to check the SIP registration status
of subscribers.

= Do not register users with PBX server (SIP trunk)
Select this option so that radios will use the SIP trunk system to get
extensions.

¢ Do not register internal users with PBX server
Select this option so that internal users won't be registered with the
external PBX server.

= Change User Authentication settings
Click this link to set up user authentication for the systems with
enhanced authentication parameters. It is recommended to be used
when Radio ID is equal to User’s Extension. In case when voice is
transmitted via a radio channel, the Radio ID is used. When voice is
transmitted via a GSM channel, the User’s Extension is used.

SIP Authentication Users X

User's Extension a | Authorization User

i
i
m

b 010101 ‘User 1

o Add Delete
bl

e Click Add to add a user.

e User’s Extension
Enter the extension number for the new user.

e Authorization User Name
Enter the name that will be used as the authorization user name.

e Click OK to save the new user authorization.

= First VoIP port
Enter the number of the first VoIP port for audio communications. The
default value is specified in Network Parameters.

= Use VoIP ports
From the drop-down list, select which VoIP ports will be used (all, even,
or odd).

= Allow outgoing SIP calls
Select this option to allow users to make outgoing SIP calls.
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e Available SIP numbers
Enter the range of SIP phone numbers that will be available for
outgoing calls.

5.15.3.2 Redundancy

A Redundant PBX Server be used when a connection to the main PBX Server
fails.

¢ In the Configuration pane, under the corresponding External PBX
Server, select Redundancy.

Configuration Redundancy
~LF MNIS data service A
," Advanced Setting

.01 Audio Paths -
Bj PTT over Cellular 1 i[v] 123.21.102.201 5060 5061

Redundant PBX Servers:

PBX 5 P

rver Address BX Server Port TREOnet Local Port

7T Teltonika
33| Remote Agents

3l Friendly Servers
‘& Phone Connect

o )’_ Advanced Settings
External PBX Server
i )’_ Advanced Settings
----- ¢ Redundancy

| Data Sources

4 Email
[ 5MS Notifications

[E Push Notfications | Reqgister users when PEX server changes

E License
¥ Add Delete Test Al
< >
Set Defaults Apply Cancel

¢ Inthe Redundancy pane, click Add.

= PBX Server Address
Enter the IP address of the redundant server.

= Check the corresponding port numbers (PBX Server Port and
TRBOnet Local Port).

= Select the checkbox beside the server address.

= Register users when PBX server changes
Select this checkbox so that phone users will be registered when the
PBX server is switched to the redundant server.

5.16 Data Sources

The Data Sources feature allows receiving data from third-party applications
and devices.
TRBOnet Dispatch Software can work with the following two data source types:
1. Physical or virtual devices connected via a COM port
2. PCs running third-party applications connected via TCP/IP

To allow TRBOnet Dispatch Software to receive data from a third-party
application or device:
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e Inthe Configuration pane, select Data Sources.

Configuration Data Sources
.54 Advanced Setting A
L} MNIS data service | Enable Data Sources
.54 Advanced Setting
I Audio Paths

B PTT over Cellular
,’_ Advanced Settings
..l TRBONet.Mobile gateway
7 Teltorika
55| Remote Agents
2 Friendly Servers
‘B Phone Connect
Advanced Settings
Internal PBX Server
)’_ Advanced Settings
¥
¥ CcoMports
A= Tepgp
4 Email
[ 5MS Notifications
[@ Push Notifications

E License

< >

Set Defaults Apply Cancel

e Inthe Data Sources pane, select the Enable Data Sources option.

5.16.1 COM Ports

To manage physical or virtual devices connected to the TRBOnet Server PC via
COM port:

¢ Inthe Configuration pane, under Data Sources, select COM ports.

Configuration COM ports
[ )!' Advanced Setting A
MNIS data service MName Baud | Parity Data Bits | Handshake | Stop Bits
j’ Advanced Setting
- Audio Paths
] PTT over Cellular ~| COM2 9600 None 8 MNone i
/ Advanced Settings
- [l TREOnet.Mobile gateway
7 Teltonika
5=l Remote Agents

| | COM1 9600 | None 8| None 1

F5| Friendly Servers
I Phone Connect
)f Advanced Settings
IR Internal PBX Server
/’_ Advanced Settings
J Data Sources
A= TCP/IP
4 Email
|55} SMS Notifications
[ Push Notifications

E License

< >

Set Defaults Apply Cancel

Add Delete Edit

e Inthe COM ports pane, click Add to add a device.
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5.16 Data Sources

COM Port X

Serial port name:

Baud rate:
Parity checking: MNone

Stop bits per byte: 1

Diata bits per byte: 8

Handshzaking protocol : Mone

Protocol Text

Text Encoding: ASCIT

Message delimiter: LINE FEED 0x0A(\)
Cancel

In the COM Port dialog box, specify the following parameters:

Serial port name
From the drop-down list, select the COM port on the PC with TRBOnet
Server to which the device is connected to.

Baud rate
From the drop-down list, select the baud rate at which the data is
transmitted.

Parity checking

From the drop-down list, select one of the values that represent the
parity-checking protocol.

Stop bits per byte

From the drop-down list, select the standard number of stop bits per
byte.

Data bits per byte
From the drop-down list, select the standard length of data bits per
byte.

Handshaking protocol
From the drop-down list, select the handshaking protocol for serial
port transmission of data.

Text Encoding
From the drop-down list, select the Text Encoding type.

Note: The Text Encoding types selected in the TRBOnet Server
and in the connected application must be the same to
avoid incorrect text display and incorrect data parsing.

Message delimiter
From the drop-down list, select the type of delimiters in the data.

Note: The Message delimiter types selected in the TRBOnet
Server and in the connected application must be the
same to avoid incorrect text display and incorrect data
parsing.
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= Click OK to save settings and close the dialog box.

5.16.2 TCP/IP

To manage PCs running third-party applications:
e Inthe Configuration pane, under Data Sources, select TCP/IP.

Configuration TCP/IP
,’_ Advanced Setting A
MNIS data service Name Remote IP Port Mode | Encoding
L2 advanced Setting
.17 Audio Paths

B PTT over Cellular

j’ Advanced Settings

.. [l TRBONet.Mobile gateway
T Teltonika
35l Remote Agents

-+ Terminal 1 11002 Client  UTF8
| | Terminal 2 10.10,102,218 11002 | Server | UTF8

[ Friendly Servers
' Phone Connect
)f Advanced Settings
LR Internal PBX Server
)’, Advanced Settings

[0} SMS Notifications
[ Push Notifications

S icense

€ >

Set Defaults Apply Cancel

Add Delete Edit

e Inthe TCP/IP pane, click Add to add a TCP/IP connection.

External Connection X
Name: Terminal 2
Mode: Server {TRBCnet connects to App) -
Remate IP: 10.10.102.216
Port: 11002 7
Protocol: Text -

Text Enceding: |UTF3 -

[] Ignere the following data

During: 30 min
Discard the following substring:
\d{Z}:\d{Z}:\d{Z}
Cancel

e Inthe External Connection dialog box, specify the following parameters:

100

Name
Enter a name for the TCP/IP connection.

Mode
From the drop-down list, select the connection mode. The connection
mode depends on the type of the application installed on the
connected PC:
e Client
In this case, the application connects to TRBOnet Server which sends
the data to the application.
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e Server
In this case, TRBOnet Server accepts connections from the
application and receives the data.

= Remote IP
Enter the IP address of the application server.

Note: Available only when the Server connection mode is
selected.

= Port
In the case of the Client connection mode, select the local port of the
PC with TRBOnet Server PC.
In the case of the Server connection mode, select the port of the PC
where the third-party application is installed.

= Text Encoding
From the drop-down list, select the Text Encoding type.

Note: The Text Encoding types selected in the TRBOnet Server
and in the connected application must be the same to
avoid incorrect text display and incorrect data parsing.

= Ignore the following data
Select this option so that the following messages arriving during the
specified time period will be ignored.
e During
Specify the time period, in minutes, so that similar messages that
arrive during this time period will be ignored.

¢ Discard the following substring
Enter a regular expression that will be used to filter messages upon
arriving and before being processed. For example, the following
regular expression \d{2}:\d{2}:\d{2} means that if a message
contains a substring like 11:01:54, then this substring will be
dropped before processing the message.

5.17 Email Settings

TRBOnet Dispatch Console allows processing emails as follows:

1. Receive emails from email servers and forward them to a particular radio
or talk group (via a POP3 or IMAP server);

2. Send emails from radios to a particular email address (SMTP Server).

Note: Microsoft Exchange Server can be used as SMTP and
POP3/IMAP servers.

¢ Inthe Configuration pane, select Email.
¢ Inthe Email pane, select Enable Email Server.
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Configuration Email
i )’_ Advanced Setting ~
MNIS data service | Enable Email Server
,f_ Advanced Setting
.. Audio Paths
EJ PTT over Cellular

)’ Advanced Settings

... [] TRBOnEet.Mobile gateway
5=l Remote Agents
[l Friendly Servers
‘& Phone Cornect
)f_ Advanced Settings
i/ ZR Internal PEX Server
/ Advanced Settings

: 3 External PBX Server
}’ Data Sources

B

-w Incoming Mail Server

..au® Outgoing Mail Server

L) 5M5 Notifications
@i Push Motifications

E License

< >

Set Defaults Apply Cancel

5.17.1 Incoming Mail Server

The Incoming Mail Server is used to synchronize the Incoming Emails folder
located on a mail server with your local PC. If you are using a POP3 server, all
incoming emails can be downloaded from the mail server to the local PC to be
then forwarded as text messages to radios or talk groups.

¢ In the Configuration pane, under Email, select Incoming Mail Server.

Configuration Incoming Mail Server
; MMIS data service &
)’_ Advanced Setting Enable

- Audio Paths Server: ‘imap.gmail‘com |

BJ FTT over Cellular = - -

A advanced Settings is server requires a secure connection (S5L)
... [l TRBONet.Mobile gateway Port: 993 =

i Teltonika Protacol: IMAP
izl Remote Agents
I Friendly Servers Check for new messages
‘B Phone Connect every: 60 + seconds

Advanced Settings

2 Enternal FEX Server Connect using OAuth 2.0
/’: Advanced Settings

8 External PEX Server HIEEE Gmei -
}' Data Sources Email: ‘ |
24 Email

m, Client ID: ‘ |
[ Outgoing Mail Server Client secret: ‘ “““““““““ |

[ 5MS Motifications
[ Push Notifications

E License

< >

Set Defaults Apply Cancel

Authorize and Check

¢ In the Incoming Mail Server pane, specify the following incoming mail-
related parameters:

Enable
Select this option to enable Incoming Mail Server.

Server
Enter the server hostname or IP address.

This server requires a secure connection (SSL)
Select this option to enable a secure connection. Note that a dedicated
port will be used to connect to the mail server via SSL.
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5.17 Email Settings

Note: The port number will automatically change when you
select this option. For example, from 110 to 995 for
POP3, and from 143 to 993 for IMAP.

Port
The port number to be used for the connection.

Note: This box is populated automatically depending on the
selected protocol and whether a secure connection is
required.

Protocol

From the drop-down list, select either IMAP or POP3. Note that if you
select POP3, all email messages will be deleted from the server once
you have downloaded them. In the case of IMAP, all new messages will
be marked as read once you have downloaded them.

Note: The port number will automatically change when you
change the protocol.

Check for new messages every X seconds
Enter the time interval to check for new email messages (60, by
default).

Connect using
From the list, select one of the following options:

e Anonymous access
Select this option to use an anonymous access to the incoming mail
server.

¢ Windows authentication
Select this option to connect via TRBOnet Service Windows Account,
if it is running under a specific account;

¢ Use login and password
Select this option and specify the credentials for the mailbox:
v Login
Enter the incoming mail server login.
v' Password
Enter the incoming mail server password.

e OAuth 2.0
Select this option if the email server requires
OAuth 2.0 authorization.

v Provider
From the drop-down list, select either Office 365 or Gmail.

v Email
Enter the email address.
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5.17.2 Outgoing Mail Server

v If Gmail is selected as the email provider, enter the Client ID and
Client secret.

If Office 365 is selected as the email provider, enter the Client ID

and Tenant ID.
v" Authorize and Check

Click this button to authorize your email account and check for

new emails.

The SMTP Server is used to send emails from users to mail servers as well as
between mail servers to deliver emails to the final destination.

For example, the administrator can enable email notifications from TRBOnet
Dispatch Console to particular email users when alarms occur on selected
radios. In this case, the radio sends an alarm to TRBOnet Server which in turn
converts this alarm to text and then forwards it as an email message to
particular email addresses (for example, to admin@yourcompany.com).

¢ In the Configuration pane, under Email, select Outgoing Mail Server.

Configuration

MMIS data service

L3 Audio Paths
B P77 over Celular
)’_ Advanced Settings

7 Teltonika
5=l Remote Agents
2 Friendly Servers
‘& Phone Connect

- Advanced Settings
SR Internal PEX Server
/ Advanced Settings
@ External PEX Server
7 Data Sources

24 Email
m" Incoming Mail Server

e Outgeing Mail Server

. SMS Motifications
[ Push Notifications

E License

<

Set Defaults

,’_ Advanced Setting

TRECNet.Mobile gateway

Outgeing Mail Server

Enable

Sender's Email: ‘

SMTP Server:

‘nuﬂnnk.mfﬁceBSE.cnm

Encryption:

SMTP Server Port: 587

Connect using

Provider: Office 365

QAuth 2.0

Explicit {TLS)

Email: ‘

Client ID: ‘

Tenant ID: ‘ ===================== |

Apply

Authorize

Send Test Message

e In the Outgoing Mail Server pane, specify the following outgoing mail-
related parameters:

Enable
Select this option to enable Outgoing Mail Server.

Sender Email
Enter the email address (optional) of the sender.

SMTP server
Enter the server hostname or IP address of the SMTP server.
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5.17 Email Settings

= Encryption

From the drop-down list, select the encryption protocol (SSL, TLS) if a
secure connection is required, or select None if not. Note that three
different dedicated ports will be used to connect to the mail server: via
SSL, TLS, or with no encryption.

Note: The port number will automatically change when you
select the encryption protocol. For example, from 25 (no
encryption) to 465 for SSL, and to 587 for TLS.

SMTP server port
The port number to be used for the connection.

Note: This box is populated automatically depending on the
selected encryption protocol.

Connect using
From the list, select one of the following options:

¢ Anonymous access
Select this option to use an anonymous access to the SMTP server.

¢ Windows authentication
Select this option to connect via TRBOnet Service Windows Account,
if it is running under a specific account;

e Login and password
Select this option and specify the credentials for the mailbox:
v' User name
Enter the SMTP server user name.
v' Password
Enter the SMTP server password.
v Type
From the drop-down list, select the SMTP login type.
e OAuth 2.0
Select this option if the email server requires
OAuth 2.0 authorization.
v Provider
From the drop-down list, select either Office 365 or Gmail.
v" Email
Enter the email address.
v If Gmail is selected as the email provider, enter the Client ID and
Client secret.
If Office 365 is selected as the email provider, enter the Client ID
and Tenant ID.
v Authorize
Click this button to authorize your email account.
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v Send Test Message
Click this button to send a test message from the Sender Email
address.

5.18 SMS Notifications

TRBOnet Dispatch Console allows sending SMS notifications to a cell phone
when alarms and other events occur on selected radios (for example, DTMF
commands from radios, Telemetry, Radio Status, and other events).

e Inthe Configuration pane, select SMS Notifications.
¢ Inthe SMS Notifications pane, select Enable SMS Service.

Configuration SMS Notifications
,’_ Advanced Setting A
[ Audio Paths | Enable SMS Service

B PTT over Cellular
}' Advanced Settings Connection to GSM via: Vianett service (www. vianett.com) ~

[ l TREOnet.Mobile gateway

- i Sender: | |
o Teltonika
55 Remote Agents Username: |Iogin@:yourcompany.com |

5= Friendly Servers
‘R Phone Connect
/ Advanced Settings Send Test MMS
LR Internal PBX Server
/’_ Advanced Settings
I’ Data Sources
L. 1¥ COM ports
LS Topgp
=4 Emal
-rery Incoming Mail Server

Password: | ------- |

L Outgaing Mail Server

8} 5Ms Motifications
[© Push Notifications

[ vicense

€ >

SetDefaults Apply Cancel

¢ Inthe SMS Notifications pane, specify the following SMS-related
parameters:

= Connection to GSM via
From the drop-down list, select the type of connection.

e COM port GSM modem
Select this item if you are using a GSM Modem connected via COM
port. In addition, select the COM port the modem is connected to,
and enter the SIM Card Pin Code.

e Gemalto Cinterion EHS6T LAN
Select this item if you are using a Cinterion EHS6T GSM modem
connected via LAN. In addition, enter the IP address of the modem,
and enter the SIM Card Pin Code.

e Vianett service
Select this item to use an account on Vianett service.
For more details on Vianett service, see www.vianett.com
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e SMS Broadcast
Select this item to use an account on SMS Broadcast service.
For more details on SMS Broadcast service, see
www.smsbroadcast.com.au

e Clickatell
Select this item to use an account on Clickatell service.
In addition to the Login and Password, you'll have to specify the
API ID.
For more details on Clickatell service, see www.clickatell.com

¢ IntelliSoftware
Select this item to use IntelliSoftware SMS Gateway.
For more details on IntelliSoftware SMS service, see
www.intellisoftware.co.uk

= Sender
Enter the sender phone number.

= Username
Enter the login for the selected service account.

= Password
Enter the password for the selected service account.

= Send Test MMS
Click this button to send a test MMS from the selected service account
to a recipient's phone number.

Note: This button is available when connected via Vianett
service only.

= Send Test SMS
Click to send a test SMS from the selected service account to a
recipient’s phone number.
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5.19 Push Notifications

TRBOnet Dispatch Console allows sending push notifications to connected
TRBO.SOS applications.

¢ In the Configuration pane, select Push Notifications.

¢ Inthe Push Notifications pane, select Enable Push Service.

Configuration

)’, Advanced Setting A

.01 Audio Paths
B PTT over Cellular
,’_ Advanced Settings

[ TREOnet.Mobik gateway

T Teltonka

53 Remote Agents

| Friendly Servers

ER Phone Connect
)’_ Advanced Settings
LR Internal PBY Server

} Data Sources
COM parts
;A
B 1epp
4 Email

{--rera Incoming Mail Server
L.aIF QUtgoing Mail Server
J SMS Notifications

e} Push Notifications:
E License

<

Set Defaults

)’ Advanced Settings

Push Notifications

v| Enable Push Service
Server: push. trbonet.com

Port: 3081 . Test

¢ In the Push Notifications pane, specify the following parameters:

Server
Enter the Ethernet IP address of the push server.

Enter the UDP port number of the push server.

Click this button to check the connection to your push server. If the test
is successful, you'll see information on the server you are connected
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6 TRBOnNet Dispatch Console

The key features of TRBOnet can be configured by the administrator in
TRBOnet Dispatch Console after initial installation and configuration.

6.1 Connecting to Server

e Launch TRBOnet Dispatch using the desktop or Start menu shortcut.

e Enter the required connection settings as explained below.
For the default Admin credentials (User Name and Password), consult
our support team.

Note: For security reasons, we strongly recommend that you
change the password for the administrator immediately
after the first login. See section 6.3.4.5, Changing

Password.
Connect to TREOnet Server X
Connect to:
Address: Server 1 w
Port: 4021 = Configure
Authentication:
Method: TREOnet Authentication v
User Name: |adm\n |
Password: |uuuuu |
[] remember passward
[] connect on startup
Concl
Connect to:
= Address

Enter the IP address of the TRBOnet Server to connect to.

Note: This is the Network interface parameter of TRBOnet
Server configured in section 5.4, Network Parameters

(page 18).

= Port
Enter the local port of the TRBOnet Server PC to accept connections
from the Dispatch Console.

Note: This is the Command port parameter of TRBOnet
Server configured in section 5.4, Network Parameters

(page 18).

Authentication:

= Method
From the drop-down list, select the Authentication method:
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o TRBOnet Authentication
Select this method to log on as a User registered in the TRBOnet

Dispatch Console Users

list.

¢ Windows Authentication
Select this method to log on using the PC name. The system
automatically shows the PC name as a User Name.

Note: The Windows user must be registered in the TRBOnet
Dispatch Console Users list.

= User Name/Password

Enter the user name and password.
For the default Admin credentials (User Name and Password), consult

our support team.

Note: For security reasons, we strongly recommend that you
change the password for the administrator immediately
after the first login. For this, on the Tools menu, click

Change Password.

e Remember password

Select this option to have the Dispatch Console application remember

your password.
e Connect on startup

Select this option to launch the Dispatch Console application without
having to type the User Name and Password every time. Use this option if
you regularly connect to the same TRBOnet Server and your workstation

is in a secure location.

6.2 Main Window Elements

When the TRBOnet Dispatch Console application is initially launched, the
default Dispatch Console window will be displayed with the Voice Dispatch tab

being active.

1

Voice Dispatch Radio Interface [ [
ERllg e [V X aa e
\ X X
& B oniine Dispateners (1) = TrursE, SRR
8 saministator 1 1 : 06 AM
() oniine, Indoor s n
’ B
@ oniine, 6P Ficed X Contact Dialer HE Bcrow 11 DEE Group 22 HEE a
& () Online, No GPS oo
@ 1 ve = =
@ Roawo 125 s
=) Q Emme (19) ‘ Ses: Session:
[ | Freech Freech
(1)) voice Dispatch
| | Senc senc
-2, tocation Tracking | |
. b7 b s e oo Radio Brdge
& 700 Ticketing ‘ = | . _ . N R oe [7]
L] L] Unknown
o —— . Ay Groups

[ Text essages

B playback [ Save~| print | 11 P 7 Ci
B Date System Sender

§ vorerecoring © 3056921 1057247 AN Moble 1
E —; e
SRS DSep21 10:570AM P Admistator
= [0 05021 1:57:00AM  Intercom Acmnistrator
Event Viewer © Dsep21s0A Mol 444

[ 30-Sep-21 10:55:16 AM P
[-52) Radio Allocation ) 305ep21 10:52:58 AM CPL Racio 125

d1of7 »|nlm| «

L'é Administration

Requests ToTak | Radio State | Active Tasks || Active Routes | User Activity | Map | Cameras

r @ Defautt Settings || 5 Details || (7] Show Notes [ Add Note
Note

Priv :
Battery: 50%
Group Cal: Radio 125" called'11' (00:04)  Takers: Radio 125

[® Connected &5 B By B | § Administrator | [ Licensed to: demo (Walt) (Demo License)
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The main user interface elements are as follows:

Main menu

Radio list panel
Modules tab panel
Radio Interface panel
Activity Monitor panel

o v kd N =

Quick Pane panel

Note: The look of the Dispatch Console windows may have been

customized for your specific operation.

6.3 Main Menu

The TRBOnet Dispatch Console main menu allows the user to manage the main

Dispatch Console options. The main menu is located in the upper left corner of
the main window.

6.3.1 File

The File menu contains the following items:

File > Connect to TRBOnet Server

Choose this menu item to connect to a different TRBOnet Server, or to
use different credentials for the current connection.

For more details, see section 6.1, Connecting to Server (page 109).

File > Exit
Choose this menu item to exit TRBOnet Dispatch Console.

6.3.2 View

The View menu contains the following items:

6.3 Main Menu

View > Show Navigation Pane

Choose this menu item to toggle the display of the Navigation pane on
the left of the main window. The Navigation pane includes two panes: the
Radio list pane and the Modules tab panel (see section 6.2, Main Window
Elements).

View > Show Touch Keyboard Button

Select this menu item to display a Touch Keyboard button on the bottom
of the Modules panel. Clicking this button will bring up a virtual keyboard
on the screen.

View > Show Modules
Choose this menu item, and in the drop-down menu select/deselect the
modules to display in the Modules tab panel.
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e View > Additional Tabs
Choose this menu item, and in the drop-down menu select/deselect the
tabs to display in the Activity Monitor panel.

e View > Configure PTT Boxes
Choose this menu item to configure the view of PTT boxes.

Configure PTT Boxes x

Radio Interface

Type MName View Mode Available Calls

Channel Intercom Normal -
Channel Control Station #1 Normal Al

Group Group 1 Normal Firemen

Group Group 2 Normal Palice -

-

Create |=hEdit Delete
et Bt Xoskts cance

In the Configure PTT Boxes dialog box, specify the following PTT box
parameters:
= Type
In this column, the box type (for example, Channel, Group, Radio or All
Call) is displayed.

Note: The 'Channel' type means that the PTT box has been
automatically created by the radio systems connected
to TRBOnet Server and it can only be partially edited.
The Edit link is grayed out when a PTT box of this type is
selected.

= Name
Enter a name for the selected box. This name will be displayed in the
title of the PTT box.

= View Mode
From the drop-down list, select the view mode:

e Invisible
Select this mode so that the PTT box will not be displayed.

¢ Normal
Select this mode so that the PTT box will be displayed in Normal
view mode:
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/_ Control Station #1 [ (=]

Channel 1
All call (-]

Session;

Free channel

Sender:

L 1

RX [T

- J

¢ Minimized
Select this mode so that the PTT box will be displayed in Minimized
view mode:

ControlStation #1__ [1][<][@] ]

Note: Hover the mouse pointer over the Minimized PTT box to
view the PTT box in the Normal view mode.

= Available Calls

From the drop-down list, select the destination radio or radio group for
the PTT box.

Create virtual channel boxes

= To create a virtual PTT box, click the Create link in the lower-left corner
of the Configure Voice Boxes dialog box.

Virtual Channel X
Name: Group Call
Call Type: Call Destination:
O ancal (® Select by Dispatcher
(®) Group Call () Selected from list
(O Private cal ‘ j

Execute call on channels:

() Execute call on all available channels
(® Execute call only on selected channels
v Control Station #1

[~ Intercom

¥ Local Brine's

Repeater #1: Slot #1
[ Repeater £1: Slot 22

crcel

In the Virtual Channel dialog box, specify the following virtual channel
parameters:

* Name
Select this option and enter a name for the virtual channel.

= Choose a Call Type for the channel.

6.3 Main Menu
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Call Destination

(available only when Group Call or Private Call is selected as the Call
Type)

Choose Select by Dispatcher to allow the dispatcher to select a Call
Destination.

Or, choose Selected from list and from the list below select the
desired group (if the Group Call type is chosen) or individual radio (if
the Private Call type is chosen).

Execute call on channels

(available only when All Call or Group Call is selected as the Call Type)
Choose Execute call on all available channels,

or Execute call only on selected channels and in the list below select
the available channels.

e View > Configure Active Calls panel
Choose this menu item to configure call types and advanced settings for
the Active Calls panel. This menu item is available if View > Show Active
Calls Panel is selected.

Call Types
On this tab, you can select which call types to display in the Active Calls
panel:

Active Calls X

I show All Call

I show Group Calls

W Show Emergency Calls

W show Private Calls

[+ show Remate Monitar

W Show Intercom Group Calls

W Show Intercom Private Calls

canel

Advanced
On this tab, you can set following options:

e Show Visible Channels
Select this option to display Visible channels in the Active Calls panel.

e Show Hidden Channels
Select this option to display Hidden channels in the Active Calls
panel.
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Note: For the visibility of channels, see Configure PTT boxes,
View Mode.

e Show Requests To Talk
Select this option to display Requests To Talk in the Active Calls
panel.

¢ Show Missed Call
Select this option to display Missed calls in the Active Calls panel.

Active Calls X

¥ Show Visible Channels
[V Show Hidden Channels
¥ Show Requests To Talk
[V show Missed Calls

[oc ] camel

The Active Calls panel is displayed in the upper part of the Dispatch
Console:

File View Map Tools Help

Radio Interface B
=t & X7 &

E] & Online Dispatchers (1)
B administrator

- L )

L Police (=]

Drag and Drop PTT Box here to
create new group

ession:

Recent Calls/Events

‘l [0 Playback [l Save~ () Print | 11 Pause < Clear + i Reload | [ Filter By Radio | = Grouping '\ Auto Filter > Default Settings >
Date | Radio System | Sender | Redipient | Message | Details | Note.

29-5ep-2016 17:03:17  Control Station... Administrator  Police Dispatcher ‘Administrator' ... Members: Administrator i‘

29-5ep-2016 17:02:37  Control Station... Administrator  Police. Dispatcher 'Administrator’ ... Members: Administrator

P e : Control Station... Administrator  Police Dispatcher ‘Administrator’ ... Members: Administrator

Control Station... Administrator  Firemen Dispatcher ‘Administrator' ... Members: Administrator

29-Sep-20 01:47  Control Station... Administrator  Police Dispatcher 'Administrator' ... Members: Administrator
(5] Radio Allocation 295ep2016 17:01:25  Intercom Administrator Al Intercom Call: Dispatcher .. Members: Administrator >
i) 4] 4| Record1ofae v [m|mi«] L,J

E et Recent Cals/Events | RecentCals | Radio State | Active Tasks | | User Activity | Map | Cameras

127001 By G B B | § Administrator | (8 Licensed to: demo Demo License | @ Active-

e View > Customize Shortcuts

Choose this menu item to configure shortcuts for the actions on the
selected channels.
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Change Shortcut Settings X

¥ Show shortcut buttons

Shortout Device Button Action Caption

Shift Terminate Al Tran... Terminate -
Space Toggle Select chan... Toggle Select

L Unmute channels Unmute

Enter Maone (Footswitch Intercom

DG 1

IPSC 1: Slot #1

IPSC 1: Slot #2

333319

Group 11

-
M4 | 4| Record 4of 11 k| KM 4 4
qpCreate [ShEdit X Delete Show all PTT boxes

Cance

To configure shortcut PTT actions to the PTT boxes, click the
Show all PTT boxes link, double-click the desired PTT box(es) to apply
the changes, then assign a keyboard shortcut or combination of keys.

To configure specific non-PTT actions to PTT boxes (for example, mute
channels or set default PTT channels), click the Create link to make the
changes:

Action X
Caption: ‘Mube Mode
Shorteut: ctrl i
Device Button: ‘Mone (Footswitch PTT) j
Action: [Mute channels j

Channels:
[v Telephony

[¥ Intercom

[~ DG1

[~ IPSC 1: Slot £1
[ IPSC 1: Slot %2

L4

Lo

[ Group 22 ¥

In the Action dialog box that appears, specify the following
parameters:
e Caption
Enter the caption that will be displayed in the Dispatch Console.
¢ Shortcut
Click the Configure button, and on the keyboard, press the key or

key combination you want to assign as a shortcut for the selected
action.

e Device Button
From the drop-down list, select the external device button you want
to assign for the selected action.

e Action
From the drop-down list, select the desired action:

v Toggle Select channel
This action sets the Select status to selected PTT boxes and the
Unselect status to others.
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v Mute channels
This action mutes selected PTT boxes.

v Unmute channels
This action unmutes selected PTT boxes.

v Toggle Mute channel
This action sets the Unmute status to selected PTT boxes and the
Mute status to others.

v Terminate All Transmissions
This action terminates all transmissions for selected PTT boxes.

v' Change channel settings
This action will configure settings, such as Recorder, Player,
Speaker, etc., for the channel specified below.

v' Change Sound settings
This action will configure the Sound settings, such as Recorder
and Player.

e Channels
In the list below, select the PTT boxes to which to assign the actions
specified above.

= To enable displaying the configured shortcuts in the Dispatch Console,
select the Show actions panel option.

All the shortcuts you have configured are displayed in the upper part of the
Dispatch Console:

File View Map Tools Help

Radio Interface € )
" Radio Interface | Recent Calls/Events Radios
Terminate all  Transmit Quick Commands [
& B, Online Dispatchers (1) Actve Calis ®
B administrator Pre-recorded Messages [X]
L Police 2 S ~ || To: Selected Channels
(D Intercom [Enfcs] Control Station #1 [ E?l\ Patch X

E‘E‘lj Voice Dispatch All Call Channel 4
All Call -

Session: Session:

@, Job Ticketing Free channel Free chamel

Ej Route Management Sender: Sender
éll RFID Tracker
RX[TX RY /TX
[ Teteges L ) € A.
E Recent Calls/Events ™ |
Voice Recording . = = Y
¥ Playback | Saver () Print | 11 Pause ¥ Clear v & Reload | | Filter By Radio | = Grouping 7 AutoFilter @ Default Settings =
@ Reports Date Radio System | Sender Recipient Message Details Note
D 29-Sep-2016 18:15:42  Intercom Administrator Al Intercom Call: Dispatcher ... Members: Administrator -
= - e 29-5ep-2016 17:53:22 RadioServer All Connection to ‘Control Sta...
15| Event viewer
* D 29-5ep-2016 17:27:01 Intercom Administrator Al Intercom Call: Dispatcher ... Members: Administrator
— 29-5ep-2016 17:27:00 Control Station... Administrator  Police Dispatcher ‘Administrator’ ... Members: Administrator
*2] Radio Allocation
([ 29-5ep-2016 17:26:48  Intercom Administrator Al Intercom Call: Dispatcher ... Members: Administrator -
= 6] 9| «] Record10F319 [ m|mi| B
@ Administration Recent Calls/Events | RecentCalls | RadioState | Active Tasks  ActiveRoutes | User Activity | Map | Cameras
[ 127.00.1 &3 B B B | § Administrator | [ Licensed to: demo Demo License @ Active -

e View > Add Radio Interface Tab
Choose this menu item to add a new Radio Interface tab to the Radio
Interface pane.

6.3 Main Menu 117



118

neocom

software

Configure PTT Boxes X
Name: |Rad\o Interface #1 |
Type ‘ Name View Mode Available Calls
Channel Telephony Mormal EI
Channel Intercom Normal
Channel DG 1 Normal
Channel IPSC 1: Slot #1 Normal All
Channel IPSC 1: Slot #2 Normal All
Channel Group 11 Mormal
Channel Group 22 Mormal
Channel All Call Normal All
Radio Private Call Normal Al

dpcreate [ShEdit ¢ Delete

=
o ][ conce |

= In the Configure PTT Boxes dialog box, specify the following PTT box
parameters for the new radio interface:

¢ Name

Enter a name for the radio interface.

Other parameters can be configured in the same way as when

Configuring

PTT Boxes.

The user can switch between Radio Interfaces by clicking on the tab bar in the
upper part of the Radio Interface pane.

File View Map
Voice Dispatch

EBi= 5 &R 7| &

Tools  Help

Radio Interface

5 B, oniine Dispatchers (1)
& administrator
@ | Firemen

[ Police

44

[Jantercom

=E

Control Station #1

&[]

{1 Raco interface ” Radlio Interface #1 [ RecentGlofevents [Redos || |

(i voice Dispatch

FE—
ﬁ Job Ticketing

;"] Route Management

ssssss

@ Al Call

Il

Channel 4

Session:

Sender:

Recent Calls/Events

5] Playback (el Save~ () Print | 11 Pause . Clear ~

& Reload | [ Filter By Radio | = Grouping "/ Auto Filter

Date | Radio System

| sender

| Recpient

| Message | Detaiis Note |

14 4| Record10f303 b |mm| ]

30-Sep-2016 10:48:54  Intercom
29-5ep-2016 18:15:42  Intercom

$% 29-5ep-2036 17:53:22

29-5ep-2016 17:27:01  Intercom
29-5ep-2016 17:27:00  Control Statio.
29-8ep-2016 17:26:48  Intercom

Administrator
Administratar
RadioServer

Administrator

. Admiristrator

Administrator

Intercom Call: Dispatche.
Intercom Call: Dispatche. .
Connection to 'Control §...

Members: Admiistrator ﬂ
Members: Administrator
Members: Administrator

Members: Administrator
Members: Administrator

Intercom Call: Dispatche. .
Dispatcher ‘Administrato...
Intercom Call: Dispatche.

oR

Recent CalsfEvents | RecentCals. | Radio State. | Actve Tasks |

| User actvity | Map | Cameras

127001 B | & Administa

tor ‘ [ Licensed to: demo Demo License

e View > Delete Radio Interface Tab
Choose this menu item to delete the Radio Interface tab currently
selected in the Radio Interface pane.

| @ Active-

Note: The default Radio Interface tabs can't be deleted.

View > Show Channel Selector Box

Select this menu item to display a separate PTT box that allows selecting a

channel.
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T )
Intercom

1P Site Connect: Slot #1

IP Site Connect: Slot #2

|

Session;

[ 1

Sender:

Channel not selected

- J

Click the arrow of the drop-down list and select the channel for this PTT
box.

e View > Show Call Type Buttons
Select this menu item to display the Call Type Buttons panel in PTT boxes.

[P site Connect: Slot #1 | -|\

Session:

Free channel

Sender:

L 1

RX /T
li ™

. J

e View > Show Keypad Panel
Select this menu item to display the Keypad panel in PTT boxes.

(_ 1P Site Connect: Slot #1 [=g

Note: The Keypad panel will be displayed only when the Num
button is pressed in the Call Type Buttons panel.

e View > Audio Message Library
Choose this menu item to add configured Voice Messages to the Queued
Messages panel. For how to configure Voice Message settings, see Tasks,
Voice Message.
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Saved Audio Files X
4 Add % Remove | v Filter | Shortcut
| Filename | Description Severity Shortcut Visibility
Alarm Tone Alarm Hidden
»  Bobby.mp3 Infarmation ]
Daisy.way Information
Send Cancel |

= In the Saved Audio Files dialog box, specify the following parameters:

¢ Filename
The name of the message displayed in the Queued Messages panel.
e Description
Enter a description for the Voice Message.
e Severity
From the drop-down list, select the severity level (Information,
Alarm, or Warning).

e Shortcut
Click the Shortcut button and press the key or key combination you
want to assign as a shortcut for the selected Voice Message box.
o Visibility
From the drop-down list, select how to display the selected Voice
Message box:
v Hidden
Hide the Voice Message box.
v Button
Display the Voice Message as a button (1).
v' Link
Display the Voice Message as a link (2).

Radio Interface

Radio Interface | Recent Calls/Events

[Jintercom [

@ -
Session:

fon:
[Free channel
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o View > Extended PTT boxes
Select this menu item to display PTT boxes as shown:

4 Control Station #1
|Control Station #1 | @&
EN |channel 1 - Q @
— Free channel
Tone & PTT [ RXITX } Terminate J
cal: |All Call o [ enea )
P —— =
7 8 9
L& & Fenmenieas NI

e View > Large PTT boxes
Select this menu item to display PTT boxes as shown:

e View > Medium PTT boxes
Select this menu item to display PTT boxes as shown:

[ control Station #1 Channel
All Call -
|| €| @

Channel 1

¢ View > Small PTT boxes
Select this menu item to display PTT boxes as shown:

[Cuntrol Station #1 [« }

Free channel
alcal Channel 1

e View > Custom PTT boxes >

Select Custom PTT Boxes 1 to display PTT boxes as shown:

Control Station #1

H«o
Free channel

Select Custom PTT Boxes 2 to display PTT boxes as shown:
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Select Custom PTT Boxes 3 to display PTT boxes as shown:
Slot 1

ARl @

[ »

Al Call ®

Free channel £
:

=)

RX fTX 7
! B

e View > PTT Box Themes
Click this menu item and select the theme to be edited, or create a new
theme.
To create a new theme:
e C(Click View > PTT Box Themes > Create Theme.

e Inthe PTT Box Theme dialog box, enter a theme name and specify
desired colors for PTT box elements in various statuses and for
various call types.

e From the Preview list box, select the box size/type and see how it
will look like.

e To set the theme as default, select the Set as default theme option
located at the bottom of the dialog box.

o Click OK.

PTT Box Theme X

Name: Police:

PTT Box Statuses Defeuts  Preview: | Lorge PTT Boxes 3
H * | { [ control station / Channel @

Q

Recipients

Session:
Free channel

Background: 1255, 213, 213 -

Outer Border (= 4
Text [mmws oo
Field Borders (= 4
indicstor Background: [ ]
Status Bar Text ’El—;|
P =
[ Set as defaut theme Cancel

e View > Show Active Calls Panel
Select this menu item to display the Active Calls panel in the Dispatch
Console.
See also Configuring Active Calls panel.

e View > Show PTT Search Bar
Select this menu item to display the search bar in the Radio Interface
panel.

¢ View > Show Clock Panel
Select this menu item to display the Clock panel (1) in the Dispatch
Console.
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e View > Show Quick Commands Panel
Select this menu item to display the Quick Commands panel (2) in the
Dispatch Console. For more details, see section 6.5.6, Quick Commands.

e View > Show Pre-recorded Messages Panel
Select this menu item to display the Pre-recorded Messages panel (3) in
the Dispatch Console. For more details, see section 6.5.7, Pre-recorded
Messages.

e View > Show Patch Panel
Select this menu item to display the Patch panel (4) in the Dispatch
Console. For more details, see section 6.5.5, Patches.

e View > Show Phone Calls Tab
Select this menu item to display the Phone Calls tab (5) in the Radio
Interface pane.

e View > Show Extended Messages Tab
Select this menu item to display the Extended Messages tab (6) in the
Radio Interface pane.

e View > Show Radios Tab
Select this menu item to display the Radios tab (7) in the Radio Interface

pane.
Radio Interface
Monday, May 27, 2019
12:24 pm
M intercom
@ Allcall
: [ Record [t Fie [
To: Selected Channels
6.3.3 Map
e Select Location Tracking (1) in the Navigation pane to enable Map
Options:

e Click the Map menu (2).
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% Map Content.
= Print S
e [} Fire([55 G- [ Beacons
_ E 2K Geocoding. W12 Beer
® Open New Map in Tab. | ME@coffee
@ q I — o Floor plan__X| | Ll @Tes
- en New Map in Window... = S
& [} Poi | pen Tew ap I R[E[O]E)] 7 [8] showseacons: a ~ [ Drawing Panel > | G- [ Map Objects
&S Google Earth = [ [&) camera 1
|3 Delete Route on Google Earth 2 1] Hospital
Show Radios on Google Earth » J@ i [ roice
& 12p Regions
2 ¥l [ Map R
% Location Tracking . o) =7 Region 1
=1 F (] [ Map Routes
i 2ot ki @ Er—
M S 235
| ] RFID Tracker ]
125
[ Text tessages Wm Laiiude, 55'5627,63" N; Longtude: 30'1649.88" E |
i _ Recent Calls/Events 7
[ Playback [l Save~ () Print | 01 Pause < Clear - 'S Reload | [J Filter By Radio | = Grouping 7 Auto Filter (> Defautt Settings 2
@ Reports Date Radio System Sender Recipient Message Details
S 09.06.2017 14:43:57 Server Al Connection to ‘Capaity Plus 1" h. i‘
Event Viewer 09.06.2017 12:43:30  CapadityPlus 1 Administrator 1 Dispatcher 'Administrator’ calls gr... Members: Administrator, 125
5 09.06.2017 12:40:06  Capacity Plus 1 125 1 Radio '125' calls group '11' (00:08)  Members: 135
) - 09.06.2017 12:39:55 Capadity Plus 1 Administrator 11 Dispatcher ‘Administrator’ cals gr... Members: Administrator
I i teher ‘Ach  call bers: Ack
06,2017 12:38:34 Capadty Plus 1 Administrator Police Dispatcher 'Administrator’ calls ar... Members: Administrator A
Wil 4| ] Rerord 167305 D %] 5
e
@ Recent Calls/Events  RecentCalls  RequestToTalk RadioState  Active Tasks = Active Routes | User Activity = Beacons  BeaconEvents  Tag List

127001 &3 B | § Administrstor | [ Licensed to: demo. | @ Active~

The Map menu contains the following items:

e Map > Select Active Map
Click this menu item to select the map to display in the Dispatch Console.

Select Map.. X
Caption: |
Avaiable Maps
Name Path State
MAPNIK oK
CYCLE oK
TRANSPORT oK
LANDSCAPE oK
BING_ROAD oK
BING_AREA oK
BING_HYERID oK
Add Edit Remave Cancel

= Enter the Caption of the map that will be displayed in the Dispatch
Console.

= In the list of Available Maps, choose the map to be displayed.
Adding custom maps

You can also add an online map using its specific URL.
= Click the Add button.

Add Map X
Name: =X |
Map Type: WM (web Map Service) -
URL: [ttp:4/maps dgs.udel edu:80/geoserver/DGS_Suricial_and_Cortact_Geology/wms |

AW Get Capabilties
[)|mepTite [ rdentfier | Desaription [ style

is map shows the surfical geology of D...
p shows the surficial geology cont.

DGS Statewide Geologic Map ...
logic Statewide Map

i //maps.dgs udel edu:80/geoserver/DGS_Suficia_and_Cortact_Geology/wms ?REQUEST-GETMAPSSER] (5

=

e Enter a Name for the new map.
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6.3 Main Menu

e Map Type
From the drop-down list, select the map type: Custom Map, WMS
(Web Map Service), or WMTS (Web Map Tile Service)

e Enter the URL of the map service and click Get Capabilities.
As a result, the table in the lower part of the dialog box will get
populated with the available map layers.

e Select the checkbox in the left column of the table to enable the
appropriate map layer.

e Click OK.

As a result, the new map will appear in the list of available online maps.

e Map > Save Online Map Data
Click this menu item to save your current map region.

Download Map Tiles - o x
Region from N59°57'32.29" E030°17°59.68" to N59°56"13.91" E030°17'19.45"

Tie expiation, days: |30
[0 Refresh dll tiles

Zoom level: 16 Tiles to download: 23

Status: Finshed
Loading zoom level: 16
Loaded fromthe web: 0
Updated from the web: 0
Loca: 23

Failed: 0

[ Previewties [] Show downloaded ties

Loaded: 23 of 23 (100 %)

In the dialog box, specify the following parameters:

Tile expiration, days

Enter the expiration time, in days, for the map tiles. When you
download the map, the already downloaded tiles are checked and if
they are older than this number of days, these map tiles will be re-
downloaded from the Internet.

Refresh all tiles
Select this option to re-download the map tiles before saving to your
PC.

Zoom level

Move the slider from left to right to increase the detail level of the
map.

Preview tiles

Select this option to show how the map is divided into tiles.

Show downloaded tiles
Select this option to show the progress bar while the online map is
being saved.

Click Start and wait for the system to save the files. This may take
several minutes.

heocom
SOftware
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e Map > Map Content
Click this menu item to specify the folder and settings to store the map
data.

Online Map - o X
Map cache

Cache folder:
D:\Temp\Maps

Update: Never

Map Type: BING_ROAD

hitp://msdn microsoft fibrary 428642 ssp

G

In the Online Map dialog box, specify the following settings:

Cache folder
Click Change and locate the folder on the PC where you want to store
the map data.

Update

Select the update interval ('Never', 'Immediately’, or 'By period') for
the map data stored in the specified Cache folder.

Map Type

From the drop-down list, select the map type. For more details on the
maps used in TRBOnet Dispatch Console, see section 6.3.3.1, Map
Types (page 126).

<Map Provider> key

Enter the key for the selected map.

Note: To obtain the key, click the hyperlink below and follow
the instructions.

6.3.3.1 Map Types

Online maps:

MAPNIK - free online map. For more details on OpenStreetMaps, visit
the official the website: http://www.openstreetmap.org

Thunderforest - commercial online maps. Visit
http://www.thunderforest.com/docs/apikeys/ to get a key.

Microsoft BING - commercial maps from Microsoft. Includes
BING_ROAD, BING_AREA, and BING_HYBRID subtypes. A user may use
BING maps for 90 days and then they must get a Basic Key. Visit
http://msdn.microsoft.com/en-us/library/ff428642.aspx to get a Basic
Key.

Google Maps - online mapping service from Google. Visit
https://developers.qoogle.com/maps/documentation/javascript/get-

api-key#key to get a key.

6 TRBOnet Dispatch Console
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Custom Maps - online mapping services such as TRBOnet Map Server,
WMS and WMTS services. For more details, refer to TRBOnet Map Server
User Guide. For more details on the WMS/WMTS services, visit
http://www.opengeospatial.org/standards/wms/introduction.

Offline Maps:

6.3 Main Menu

TMap - internal map-making resource. The user can create an offline
copy of online maps for selected regions according to their needs and
requirements. The user can create a map from any picture via the
TRBOnet Map Edit application.

Click Start > All Programs > Neocom Software > TRBOnet
Enterprise> Console> TRBOnet.MapEditor.exe

For more details on map calibration, read the following article at:
https://trbonet.com/kb/how-do-i-create-a-custom-map-for-trbonet/

Beacon 2D - two-dimension offline map for Indoor positioning. The
user can create indoor maps using the Indoor 2D Map Converter. See
section 6.4.21.2, Indoor 2D Map Converter.

Beacon 3D - three-dimension map for Indoor positioning. The user
can use any DirectX file as a map.

e Map > Print

Click this menu item to print the map region currently displayed in the
Map pane.

Map > Geocoding
Click this menu item to configure geocoding servers in the Dispatch
Console.

Geocoding X

Load data from TREOnet Server if Geocoding services are unavailable on local PC

[ server Name
I | Goode
¥ |Nominatin

Load data from TRBOnet Server if Geocoding services are
unavailable on local PC

Select this option to receive location data from the TRBOnet Server PC
if the Dispatch Console is unable to resolve location data.

For other settings, see section 5.9.1.1, Configuring Geocoding Servers
(page 28).

Map > Open New Map in Tab
Click this menu item to add a new map tab to the Map pane.
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Select Map.. %
Map Type: Online maps v
Caption: [y maapl
Available Maps
Name Path State
MAPNIK oK
crae oK
TRANSPORT oK
LANDSCAPE ok
BING_ROAD oK
BING_AREA oK
BING_HYBRID oK
ndd e cancel

= Map Type

From the drop-down list, select the map type.
= Caption

Enter a caption for the new map tab.

= For other settings, see Selecting Active Map.

Once you have clicked OK, the new tab will appear in the Map pane:
BING ROAD ¥ My Map XI|

G} ©) T e Fifer R Show Beacons: Al « | & Ruler 4 FindonMap=~ &\ 4 DrawingPanel 7 Route~ < Geofencing 7
%, ) % %Y
0 % iz %
Z o A 5
b 2 L %
£ = © )
© s . Z
& % 5 O\
2 % 2 %
2 235 4 ) %
- % %
o % 5
2% B‘L O
‘c ei, 4 V.\\l‘
% 3 T
T (= s X
(0 Q. “ \;
T > )
e 125 o
o ® :
s Vasil'yevskiy Island
% .
% Nbe =
% )
% \ - 5,
%, 2 4 ‘,c““d‘ £
=] %, & s?e“ 5
2 C % & 4
100m % 9 % O %
% % 2 o0 [ Lattude: 59°5629,70" N; Longitude: 30°1653,10"E |

e Map > Open New Map in Window
Click this menu item to create a new map window with the specified map.

= For required settings, see Selecting Active Map

Once you have clicked OK, the new Map window will appear:

235 - o x
o [CETES R | Reler 4 FindonMap= & | & Drawing Panel | 7l Route~ & Geofencing
HEEEE IS E

EA |l

g & B} Online Dispatchers (1) Ves[yevskiy lslanc

2

& adminisirator

© [} Firemen |
BH® 12 e

® Ok [V]S]%]

| Police (=]

A
‘O Latitude: 53°5628.50"N; Longitude: 30°16'45.62'E "

235

e Map > Google Earth
Click this menu item to open the Google Earth application.
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Note: Google Earth must be previously installed on the PC. To
download Google Earth, go to the Google Earth website
https://www.google.com/intl/en/earth/desktop/, and
click Download.

e Map > Delete Routes on Google Earth
Click this menu item delete all routes from Google Earth.

e Map > Show Radios on Google Earth
Click this menu item and in the drop-down menu select which radios to
display on Google Earth.

6.3.4 Tools

The Tools menu contains the following items:

e Tools > Event Viewer in Window

Click this menu item to open the Event Viewer in a new window.

B Event Viewer - o X
) Al Events [ Playback [ Save | 11 Pause ¥ Clear & Reload | = Grouping '/ Auto Filter @ Default Settings || 5 Details ||[11] Show Notes
-] Text essages Date | system | sender Destination Desciption Detais
i mbox (D 0502 IL2%AM PL Radolzs 2 Group Cal: Radio 125'called 22 (00:09) _ Takers: Radio 125 -
o8 sent (D 0Sep2111:12:46AM CP1  Rado12s 11 Group Call: Radio 125'called 11! (00:07)  Takers: Radio 125, Adrminitrator
&y Telemetry (D M0Sep211L1240AN P1 Radois 2 Group Call Radio 125'called 22 (00:04)  Takers: Radio 125
B obtanedsonds |5 3gep 2t 1n238AM 1 Radois 1t Group Cals Radio 125'called" 11" (00:04)  Takers: Radio 125
G Senteommands |5, 30 cep21 sussais AN voble 1 44 Rade 125 Private Cal: 4444 called Radio 125 (00:13) Takkers: 444 Rado 125
B vacecals () 305021 L10:52AM Moble 1 4444 Rado 125 Private Cal: 4444 called Radio 125 (00:09) Takers: 4444
i © w2z b1 s aunswoir  PrvateCl 444 caled Admnstatr ... Takr: 444, Adinsatr
i Dot o || DS MTIM L adninsor 2 Group Cal: ‘Adrinistrator caled 22 (00:08) Takers: Admiistatar
30Sep21STDAM P Admnstator 11 Group Cal: ‘Adminstrator calld '11'(00:08) Takers: Admiistrator
() 30.Sep21 1:57:00 AM  Intercom Administrator Al AlICall Adminisrator caled"AF 00:01)  Takers: Adniisrator
(D 30.Sep21 :56:I0AM Moble 1 4444 Rado 125 Private Cal: 4444 called Radio 125 (00:26) Takers: Radio 125, 4444
(D 30Sep21 M:5uSOAM CPL Radol25 11 Group Cal: Ratio 125'caled" 11 (00:04)  Takers: Ratio 125
(D 21Sep214m0m L Adminsvator Al Al Call Administrator caled"AT (00:03) [ Takers: Admistrator a
(© 21Sep21430:10PM  CPL Adminstiator 11 Group Cal:‘Adminstrator caled '11 (00:06) Takers: Adminstrator
() 2150021 430:10PM  Intercom Administrator  Dispatcher Graup 1 Group Cal: ‘Acninsirator caled Dispatche .. Takers: Adminsirator
( 20:5ep21430:10PM  Intercom Administrator Al Al Call Administrator caled"AF (00:02)  Takers: Adminstrator
() 2150021 430:10PM  Intercom Administrator  Dispatcher Group 2 Group Cal: ‘Achminitrator caled Dipatche
(© 205ep2142832PM 1 Adminstator 22 Group Cal: etor’ called 22 (00:09) =
W[ €] Record 20212 ¥l « [T G ail i >
H Sender Radio 125 Date: 30Sep-21 11:12:4 AM
Destination; [FElPlavback (g Save (7 Add Mote
Group Call: Radio 125 called 11 (00:07)
|

¢ Tools > Recent Calls/Events in Window

Click this menu item to open Recent Calls/Events in a new window.

| Recent Calls/Events. — [m] X

[ Playback (d Save~ (i Print | 1 Pause <# Clear - '&i Reload | [ Fitter By Radio | = Grouping /' Auto Filter ©» Default Settings bl
Date System Sender Destination Desaiption Details N.

30-Sep-21 11:12:46 AM  CP1 Radio 125 22 Group Call: Radio 125' called 22’ (00:04) Talkers: Radio 125 -
30-5ep-2111:12:46 AM  CP1 Radio 125 11 Group Call: Radio 125' called *11' (00:07) Talkers: Radio 125, Administr.
30-5ep-2111:12:40 AM  CP1 Radio 125 22 Group Call: Radio 125' called 22’ (00:04) Talkers: Radio 125
30-5ep-2111:12:33 AM  CP1 Radio 125 11 Group Call: Radio 125' called *11' (00:04) Talkers: Radio 125
o 30-5ep-2111:12:11 AM  Mobile 1 4444 Radio 125 Private Call: '4444' called Radio 125 (00:13) Talkers: 4444, Radio 125
o 30-5ep-21 11:10:52 AM  Mobile 1 4444 Radio 125 Private Call: '444<4' called Radio 125' (00:08) Talkers: 4444
o 30-5ep-21 10:57:47 AM  Mobile 1 4444 Administrator  Private Call: '4444' called "Administrator’ (00:02)  Talkers: 4444, Administrator
30-5ep-21 10:57:27 AM  CP1 Administrator 22 Group Call: ‘Administrator’ called ‘22 (00:08) Talkers: Administrator
30-Sep-21 10:57:20 AM  CP1 Administrator 11 Group Call: ‘Administrator’ called '11' (00:08) Talkers: Administrator
D 30-5ep-21 10:57:00 AM  Intercom Administrator Al All Call: 'Administrator’ called ‘All' (00:01) Talkers: Administrator
o 30-5ep-21 10:56:10 AM  Mobile 1 4444 Radio 125 Private Call: '444<4' called Radio 125' (00:26) Talkers: Radio 125, 4444

[9 30-5ep-21 10:55:15 AM 4444 Al Battery: 80%
n 30-5ep-21 10:52:59 AM  CP1 Radio 125 1 Group Call: Radio 125' called *11' (00:04) Talkers: Radio 125 A
i «| <] Record 10f 351 »|wmi| ¢ »

u Sender: Radio 125 Date: 30-5ep-21 11:12:4%6 AM
Destination: 22 [FBlPlavback [T Add Note
0(125‘ called 22 (00:04)

= Click Playback to play back the selected call.

6.3 Main Menu

Click Save to save the selected call as an audio file.
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In the Save As dialog box, locate the folder where you want to save the
audio file, specify the file name, and from the drop-down 'Save as type'
list, select the format (*.wav, *.tna, or *.0gg) for the audio file.

= (Click Add Note to add a note to the selected event.

Mote X
well done ;I
=
Add Extension... oK | Cancel

e Enter the text of the note in the text box.

¢ You can extend the form of a note by clicking the Add Extension
link and adding new fields and their possible values to the form.

e Tools > Job Ticketing Monitoring
Click this menu item to open the window that visually represents the job
tickets created by dispatchers and assigned to radios.

In this window, you can perform the following actions:

= Select a time period for which to display Job Ticketing data.
= Monitor tickets created by dispatchers.

= Monitor tickets assigned to radios.

All data are shown in the form of status diagrams.

¢ Tools > Radios in Window
Click this menu item to open a new window that displays the radios
present in the system.
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Radios — [m] X

Filter: l:l Radio Groups: Al -

e —

Statuses: | (Online, Indoer), (Online, ...

¥ Firemen
¥| Cleaners
W 11
W 22
| Mobile Client d
oK Cancel | |
& @ & Q |

In this window, you can make radio calls, send text messages. In addition,
you can select to display radios by groups and statuses.

e Tools > Phone Calls in Window
Click this menu item to open a new window that displays Phone Calls
available in the system.

[ \;n

Hold Forward 00:15

Contacts |

Shortcuts |

=

In this window, you can make and receive phone calls. To make a call,
enter a phone number in the dial string and click Call. You can also select
a contact from the Contacts list. Or, use the shortcut buttons you have
previously created for your contacts (Tools > Contacts).

e Tools > Telemetry Monitoring

Click this menu item to open the window that displays configured
telemetry profiles for the radios.

Telemetry £1 - o X

B
i
iig
99 ¢
99 ¢

* From the Show drop-down list, select the Telemetry profile to display.
See also section 6.4.12, Telemetry (page 227).

e Tools > Text Messages in Window
Click this menu item to open a new window to manage text messages.
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Text Messages - o x

BlEs & XY S'@ | Clear S Reload ||} Inbox [ Sent

[05-0ct-2016 17:51:13 Received from 235 to 125
His be on

[05-0ct-2015 18:01:43 Received from 235 to 125
only §m

I05-0ct-2015 18:06:04 Received from 125 to 235
nog

3 | [05-Oct-2016 18:10:53 Sent from Administrator to Police
p making me fool

Recipient: % | Police | EJ send | ] AttachFile

125

In this window, you can perform the following tasks:
= View sent messages in the upper-right pane.

= Select online dispatchers and radio groups in the left pane, or by
clicking the ellipsis (...) button in the lower-right pane.

= Type messages in the text box in the lower-right pane.
= Send messages by clicking the Send button in the lower-right pane.

Tools > Routes in Window
Click this menu item to open a new window to manage routes.

For more details on Route Management configuration,
see section 6.8, Guard Tour / Route Management (page 349).

Tools > Camera in Window
Click this menu item to open a new window with an IP camera view.

® Camerat - [m} >

Camera: ICamera 1

T

In this window, the IP camera view is displayed.

= Camera
From the drop-down list, select a camera that is connected to TRBOnet
Dispatch Console.

See also section 6.4.9, IP Cameras (page 220).

e Tools > Reset All Location Triggers

Choose this menu item to stop/start location triggers on all radios.

6 TRBOnet Dispatch Console
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e Tools > Dynamic Regrouping
Click this menu item to dynamically regroup radios depending on current
needs. For more details, see section 6.4.31.2, Dynamic Regrouping.

Note: The Dynamic Regrouping feature is available only for
Capacity MAX systems. In addition, the radio's firmware
version must be 2.10 or later, and the DGNA feature
must be enabled on the radios.

e Tools > Terminate All Transmissions
Click this menu item to terminate all voice sessions.

This action is a "hard" request to stop all "hung" transmissions in the
TRBOnet software. If a radio communication session is not allowed to be
interrupted on a repeater or base station, it will only be stopped for the
TRBOnet software.

¢ Tools > Contacts

Click this menu item to open the Contacts list for reference purposes as
well as for creating favorites and shortcut buttons.

Contacts w
AII ' spedify text to searh
2‘ Dispatcher Group 1 wr
R Dispatcher % Dispatcher Group 2 -
%& Disp. Group R Administrator /
Disp 1
El Radio R P L

8 pisp2 .-
Radio Group R Disp 3
,;:; Phone 2222

3333
<"}‘ Favorites
L~ 4444
5555
PA2 W [+
OK | Cancel |

Creating favorites

e Inthe right pane, click the gray star on the right of the contact's
name until it turns yellow.

Creating shortcut buttons
o Click the Favorites tab.
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Contacts X

A an - Specif

;}_ Dispatcher Group 1
Dispatch
R spatcher % Dispatcher Group 2

& Disp. Group $ Eugene /' g

= & -
. ;‘Walt I
Radio Group

::"; Phone

xt to searh

ﬁ:}‘ Favorites

oK | Cancel |

¢ Inthe right pane, click the circle to on the right of the contact's

name and from the menu that opens select the desired button
color.

The shortcut buttons you have created will appear in the Phone Calls
window (Tools > Phone Calls in Window).

6.3.4.1 Options

e On the Tools menu, click Options.

Options X

Sound Map  Coverage Map Hardware Advanced Audic Alarm  Phone Calls
@ Configure the Sound Notification
2

Use Sound Notifications

@, Textmessage received
. Information received
@, warning received

@, Marm received

Sound:
(Sound by default) ~r Select...

Alarm or Emergency Call duration: 53 seconds

Sound

¢ Inthe Options dialog box, click the Sound tab.

¢ Use Sound Notifications
Select this option to enable sound notifications in the Dispatch
Console.

e Select the event in the list and specify the sound.

e From the Sound drop-down list, select ether 'Sound by default' to

play default sound, or 'Disabled’ to disable sound notification for
the event.
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Map

(el L
e C(lick l—l to listen to the sound notification for the selected event.
e Click Select and browse for the audio file on your PC.

Alarm of Emergency Call duration
Enter the time value, in seconds, for the duration of the alarm tone
when an emergency call is received.

e In the Options dialog box, click the Map tab.

6.3 Main Menu

Options X

Sound Msp  CoverageMap Hardware Advanced Audio Alarm  Phene Calls

= Canfigure the image parameters that are shown on the map

£

seconds

m}
m}
m}
[ ra
ear

Select defauitimage type

‘The images below will be shown on the map:

®®®e

Path to Google Earth exe fle

e Map refresh interval
Enter the time period, in seconds, to update map data.

e Show directions
Select this option to display a direction of motion for map objects.

e Show radio names
Select this option to display radios names on the map.

e Show map object names
Select this option to display object names on the map.

e Hide overlapping names of objects
Select this option to hide overlapping object names.

e Group nearby icons
Select this option to group nearby icons together.

e Show last known indoor locations of online radios
If this option is selected, online radios will remain displayed at the

beacon location after they left the beacon's coverage area and have

not detected another beacon yet.

e Show PTT on map
Select this option to allow the dispatcher to make private calls by
clicking a corresponding radio icon on the map.
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o Default Map Filter

Select/deselect the icons for the default map filter (for a description
of the icons, see section 6.6.2.4, Filters).

e Show coordinates on map
In the drop-down list, select the coordinate systems/units that will
be used to display coordinates in the lower-right corner of the Map
pane.

e Select image size
From the drop-down list, select the size of a radio icon.

o Select default image type

From the drop-down list, select the default image type of a radio
icon.

e Path to Google Earth exe file
Click the ellipsis (...) button and specify the location of the Google

Earth exe file on your PC. For example, the path may look like:
C:\Program Files\Google\Google Earth Pro\client\googleearth.exe

Coverage Map

TRBOnNet Dispatch Console allows displaying RSSI levels on a map. The RSSI is a
received signal strength indicator. It measures the power level of the RX signal
at a repeater's receiver. The RSSI maps can be used by radio system engineers
to plan further extension of their radio networks.

¢ Inthe Options dialog box, click the Coverage Map tab.

Options X
Sound Msp  CoversgeMsp ardware Advanced Audio  Alam  Phone Calls

() Show as dots
@ show coverage zanes

200 2] RSSI zone size (m)

Value (dB) [ Desription [ color
65 Excellent I Green
-81|Normal [ Orange
~97 | satisfactory B parkGoldenrod
-113 Poor I DarkMagenta
-oo0| Bad I Red

Add Delete Default

= Show as dots
For a more detailed data view, choose this option to display on the
map, dots of RSSI levels representing coordinate points.
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= Show coverage zones
For a less detailed view, choose this option to configure and display on
the map, RSSI zones of average RSSI levels using GPS coordinates.

e RSSI zone size
Enter the size of the RSSI zone within which RSSI levels will be

averaged.
Emsha MAPQUEST *
40T e S A showRote. F Fire B[O @ & s 6, '
— Lj. ¢ \"w.}, DK ._"“ e, O, Selct RSS! data by pariod =
i e .
e |
od | [ Coce |
3\
el
N\ .
L
L
T Ao

" PETERSBURG
i o CAHKT-NETEPBYPT)

J

; &
Lottude: 59 9475618: Longeuce: 30.2354390

= Click Add to add a new RSSI level.

¢ Value

Enter the minimum level for the signal range (for example, -65
means -65 and higher).

e Description
Enter the name of the RSSI level to display in the system.

e Color
Pick a color for the RSSI indicator on the map.

To view RSSI Levels on the map, click the Location Tracking tab in the
Navigation pane, and on the Map pane toolbar, click Coverage Map.
Then set the Start Date and End Date to display RSSI data.

Hardware

e In the Options dialog box, click the Hardware tab.
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Options X
Sound Map  CoverageMap Hardnare Advanced Audio Alarm  Phone Calls
9%  External hardware opions. You can comect additional equipment such as a
%) footswitch or a fist microphone to press the PTT button.
[ use signaiing device

coML

Description
com3

TREONEt Mic Adapter
Wired Keyboard 600

TRBORet Foatswitch (RS232)

§ TRBOnet Footswitch (USB)

se

cor 45 HID

X Directx

| mero

J com oK Cancel

= Use signaling device
Select this option to use an external signaling device.

e Serial port
From the drop-down list, select the COM port the signaling device is
connected to.

= Click Configure and specify the duration of a signal and which call
types to include in signaling.

Signaling COM port x
Duration 10 3: seconds
Private Cal
Call Alert
Alam

oK Cancel

The External Devices table displays the connected devices

(Type/Name/Description).

e Click the Add link, and from the pull-down menu select the type of
TRBOnNet device with a PTT button connected to the PC (Microphone
Adapter, Media Dock, or Footswitch), or the device type (HID,
DirectX, TIPRO, or COM).

¢ Inthe dialog box that opens, specify the desired device parameters,
and click OK.

e First VoIP port
Enter the number of the first VoIP port for audio communications
(4022, by default). Each additional Dispatch Console will create a
connection on the next port number.

e First IP Camera port
Enter the number of the first IP Camera port for video
communications (13152, by default). Each additional Dispatch
Console will create a connection on the next port number.
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Select this option to enable a Proxy Server service in TRBOnet

Dispatch Console to access the Internet.

A proxy server can be used when a user's computer cannot be
connected directly to the Internet, but there is another computer

with Internet access in the network.

v" Click the Configure link to specify the alternative server settings.

Configure the proxy server X

Use an alternative server

Settings

Address:  [177.71.134.70
Port: 80 =
Authentication

Use authentication

Username: |User

Password:

Core

Advanced

e Inthe Options dialog box, click the Advanced tab.

Options X

Sound Map  CoverageMap Hardware Advanced Audio Alarm  Phone Calls

Q7% Advanced appication options
&

‘Configuration Scope

QO Per machine: all dispatchers share the same workspace

(®) Per user: a separate workspace for each Windows user account

PTT Options

[ Tone anc d PTT when using an external PTT device

[ Use Record Mode with external PTT device

Suggest recording a message hen channel is busy or radio s offine
Enable sticky PTT

Use 'Space’ key to press PTT Configure...

[[] Enable Single PTT Select mode

Dispatch Options

[ Mute other dispatchers

O Mute radio-to-radio calls

[] Mute other channels during incoming and outgoing calls

[ Mute incoming Tone and PTT cal

[ Play a sound when starting a Tone and PTT call

[ Automatically set channe! to Solo when transmitting audia

[ Automatically unmute channel when transmitting audio
View Options

[ customize automatic radio name pattem Confiqure..

Show extended
Show
Show

[ show incoming text messages in a pop-up windaw

ol

Configuration Scope

= Per machine

Choose this option to store settings in a common place for all
dispatchers of the Dispatch Console.

= Per user

Choose this option to store settings for each dispatcher separately if

they are using different Windows user accounts.
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PTT Options

= Tone and PTT when using external PTT device
Select this option to enable Alert Tone for all subscribers on a channel
when the dispatcher presses the PTT button on an external PTT device.

= Use Record Mode with external PTT device
Select this option to record all voice transmissions from external PTT
devices (Palm mics, Footswitches, and other devices).

= Suggest recording a message when channel is busy or radio is
offline
Select this option to record a message when a radio channel is busy or
radio is offline.

= Enable sticky PTT
Select this option to start and finish voice calls by a short press of the
PTT rather than holding the PTT down until the end of a voice call.

= Use 'Space' key to press PTT
Select this option to use a shortcut for the PTT. Click the Configure
link, and on the keyboard, press the key or combination of keys you
want to use as a shortcut for the PTT button.

= Enable Single PTT Select mode
Select this option so that only one PTT box can be selected at a time,
that is you can't have multiple selected PTT boxes.

Voice Options

= Mute other dispatchers
Select this option to mute all other dispatchers voice transmissions.

= Mute radio-to-radio calls
Select this option to mute all private calls on the channel.

= Mute other channels during incoming and outgoing calls
Select this option to mute other channels when the dispatcher
transmits audio or records a voice message.

= Mute incoming Tone and PTT call
Select this option to mute the tone when you receive a Tone and PTT
call.

= Play a sound when starting a Tone and PTT call
Select this option to play the tone when you start a Tone and PTT call.

= Automatically set channel to Solo when transmitting audio
Select this option to mute other channels when transmitting audio.

= Automatically unmute channel when transmitting audio
Select this option to automatically unmute a channel when
transmitting through this channel.
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View Options

= Customize automatic radio name pattern
Select this option and click the Configure link to set a custom alias for
a radio in the list of radios. Once the changes are made, selecting this
checkbox will cause a change to the radios in the Radio list pane
(upper left pane of the Main Interface screen).

Display Formats

Radio display name:

Example: My Radio

Display name of allocated radio:

‘%NAME % (SOVNER %)
Example: My Radic (John Smith

Display name of allocated radio
{user took two or mare radiog):

[ %ENAME®% (%OWNER %)

Defaults

Exemple: My Radic (John Smith

e Radio display name

heocom
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Click the ellipsis (...) button and in the Format dialog box pick the

fields to display for a radio.

Format

FoMAME % (%CHANNEL ¥a)

Add Field:

Radio Name

Radio Qwner's name
Radio [D

Active Channel

Example: My Radio (Control Station [ Channel)

COK

¢ Display name of allocated radio

Click the ellipsis (...) button and in the Format dialog box pick the

fields to display for an allocated (taken) radio.

Display name of allocated radio (user took two or more radios)
Click the ellipsis (...) button and in the Format dialog box pick the
fields to display for an allocated (taken) radio in case when a user

has more than one radio.

Show extended notes
Select this option to enable Extended Notes in the Dispatch Console.

e Click Defaults to set default settings for radio display.

The Extended Notes feature is intended to add predefined Extended
Notes templates, the same as for Extended Messages, for the selected
calls and events.

For example, a Taxi Dispatcher needs to check clients' call response
period for the company internal monitoring of the employees. They
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can add a predefined template and check the time period. All Extended
Notes are displayed in the Ext. Note column in the Recent

Calls/Events tab:
Recent Calls/Events
5] Playback (=l Save || Il Pause ¥ Clean 'Si Reload | [ Filter By Radio | = Grouping "/ Auto Filter (7 Default Settings | 7 Details ||[] Show Notes [l Add Note || Extended Not:
Date W Radio System Sender Redpient Message Ext. Note Note
& 7/7/2014 3:49:55 AV Radio 11 Al Geofencing Alarm [Dat...
S 7712014 3:40:56 AM Radio 11 Al Radio left allowed region
&} 7/7/20143:47:524M  Repeater £1 80t 1 Radio 105 Dispatcher Administrator Accept 1
% 7/7/20143:41:24AM  Repeater #1 5ot 1 RadioServer Radio 105 Telemetry status cann..
=} 7712014 3:40: 15 am Administrator Al test
7/7/20143:39:08AM  Repeater #1 Siot 1 Radio 105 Unknown group: 1010 Radio Radio 105' calls View
3 7/7/2014 3:32:55 AM Administrator Radio 105 Dispatcher ‘Administra...
3 7712014 3:18:43 AM 05 Al Onbuty 2
[0 772014 12:56:90 AM  Intercom Dispatcher 1 Al Intercom Cal: Dispatc...
[0 7412014 401:35 4 Intercom Dispatcher 1 Al Intercom Call: Dispatc...
S| recrd saofa: PIBB]E e e ,
Recent CallsEvents  RecentCalls Radio State  Active Tasks Active Routes  User Activity Map

Click the Extended Notes button (1) to fill the template;
Click the View button (2) to see the Extended Note.

= Show status in radio information tooltip
Select this option to show the radio status in the Radio information
tooltip (see section 6.5.1.3, Radio Information Tooltip).

= Show confirmation dialogs
Select this option to enable confirmation dialogs for dispatcher actions.
For example, when sending a configured Voice Message from the
Dispatch Console, the following confirmation dialog box will appear:

TRBOnet Enterprise 5.1 / Dispatch Console

o Start 'Voice Message'?

= Show incoming text messages in a pop-up window
Select this option so that incoming Text Messages will pop up over the
application window.

File View Map Tools Help
Voice Dispatch Radio Interface

X| quick commands [} ~

e ]
Message 1of 1 x N wezemie
" Cofore
‘g = Messages (X]
o @@ Pre-recorded X
» Tort message 210
1 18 nov-s 1253 a
ar
7] 0o notshow s meceage next tme showonmp [
Rt Locaten
) e Trmcker
[ Text Hessages
' Voiee Recording
(5] event viewer

= Close button minimizes application
Select this option so that clicking the Close button will minimize the
Dispatch Console rather than close it.
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Select this option so that when you click the Minimize button you will
see only the PTT Panel displayed at the top of the PC's screen.

= Show this number of recent calls/events

Enter the number of items to display in the Recent calls/Events pane.

= Measurement system

From the drop-down list, select Metric, US, or Nautical units.

= Coordinate system

From the drop-down list, select the coordinate system to be used.

Audio

6.3 Main Menu

¢ In the Options dialog box, click the Audio tab.

Options

Recorder

Player:

Sound Map  Coverage Map Hardware

Default audio devices:

Phene Calls

Filter.

Player:

Theme:

Selected channel

Recorder:

Indicator:

Unselected channel

Intercom

Private Calls

System sounds

Alarm

Telephony

LKKKK KK

Audio player

Reset Al audio devices to default

B
g
a [
e 3 <

Default audio devices
= Recorder

From the drop-down list, select the recording device the microphone is

connected to.
= Player

From the drop-down list, select the audio device to play incoming voice
messages and playback voice recordings in the Dispatch Console.

Note: If TRBOnet Dispatch Console is running on the same PC
with TRBOnet Server connected to control stations via a
programming cable and sound card, the playback and
recording devices cannot be the same for TRBOnet

Dispatch Console and TRBOnet Server.

In the list below, you can configure audio settings for specific channels by
expanding the corresponding items (Selected channel, Unselected

channel, Intercom, etc.)

The configurable audio settings are as follows: Recorder, Player, Speaker,

Volume level, External PTT, Indicator, and Theme.
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Alarm

¢ Inthe Options dialog box, click the Alarm tab.

Options

x

sound Map  CoverageMap Hardware Advanced Audio

Configure: display options for radios in alarm mode:

#larm Panel: [main window

Alarm - phone Calls

Lellel

Call Button: [none
Always show radio on map
[ oisplay camera in new window

[ Display radio in new window

Select map

Canc

= Alarm Panel

From the drop-down list, select where to show the alarm panel (in the
main window or in a new window), or select 'None' to hide it.
= Call Button

From the drop-down list, select the call destination when the PTT
button is pressed in the alarm panel (private call, group call, or all call).

# Radios in Alarm

235

Request Location
PTT Copy Coordinates
Find on GPS map

Find on Beacon map

GPS: 18 Jul 2018 17:01

Region: Region 1

Coffee 18 Jul 2018 17:01
125 x
Emergency Call

Request Location
PTT Copy Coordinates
Find on GPS map
Find on Beacon map
Beer

GPS:
Region:

18 Jul 2018 16:58
18 Jul 2018 16:57
Region 1

irimze

= Always show radio on map

Select this option so that radios in alarm mode will always be displayed

on the map regardless of the filters applied to the radio (see section
6.6.2.4, Filters).

Note: When this option is selected, you cannot disable the
display of radios in alarm mode.
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= Display camera in new window
Select this option so that when a radio is in alarm mode, a window will
open with the camera associated with the radio.
= Display radio in new window
Select this option to display a radio in alarm mode on the selected map
in a new, separate window.
e Map
This field displays the map name. Click the Select map link and
specify the map on which to display a radio in alarm mode.

125 - 0 x

& ol e (OO0 @ BT B srompescons » « g QuFind onMsp . | P Draving Panel | A Route-

[}
Apkai

Bloom

e au b0 spal0

Lattude: 53°5626.78" N; Longtude: 30°1646.14"E

Phone Calls
e In the Options dialog box, click the Phone Calls tab.
10 El:
b play
b Play
b Play
Concel

* Queue all incoming phone calls
Select this option so that when the phone line is busy, incoming calls
will be queued rather than rejected.
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= Show this number of recent phone calls
Enter the number of items to display in the list of recent calls. The list
of recent phone calls appears when you click the arrow on the right of
the dial string in the Contact Dialer box (see section 6.5.9.1, Phone Calls
from/to Dispatch Console).

Ringtone configuration
On the Incoming Call (Call Waiting) tab:

e Click a corresponding link in the Ringtone column, and from the
pull-down menu, select either Set Default, Set Custom, or Disable.
If you select Custom, in the dialog box that opens, browse for the
audio file on the local PC and click Open.

e Click a Play link in the Action column to play back the
corresponding ringtone.

On the Call on hold tab:

¢ Remind after
Enter the timeout, in seconds, that will be used for playing the
reminder tone when a call is on Hold.

¢ Ringtone
Specify the reminder tone to be played when a call is on Hold.
6.3.4.2 Exporting/Importing Options

A dispatcher can export custom Dispatch Console settings (Volume level, UI
view, shortcuts configuration, and other settings) as a .config file and save it to
the local PC or to a selected external device.

e Click Tools > Export Options and save the file to the specified location.
If you want to apply settings from a different TRBOnet Dispatch Console:
¢ Click Tools > Import Options and browse for the .config file with the
desired settings.
6.3.4.3 Exporting/Importing Objects

A dispatcher can export/import various types of objects, such as beacons, IP
cameras, map objects, maps regions, map routes, phone contacts, radio users,
and radios.

To export objects:
e Click Tools > Export Objects.
In the dialog box that opens, enter the following information:
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“ Object Export

Objects:

Radio ID
Al

235
444
125
3333
100

NINRINNE

Select Al

Radios [-

— Map Objects j
Radio | Map Regions

aflc  |Map Regions (cirdes)
-~ Map Routes
it Phone Contacts
Radio | Radio Users
Radio b

3333
Radio 100

Unselect Al

SipContact:UserExtension

il

4444

3333

Block incoming calls Block outgeing calls

Alc

False
False
False
False
False

il

False
False
False
False
False

Export

= Objects

From the drop-down list, select the type of objects you want to export.

= In the table below, select/deselect the desired records.

= Click Export, and in the Save As dialog box, locate the folder where
you want to save the file, type a filename, and click Save.

To import objects:

¢ Click Tools > Import Objects.

In the dialog box that opens, enter the following information:

= Objects

From the drop-down list, select the type of objects you want to import.

Passwords encrypted
Delete objects not present in file

Object Impert frem File *
Name: |Import Objects
General lpdate Column Mapping
Objects: |Radi0 Users j
File Path
|D:\,C5U\users.csv J

Cancel

= Inthe table below, in the right column, enter/change the column
names that would correspond to the database field names.

= Passwords encrypted

Select this option if the passwords are kept encrypted in the data being
imported.

= Click Import, and in the Open dialog box, locate the desired file and
click Open.

6.3.4.4 Setting Language

e On the Tools menu, click Set Language

6.3 Main Menu
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Select Language x

Language: En

acel

= From the drop-down list, select the desired language and click OK.
The changes will apply after you restart the Dispatch Console.

6.3.4.5 Changing Password
e On the Tools menu, click Change Password

Change Password X

{f@ Change Password

Old password: | ----- |

Mew password: | oooooo |

Repeat password: | oooooo |

Caeel

= In the Old password box, enter your current password.

= In the New password box, enter the new password.

= In the Repeat password box, enter the new password again.
= Click OK.

6.3.5 Help

e Help > Send Feedback
Click this menu item to send your feedback to Neocom Software, either
through E-mail, or online via the site.

e Help > Save System Logs
Click this menu item to save the logs as a .zip file. This .zip file can then be
sent to Neocom support.

e Help > About
Click this menu item to see the About dialog displaying information about
TRBOnNet Enterprise (applied license, version, build date, and other
relevant information).

6.4 Administration

This section describes how to configure the most important settings of
TRBOnet Enterprise.

e Click the Administration tab (1), and see the full system information in
the Server (2) pane:
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6.4.1

File View Map Tools Help
Administration

o
A License:
i [l Database
L Systems
i o System Bridge
&P Phone Calls
iLF Tacke

(1) voice Dispatch

% Location Tracking

@ Job Ticketing
Route Management
@nﬂnrmﬂmr

[] Text Messages

§ Voice Recording
C% Reports
Event Viewer

[sg, Administration -]

™
F@ Administration

Server

[rrivate cal (<]

Licensed to:

demo

Demo License
Server is available

CapadityPLUS
Capacity Plus (Departmentl)
Data (Data)
Serial ursber: 4B4TMG110

: 2607
CapacityPLUS: Private Call
Serial pumber: 484THG110
Version: 260.7
CapacitypLUs: Al Call
Serial pesmbers 494THG4110
fersion: 26.0.7
CapacityPLUS: Group #10
Serial pumber: 484THG110
fersion: 26.0.7
CapadityPLUS: Group #20
Serial pesmbers 494THG4110
Version: 26.0.7
CapacityPLUS: Group #30
Serial pumber: 484THG110
Version: 260.7

Phone Connect
Service is avaiiable

Internal PEX Server: 10,10,100,99:5060

— 1

3 1: Line free P2 intercom [1][«] (@] o I Al call
B croup 10 M[<] B M crou 20 ooE TR
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127001 &3 g | & Administrator | (8 Licensed to: demo Demo License

Database

| @ Active~

e Go to Administration (1), Database (2) to see the full overview of the

database:

File View Map Tools Help

Administration Database &[4
E
g i ~ W 5 e free e )@ W Eowetcher sow . @ER
IJ [ 1PsC 1: Slot £1 [)][+][@] N B tesc 1: ot 22 ][« [@] BN M crowp 11 [
i..gish Radio Systems
[ 2 Moo BEE) (T @) Ml ervatz cal BEE]
i v
5 Back Up Database | 'y Schedule Backup
{11 voice Dispatch
B u
= ion T i
E’ Server name: (local)\SQLEXPRESS
# b " Database name: TRBOnetl
Job Tk Backup date: 30-5ep-19 12:56:02PM
Database version Microsof ft SQL Server 2017 (RTM-GOR) (KB4505224) - 14.0.2027.2 (X64)
Route Management Jun 15 2018 00:26:13
Copyright (C) 2017 Microsoft Corporation
Express Edition (54-bit) on Windows 10 Pro 10.0 <X64> (Build 18352: )
[] Text Messages
Data size: 163.19 MB
i Voice Recording Audio size: 629,43 M8
R
Event Viewer
[75] Radio Allocation 1
2 e ]

[ Connected 23 Bh B B} Bh | § Administr

= ‘ A Licensed to: demo Demo License

| @ Active-

In the Database pane, the administrator can restore and back up the
database and audio recordings.

For more details on backups, see Appendix D: Backing up and Restoring
Database and Audio Recordings (page 394).

6.4.2

Systems

All radio systems registered in the Server are represented in the Systems pane.
In addition to radio systems, the following systems can also be present in the
Systems pane: Intercom, Phone Connect, PoC, and Public Announcement
systems.

e Go to Administration (1), Systems (2) to see the system parameters:
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File Wiew Map Tools Help

Administration &)
|| 5 properties
System type System 1D Caption
o Intercom Intercon
of Fhone Telephany
o/ Capacity Plus 1
v ||of TREONEL PoC System Mobie 1 Mobile 1
v Anrourncement e
Q] RFID Tracker
[ rest Messages
@ voice Recording
(2 Reparts
Event Viewer
*2] Radio Allocation / 1
el icton +1
4] «0| « | Record 30 5 v ||| ¢ »
[ Connected 83 € B B | & Adwinistrator | [ Licensed to: demo (Wal) Qerno License) | @ active~

The administrator is able to see the following system parameters in the table:
e System Type - the type of the system.

e System ID - a unique System Identifier configured in TRBOnet Server
configuration for repeater or control stations in the system.

e Caption - the caption of the system.

6.4.2.1 System Properties
To see the radio system properties, do the following:

e Select a radio system in the list and click the Properties button (1);
or,
double-click the radio system in the list;
or,
click the corresponding element at the bottom of the Dispatch Console
window, and choose Properties (2).

File View Map Tools Help

Administration e |
Qo " | W% & ine free ][] I B ntercom IEE (L Plislel

M croup 10 [2][<][2] B Groun 20 [2][<][2] B [ Groun 30 [][«][2]

. dging [JPrivate cal [][<][e@]
@, Te\iuhwnv v |l= Propeties

System System ID Caption

J\=); Voice Dispatch -/ Tntercon Intercom
of Phone Telephony
@ Location Tracking «ff Capacity Plus Department1 CapacityPLUS
& sob Ticketing
Route Management
1
@ RFID Tracker
[] Text Messages
ﬁ Voice Recording
ey
Event Viewer
2

fpe——

«t| < |Record 10F3 b || mi] <] »
127001 £3[Eh| @ Administrator A Licensed to: demo Demo License | © Active~

Reset

-
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The administrator is able to see Active and Inactive registered systems. In case
you have more than 10 registered systems, systems are grouped and can be
seen in the drop-down list.

Common information for all system elements is listed below:

Description tab

On the Description tab, you can see the general info:

e System Type
The system type for a repeater/control station (in Digital or Analogue

Channels tab

Repeater #1: Slot #1 X

Description  Channels  Transmits

System Type: |IP Site Connect

System ID: |Deparh11&ntl

Caption: |Repeater #1: Slot #1

Systems (page 4).
System ID

The Unique System Identifier configured in TRBOnet Server for a repeater
or control stations in the system.

For more details on the systems, see section 3.2, MOTOTRBO Radio

Enter the system name.

On the Channels tab, you see the list of channels:

6.4 Administration

Repeater #1: Slot #1 X

Description Channels  Transmits

' Properties Control | =% Reset

‘ Name Woice Data
- Repeater #1: Slot #1 RX, TX RX, TX
Channel for private and phone calls:
El
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¢ Click the Properties button to see the channel additional data:

Repeater #1: Slot #1 X

Description  Talk groups  Volume

D: |8:cc‘3f1853&64&14ﬂ:85}58 1e19debceb

MName: |Reneater #1: Slot #1

Type: [MoToTREC Repeater

Mode: [ site Connect

Connected

Serial Number: |484TMG4110

Firmware version: ‘2‘6.0.7

Cancel
= ID
Default registration number (manufacturer’s number);
* Name
System element’s name in the system;
- Type
System type for a repeater/control station (in Digital or Analogue
mode).
= Mode

System type for a repeater/connection mode for a control station.

For details on the control station modes, see section 5.10.6.1, Control
Station Connection Modes (page 54).

= Connected

e Serial number
Default system element’s serial number (manufacturer’s number).

e Firmware Version
Current system element’s firmware version.

¢ Click the Reset button to test the connection to the system element.
Note: For a repeater, clicking the Reset button reconnects the
repeater.

For a control station, clicking the Reset button reloads
the radio.

Talk groups tab (for repeaters only)
= On the Talk groups tab, you can see selected Talk group info:
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Repeater #1: Slot #1

Description  Talk groups  valume

Specify available talk groups

v | all call

¥ |Firemen

W |Palice:

|

/_D Repeater #1: Slot #2 a @

ey

Sender:

L 1

RX JTX

-

Volume tab (for repeaters only)

Note: Close TRBOnet Server before applying the system
element settings.

Repeater #1: Slot #1

Description  Talk groups  Volume

x

+ +
RX ™
Reset Reset
[ configure system volume
|

o

heocom
SOftware

= Specify available Talk groups for the system element in the list of
created Talk groups.

Selected Talk groups are available on the Radio tab in the system
element box in the drop-down list:

= On the Volume tab, you can see Volume settings for the repeater:
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e Specify the RX and TX volume levels for the Repeater using a
volume control slider.

e C(Click the Reset link to set default volume level for RX or TX.

e Configure system volume
Select this option to save default volume settings for Voice
transmissions from the selected Repeater.

Extras tab

e On the Extras tab, you can see the information about audio and data
transmissions:

Repeater #1: Slot #1 *
Description  Channels  Extras

Enahle Woice Recording

Use DTMF commands ko muke and unmute incoming audia
traffic from the channel in consoles

Mute: 123

Unmute: 321

= Enable Voice Recording
Select this option to enable Voice Recording for the selected repeater.

= Use DTMF commands to mute and unmute incoming audio traffic
from the channel in consoles
Select this option to use certain DTMF commands that can be sent to
the channel so that the channel will be muted/unmuted in active
consoles.

e Mute
Enter the DTMF sequence that will be sent to the channel to mute
the channel in active consoles.

e Unmute
Enter the DTMF sequence that will be to the channel to unmute the
channel in active consoles.

6.4.2.2 Intercom Properties

e Select Intercom in the list and click the Properties button;
or,
double-click Intercom in the list of radio systems.
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Channels tab

On the Channels tab, you see the list of Intercom channels.
These are the dispatcher groups you added in TRBOnet Dispatch Console
(see section 6.4.24, Dispatcher Groups).

Extras tab

Intercom x
Descripion  Channels  Trunked Channels  Extras
Enable Voice Recording
Call Hangtime (ms):
Group Call: 3000 El:
Private Call: 4000 L
TX Timeout: &0 3: seconds
Always transmit when the PTT is pressed

Enable Voice Recording
Select this option to record all audio transmissions over the Intercom
channel.

Call Hangtime (ms):

6.4 Administration

Group Call

This value sets the duration of reserving the channel after the end of a
group call transmission. During this time, only members of the
dispatcher group that the channel is reserved for can transmit.

Private Call

This value sets the duration during which the private dispatcher call
setup is kept after a dispatcher releases the PTT button. This is to avoid
setting up the call again each time a dispatcher presses the PTT button
to transmit. During this time, other dispatchers can still transmit since
the channel is essentially idle.

TX Timeout

Enter the time, in seconds, to be used as a voice session limit. When
the dispatcher starts a voice session over the Intercom channel,
transmission will be interrupted after this TX Timeout expires.

Always transmit when the PTT is pressed ("Impolite" channel
access)

Select this option so that when the PTT button is pressed, the
dispatcher will start transmitting regardless of whether the channel is
free or not (that is any transmission in progress will be interrupted).
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6.4.3 System Bridge

TRBOnNet Dispatch Console provides the System Bridge function that allows

configuring the network for redirecting radio calls.
The administrator can create the following two type

s of system bridges:

1. System Bridge for Radio Channels - allows connecting all types of
Radios (analogue and digital radios, supports IP Site Connect, Capacity
Plus, Linked Capacity Plus and Connect Plus modes). See section 6.4.3.1,

Radio Bridge.
System Bridge for Repeaters (Binary Patch)

- allows connecting only

the repeater slots between IP Site Connect systems without
encoding/decoding voice and data. See section 6.4.3.2, Binary Patch.

To add a system bridge:
e Go to Administration (1), System Bridge (2).

5 TREOnet Enterprise 5.3 / Dispatch Console

File View Map Tools Help
Zp 1: Line free
[erowp 10
[Jsiot 1
[eroup 11

4@l
DEE
2

[«[e]
]« =]

54 Addf- =) edit | [k Delete

[Jintercom
[aise

[Jroup 20
[eroup 22

[+
EE
[+

[«[e2]

[Jmaintenace

[]EmerGeNCY GROUP
[siot2
[JGroup 1

AEE
[@EE] 2]
[EE
2] <[]
@]« ]2

[Jsales 2

[ Reguiar GEROUP
[Jancal
[private cal

[7]E3 (2]
BEE
o] <[]

[«[2]

e

Binary Patch (for IPSC Systems only)
Iv' Radio Bridge Private calls
vl Radio Bridge Radio Bridge

Route Management \ 3

- 2] Radio Allocation 1
L~

RIRIK]

Record 2of 3 » | m || |

& Connected g3 B Bl B B | & Administiator | (2B Licensed to: demo (Walt) Demo License

>
| k2| @ active-

¢ Click the Add button, and from the drop-down
Bridge type (3).

6.4.3.1 Radio Bridge

menu, select the System

Radic Bridge

Name: [Radio ridge

Bridge Mode: IChannE\s redirect calls to each other

PTT Button:

[Always Enabled

Channels | Parameters | Initialization

Channels to redirect calls

Mode
Always

Always \

4

System
IPSC 1: Slot #1 Cleaners
Pl

2 3

—

Cancel

e On the Channels tab, specify the following bridge parameters:
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= Name
Specify a name for the Radio Bridge to display in the Radio Interface
pane.

= Bridge Mode
Select the mode from the drop-down list. For more details on System
Bridge types, see Radio Bridge Types (page 158).

= PTT Button
From the drop-down list, select how to display the PTT button in the
System Bridge box. There are 3 options available:

e Enabled when Bridge is activated
e Always Enabled
e Invisible

= On the Channels tab, click the Add button (1) to add a channel to the
list.

= In the System column, select a radio channel from the drop-down list
(2).

= In the Group column, select available group for the radio channel (3).

= In the Mode column, select a mode for the radio channel (4).

e Always
Enables the System Bridge always, regardless of the radio status
(online/offline).

e By Radio
Enables the System Bridge on a selected channel when there are
online radios capable to receive voice calls from the selected group.

e On the Parameters tab, specify call types for the System Bridge:

Radio Bridge X

Name: [Radio Bridge
Wiork Mode: [channes redirect the cals to each ather -
PTT Button: | Alwvays Enabled E|
Channels | Parameters | Initialization

Specify call types for System Bridge:

¥ voice Call ¥ Text Message

™ checkRadio I Telemetry

I~ Enable/Disable Radio ¥ Location (GPS)

I™ Call Alert I User Data

¥ Emergency Alert

Cancel

= Select call types to use in System Bridge mode.
= Click OK to add a System Bridge for the radio channels.
e On the Initialization tab, specify how the bridge will be initialized:
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Radio Bridge X
Name: [Radio Bridge

Vork Mode: [channels redirect the cals to each other B
PTT Button: INways Enabled B

Channels | Parameters | Initialization

Specify call sources for System Bridge:
[¥ call from dispatcher

Dispatcher:  [(Any) B
¥ Call from other bridge

Bridge: [cany) B
[V Call from radio

Rado: () -

= Call from dispatcher
Select this option and from the Dispatcher drop-down list, select the
desired dispatcher.

= Call from other bridge
Select this option and from the Bridge drop-down list, select the
desired bridge.

= Call from radio
Select this option and from the Radio drop-down list, select the desired
radio(s).

The System Bridge boxes are displayed on the Patch panel of the Radio
Interface pane:

File View Map Tools Help

Voice Dispatch a a [AED
i= [ g B |7 8 K || Radio tnterface| Teephony | Recent Cals/events | Rados
e -
() Online, No GPS: Confiaure
e O Offline (18} ~
() Radio 235 [J1ntercom [[J pispatcher Group 1 [« -
E Free channel E Free channel
""""" Alcal Dispatcher Group 1
paes [E capplus - cleaners
[J1psc 1:5lot #1 (=@ [J1psc 1: kot #2 B E é‘:ﬁ;’:sm "
% Location Tracking " | Cleaners | Firemen 1
=3 | Adminstrator =3 | Administrator Al Cal
o i . Y i cal
B sobTicketng || L EE Ceener = [ Firemen - Cleaners
") = TPSC 1: Slot #2
W Dlsroup 11 @@ | Oeow2 EE Qrescx
Free channel Free channel — () IPSC 1: Slot #1
[ ] Text © Cleaners
Recent Cal
i Voice Recording B Playback 5m~|@ Print | 11 Pause ¥ Clear - '&i Reload | [ Filter By Radio | = Grouping "/ Auto Filter & Default Settings
Date |Raio System | Sender | Redpient | Details Hote |
Ca Reports (7] 13-Mar-20 4:08:55PM  [PSC 1: Siot #2  Administrator er ‘Administrator’ calls group ... Units: Administrator -
7] 13-Mar- 03:. IPSC 1: Slot #1
F" ‘Event Viewer 7] 13-Mar- 208 IPSC 1: Slot #2.
-20 4:08:38 PM IPSC 1: Slot #1 " s
(/) Radio Allscation 13Mar-20 405:24PM PSC 1 Slot £2  Administrator Firemen
12Mar-90 441072 DM DS 10 Ent 21 Ardminictratnr laznare ier e ' inictratne' calle areon Inites inietr 3ter hd
o Rrd ot 95 v Drlw 4 »
E i unes Recent Call/Events | Recent Calls | Requests ToTalk | Radio State | Active Tasks | || User Actiity | Map | Cameras
[ Connected 3 € B € B | @ Administrotor | [ Licensed to: deme (Walt) Demo License | @ active~

Radio Bridge Types

1.

Channels redirect calls to each other

This is the most common type of System Bridge when data exchanges
between the channels set in the System Bridge settings. Thus, there is a
common channel for all the radios of the specified control stations:

To create this type of System Bridge, add a System Bridge and set the
Work Mode as Channels redirect calls to each other.
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«———————Voice Call via System Bridging—————— MOTOTRBO IP

D

To create this type of System Bridge, add a System Bridge and set the
Work Mode as Channel redirects calls to multiple channels.

3. Multiple channels redirect calls to one channel

.

To create this type of System Bridge, add a System Bridge and set the
Work Mode as Multiple channels redirect calls to one channel.

4. Redirect private calls

Select this mode so that private calls can be redirected between radio
systems.

5. Redirect private calls to group calls

Select this mode so that private calls will be redirected to group calls
within one radio system or between radio systems.

6.4 Administration
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6.4.3.2 Binary Patch

Name
Specify a name for the Binary Patch to display in the Radio Interface pane.

Rules

Specify the rules for redirecting calls between IPSC systems. Click the Add
link below to add a rule.

Slot

Binary Cross Patch (IPSC Systems only) X
Name: [Binary paten
Rules
Rule 1of 2 “
Siot: Slot 1 M voice Data
[ Al calls [l private Calls W Group Cals
Groups: (All Groups)
Repeaters: (Al Repeaters)
Rule 2of 2 -~
Siot: Slot2 [ voice [lpaa
1 all calls M private Cals [ Group Calls
Groups: (All Groups)
Repeaters: (Al Repeaters)

g Add X Delete

From the drop-down list, select the slot (Slot 1 or Slot 2) of the IPSC
systems being connected.

Select the type of data: Voice and/or Data.

Select the call types: All Calls, Private Calls, and/or Group Calls.

Groups

In the drop-down list, select the group(s).

Repeaters

In the drop-down list, select the IPSC systems to be connected via the

selected slot.

The Binary Patch boxes are displayed on the Patch panel of the Radio Interface

pane:

File View Map Tools Help

Voice Dispatch

B EG RS

e & Online Dispatche.
& administrator

() Online, Indoor (0
() Online, GPS Fixe.

() Online, No GPS (0)
© () Offine (2)

Jl) voice Dispatch

Radio Interface

|| Radio Interface | Telephony | Recent Calls/Events

ﬂ Job Ticketing
l Route Management
Hﬂn'l'ﬂh

Text Messages

[J Repeater #1: slot #2

h Free channel
PTT
= All Call

[ @ Cancan

Free channel

Al cal

Drag and Drop PTT Box here to
aeate new group

Patch on Repeaters
Binary Patch

3 Radio Bridge

\\\\\\
cumml St
Any Groups

Recent Cal

jmmmﬁu

) playback |l Save- () Print | 1l Pause < Clear - &i Reload | ‘[ Filter By Radio | = Grouping "7 Auto Filter » Defautt Settings || ' Details |

(p) meports

Date | Radio System
17-0ct-2016 14:21:07
17-0ct-2016 14:21:06
17-0ct-2016 14:21:02

| Message | Detais
AllCall from 125 (00:01)  Members: 125

| sender | Recpient
Repeater #1: Slot #1 125 All
Control Station #1 Dispatcher Al

Control Station #1  Dispatcher Al

| Note | Ext. ote |

All Call from dispatcher "
All Call from dispatcher "

mnmm

17-0ct-2016 14:20:57  Control Station #1  Dispatcher Al
17-0ct-2016 14:20:51  Repeater #1:Slot 1 125 Al

Al Call from dispatcher *..
All Call from '125' (00:01)  Members: 125
PIENE—

e

ol

e P e I
T e s FOTSIAT,

Recent Cali/Events | Recent Calls | Radio State || Active Tasks || Acti

|| User actiity | Mop | Cameras

127001 53 B By @| < Aﬂm\mmatnr‘ =8 Licensed to: demo Demo License

| @ nctive~
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Note: System Bridges can also be created by drag and drop of
the PTT boxes in the Radio Interface pane. Itis a
temporary System Bridge, which will be deleted after
reconnecting to TRBOnet Server or exiting TRBOnet
Dispatch Console.

6.4.4 Phone Calls
This section describes how to configure the Phone Connect system in TRBOnet
Dispatch Console.
e Go to Administration (1), Phone Calls (2).
e Inthe Phone Calls pane, click the Configuration tab (3).

File View Map Tools Help

Administration Phone Calls &
onfiguration | Extansons

Checkif the radio is avallable before making a call No

cal natifications Yes
Play 2 tone when PTT s pressed or released: Yes

fie (TRBOnet Mobie) Confanre

fie (TREO.50S) #4\\ 4

fle (TRBOnet Communica tor) Inbound Call Configuration

Inbound Call Control

Cal to Dispatch Center: Redrect to onne dispatchers
Cal to unregistered number: Reject

Donot
Inter:

v Do ot Yes
of dgis: Uninited
Accept code: #
Number
|14\, Location Tracking 0
Numbers
& 30b Ticketing Configure [+
= 5
Ej Route Management Conference Configuration
60 minutes
[ i o
No
' Voice Recording o
s
Event Viewar Voice Message Loop Settings
Play No
[75) Radio Allocation Py voice message this many times: 2
1 set ves
e [ el 7 5
[ Connected &5 B B B B B | 8 Administrator | (28 Licensed to: demo (Walt) (Demo License) @ Active~

6.4.4.1 Radio Call Configuration

e Click the Configure button (4) to set radio call configuration parameters:
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Radic Call Configuration

Access code:

Deaccess code:

|

Callback Reguest Options

[ allow radios to make outgoing calls
¥ Send a OTMF command to request a callback
[V Send 2 text message to request a callback

Use this prefix in text messages: sip:

Immediately -

Wait for PTT -
10 El: seconds

¥ Check if the radio is available before making a call

Start transmission:
Calls to Radios and PoC Devices
Start transmission:

Max ring time:

[ Call notifications
[¥ Play a tone when PTT is pressed or released

-—

Tone volume level:

oK Cancel

Access Code

Set the value to that configured for the radios as Access Code in
MOTOTRBO CPS (see Appendix E: SIP Setup for Motorola Phone System,
section Programming Radios).

Deaccess Code

Set the value to that configured for the radios as Deaccess Code in
MOTOTRBO CPS (see Appendix E: SIP Setup for Motorola Phone System,
section Programming Radios).

Callback Request Options

Allow radio users to make outgoing calls
Select this option to enable outgoing phone calls from the radios.

Send a DTMF command to request a callback
Select this option to allow radio users to dial the phone number as a
sequence of DTMF tones sent over the radio channel.

Send a text message to request a callback
Select this option to allow radio users to initiate phone calls via sending
TMS messages with a specified prefix to the dispatcher.

= Use this prefix in text messages
Enter the specific prefix for a text message.

Start transmission
Select the mode for starting transmission on the radio that initiates a call.

= Wait for answer

Transmission will be started as soon as the called party answers the
call.

= Immediately
Transmission will be started immediately that is without waiting for the
called party to answer the call.
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Calls to Radios and PoC Devices

Start transmission
Select the option how to start transmission on the radio receiving a
phone call.

= Immediately
Select to start the call immediately.

= Wait for PTT
Select to play a ringtone until the radio user presses the PTT.

Max ring time
Specify a timeout that defines how long to attempt to connect to the
radio.

Check if the radio is available before making a call

If this option is selected, a Radio Check command will be executed before
placing a call. Select this option if the Use NAI Data (MNIS and DDMS)
option is not selected in the Repeater pane (see section 5.10.2, Adding a
MOTOTRBO Repeater).

Call notifications
Select this option to send a text message to the radio when the channel is
busy and a phone call cannot be established.

Play a tone phone when PTT is pressed or released

Select this option so that a tone will be played during the established
phone call when PTT is pressed or released on the remote radio that
doesn't support a Full-Duplex mode.

6.4.4.2 Inbound Call Configuration

6.4 Administration

Click the Configure button (5) to set inbound call configuration
parameters:

Inbound Call Configuration X

Inbound Call Control

Call ko Dispakch Center: fForward ko TR j

Call to unregistered number : |Re]act j
I Do not establish call until called party responds

Interactive Yoice Response (IYR) Options

[¥ Do nok wait For Accept code iF one of the Fixed numbers below is disled

Mazimum number of digits: 3 El:
Accept code: # =

Mumber Destination

1] Call dispatcher {any available)
1<Nurber > Call radio with Radio ID = <kumber >
235 Call radio Unknown’

56 Call dispatcher {any available)

__%,m _—3 Edit _—3( Delete

0K Cancel
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Inbound Call Control

e Call to Dispatch Center
Select the mode for handling incoming calls made to the Dispatch Center.
= Reject
All incoming phone calls will be declined.
= Forward to IVR

When an incoming call arrives, the phone user will hear Voice Menu
commands.

= Redirect to online dispatchers
All incoming voice calls will be redirected to all dispatchers of the
Dispatch center and any available dispatcher will answer the phone
call.

= Use as a regular phone number
A call to the Dispatch Center's number will be processed as a call to a
regular phone number, and will depend on the selection made in the
parameter below.

e Call to unregistered number
Select the mode for handling incoming calls made to unregistered
numbers.
* Reject
Select this option to decline all phone calls to unregistered subscribers.
= Use this number as Radio ID

Select this option so that the system will use unregistered numbers as
a Radio ID and start a Private Call.

= Use this number as Internal Phone Number
Select this option to allow the system to read unregistered numbers
according to Voice Menu rules.

= Forward call to PABX
Select this option to forward all calls to unregistered numbers to the
External PBX.

Interactive Voice Response (IVR) Options

¢ Do not wait for Accept code if one of the fixed numbers below is
dialed
Select this option to search for the fixed number in the Extensions table
automatically.
When this option is disabled, the subscriber must dial the number
according to the following example: (phone number)#. The character #
(or *, if selected as the Accept code) is used to search for the phone
number in the table.

¢ Maximum number of digits
Specify the maximum number of characters allowed in a phone number.
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e Accept Code

Specify the character that will be used to finish dialing the extension
number.

All available numbers are listed in the table below.
e Click the Add link to add a number to the table.
To add a static (fixed) number

= Choose Static number.

Extension numl ber x

{* Static number

" Dynamic number

Number: 123458

call Type: [ca Group

Channel: [tPsc 1: Slat 21

Group: |Cleaners

Priority: [wormal

= Number
Enter a phone number to add to the table (contact list).

= Call Type
Select the call type from the drop-down list.

o Call Dispatcher
Select this type to make a phone call to the dispatcher.
e Call Radio
Select this type to make a phone call to the selected radio.
e Call Group
Select this type to make a phone call to the selected group.
= Channel
Select the channel to make a group phone call through (available for
group calls only).
= Dispatcher/Radio/Group
Select the dispatcher, radio, or group depending on what you have
selected in the Call Type box.
= Priority
Select the priority with which the call will be made (available for radio
and group calls only).

To add a dynamic number

= Choose Dynamic number.
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Extension number X

" Static number

¥ Dynamic number

Prefix: [1231

calType:  [call Radio

|Detectad by Radio ID

H
[futo Detect =l
El
El

Priority: |Norma|

= Prefix
Specify a prefix to type in on the keyboard.

= Call Type
Select the call type from the drop-down list.

o Call Radio
Select this type to make a phone call to a radio.

e Call Group
Select this type to make a phone call to a group.

e Call Phone
Select this type to make a phone call to a phone number.

= Channel
Select the channel to make a group phone call through (available for
group calls only).

= Priority
Select the priority with which the call will be made (available for radio
and group calls only).

6.4.4.3 Conference Configuration
e Click the Configure button (6) to set conference parameters:

Conference Configuration =
Max Call Duration: 50 EI: minutes
I Automatic Voice Detection
[ Automatic Gain Control Disabled
[ Automatic Moise Reduction
Cancel

= Max Call Duration
Enter the maximum time allowed for the conference, in minutes.
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= Automatic Voice Detection
Select this option to enable automatic voice detection during a
conference call.

= Automatic Gain Control
Select this option to enable automatic gain control during a conference
call. In the list on the right, select the desired gain level, in dB.

= Automatic Noise Reduction
Select this option to enable automatic noise reduction during a
conference call.

6.4.4.4 Voice Message Loop Settings

e Click the Configure button (7) to configure Voice Message Loop Settings:

Note: These settings apply if the Voice Message task is
enabled or the Voice Message or Text to Speech actions
are selected in an Alarm Management rule.

Voice Message Loop Settings X

[V Play intro message

Play voice message this many times: B 3:

[V Set delay between voice messages

OK Cancel

= Play intro message
Select this option to play an introduction message before playing the
voice message itself.

= Play voice message this many times
Specify how many times to play the voice message.

= Set delay between voice messages
Select this option to set a delay between repeated voice messages.

6.4.4.5 Adding Extensions
e Go to Administration (1), Phone Calls (2).
e Inthe Phone Calls pane, click the Extensions tab (3), and then Add (4).
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Fil: View Map Tools Help

Administration Phone Calls 4)
3 Server P Corfiguratior isions rection
A License B.add 5 Edit I Auto Filter @ Default Settings
(3 Database Type Last Name Display Name: | Logical Groups
il Systems 4 / & Dispoteh Cent Tnternal PBX
i Sysem Bridge K G ST Ph 2408 o Johi Bingh: Jobn B,
5 Phone Cals one: iohn john ingham john B,
@ Tasks X &3 SIP Phone 2409 2409 walt
1] Custom Fields X & SIP Phone Phone User X Eugene
54 Madbus TCP Connections 2 X & SIP Phone Prune
-8 Virtual Modbs Devices General | Logical Groups | Custom Fields
5 1p Cameras
1| Public Arnouncements 3 User’s Extension: |2408]
[, Event/alarm Management
Y Telemetry User Name: __]uhrv
L=, v
< D User Password; | seemee
: [enssn
U, voice Dispateh Password {repeat):
s Last st
Lj Route Management
[] Tent Messages
oK. Cancel
ﬁ Voice Recording
Qa Reports
Event Viewer
[7] Radio Allocation 1
[é Administration ]
| «e| «|Record 105 oo < >
@ connected &3 B B B | & Administrator | [ Licensed to: demo ¢ialt) (Demo License, ) @ Active -

In the Phone User dialog box, specify the following parameters:
= User’s Extension
Enter the extension number that will be used by the phone user.
= User Name
Enter the user name that will be used by the phone user.
= User Password
Enter the password for the phone user to be authenticated by the
phone system.

= Password (repeat)
Enter the password again.

= Fist Name/Last Name/Display Name
Enter the first, last and display names of the phone user.

e [n addition, on the Logical Groups tab, specify logical groups for the
phone user. For more information about logical groups, see section
6.4.29, Logical Groups.

e On the Custom Fields tab, specify the desired values for the custom
fields. For more information about custom fields, see section 6.4.6
Custom Fields).

6.4.4.6 Call Redirection

If a dispatcher doesn’t take a phone call within the set period or they have
changed their status to unavailable, the call is automatically forwarded to a
specified dispatcher, radio, radio group, or phone account. This can be useful
during night shifts when no dispatcher is available.

¢ Click Administration (1), Phone Calls (2), Call Redirection (3), Add (4).
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6.4 Administration

Fil: View Map Tools Help

Administration Phone Calls )
[ server " Configuration | Extensions” Call Redirection [ Phone Contacts | Dial Plans
({8 License Ehadd Edit Delete | = Groupt 7 Buto Filker &> Default Settings
3 patab: cits e Redrect to
-l Systems
L33 System Bridge
2 Phone Call Redirect Call X
4 call to:
Destination: [S o1 |
~ Timeout: El =] seconds
< >
Redirect to:
i .
(i voice Dispatch T [ rado orowp 5|
System: CP1 hd
[, tocation Tvrking : | E
Destinaton: [ |
@ Reblicketing Priority: [normal -
L:ﬂ Route Management
[] Text Messages
ﬁ Yoice Recording
@ Reports
Event Viewer
0K Cancel
“5] Radio Allocation 1
L% Administration /
e «| <|record0af 0 » ] « »
[ connected &3 B B B | | Administrator | [ Licensed to: demo (Walth (Demo License) @ Active -

In the Redirect Call dialog box, specify the following parameters:

Call to

= Destination
From the drop-down list, select the dispatcher or dispatcher group.

= Timeout
Specify the time period, in seconds, defining how long to wait until the
dispatcher answers a call.

Redirect to

- Type
From the drop-down list, select one of the following:
e Decline
The calls will be declined.

o Dispatcher
The calls will be redirected to a specified dispatcher or dispatcher
group.

e Radio unit
The calls will be redirected to a specified radio.

e Radio Group
The calls will be redirected to a specified radio group.

e Phone account
The calls will be redirected to a phone account from the phone
book.

= System
If a radio group is selected as the redirection destination, select the
radio system over which to make a call to the specified radio group.
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Destination

From the drop-down list, select a particular dispatcher/dispatcher
group, radio, radio group, or phone account, depending on what you
have selected in the Type field.

Priority

If a radio or radio group is selected as the redirection destination,
select the priority with which the call will be made over the radio
system.

6.4.4.7 Phone Contacts

In addition to SIP extensions, the phone contacts can also be used in your
Phone Connect system.

e Go to Administration (1), Phone Calls (2).

e Inthe Phone Calls pane, click the Phone Contacts tab (3), and then Add
(4).

File View Map Tools Help

Administration Phone Calls 8]
i

[ server ~ c tion_| Extensions | Cal Redrection,” Phone Contacts | Dial P
7 Auto Fil

ns o Dial Plans
= Add =) Ed Del %
ShAdd =) Edit | X Delete fter "8k Defautt Settings

Ledtdame Display Name Logical Groups

1 Datzbase User Extension
ik Systems 55496 walt

= Grouping "/
First Name

i System Bridge Phone Contact X
5547 Eugene

éj ::::: Cals 2 \
< B 4 3

User's Extension:

| R
i voice Dispatch User Name:

% Location Tracking First Name:

Last Name: wil

@ b Dicketing Display Name:

Ej Route Management

[] Text Messages

'& Voice Recording

CB Reports

Event Viewer

(2] Radio Allocation

/'1

4[| <| Record 10f2_¥|wmi| ¢ 3
[ Connected &3 B B BY | ¥ Administrator | [ Licensed to: demo (Walt) (Demo License) @ Active -

e

L% Administration

In the Phone Contact dialog box, specify the following parameters:

User’s Extension
Enter the extension number for the phone contact.

User Name
Enter the user name for the phone contact.

Fist Name/Last Name/Display Name
Enter the first, last and display names of the phone contact.

In addition, on the Logical Groups tab, specify logical groups for the
phone contact. For more information about logical groups, see section
6.4.29, Logical Groups.

On the Custom Fields tab, specify the desired values for the custom
fields. For more information about custom fields, see section 6.4.6
Custom Fields).
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In order to restrict incoming and outgoing calls as well as set priority for calls,
dial plans can be used in your Phone Connect system.

e Go to Administration (1), Phone Calls (2).
e Inthe Phone Calls pane, click the Dial Plans tab (3), and then Add (4).

File View Map Tools Help

L Tasks v
L & T > 4

| —1

[é Administration
| 4] 4| Record 1

General | Patterns | Inheritance
Mame: Droite

Description: Restrict dialing for Bob's group

[ Apply te Incoming calls (Caller number)
[ Apply to Incomin g cal

¥ Apply to Outgoing calls (Destination number)

[ Connected &3 B B B | | Administrator | 28 Licens

In the Dial Plan dialog box,

= Name

@ Active~

specify the following parameters:

Enter a name for the dial plan.

= Description

Enter a description for the dial plan.

= Apply to Incoming Calls (Caller number)
Select this checkbox to apply the dial plan to incoming calls from the
numbers specified in the patterns.

= Apply to Incoming Calls (Destination number)
Select this checkbox to apply the dial plan to incoming calls to the
numbers specified in the patterns.

= Apply to Outgoing Calls (Destination number)
Select this checkbox to apply the dial plan to outgoing calls to the
numbers specified in the patterns.

Click the Patterns tab.
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Dial Plan

General | Patterns | Inheritance

You can use wildcard characters in pattern:
* - any number of characters
? - one character

XNH-YyY -range of numbers from ¢ to yyy
If pattern starts with ** the following number will be exduded

311777

Call Priority: Normal

= Specify the pattern that will be used to match the numbers in the dial
string or the incoming call numbers.

= Call Priority

From the drop-down list, specify the priority for the calls
corresponding to the specified patterns.

e C(Click the Inheritance tab.

Dial Plan

General | Patterns | Inheritance

Call Priority Dial Plan

| Inherit ~ Fedora

Inherit
Emergency
High
Narmal
Low

On this tab, you can select the profiles to include in the dial plan you are
adding/editing.

= Call Priority
From the drop-down list, select the priority for the inherited dial plan.

6.4.5 Tasks

This section describes how to configure the tasks that can be performed in
TRBOnet Dispatch Console.

e Go to Administration (1), Tasks (2), and see the list of the tasks in the
right pane.
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File View Map Tools Help

:
[ server A
4 Licer
(3 Datab:
ik Systems
i System Bridge

|1

| 4| «|Record30f7 » | ||« »

[ Connected &3 B B B B B | ¥ Administrator | [ Licensed to: demo Deme License @ Active~

e To create a task, click Add (3), and from the drop-down list, select the
appropriate task.

Note: After you have created a task you need to enable it. Just select
the checkbox (4) beside the task you want to enable.

6.4.5.1 Dispatcher Presence Control

When enabled, this feature checks the presence of dispatchers and sends
notifications to interested parties if the specified dispatchers are not present in
the system.

e Inthe Tasks pane, double-click Dispatcher Presence Control.

e Inthe Dispatcher Presence Control dialog box, specify the following
options:

Dispatcher Presence Control x

Presence timeout 10 minutes

Reminder time 30 seconds

®) Al Dispatchers
(O) Selected Dispatchers

Notifications

0K Cancel

= Presence timeout
Enter the time period, in minutes, that will be used as a timeout to
check for the presence of dispatchers.

* Reminder time
Enter the time period, in seconds, that will be used to show a reminder
pop-up dialog before the planned time of performing the check. When
the reminder appears on top of the screen, the dispatcher must click
the round button in the center to confirm their presence in the system.
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= All Dispatchers
Choose this option button so that all dispatchers will be checked for
presence.
= Selected Dispatchers
Choose this option button so that only selected dispatchers will be
checked for presence.
e Dispatchers
In the drop-down list, select the dispatchers.
= Notifications
Click this link to select who will receive the appropriate notifications.

The recipients may include dispatchers, Email groups, SMS groups,
radios, and radio groups.

6.4.5.2 Export to SWD - Location of radio

When enabled, this task will perform exporting location data to a dedicated
SWD Server database.

¢ Inthe Tasks pane, double-click Export to SWD - Location of radio.

e Inthe Export to SWD - Location of radio dialog box, specify the
following options:

Export to SWD - Location of radia X

SWD Server Address: |swd.trbonat.com Port: |SDDD il

TREONet Server Address: |p0rts.trbonet.com Port: |282EIU jl

¥ 5end data with confirmation

Connection tab
e SWD Server Address
Enter the IP Address of the PC with the running SWD Server.

= Port
Enter the port number that will be used for the connection.

o TRBOnet Server Address
Enter the IP Address of the PC with the running TRBOnet Server.

= Port
Enter the port number that will be used for the connection.
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Send data with confirmation
Select this option to send location data to the SWD server until a
confirmation is received.

Radios tab

Add data received from all radios
Choose this option so that location data will be sent to the SWD server
from all radios in the system.

Add data received from selected radios
Choose this option, and in the list below, select the radios whose location
data will be sent to the SWD server.

6.4.5.3 Geofencing

The Geofencing feature allows controlling the location and speed of radios
relative to manually defined regions on the map.

The Geofencing monitoring consists of the manually defined regions and the
tasks. The regions specify where to apply the rules, while the tasks specify how
to apply the rules for the regions and radios.

In the Tasks pane, double-click Geofencing.

The administrator can add/disable/delete the rules for Geofencing as well as
edit the currently selected rules:

6.4 Administration

Geofencing and Speed Contral X

General | Time Range | Location| Speed| Regions| Radios| Lone Worker|
Select the general parameters of the rule
Name [Monitor Ares 3 |
Description: | Watch out for the strangers
After the rule s triggered:
[ Reset Alarm mode when the rule conditions are no longer met
[renn th / fher each rule modii nuyserver restart, and amylstar of each scheduled tme window (not recommended) (1)
7 7 7
[ addrie -] pssblerut [ vekterue |

Click the Add Rule button (1) and select the appropriate rule from the
drop-down list (Map Region, Beacons, Radios) to add a rule to the current
Geofencing configuration. A new rule will be displayed in the list of rules

(4).
Click the Disable rule button (2) to disable the selected rule.
Click the Delete rule button (3) to delete the selected rule.

Rerun the rules after each rule modification, ...

If you select this option (though it is not recommended), the rule will be
rerun each time the rule is modified, or the server is restarted, or when
the scheduled time window starts.
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Map Region Rule
This section describes settings that can be applied for a Map Region rule.
General tab

e Name

Enter the rule name.
e Description

Add a description of the rule.
e After the rule is triggered

= Reset Alarm mode when the rule conditions are no longer met
Select this option to reset Alarm mode after the rule is triggered.

Time Range tab

On this tab, you can select which time periods the rule will be monitored.
e AllTime
Choose this option to monitor the rule all the time.
e Selected Time

Choose this option and specify the days of week and the time of day the
rule will be monitored.

= Click the Add link.
o Day of Week
From the list, select the day of week on which to monitor the rule.

o Start
Specify the time of day at which to start monitoring the rule.

e End
Specify the time of day at which to stop monitoring the rule.

Location tab

Geofencing and Speed Control %
General| Time Range | Location | speed| Regions| Racios| Lone werker|

| Monitor Area 1

Define the radic's relative pesitioning conditions which will trigger the rule and choose
speific actions to perform when the rule is executed

Trigger this rule when raio:
[] Enters selected regions
Leaves selected regions

For multple nested overlapping regions
@ Crosses outer border only
O Crosses any border

Perform the following actions:
Activate Alarm mede
[ Activate Lone Worker mode
[] Notify source radio
[ send notification

........

[JRenun the ruies after each rule modfication, server restart, and at the start of each scheduled time w

[ addrie  [-|[  Dssberue ][ Deeterue
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Trigger this rule when radio:

Enters selected regions
Select this option so that the rule will be triggered as soon as a radio
enters the selected region.

Leaves selected regions
Select this option so that the rule will be triggered as soon as a radio
leaves the selected region.

For multiple nested/overlapping regions

Choose one of the options specifying for multiple regions whether to
consider only an outer border of the group of regions, or any border of a
region within the group.

Perform the following actions:
Here you specify which actions to execute when the rule is triggered.

Activate Alarm mode
Select this option to activate an Alarm mode in the Dispatch Console.

Activate Lone Worker mode
Select this option to automatically activate a Lone Worker mode for the
radio in case of entering or leaving the selected region.

Notify source radio
Select this option to automatically send a text message to the radio when
it enters or leaves the selected region.

Send notification

Select this option to send a notification when the radio enters or leaves
the selected region. Click the Recipients link and specify the recipients to
send the notification to.

Send RTT to source radio
Select this option to automatically send a Request-to-Talk to the radio
when it enters or leaves the selected region.

Speed tab

6.4 Administration

Geofencing and Speed Control X

General| Time Range| Location | Speed | Regions| Racios| Lone warker|

vl Monitor Area 1

on atributes which will trigger the rule and choose spedific
rule is executed

Trigger this rule when radio:
[ Moves faster than: 60 2|k
[ Moves slower than: ) <] b
[ Remains motionless longer than: |30 2| seconds

Monitor speed in relation to regions: ~[Everywhere

[CIRerun the rules after each rule medification, server restart, and at the start of each scheduled time window {not recommended) ( E )

|__addrie  [-][ osaberue |[ pekterue
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Trigger the rule when a radio:

¢ Moves faster than
Select this option and specify the maximum allowed speed for the
vehicles. The rule will be triggered when the vehicle with the radio
exceeds this speed limit.

¢ Moves slower than
Select this option and specify the minimum allowed speed for the
vehicles. The rule will be triggered when the vehicle with the radio drops
below the specified speed.

¢ Remains motionless longer than
Select this option and specify the time period, in seconds, during which
the vehicle is allowed to remain motionless. The rule will be triggered
when the vehicle with the radio remains motionless longer than this
specified time period.

e Monitor speed in relation to regions
From the drop-down list, select where to monitor the speed of the
vehicles: inside or outside the selected regions, or independently of the
regions.

Perform the following actions:
Here you specify which actions to execute when the rule is triggered.

e Activate Alarm mode
Select this option to activate an Alarm mode in the Dispatch Console.

¢ Notify source radio
Select this option to automatically send a text message to the radio when
it enters or leaves the selected region.

e Send RTT to source radio
Select this option to automatically send a Request To Talk to the radio
when it enters or leaves the selected region.

Regions tab

Geofencing and Speed Control x

General| Time Range| Location| Speed| Regions | Radios| Lone warker|

where the rule will be triggered

@ selected regions

Regions
[ 456733
[ My zone
[ Route 1
[ Route 2
[Flizone 2

Select Al Deselect All

[IRerun the rules after each rule modification, server restart, and at the start of each scheduled time window {not recommended) ()

[ _addrue  [-][ oisblerue |[  Deeterue Cancdl
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All regions
Choose this option to apply this rule for all regions.

Selected regions
Choose this option to apply the rule for one or several regions.

Select all
Click this button to select all regions in the list.

Deselect all
Click this button to deselect all regions in the list.

Radios tab
Geofencing and Speed Control X
General Time Range| Location| Speed| Regions| Radios | Lone Worker |
¥ Manitor Beacan Apply the ruie to selected radios:
O Alradios
@® Selected radios
e
> [/ (3 Al
~[@n
® 333
@ 4444
(@ radio 235
¥ mez
¥ e}
> [ Cleaners
> (3 Firemen
12 3 4 5 6
Sele ed// \
&3 a - ek -
[JRerun the rules after each rue modfication, server restart, and at the start of each scheduled tme window (notrecommended) (1)
[amrus_[-] [ oseemun | [ ossterua
Il radi
e All radios

6.4 Administration

Choose this option to apply this rule for all radios.

Selected radios
Choose this option to apply the rule for one or several radios.

Select all (1)
Click this button to select all radios in the list.

Clear all (2)
Click this button to deselect all radios in the list.

Collapse all (3)
Click this button to collapse the view of radios in the list.

Expand all (4)

Click this button to expand the view of radios in the list.

TIs)

Click this button, and from the drop-down menu, select filters for the
radios to be displayed in the list (Online (Indoor, GPS Fixed, No GPS),
Offline).

gi - (s)

Click this button, and from the drop-down menu, select which list to
display: Radio List, Radio Groups, or Logical Groups.
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Lone Worker tab

Geofencing and Speed Control X
General| Time Range| Location| Speed| Regions | Radios [ Lone Warker |
¥l Moritor Area 1
v Monitor Area 3 Select the tasks to be executed when the rule is riggered
O Al tasks
(® selected tasks
Lone Workers
[ Lone Worker
[JRenun the rules after each rule modification, server restart, and at the start of each scheduled time window (not recommended) ()
[ scrie  [-[[ owvense [[ ooercrue [oc e ]

e All tasks
Choose this option to execute all Lone Worker tasks configured by the
administrator when the rule has been triggered.

e Selected tasks
Choose this option, and in the list below, select the Lone Worker tasks to
be executed when the rule has been triggered.

Other Rules

This section describes settings that can be applied for Geofencing rules of the
types other than Map Region. These settings are represented in the table

below:
Rule Type ’ Tab Name Parameters Description
Settings common General Name - Enter the rule name.

for all rule types Description - add the rule description.

All Time
Choose this option to monitor the rule all the time.

Time Range

Selected Time
Choose this option and specify the days of week and
the time of day the rule will be monitored.

= (Click the Add link.

e Day of Week
From the list, select the day of week on which
to monitor the rule.

e Start
Specify the time of day at which to start
monitoring the rule.

e End
Specify the time of day at which to stop
monitoring the rule.
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Rule Type

’ Tab Name

Radios

Parameters Description
All radios - choose to apply this rule for all radios;

Selected radios - choose to apply the rule for one or
several radios;

Rule Type

Beacons General

Allows configuring
rules when a radio
enters or leaves
the beacon
coverage zone

’ Tab Name Parameters Description

Rule Type:

Beacon entry - select to enable the rule when a
radio enters the beacon coverage zone.

Beacon exit - select to enable the rule when a
radio leaves the beacon coverage zone.

Activate Alarm mode when the rule is triggered -
select this option to activate Alarm mode in the
Dispatch Console if Beacons rule has been triggered.

Reset Alarm mode if the rule is not triggered -
select to reset Alarm mode in the Dispatch
Console automatically if the rule condition was not
triggered (for example, when Beacon entry is
selected and the radio enters the monitored
coverage zone and then leaves the zone, the
alarm mode in the Dispatch Console will be reset
automatically).

Send RTT to radio when the rule is triggered -
select this option to automatically send a
Request To Talk to the radio if the rule has been
triggered.

Send text message to radio when the rule is
triggered - select this option to automatically send a
text message to the radio if the rule has been
triggered.

Activate Lone Worker when the rule is triggered -
select this option to allow automatically activating a
Lone Worker policy for a radio in case of entering or
leaving beacon coverage zone.

Time Range

See above.

Radios

See above.

Beacons

All Beacons - choose to apply this rule for all
beacons;

Selected beacons - choose to apply the rule for one
or several beacons.

Lone Worker

All tasks - choose to apply all tasks configured by the
administrator when the rule has been triggered;

Selected tasks - choose this option, and in the list
below, select the Lone Worker tasks to be executed
when the rule has been triggered.

6.4 Administration
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Radios General Rule Type:

Allows using Geofence entry - select to enable the rule when a
radio(s) as map radio enters the proximity zone associated with
region(s) and another radio.

monitoring when
another radio
enters or leaves
the vicinity of the
radio’s zone

Geofence exit - select to enable the rule when a
radio leaves the proximity zone associated with
another radio.

Activate Alarm mode when the rule is triggered -
select to activate Alarm mode in the Dispatch Console
if Radios rule has been triggered.

Reset Alarm mode if the rule is not triggered -
select to reset Alarm mode in the Dispatch Console
automatically if the rule condition was not triggered
(for example, when Geofence entry is selected and
radio enters the monitored vicinity zone and then
instantly leaves the zone, alarm mode in the Dispatch
Console will be reset automatically).

Send text message to radio when the rule is
triggered - select to inform radio user if the rule has
been triggered.

Send RTT to radio when the rule is triggered -
select to inform radio user if the rule has been
triggered.

Minimum distance between radios - specify the
distance, in meters or feet, depending on what is
chosen in Tools > Options > Advanced /
Measurement system. When a distance is less than
the selected value, the rule will be triggered
according to the settings above.

Color of region - select the color for the radio's
proximity zone.

Time Range See above.

Proximity Select the radios in the proximity zones of which the
Zones rule is applied.

Radios See above.

Map Regions Rule works only in regions
Select this option and then choose either All regions
or Selected regions.

6.4.5.4 Idle Time

The Idle Time feature allows monitoring vehicles idle time assigning Telemetry
Commands on selected VIOs.

¢ Inthe Tasks pane, double-click Idle Time.
Specify the telemetry command to set the Idle Time:
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Idle Time x

Start vio: [T 1] Command: [vigh

Bl
Stop vio: | 14| command: [High -

Start
e Specify the telemetry VIO and Command to start the Idle Time task.

Stop
e Specify the telemetry VIO and Command to stop the Idle Time task.
The administrator can see Idle Time reports and statistics.

Click Reports (1), and under Location History > Vehicle Tracking, select
Idle Time (Summary) or Idle Time (Detailed) (2), and specify report
parameters:

Fie View Map Toos Help

[ge
EEr——

Idle Time (Summary) Sovediroes: | ot seiactads-
enrscy fraton o e e hIEd Wk o e the I Time sk  aniQured e

Note: Specify the speed accuracy value in the Speed box (3).

6.4.5.5 Radio Allocation (Sprite Forms)

This function is used for direct communication between the dispatcher and the
subscriber via special Tallysman Option board installed into the radio. The
dispatcher and subscriber have special form templates. The dispatcher receives
Duty ID of the subscriber with his template output form whereas the
subscriber sends it using his template input form. The radio name changes to
its Duty ID.

Note: Any activity may be decoded with its Duty ID so this is a
way to communicate for the dispatcher and subscribers
only.

e In the Tasks pane, double-click Radio Allocation (Sprite Forms).
e Load the Sprite Form (output template) and select the Field Name:
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Radio Allocation (Sprite Forms) x

Form Description:

(APP_VERSION1=0.14 -
APP_VERSION2-1

DATE_MODIFIED=12/12/2012 8:21:05 a.m.

FORMATTED=
0203000FBIECOAFS02FBO04ESA204275730128000000106120500028768CEQF1
OFBOOF5025368696674206E756D62657235AD781E

AS_ARRAY=0:02, (03, (00, 00F, (xBY, (x8C, (DA, BcF5, (02, OxFB, (<00,
Ox4E, Ox5A, (20, (xd2, (75, 073, (01, (80, (00, (0O, (01, (06, (x18,
0x05, 200, (02, (<87, (x68, IxCE. (xOF, Bx10, BcFB, (00, OxF5, (<02, (53,
0x68, (x63, (66, (74, (20, (xBE, (75, (eBD, (x62, (65, (72, (35, (xAD,
0x78. I 1E

METADATA=-0002000000000000

m

FORM_TITLE=NZ Bus
FORM_ID=2
FORM_REVISION=3

[Field Data #0]
JapapSi sy <

Load

Field Name Shift number ﬂ

Cancel

e Click OK to add a Sprite Form.
6.4.5.6 SMS and Email Notifications

TRBOnet Dispatch Console allows managing text messages:

1. Send Text Messages from LAN to a particular radio or talk group (POP3
Server);

2. Forward all Text Messages from radios to base radio to particular email
address (SMTP Server).

Note: Microsoft Exchange Server can be used as SMTP and
POP3 servers. For more details on SMTP or POP3
servers, ask your System Administrator.

¢ Inthe Tasks pane, double-click SMS and Email notifications:

SMS settings tab

SMS and Email Notifications

SMS settngs  Outgeing

ettings (SWTF) _ Incoming Email setings
Send SMS to

[ send muis to

Forw
I
Qutgoing mes (from dispatchers to radio network)

SMS Groups

cone

= Send SMS to recipients if radio is in alarm mode
Select this option to send an SMS in case of an alarm on the radio.
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= Send MMS to recipients if radio is in alarm mode
Select this option to send an MMS in case of an alarm on the radio.

Forward Text Messages to mobile phones

= Input messages (from radio network to dispatchers)
Select this option to forward incoming text messages to mobile
phones.

= Output messages (from dispatchers to radio network)
Select this option to forward outgoing text messages to mobile
phones.

For more details on SMS settings, see section 5.17.2, Outgoing Mail Server
(page 104).

A radio sends text messages to the base station. TRBOnet Server forwards all
text messages to a particular email address (for example,
admin@yourcompany.com). The administrator receives text messages from
radios as regular emails.

Outgoing Email settings (SMTP) tab

= Send email to recipients if radio is in alarm mode
Select this option to send an Email in case of alarm.

Forward Text Messages to email recipients

= Input messages (from radio network to dispatchers)
Select this option to forward incoming text messages to Email
address(es).

= Output messages (from dispatchers to radio network)
Select this option to forward outgoing text messages to Email
address(es).

Incoming Email settings tab

TRBOnNet Server connects to POP3 server, reads emails and sends text
messages to radios or talk groups.

1. Create an email account on your email server.
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2. Send an email to radioserver@yourcompany.com. In the Subject field,
enter either 'RadioIlD:XXX' to send an email to a selected radio, or
'GroupID:XXX' to send an email to a selected radio group.

Note: If you don't properly specify the email Subject, or

e Forward incoming emails to radios

specified a non-existing RadioID (or GroupID), a
corresponding notification will appear in the Event
Viewer of the Dispatch Console.

Select this option to forward incoming emails to radio network.

6.4.5.7 User Activity

The User Activity function allows the dispatcher to create the statuses to

which radios can be assigned due to their activity.

For example, if a radio sends an On duty message or presses an exact preset
telemetry button, this radio gets assigned to the On duty status in the Dispatch
Console. The dispatcher can also manually assign desired statuses to radios.

¢ Inthe Tasks pane, double-click User Activity:

Statuses tab

User Activity

Statuses  Advanced

Mame Description
@ offouty
@ onbuty

(@) User Activity #1

Add Edit Delete

Cancel

e Click Add to add a User Activity status:
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User Activity Configuration X
General | ogical Groups

Mame: |User Activity #1

Description:

Background: ® Sea - |+

Assign this status to radios by using the following rules:
Manualy by dispatcher
[ automatically by receiving Text Message from a radio

[] automatically by receiving Telemetry Command from a radio

1 5 Any event

[ automatically by receiving DTMF command from a radio

—

[ Automatically by receiving Status Message from a radio

Carcel

Name
Enter a name for the user activity status.

Description
Add a description for the user activity status.

Background
Select the background color to display the radios assigned to the
status.

Assign this status to radios by using the following rules:

Manually by dispatcher
Select this option to assign the status to radios manually.

Automatically by receiving Text Message from a radio

Select this option to assign the status to the radio list after receiving a
text message from the radio. If you select this option, enter the text
message in the Message box.

Automatically by receiving Telemetry Command from a radio
Select this option to assign the status to the radio after receiving a
telemetry command from the radio. If you select this option, specify
the VIO contact, and from the Command drop-down list, select the
signal level at which the radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to assign the status to the radio after receiving a
predefined DTMF command from the radio, for instance, #11#. If you
select this option, specify a DTMF combination without the #
characters in the Command box.

Automatically by receiving Status Message from a radio

Select this option to assign the status to the radio after receiving a
specified Status Message, for instance, 1. If you select this option,
specify the Status.
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Click the Advanced tab:

User Activity >

Statuses Advanced

Assign default status to offline radios

% minutes

Timeout: 1

Cancel

e Assign default status to offline radios
Select this option to assign the default status to offline radios.

e Timeout
Specify the time period, in minutes, after which the default status will be
assigned an offline radio.

6.4.5.8 Lone Worker

The Lone Worker policy lets the dispatcher set a time interval the
communication with a radio user is expected. For example, if a lone worker has
not called the dispatcher for 15 minutes, the radio receives a message and the
Dispatcher receives an alarm signal.

e To add a Lone Worker task, in the Tasks pane, click Add > Lone Worker.

¢ Inthe Lone Worker dialog box that appears, specify the following
parameters:

Lone Worker X

Task name: Lone Warker

Task Start Conditions Task Stop

[ Manually by dispatcher
Automatically by receiving Text Message from a radio

Message: Start |

Automatically by receiving Telemetry Command from a radio

VIO: 1 % Command: Any event -

[ Automatically by receiving DTMF command from a radio
[ automatically by receiving Status Message from a radio
0 =

Send text message to radio
Message: |L\"nl started|

canal
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Manually by dispatcher
Select this option to start the Lone Worker task manually by the
dispatcher.

Automatically by receiving Text Message from a radio

Select this option so that the Lone Worker task will start after receiving a
message from a radio. If you select this option, specify a text message in
the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option so that the Lone Worker task will start after receiving a
telemetry command from a radio. If you select this option, specify the VIO
contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option so that the Lone Worker task will start after receiving a
predefined DTMF command, for instance, #11#. If you select this option,
specify a DTMF combination without the # characters in the Command
box.

Automatically by receiving Status Message from a radio
Select this option so that the Lone Worker task will start after receiving a
specified status from a radio. If you select this option, specify Status.

Send text message to radio
Select this option and in the Message box enter the text message that
will be sent to the radio when a Lone Worker task is started for that radio.

Conditions tab

6.4 Administration

Lone Worker X

Task name: Lone Worker

Task Start  Conditions  Task Stop

Response time 30 2| minutes

Send notification to radio
Reminder time ) < seconds
(® send Request To Tak
(C) Send Text Message

|:| Reset Lane Worker when receiving Text Message
["] Reset Lone Worker when receiving Telemetry command
1 e Any event -

[] Reset Lone Worker when the distance has been traveled

[[] Do not trigger alarm if radio is offline for less than

Cancel
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Response time
Specify the time period, in minutes, that determines how long TRBOnet
Server waits since the last radio transmission.

Send notification to radio
Select this option so that TRBOnet Server will send a notification to the
radio before raising the alarm if the radio has not transmitted for the
specified time period.
= Reminder time
Specify the time period before it comes to raise the alarm, to send a
notification asking the radio to respond.

= Send Request to Talk
Choose this option to send a Request-to-Talk to the radio.

= Send Text Message
Choose this option to send a text message to the radio. Specify the
message text in the Message box.

Reset Lone Worker when receiving Text Message
Select this option to reset the Lone Worker task after receiving the
message specified in the Message box.

Reset Lone Worker when receiving Telemetry command

Select this option to reset the Lone Worker task after receiving the
telemetry command. If you select this option, specify the VIO contact, and
from the Command drop-down list, select the signal level at which the
user's radio should send the telemetry command.

Reset Lone Worker when the distance has been traveled
Select this option to reset the Lone Worker task after the distance
specified in the Distance box has been traveled.

Do not trigger alarm if radio is offline for less than
Select this option so that the alarm is not triggered if the radio is offline
for a time less than the time specified in the Interval box.

Task Stop tab

Lone Worker x

Task name: Lone Worker

Task Start Conditions Task Stop

Manually by dispatcher
[ automatically by receiving Text Message from a radio

[ automatically by receiving Telemetry Command from a radio
1 S Any event
Automatically by receiving DTMF command from a radio
Command: 123 #123#
[ automatically by receiving Status Message from a radio

[] Automatically when a radio goes offline
[ send text message to radio

Cancel
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In the Task Stop tab, you can specify how to stop the Lone Worker task.
The available options are similar to those you specified on the Task Start
tab.

Enabling Lone Worker

e To enable the Lone Worker task for a selected radio, go to Voice Dispatch
(1), right-click the selected radio (2), and choose Start Lone Worker (3):

Private Call
Send Call

Request Location

Send Message..

Show Route on Google Earth

Monitoring »
Specify Custom lcons...

Set Radio Channel »

Set On Duty
StartLoneWorker | &
Start Timer

: Slot #1 [ A @l [IRepeater #1: Slot #2

e+ (L Print | 11 Pause f Clear ~ &3 Reload | [ Fiter By Radi ouping ‘/ Auto Filter @ Default Settings >
Date |Radiosystem  |sender | Recpient |Message | petais | Note |Ext.note |
21-0ct-2016 17:56:27  Repeater £1: Sh... Administra... Police Dispatcher ‘Adrinistr... Members: Administr -
20-0ct-2016 17:56:27  Repeater £1: Slo.., Administa,., Folice Dispatcher ‘Adrinisir... Members: Adrinisir,.,

Repeater #1: Slo... Administra... Al Al Call from dispatch... Members: Administr...

125 Al Al Call from 125" {00.... Members: 125

25 o Al Call rom ‘235 (00... Memberss 235
-0 ERe 1T Reneater £1: Cn 778 all all Call fram 940N Memhera: 738 A
i) #[ 4] Record 10f 453 »T‘i»f;fil »
Recent CallsEvents | Recent Calls | Rado State | Active Tasks || || user actvity | Map | Cameras |
(6127001 g8 B € | § acministrator | [ Licensed to: demo Demo License | © active-

e To monitor the Lone Worker task, click the Active Tasks tab:

Drag and Drop PTT Box here to
reate new group

Patch on Repeaters
Binary Patch

1M Stop | = Grouping 7 Auto Filter @ Defautt Settings
Task | Radio
Lone Worker 1 125 (Pete) 125 P
6] @] <] Record 1o 1 ¥ [ | mi[ <] |
It | Recent CallsfEvents | Recent Calls | RadioState | Active Tasks | | User Actity | Map | Cameras
127001 &3 @ B | § Administrstor | [8 Licensed to: demo Demo License | @ Active-

6.4.5.9 Lone Worker Scheduler

The Lone Worker Scheduler task allows configuring a schedule for the Lone
Worker task.

e To add the task, in the Tasks pane, click Add > Lone Worker Scheduler.

e Task name
Enter a name for the task.
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Time Range tab

e All Time
Choose this option to run the task all the time.

e Selected Time

Choose this option and specify the days of week and the time of day the
task will be run.

= (lick the Add link.

o Day of Week
From the list, select the day of week on which to run the task.

e Start
Specify the time of day at which to start running the task.

e End
Specify the time of day at which to stop running the task.

Radios tab

¢ All radios
Choose this option to run the task for all radios.

e Selected radios
Choose this option to run the task for one or several radios.

Lone Worker tab

e All tasks
Choose this option to run all Lone Worker tasks.

e Selected tasks

Choose this option, and in the list below, select the Lone Worker tasks to
run.

Note: When a Lone Worker task is mentioned as Disabled,
enable it on the Tasks pane.
6.4.5.10 Export Data

TRBOnet Dispatch Console provides the Export Data function, which allows
exporting data to an external database table.

e To add an Export Data task, in the Tasks pane, click Add > Export Data.
e Inthe Export Data dialog box, specify the following parameters:
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Export Data X
Task name: |Export to database table - Location of radio ‘
Type: |Export to database table j
Data: |Location of radio j
Connection Data  Scheduler Advanced
" Use default connection
{* Select connection
Server name |focal)\sqLEXPRESS
Database name |TRBOnet j
¥ Windows authentication
User name |
User password |
Conce
Connection tab
e Task name
Enter a name for the task.
« Type

6.4 Administration

Select the type of data export from the drop-down list. TRBOnet Dispatch
Console allows exporting data for third-party systems using data export
tasks.

Export to database table
Allows exporting data to MS SQL Server tables. Specify MS SQL Server
connection parameters, database, and table to export data.

Export to Versatrans
Allows exporting data to the Versatrans data collection system via IP.
For more details, visit the official website of Versatrans.

Export to Google
Allows exporting data to file (file format is KML). For more details, visit
the following website.

Export to NMEA
Allows exporting data to a file (text file format, export format is NMEA
0183). For more details, visit the following website.

Export to file
Allows exporting data to a text file.

Data
Select which data to export from the drop-down list.

Use default connection
Choose this option to use the default connection to SQL Server.

Select connection
Choose this option and specify the SQL Server and database name.
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e Server name

Enter the SQL server name.

e Database name

Select the database from the drop-down list.

e Windows authentication
Select this option to use Windows authentication, or deselect it to use
SQL Server authentication (SQL Server user name and password will be

required).
Export Data X
Task name: |Expurt to database table - Location of radio |
Type: |Expnrtbo database table j
Data: |LUcatUr| of radio j
Connection Data  Scheduler Advanced
Table: [Export_Locations]
Create table  Load columns list
Column mapping:
Table column Data
Date Location date -
Latitude Latitude
Longitude Longitude
Speed Speed
Direction Direction
Predision Accuracy
RardinTn Radin TN hd
oK Cancel
e Table

the name of the table to be exported into external database (by default,
the name of the table is created after you have specified it in Create table

dialog box).

¢ Click the Load columns list link to update the columns list in case you
have made any changes to the table.

e Click the Create table link to add a new table for data export:

Create table

Create new table to export data
Active database connection

X

Table name: Export_Locations
Column list:

Table column Data
v Date Location date
v| Latitude Latitude
v| Longitude Longitude
v| Speed Speed
| Direction Direction
v Predsion Accuracy
v| RadiolD Radio ID
v ID Unique radio ID
v Name Radio name
L'd

ExportDate Export date

-

Cancel
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= Select the data fields to add to the table.

Scheduler tab
Export Data x
Task name: |Export to database table - Location of radio |
Type: |Exportm database table j
Data: |L0can0n of radio j
Connection Data ~ Scheduler  Advanced

6.4 Administration

Days of week: |(AII days) j

Start time: 13:00 E|:
Stop time: 15:00 E|:
Repeat every: 01:00:00 3:

" Execute at particular time

Cancel

Days of week
In the drop-down list, select the days of the week on which to export the
data.

Execute recurrently with interval
Choose this option to perform data export on a periodic basis.
= Start time
Specify the time at which to start data export.
= Stop time
Specify the time at which to stop data export.

= Repeat every
Specify a time period for periodic data exports.

Execute at particular time
Choose this option and specify the times in the columns of the table
below.

195



neocom
SOofFtware

Advanced tab

Export Data X
Task name: |Expurt to database table - Location of radio |
Type: |Exp0rth0 database table j
Data: |L0caﬁ0n of radio j

Connection Data  Scheduler Advanced

Export only modified data

Export mode
(® Always add new records
(0) Update existing and add new records
() Update existing records

Cancel

e Export only modified data

Select this option to export only modified data.
e Export mode

Choose the mode for exporting data.

6.4.5.11 Scheduled Task
This task allows sending scheduled commands to selected radios.

e To add a scheduled task, in the Tasks pane, click Add > Scheduled Task.
¢ Inthe Scheduled Task dialog box, specify the following parameters:

Scheduled Task

X
Task name: |S|:heduled Task 1
Command | Scheduler
Command: ‘Send Text Message [~

Message Send Telemetry

" Send to Radio| REqUest Location
Send Voice Message
& "
* 5.en.d to Radio Send Signaling
Recipient: Send command to Control Station
o Regquest To Talk
Custom Event
4 ® 3333 |send Swift Command
] ® 5555 Send Push Notification

/| (@® Radio 100
(® Radio 125
(® Radio 235
(®) Radio 4444

Selected: 3

=} |-

Cancel

= Task name
Enter a name for the task.
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= Command

From the drop-down list, select what to send to selected radios.
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For a description of the available commands, see sections 6.5.6.1 -

6.5.6.10.

Scheduler tab

6.4 Administration

Start date

Scheduled Task

Task name: |5|:heduled Task 1

Command Scheduler

Start date:
End date:

Days of week:

¥ Execute recurrently with interval

Start time:
End time:

Repeat every:

" Execute at particular time

-l
|12 December 2022 j

|M0nday,Tuesday, Wednesday, Thursday, Frid. j

12:00 AM E|:
12:00 AM 3:
01:00:00 E|:

Cancel

Select the date to start the task.

End date

Select the date to end the task.

Days of week

In the drop-down list, select the days of the week on which to perform the

task.

Execute recurrently with interval
Choose this option to perform the task on a periodic basis.

Start time

Specify the time at which to start the task.

End time

Specify the time at which to end the task.

Repeat every

Specify a time period for periodic task executions.

Execute at particular time

Choose this option and specify the times in the columns of the table

below.
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6.4.5.12

Voice Message

The Voice Message task allows you to automatically broadcast a predefined
Voice Message after receiving a telemetry command, a text message, or a

DTMF command.

To add a Voice Message task, in the Tasks pane, click Add > Voice
Message.

The user can have several Voice Message policies for different purposes. Enter
a name for the policy in the Task name box and set the policy parameters.

Task Settings tab

Voice Message

Task name: Voice Message

Task Settings  Start Conditions  Stop Conditions  Telemetry

|| Load from file

j" Record message

@, Play back message

Call Type Channel Call Destination
Private Call Auto Detect Radio 125
Group Call 5} IPSC 1: Slot #1 Cleaners
Phone Call Phone Connect 2410

b Add % Remove

Priority: |N0rma\ j
Offest: [1} 3: second(s)
Send voice message
This many times: 3 3: {0 = unfimited)
Every: 3 3: second(s)
e

Load from file
Click this link to load an existing file from your PC.

Record message
Click this link to record a new voice message.

Play back message

Click this link to play back the voice message.

Click the Add link and specify Call Type, Channel, and Call Destination
for a voice message.

Note: To send a Voice Message to a contact from the phone
book, click the ellipsis (...) button in the Call Destination
column and select a contact from the phone book.

Priority

From the drop-down list, select the priority with which the voice message
will be sent/queued. If this priority is higher than that of the current
transmission, which is, in turn, allowed to be interrupted, the current
transmission will be interrupted, and the voice message will be sent

instead.
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Offset
Specify the delay time, in seconds, for the Voice Message task.

Send Voice Message

= This many times
Enter the number of times to send the voice message.

= Every
Set the repeat interval, in seconds, if the voice message is sent more
than once.

= Resend if interrupted
Select this option so that the voice message will be resent if the
sending of the voice message is interrupted.

Start Conditions tab

6.4 Administration

Voice Message x
Task name: Voice Message
Task Settings  Start Conditions  Stop Conditions ~ Telemetry
Manually by dispatcher
[ Automatically by receiving Text Message from a radio
Automatically by receiving Telemetry Command from a radio
VIO: 1 = Command: |High level -
[] Automatically by receiving DTMF command from a radio
Automatically by receiving Emergency from a radio
Emergency type: ‘.-'—\II j

(@ Activated by any radio
() Activated by selected radios only

[[] send text message to radio

conel

Manually by dispatcher
Select this option to allow the dispatcher to manually start the Voice
Message task.

Automatically by receiving Text Message from a radio

Select this option to start the Voice Message task after receiving a
specified text message from a radio. If you select this option, specify a
brief text message in the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to start the Voice Message task after receiving a
telemetry command. If you select this option, specify the VIO contact, and
from the Command drop-down list, select the signal level at which the
user's radio should send the telemetry command.
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e Automatically by receiving DTMF command from a radio
Select this option to start the Voice Message task after receiving a DTMF
command from a radio, for instance, #114#. If you select this option,
specify a DTMF combination without the # characters in the Command
box.

e Automatically by receiving Emergency from a radio
Select this option to start the Voice Message task after receiving an
emergency command from a radio.
= Emergency Type
From the drop-down list, select the type of emergency to be sent from
a radio.

e Activated by any radio
Choose this option to expect receiving data from any radio in the system.

e Activate by selected radios only
Choose this option to expect receiving data from selected radios.
= Radio
In the drop-down list, select the radio(s).
¢ Send text message to radio
Select this option so that a text message will be sent to the radio that

activated the Voice Message task. If you select this option, specify a brief
text message in the Message box.

Stop Conditions tab

Voice Message X

Task name: Voice Message

Task Settings  Start Conditions  Stop Conditions  Telemetry

Manually by dispatcher
[ automatically by receiving Text Message from a radio

Automatically by receiving Telemetry Command from a radio

VIO: 1 +| Command:  |H
[] automatically by receiving DTMF command from a radio

e

[] send text message to radio

el

e Manually by dispatcher
Select this option to allow the dispatcher to manually stop the Voice
Message task.

e Automatically by receiving Text Message from a radio
Select this option to stop the Voice Message task after receiving a
message from a radio. If you select this option, specify a text message in
the Message box.
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Automatically by receiving Telemetry Command from a radio

Select this option to stop the Voice Message task after receiving a
telemetry command from a radio: If you select this option, specify the VIO
contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to stop the Voice Message task after receiving a DTMF
command from a radio, for instance, #114#. If you select this option,
specify a DTMF combination without the # characters in the Command
box.

Send text message to radio

Select this option so that a text message will be sent to the radio that
stopped the Voice Message task. If you select this option, specify a brief
text message in the Message box.

Telemetry tab

6.4 Administration

Voice Message x

Task name: Voice Message

Task Settings Start Conditions ~ Stop Conditions  Telemetry

Send telemetry before task is started
WIO: 1

High level =i

Delay after sending: a

< Command:
3| second(s)
Send telemetry after task is stopped

VIO: 1

Toadle level hl

Delay before sending: o

+| command:
3 second(s)

|Radios: 2 j

[] send telemetry on every voice message

Redpient:

Cancel

Send telemetry before task is started

Select this option to send a telemetry command before the voice message
is transmitted.

= Specify the VIO contact number.
= Select the signal level from the Command list.

= Delay after sending
Specify the time period, in seconds, to wait before sending the voice
message after the telemetry command has been sent.

Send telemetry after task is stopped
Select this option to send a telemetry command after the Voice Message
task is stopped.

= Specify the VIO contact number.
= Select the signal level from the Command list.

heocom
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= Delay before sending
Specify the time period, in seconds, to wait before sending the
telemetry command after the voice message has been sent.

e Recipient

In the drop-down list, select the radios/groups to send the telemetry

command to.

¢ Send telemetry on every voice message
Select this option to send the telemetry command to the selected
radios/groups every time the voice message is sent, provided the voice
message is repeatedly sent.

6.4.5.13 Recorder

The Recorder feature allows connecting to an audio recorder via IP.

e To enable the task, in the Tasks pane, click Add > Recorder:

The feature allows replicating audio recordings to the recorder:

Audio Recorder

Task name:

Settings

IP Address:
Port:

Audio Codec:

|Aud|0 Recorder

Recorder Type: | TREOnet Recorder

[10.10.168.121

3000

|oPusas000/2

x
|
B
5
Cacel

e Task name

Enter a name for the task.

e Recorder Type

Select either 'TRBOnet Recorder’, 'NetCRR Recorder’, or 'NexLog

Recorder’.
e IP Address

Enter the recorder's IP address.

e Port

Specify the recorder's port number.

e Port count

Specify the number of open ports if 'NexLog Recorder’ is selected.
Recommended value: twice the number of calls recorded at the same

time.
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Audio Codec
From the drop-down list, select the audio codec to be used.

Await confirmation for audio stream control packets
Select this option to wait for confirmation of audio stream control
packets, if ‘TRBOnet Recorder’ is selected.

Check Channels

Click this button to view all available channels on the recorder, if ‘NetCRR
Recorder’ is selected.

Click OK to add the task.
Agenda

The Agenda is used to automatically send predefined messages to the radios. It
may be used when you have any software receiving any messages but it is not
able to send them to the subscribers. In this case, TRBOnet Dispatch Console
acts as an intermediary for receiving the messages from the folder and sending
them to radios.

e To add an agenda, in the Tasks pane, click Add > Agenda.

e Inthe Agenda dialog box, specify the following parameters.

6.4 Administration

Agenda x

Task name: |Agenda |

Settings

Qutgoing messages (path to a server folder):
|C:'-.Outgoing |

Incoming messages (path to a server folder):

|C"-Incnming |

Wait for response(sec) 120

Text to confim:

Cancel

Task name
Enter a name for the task.

Outgoing messages (path to a server folder)
Enter the path to the folder for outgoing messages.

Incoming messages (path to a server folder)

Enter the path to the folder for incoming messages.
Wait for response

Specify the time interval, in seconds, for the response.
Text to confirm

Specify the text to be sent by radio users after they receive the
message.
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6.4.5.15 Import Phone Addresses

The Import Phone Addresses option allows importing phone/address data
from a NENA database to TRBOnet database.
To perform this task:
e Inthe Tasks pane, click Add > Import Phone Addresses (NENA)
e Inthe Import Phone Addresses (NENA) dialog box, browse for the
corresponding *.CSV file, and click OK.

6.4.5.16 Scheduled Report

The Scheduled Report task allows reporting on selected parameters and
sending these reports to selected Email subscribers groups. The user can have
several Scheduled Report policies for different purposes.

Note: Before configuring the task, you need to create a
number of the Email groups to send reports to. For
more details on Email groups, see section 6.4.26, Email

Groups (page 267).

e To add a Scheduled Report task, in the Tasks pane, click
Add > Scheduled Report:

e Enter a name for the policy in the Task name box and set the policy
parameters.

Scheduled Report X

Task name: Registered Radios 1

Report  Scheduler

Filter:

Radio Group: ~Hlot selected— -

Columns

Radio Name Radio ID Radio Groups
T System Reports
1.[F) User Login History
+.[7) System Bridge
{1 Channel Changes
T) usage Statistics Reports
+[T] Messages
1[5 Radio Activity
+.[F) oniine Radios (Summary)
[ Oniine Radios (Detailed)
+.[F) Radio Status
i ] Radio Status (Summary)
1) Dispatcher Messages and Notes

Logical Groups Has GP3S Has TMS

{Select |+ Sortby: Radio Name

Check OK Cancel

e On the Report tab, select the report type for the Scheduled Report task.
The report details and filter might be different.
For more details on reporting, see section 6.11, Reports (page 365).

¢ Click the Scheduler tab to configure a schedule for the report.
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Scheduled Report

Task name:  [Registered Radios 1

Report  Scheduler

Scheduiers: [Bcheduier 1 ~ [+

[m] (Select Ally
For the past:
or fhe pas Scheduler 1
[ scheduler 2
Email groups:
oK. Cancel

Check OK Cancel

e Schedulers
On the list, select the scheduler(s) to use for the report.
Or, click the plus sign button and specify a new scheduler (see section

6.4.22, Schedulers).

e For the past
Select the past time interval (in minutes, hours, days, weeks, or months)

to collect the data for.

e Email groups
In the list, select Email groups to send the report to.

The created scheduled report will be displayed in the Tasks pane:

File View Map Tools Help

Administration Tasks
" Efurs * | N (][] G 5L ree

[J Database Group 10 Group 20

il Radio Systems

g1 System Bridging

- Telephony

@ Tasks

5% virtual Modbus Devices

!} voice Dispatch

o

5k Add - 5b Edit | [k Delete
Task Name
& Agenda
G Dispatcher Presence Control
¢5% Export to SWD - Location of radio

@ Location Tracking Wl [ Geofending
vl 3 dle Tme
ﬁ Job Ticketing Wl G Lone Worker 1
Wl (5] Mesages 1_Messages for Period
Route Management W 7%, Missed GPS data loading
- | {33 Radio Alocation (Sprite Forms)
@ RFID Tracker Wl (3] scheduled Report 1_Messages for Period_26-Nov-2016 00:00:00
! [ SMS and Email notifigations
[] Text Messages | £33 Timer
Wl 28 User Activity
ﬁ Voice Recording wl @ Voice Message
- Wl @) Voice Message
‘Event Viewer

W4 4| Record 100f15 b |1 |w[ 4

»

[ 127001 &8 & | § Administrator | [ Licensed to: demo Demo License @ Active -

To enable the task, select the checkbox in front of the Scheduled Report task
you have already created.

There are three types of the Scheduled Report status icons:
e Green indicates an active task, meaning the task is enabled (checked).

e Gray indicates an inactive task, meaning the task is disabled (unchecked).

¢ Red indicates a disabled task, meaning the task period is up in the past.
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6.4.5.17 Import Beacon Data from Firebird DB

The Import beacon data from Firebird DB option allows importing beacon
data from Firebird database to TRBOnet Dispatch Software database.

e To add the task, in the Tasks pane, click Add > Import beacon data from
DB "Firebird".

¢ Inthe dialog box that opens, specify the following parameters:

Import beacon data from DB "Firebird" X

Mame: Import beacon data from DB " Firshird"|

Settings  Import

Server: User:
[locathost | [svspeA |

Database path: Password:

| | [reeeeeees |
Port: Update {sec):

3050 z 10

Test

Cancel

e Name
Enter a name for the task.

e Server
Specify a remote server or a server on the local PC.

e User
Enter the name of the Firebird DB user.

o Database path
Specify the Firebird DB path.

e Password
Specify a password to connect to Firebird DB (provided at logon).

e Port
Specify the port number to connect to Firebird DB.

e Update (sec.)
Specify the update period for Firebird DB.

e Click Test to test the connection to Firebird DB.
e Click the Import tab to specify Import settings:
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Import beacon data from DB "Firebird" X
Mame: Import beacon data from DE " Firebird™
Seftings  Import

Import data from

|<The Oldest Date Possible = j Import

Delete old data

Report:

Cancel

e Import data from
Specify the Firebird DB name.

e Click Import to import data.

e Delete old data
Select this option to delete all previously imported data from Firebird DB.

¢ Report
In this box, an import report will be displayed.

e Click OK to add the task.
6.4.5.18 HotSOS (Email)

The HotSOS (Email) task is used to automatically create and assign job tickets
upon receiving email messages at the address specified for the radio (Radio >
Additional > Email). In addition, you specify the email address at which to
receive email messages about changes to the created ticket status.

e In the Tasks pane, click Add > HotSOS (Email).
¢ Inthe HotSOS Configuration dialog box, specify the following

parameters:
Het505 Configuration x
Name: [Hotsos |
Email: |tegt@gmail com| |
Source: |Subject j
Status | Hots0s status |
Mew N
Cancelled Ca
Assigned Asz
Accepted Acc
Rejected R
Completed C
In Progress InP
Cancel
* Name

Enter a name for the task.
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* Email
Enter the email address at which you want to receive notifications
concerning the status of the created tickets.

= Source
From the drop-down list, select which part of the email message,
Subject or Body, will be included in the job ticket text.

= HotSOS Status
Enter the text of the emails that will be sent as notifications upon
changes to the job ticket status.

6.4.5.19 HotSOS (Web Service)

The HotSOS (Web Service) task is used to create and assign job tickets by
using the HotSOS Web Service.

e Inthe Tasks pane, click Add > HotSOS (Web Service).
e Inthe HotSOS Configuration dialog box, specify the following

param eters:
HotSOS Configuration X
Name: |Hats50S |
URL: ‘hﬂps.ffrfc.inl.hcﬂ‘sus.nei/apifservice.svcfsuap |
Login: ‘Tesler 123 |
Password "“‘“ |
Provider: [MOTOTREO |
Polling Interval 152 seconds
Text Meszages: O
Message TEXT%%PRIORITY%%ORDER_ID%
Format:
Text Priorty Room Mame Room Number Remark
Order D Message ID
Status HotSOS Status
New N -
Cancelled Ca
Assigned Ass
Accepted Acc .
Rejected R
Completed [of j
G
* Name
Enter a name for the task.
= URL

Enter the URL of the service.

* Login and Password

Enter the login and password of the service account.
= Provider

Enter the service provider name.

= Polling Interval
Enter the interval, in seconds, to check the service for orders (job
tickets).
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= Text Messages
If you select this option, additional text messages will arrive at the
designated radios from the HotSOS server.

= Message Format
Select the fields of a message to include in the job ticket text.

= HotSOS Status

Enter the text of the messages that will be sent as notifications to the
HotSOS server upon changes to the job ticket status.

6.4.5.20 Timer

The Timer task is used to configure the timer that can be
started/stopped/paused either manually by dispatchers, or when receiving a
certain text message, telemetry command, DTMF command, or status from
radios.

e Inthe Tasks pane, click Add > Timer.
¢ Inthe dialog box, specify the following parameters:

Timer X

Task name: |T|mar

[] Global timer
Task Start Task Stop  Status Names  Dispatchers

Manually by dispatcher
[ automatically by receiving Text Message from a radio

[ automatically by receiving Telemetry Command from a radio

1 = Any event

[ automatically by receiving DTMF command from a radio

e

[ automatically by receiving Status Message from a radio

[] send text message to radio

Corcel

e Task name
Enter a name for the task.

¢ Global timer
If you select this option, the timer will be started/stopped, etc. via the
Alarm Management (Timers action).

Task Start/ Task Stop tabs

e Manually by dispatcher
Select this option to allow the dispatcher to manually start/stop the timer
for the desired radio.

e Automatically by receiving Text Message from a radio
Select this option to start/stop the timer when receiving a predefined text
message from a radio. If you select this option, specify a brief text
message in the Message box.
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e Automatically by receiving Telemetry Command from a radio
Select this option to start/stop the timer when receiving a predefined
telemetry command from a radio. If you select this option, specify the VIO
contact, and from the Command drop-down list, select the signal level at
which the user's radio should send the telemetry command.

e Automatically by receiving DTMF command from a radio
Select this option to start/stop the timer when receiving specified DTMF
tones from a radio. If you select this option, specify a DTMF combination
without the # characters in the Command box.

e Automatically by receiving Status Message from a radio
Select this option to start/stop the timer when receiving specified Status
from a radio, for instance, 1. If you select this option, specify the Status.

¢ Send text message to radio
Select this option so that a text message will be sent to a radio when the
timer is started/stopped. If you select this option, specify a brief text
message in the Message box.

Task Stop tab

o After
Specify the duration of the timer, in minutes.

Status Names tab

In the text boxes below, enter the texts for the corresponding statuses: timer
started, stopped by dispatcher/radio/system, elapsed, and paused.

Dispatchers tab

e All Dispatchers
Choose this option button so that the timer will be available to all
dispatchers.

e Selected Dispatchers
Choose this option button so that the timer will be available only to
selected dispatchers.

= Dispatchers
In the list below, select the dispatchers.

6.4.5.21 Automatic Data Retrieval

The Automatic Data Retrieval task is used to automatically retrieve missing
location data from the radio's option board.

e In the Tasks pane, click Add > Automatic Data Retrieval (Swift GPS).

¢ Inthe dialog box, specify the following parameters:
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Automnatic Data Retrieval X
Task name: Automatic Data Retrieval
General Radios

Maximum number of simuktaneous requests: 33:

Allowed regions for requests Everywhere -
Swift Parameters
Retrieve missing locations if the data gap exceeds: 30 3: seconds
Do not retrieve missing locations older than: 30 El: minutes -

G

Maximum number of simultaneous requests
Specify the maximum number of radios being requested at the same
time.

Allowed regions for requests
Select regions where location data will be retrieved from radios.

Retrieve missing locations if the data gap exceeds

TRBOnet Server automatically checks whether the location data is
continuous. If it detects data gaps between any consecutive location
data that exceed this value, it will attempt to retrieve missing
information.

Don't retrieve missing locations older than
TRBOnet Server doesn't check location updates for consistency if they
are older than this value in seconds, minutes, or hours.

On the Radios tab, specify the radio(s) to retrieve location data from.

In the Tasks pane, activate the Automatic Data Retrieval (Swift GPS) task by
selecting the checkbox next to the task name.

6.4.5.22 Automatic Voice Download

The Automatic Voice Download task is used to automatically retrieve voice
data from the radio’s option board when the radio is in WiFi zone.

e In the Tasks pane, click Add > Automatic Voice Download (Swift).
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Automatic Voice Download (Swift) *

Mame: |Voice Download
General  Radios

Maximum number of simutaneous requests: 33:

Save to |c:‘\

%RADIO_ID% % YEAR% XMONTH% LDAY L LHOUR X LMINUTEL " SECOND %,

Year Month Day Hour Minute Second Call Type Source Source Type
Source |0 Recipient Recipient Type Recipient I Radio 1D

Example:
c:\Radio_120221130133744 oo tna

[ Save to database

{Mote that this may cause duplication of voice records in the server database)

Cancel

¢ Inthe dialog box, specify the following parameters:

* Maximum number of simultaneous requests
Specify the maximum number of simultaneously requested radios.

= Save to
Enter the path where to save voice data on your PC.
Click the appropriate links below (Year, Month, Day, etc.) that will be
used to generate the file/path name.

= Save to database
Select this option to save retrieved voice data to the server database.
Note that selecting this option may cause duplication of voice records
in the server database.

= On the Radios tab, specify the radio(s) to retrieve voice data from.

In the Tasks pane, activate the Automatic Voice Download (Swift) task by
selecting the checkbox next to the task name.

6.4.5.23 Sign-in Reminder
The Sign-in Reminder task is used to remind users to sign in into the radio(s).

e To add a Sign-in Reminder task, in the Tasks pane,
click Add > Sign-in Reminder.

¢ Inthe dialog box that opens, specify the following parameters:
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i MName: Sign-in Reminder | ‘

General  Radios

o | PEEPRN Timeaut fmmss) oLo0 3 )
24 Sign in = Y
ext to speech: |
[@1 Chop-chop P —
Chop-chop, sign in
i Add D
s X0s o
[1 run again at

[] pisable radios that were not checked out after notification

Timeout: |3 minutes
Cancel

= Name
Enter a name for the task.

= C(Click the Add link and from the drop-down list, select either
Text Message or Text to Speech.

In the dialog box that opens, specify the following:

e Timeout
Specify the time, in minutes, to wait before sending the message
(voice message) to the selected radio(s).

e Text Message /[ Text to Speech
Enter the text of the message (voice message) to be sent to the
selected radio(s).

= Run again after user signs out
Select this option to rerun the task after the user signs out.

= Disable radios that were not checked out after notification
Select this option to disable the radio(s) if the user didn't sign in after
being notified.

e Timeout
Specify the corresponding timeout, in minutes.

= Click the Radios tab, and select the radio(s) to send reminder(s) to.
6.4.5.24 Sign-out Reminder

The Sign-out Reminder task is used to remind users to sign out of the radio(s).

e To add a Sign-out Reminder task, in the Tasks pane,
click Add > Sign-out Reminder.

e Inthe dialog box that opens, enter the following parameters:

6.4 Administration 213



neocom
SOofFtware

Name- Text to Speech x
General Rad Timeout (mmiss): 01:00 El:
Add notificatiq  Text to speech:

... | Descripti| | Retum the radio|

« Sign uut-
1 Cancel

& add K
Work shift duration (hh:mm): 09:00
Autto sign-out:
Motify f the user hasnt signed out before timeout expires: o

Notification recipients

Cancel

= Name
Enter a name for the task.

= C(Click the Add link and from the drop-down list, select either
Text Message or Text to Speech.
In the dialog box that opens, specify the following:
e Timeout
Specify the time, in minutes, before the end of the work shift.
e Text Message /[ Text to Speech

Enter the text of the message (voice message) to be sent to the
selected radio(s).

= Work shift duration
Enter the duration of the work shift, in HH:MM.

= Auto sign-out
Select this option to automatically sign out the user from the radio as
soon as the work shift ends.

= Notify if the user hasn't signed out before timeout expires
Select this option and choose among Notification recipients by clicking
the link below.
6.4.5.25 Screensaver

The Screensaver task is used to launch a screensaver when the dispatcher is
idle for a period longer than the specified timeout. Once started, the
screensaver will be stopped when you click the mouse button or press any
keyboard key, or there is an emergency call or a request to talk.

e To add a Screensaver task, in the Tasks pane, click Add > Screensaver
e Inthe dialog box that opens, specify the following parameters:
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6.4.5.26

= Name

Screensaver X
Name: |Screen Saver
Show screensaver after 30 minutes El:
Background I RoyalBlue -
Foreground [ whiteSmoke |
Text
TRBOnet
(® All Dispatchers
() Selected Dispatchers
Test
oK Canesl

Enter a name for the task.

= Show screensaver after
Set the time of inactivity, in minutes, after which the screensaver will
automatically run.

= Background / Foreground
Select the background/foreground colors for the screensaver.

= Text

Enter the text that will be displayed in the screensaver.

= All Dispatcher / Selected Dispatchers
Select the dispatcher(s) to assign the screensaver task to.

= Test

Click this button to see how the screensaver will look.

Import Objects

o
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The Import Objects task is used to import new objects to the Users database
and Radios database based on the .CSV data files.

e To add an Import Objects task, in the Tasks pane, click Add > Import

6.4 Administration

Objects

Object Import from File

Name: |Impart Objects

General Update Column Mapping

Objects: Radio Users

File Path

‘D: \C5Vusers.cav
Passwords encrypted
Delete ohjects not present in file

Cancel
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In the dialog box that opens, enter the following information:

= Name
Enter a name for the task.

e General tab
= Object Type
From the drop-down list, select into which database to import data

(Beacons, IP Cameras, Map Objects, Map Regions, Map Routes,
Phone Contacts, Radio Users, or Radios).

= File Path
Click the ellipsis (...) button and locate the .CSV file on the same PC with
TRBOnNet Server.

= Passwords encrypted
Select this option if the passwords are encrypted in the data being
imported.

= Delete objects not present in file
Select this option so that objects not found in the .CSV file will be
deleted from the database.

e Update tab

= File Changed
Choose this option so that the specified database will be updated as
soon as the source CSV file is changed. Note that the source .CSV file
must reside on the same PC with TRBOnet Server.

= Scheduler
Choose this option and on the list below select the scheduler to use to
perform the task. Or, click the plus sign button and specify a new
scheduler (see section 6.4.22, Schedulers).

e Column Mapping tab
In the table below, in the right column, enter/change the column names
that would correspond to the database field names.
6.4.5.27 Export Objects

The Export Objects task is used to export objects from the Users database and
Radios database to external .CSV data files.

e To add an Export Objects task, in the Tasks pane, click Add > Export
Objects
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6.4.6

Export Objects to File ot

Name: |Export Objects

Object Type: Radios

Columns: All

Scheduler: |--Nnt selected-- VAR

File Path
D:\CSVyadios.csv

Cancel

In the dialog box that opens, enter the following information:

Name
Enter a name for the task.

Object Type

From the drop-down list, select which database to export (Beacons,
IP Cameras, Map Objects, Map Regions, Map Routes, Phone Contacts,
Radio Users, or Radios).

Columns
In the drop-down list, select the columns to be exported into a .CSV
file.

Scheduler

Choose this option and on the list below select the scheduler to use to
perform the task. Or, click the plus sign button and specify a new
scheduler (see section 6.4.22, Schedulers).

File Path
Click the ellipsis (...) button and locate the CSV file on your computer
(or elsewhere).

Custom Fields

In this section, you can add custom fields that can later be used when
registering radios (see section 6.4.32, Radios, Additional tab) and users (see

section

6.4.28, Users, Custom Fields tab).

e Go to Administration (1), Custom Fields (2)

6.4 Administration

heocom
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File View Map Tools Help

Administration Custom Fields

Iia_;‘ﬁ;ense & + L IE‘ Inbercom EEE AH Call
!~ [ Database i P cCleaners [5][<[@] SN B Firemen
il Systems

A System Bridge Pl Group 20 (][« [@]

@; :h:: Calls / 2 | ~"Custom Fields |
L Ta S Add =) Edit | Sk Delete

{078 Custom Fields
388 Modbus TCP Connections Name 2 Key Type Desaription
22 virtual Modbus Devices || Car make CAR_MAKE Text
DESUDA DESCRIPTION  Text Custom Field >
), voice Dispatch Emai 3 EmaL Email
Name NAME Text bz [car meke

% Location Tracking Phone PHONE Phone Key: [car mae
Plate number PLATE_NUMBER Text Type: |Tm -

Routetinnagemen Description r—

[ ] Text Messages
() meports PE Cancl
]

14|« | 4| Record 10f6 | |m] «]
T Connected £3 B, @ | & Administrator | [28 Licensed to: demo Demo License | @ Active-

e Click the Add button (3).

e Inthe Custom Field dialog box, specify the parameters of the field, such
as its Name, Key, Type (Text, Phone, Email, or Barcode), and Description.

6.4.7 Modbus TCP Connections

TRBOnet Server can receive and send data from/to Modbus hardware and
interact with Modbus data according to desired scenarios. There are two
connection modes between TRBOnet Server and Modbus hardware: Master

and Slave.
To connect TRBOnet Server to Modbus hardware:
¢ Go to Administration (1), Modbus TCP Connections (2):

File View Map Tools Help

Administration odb AR

il Systems A . o) [«
o538 System Bridge 3 1: Line free [«][@] B [ intercom
3 Phone cals 2 [ Jaep 15 ooE WD mEE]
W’l Tasks -
----- o e e fiis [+][e]
~3§2 Virtual Modbus D
oy i Mochus bevices v |[E Add B edit | S Delete
g 2 Manly | Mode IP Address Port SlaveID | Behavior
Il ModBud] Master  192.168.77.10 502
(il voice Dispatch vl ModBusz \Slave s02 1 Custom
=, vLocation Tracking
& 30b Ticketing 3
Route Management
-] Radio Allocation - 1
P
4| 4| 4| Record 1aF2 » [ w4 »
1zro0y & B B & | € Administrator ‘ |8 Licensed to: demo Demo License ‘ @ Active~

e Inthe Modbus pane, click Add (3).

Medbus Cenfiguration be
Name: ModBus_Siave
Mode: Slave =
For: 502 =
Slave ID: 1 D
Behavior: Custom A
e
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o

= From the Mode drop-down list, select the mode of connection.
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o If the 'Slave’' mode is selected, specify the Port of TRBOnet PC and

the Slave ID to assign to this PC.

Leave Behavior as Custom if this connection will be used for Alarm
management.

If the 'Master' mode is selected, specify the Remote Address, Port,
and ID of the Modbus device, which in turn will be running in the
Slave mode.

Medbus Configuration X

Name. [odeus Master
Mose [ —
Pt Addes
Port: 502

ID: il

[ Paralel Requests

=

v Parallel Requests
Select this checkbox so that TRBOnet Server can send multiple
requests without waiting for responses from the Modbus device.

6.4.8 Virtual Modbus Devices

Once you have created the appropriate TCP connection, you can add a Modbus
device:

6.4 Administration

Go to Administration, Virtual Modbus Devices, and click Add.

Virtual Modbus Device X

Name. [Pect |

Description:

Corfiguration: ModBus2

Table: Disretelnputs

< z
ERCIENTS . VN

Edit Filter

=

r

In the Virtual Modbus Device dialog box, specify the following
parameters:

Name

Enter the name of the device.
Description

Enter the description of the device.
Configuration

From the drop-down list, select the slave connection you previously

created for the device (that is, TRBOnet Server running in the Slave
mode).
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Table

From the drop-down list, select the appropriate MODBUS data type
('Discrete Inputs', 'Coils', 'Input Registers', or 'Holding Registers').
In the 'Address/Value' table, enter the appropriate register values.

6.4.9 IP Cameras

This section describes how to connect IP cameras to TRBOnet Dispatch
Console. Once connected, the cameras can be associated with radios, beacons
and other map objects.

¢ Go to Administration, IP Cameras to manage IP cameras in the system.

e Inthe IP Cameras pane, click the Add button.

¢ Inthe IP Camera Configuration dialog box, specify the following

parameters:
[
Description:
{;‘tj;//WDlDWDZZABBM/
: orization
Canca
* Name
Enter a name for the camera.
= Description
Enter a description for the camera.
= URI

6.4.10 Public

Enter the URI for the camera. Note the use of the RTSP:// prefix and
port number 554 (also note that some cameras may have been
configured to use a different port number other than 554).

Protocol
From the drop-down list, select UDP.

Authorization

e User
Enter the user name for the authentication, if needed.

e Password
Enter the password for the authentication, if needed.

Announcements

This section describes how to connect Public Announcement units to TRBOnet
Dispatch Console.

e Go to Administration (1), Public Announcements (2).
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¢ Inthe Public Announcements pane, select the Public Announcements

tab (3).
e Click the Add button (4).

File View Map Tools Help

Administration Public Announcements

(0 Database:

thh Systems

2 System Bridge

&3 Phone Calls

@ Tasks

) Custom Fields

58 Modbus TCP Conections
3¢ virtual Modbus Devices

&l Pubiic Arnouncements

<

>

(1L voice Dispatch

g Location Tracking

@ Job Ticketing

[j Route Management

[] Text Messages

“5] Radio Allocation

L% Admi

P

5
S add

Name

-2

—/

Edit

1

/" Public Announcements | Zones
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(8]

elete

Public Announcement Configuration

Name:

[Public Announcement 1

Description:

Fire Dep's

Extemal ID: [
IP connection:
1P address: 1010101113
Far;

Radio connection:
Cannection Type:

Radio ID.

Swift Option Board 2.0

| 4| 4 [RecordDof o » | |m] <

| 1P connection

Fadio con..,

»

[ Connected &% B B4 | § Administrator | [ Licensed to: demo (Walt) Demo License

@ Active -

In the Public Announcement Configuration dialog box, enter the following
parameters:

Name
Enter a name for the PA unit.

Description
Enter a description for the PA unit.

External ID
Enter the external ID for the Public Announcement unit. This ID will be

used when an announcement is sent to the PA unit from some external
system.

IP connection

IP Address
Enter the IP address of the PA unit.

Port
Enter the port number that will be used for the connection.

Radio connection

= Connection type

Adding Public Announcement Zones

¢ Inthe Public Announcements pane, select the Zones tab.

6.4 Administration

Click the Add button.

From the drop-down list, select how the radio is connected within the
PA unit.

Radio ID
Enter the Radio ID of the PA unit's radio. The Radio ID must be unique
in the radio system.
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¢ Inthe dialog box that opens, click the Main tab.

PAGA Zone Configuration

Main 1 Radios |

MName: |Secur|ty

Description: Security dep

Radio ID 222

% External ID |806

Cancel

Name
Enter a name for the PA zone.

Description

Enter a description for the PA zone.

Radio ID

Enter the Radio ID of the PA zone.

Note: Due to some technical restrictions, this must be the
Radio ID of the existing radio group.

External ID

Enter the external ID for the Public Announcement zone. This ID will be
used when an announcement is sent to the PA zone from some

external system.

e C(Click the Radios tab.

PAGA Zone Configuration

Main Radios

v Pal
7] Paz

Selected: 2

Canced

= Select the desired PA units that will belong to the PA zone.
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6.4.11 Alarm Management

The Alarm Management feature allows you to create rules for Alarms, Emails,
Notifications, Text Messages to radios, and other events. When a configured
rule is executed, the appropriate action(s) will start.

For example, an external application sends some text data, which contains the
text "alarm", to TRBOnet software. The text "Alarm" is configured as the rule to
start sending a predefined voice message (for example, "Alarm in Sector N") to
selected radios (for example, the group "firemen"). As a result, the group
"firemen" are notified about an emergency condition.

e Go to Administration (1), Alarm Management (2) to configure Alarm
Management rules:

File View Map Tools Help

Alarm Management EHIE
: ~ || Bh Add| b Edit (=] Create a Copy | Sk Delete

Name L
v Batteryigvel
W Send DTMi

1

15| event viewer /

= it
[FE— P

M 4| 4 Record 1of2 »|mimi < -
[ Connected &3 & b B Bb B | & Administrator | [ Licensed to: demo (Walt) (Dema License) @ Active -

e Click Add (3) to add a new Alarm Management rule.

Note: The administrator can also create a copy of the existing
Alarm Management rule. Select a rule in the list and
click the Create a Copy button. The system will create a
copy of the rule with the same configuration
parameters.

= Name
Enter a name for the alarm rule.

e On the Sources tab (1), click Add (2) to add an alarm source to the rule.
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Source X
Sources Source: [alarm Mode On

Selectone or mare alar
o soy

Active Group Changed
msoy @ Activated by ar A2 Mode
| (O Activated by se

Aam

Dispatcher Presence Alarm
TMF

[ Do not perfom 'E)msﬂ

(® Al Systems |External Network Connection
Geofencing Rules

© selected Syst| 1ob Ticket Status
Low Disk Space on Server
Modbus (master)
Modbus (dave)
Outdated Radio’s Location
PTT Event

2 Radio Allocation

Radio Status

SCADA Event

SCADA Threshold
- Schedulers

= SMS

Status Message

SWIFT

System Events
System or Site Change
Telemetry

Text Message

Tied Beacon Lost
Timer Status

Voice Call

From the drop-down list (3), select the alarm source to add to the rule.

For a description of the alarm sources, see TRBOnet Enterprise/PLUS
Alarm Management User Guide.

Note: Select the alarm source you want to enable. In case no

source is selected, all configured alarm sources are
disabled by default.

Alarm Management

Name: [Battery Level

Sources || Time Range | Location || Actions

Select one or more alarm sources that wil be monitored.
If two or more alarm sources are selected, the alarm wil be triggered
ditions for any alarm rule are met.
Name Desaiption
| Batterylevel  Active Radios: All; Battery Level: 15%;

] TextMessage  Active Radios: 3; Text: Pre;

Add Edit Delete

=

cel

e Click the Time Range tab to set the time at which the alarm rule will be

applied.

Choose this option so that the rule will be valid all the time.

Selected Time

Choose this option so that the alarm rule will be applied on the
selected days of the week at the selected time.

o Select the days of the week and specify the time ranges.
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¢ Click the Actions tab (1) to set actions for the rule.

6.4 Administration

Click the Location tab.
Under this tab, select the regions inside or outside of which the alarm rule
will be applied. You can also select the beacons in the coverage zone of

which the alarm rule will be applied.

= Regions
Select Enable to add regions to the alarm rule.

heocom
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Note: When COM Port and/or External Network Connection

¢ All Regions
Choose this option to apply the alarm rule inside/outside all map

Beacons
Select Enable to add beacons to the alarm rule.

o All Beacons
Choose this option to add all beacons to the alarm rule.

Alarm Management

Name: [New Rule

am
Sources || Time Range || Location || Actions

Location-based rules trigger actions based on the location of selected devices.
Alarm sources will be moritored if any location-based conditon is met.
Regior
Enable
Radia Location: [nsceregons -]
O AllRegions
(® Selected Regions
Regions: [selecteditems: 1 ]
Beacons.
Enable
O Algeacons
(® selected beacons
Beacons: [selecteditems:2 -]
¢

Radio Location
From the drop-down list, select whether the alarm rule will be
applied Inside Regions or Outside Regions.

v Regions
In the list, select the region(s).

v' Beacons
In the list, select the beacon(s).

Selected Regions
Choose this option to apply the alarm rule only inside/outside
selected regions.

Selected Beacons
Choose this option to add only selected beacons to the alarm rule.

are selected as the alarm source, the Location rule
won't be applied.
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In the Actions list, the administrator can add and configure actions to be
executed when the events configured and selected in the Sources page
are triggered.

e Click Add (2) to add an action:

A ° Action x
Actons Aetion Type: Alarm Escalaton [~

Select one or more actions that will be performed wh
the order shown

Aam name Alarm Management Ruie:
Beacon: Edit Properties
Camera in New Window

‘ Name / ‘ DESTDU] o source oaay
Dispatcher: Notification
Descrption Dispatcher: Show Picture
Dynamic Regrouping
2 Email 3
Geofencing Ruies
=i Job Ticket: Create and Assign
one Worker
‘ Desaription Map Object: Create New
Map Object: Delete Existing

Map Object: Edit Properties

Modbus

Phone Call Establishment.

Radio: Disable

1 Radio: Link Teltoniks Device
di ate Call

acio
adio: Ret Location
acio: Sel
Radio: Set Logical Groups
Radio: Set Radio Groups
=3 32 Radio: Unlnk Teltonika Devices
Request To Tak
RFID Signal: Emergency Contact
RFID Signal: Supervisor
-~ 13 Route

Scada
L] Gearacknontedgs o % ch otication

Repeat this many times

T

to External IP Data Source
sws

Swift Agent Telemetry
Command -
System Bridge
Task Management
Telemetry

Text Message
Text to Speech

User Activity
Virtual Modbus Device
Voice Message

= Action Type
From the drop-down list (3), select the action type.

For a description of the action types, see TRBOnet Enterprise/PLUS Alarm
Management User Guide.

Note: After you configure the alarm rule, enable it by selecting
the checkbox beside it. In case when no alarm rule is
selected, the action will not be started.

File View Map Tools Help

Administration ent/Ala anageme &[]

B * | IR iercom ()@ JC 1 i fee OE) WL B
- é Datebase [ Grow 10 DaE) (vEXE poE (VErE DE)
j Systems.
B4 System Bridge [Iprivate call [+1]
: @;:h": s =k Add 5} Edit 5] Create a Copy | Sk Delete
@ T
232 Virtusl Modbus Devices Name a
() Alarm Management o || [ New Event
Send DTMF
{4)} Voice Dispatch
Location Tracking
4 0b Ticketing
Route Management
@ RFID Tracker
[] Text Messages
ﬁ Voice Recording
Event Viewer
., Administration
|« «|Record20f2 » | w|wi[ <] D
127001 & B, | § Administrator | [28 Licensed to: dema Demo License | @ Active-
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6.4.12 Telemetry

On the Telemetry configuration page, you can configure settings for
Telemetry.

6.4.12.1 Radio Groups Telemetry

This is a default telemetry profile that is used to send telemetry commands to
radio groups.

e Inthe Administration pane, click Telemetry > Radio Groups Telemetry.
¢ Inthe Telemetry configuration pane, click Edit.

File View Mop Tools Help

Administration eleme onfiguratio 15D
2 intercom [2][«][@] Bl % 1 Line free [<][@] B[ Jancal [][«][e]
¥ Group 10 [][<][@] ¥ P Group 20 [[<][@] I P Group 30 B[«][@]
[JPrivate call [2][=][@]
) Edit
v
v Type:
Radio Groups Telemetry
V4 Digital Outputs

() VIO1: VIOL: High
(® VIOE: VIO2: High |
@ VIO3: VIO3: High
(@ VIO4: VIO4: High
@ VIOS: VIOS: High k

127001 &3 @ | § Administrator | [A Licensed to: demo Demo License | @ Active~
Radio Group Telemetry x
Telemetry Type: MOTOTRBO
Profile Name: Radio Group Telemetry
Route type: Regular |

Digital Outputs
pie Name Commant d
vio1 VIO1: High level High level
vioz VIOZ: High level High level
vio3 VIO3: High level High level
vio4 VIO High level High level
vIos VIOS: High level High level
Description
D: VIO1 ~|
Name: |
Comman o High level =
Apply
= Add [Zkremove
cnce

= Click Add and specify ID (VIO), Name, and Command (signal level).

Note: For Radio Groups Telemetry only the Digital Outputs
tab is available.

6.4.12.2 Adding Telemetry Profile for Radios
e Go to Administration (1), Telemetry (2), and click Add (3):
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File View Map Tools Help

Administration eleme &)
B prone coe * | B ntercom 2] M5 iLne free EE) @I Pl
@ Tad
+f2 Virtual Modbus Devices Group 10 M Grown 20 [«le] [«le]
[} Event/Alarm Management
(8] Swift Event Profies [_JPrivate Coll [l

=
L Add |5 Edit | Ek Deler
£ Radio Groups Telemetry E‘—"} 2| ezza
L Telemetry #1
y Type:
(i Voice Dispatch Auto refresh inputs: Disabled
(22 tocation emc Digital Inputs
= 3 @ VIOL: Telemetry VK1 (High level)
& VIO2: Telemetry VK2 (High level)
W Job Ticketing @ VIO3: Telemetry VK3 (High level)
(D VIO: Telemetry VK4 {High level)
- @ VIOS: Telemetry VKS (High leve)
o Digital Outputs

i VIOS: VIOS: Low level (Low level

@ RFID Tracker ® t h

[ Text Messages

Q Voice Recording

Event Viewer

(7] Radio allocation / 1

g =

127001 &3 @ | & Administrator | (8 Licensed to: demo Demo License | @ Active-

= Telemetry type

Telemetry Profile X

Telemetry type:

Profile name:

Telemetry #2

oret_|

From the drop-down list, select one of the following types:

¢ MOTOTRBO - telemetry from Motorola radios.

¢ Socintech Novox - telemetry from Novox devices connected to the
radio via COM port.

¢ Swift Option Board - telemetry from the option board connected to

the radio.

e Sprite - telemetry from Sprite devices.

Note: Sprite telemetry profile can be read but not written.

= Profile name

Enter the name of the profile to display in the Dispatch Console.

= Click OK.

Auta request input states

Trace digital inputs
Trace analog inputs

RFID

Requestinterval:  [600 =] secon

[ Replace status events with VIO events

d

Telemetry #1 X

Telemetry Type: ~ MOTOTREO

Profie Name [Tetemetry =1 ]

Route type: [Requiar E|
Common Digital Inputs  Digital Outputs
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Common tab

= Auto request input statuses
Select this option and in the Request interval box specify the time
interval, in seconds, to request input data.
= Trace digital inputs
Select this option to monitor digital input damages.
= Trace analog inputs
Select this option to monitor analog input damages.

= Replace status events with VIO events
Select this option to generate VIO ON/OFF event when the system
compares between the last and the current statuses of the VIO.

Note: Most of the policies are set to replace events, so it is
recommended to enable this option.

Digital Inputs tab

Telemetry 21 X

Telemetry Type: MOTOTREQ

Profile Name: [Telemetry =1 ]

Route type: [Reguiar |

Common  Digital Inputs. | Digital Outputs

ame Event
vIo1 @ Telemetry VK1 High level

]
vio2 & Telemetry VK2 High level
vio3 @ Telemetry VK3 High level
Vio4 @ Telemetry VK4 High level
Description - =
: [z -]
|Te\emeuy Kz ‘
Reset Name [ |
Event: [Honleve -]
Severity: &, waming -

Display as radio status

Apply

e Click Add to add a VIO (Virtual Input/Output) to the profile.
= ID
Select the VIO to set the parameters for.
* Name
Specify a name for the VIO to be displayed in the Dispatch Console.
= Event

Select the signal level of VIO events from the drop-down list. When an
event with the selected signal level occurs on the selected VIO, the
telemetry will be activated. The signal level must be the same in the
radio's codeplug and in Telemetry configuration in TRBOnet. It is a
programmable option that sets the pin's voltage level to High or Low
in order to trigger a selected functionality.

= Severity

Specify a severity level for the VIO event from the drop-down list.
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= Display as radios status
Select this option so that the radio will change its status after it sends
the telemetry command.

= Auto reset status
Select this option to automatically reset the telemetry VIO after the
radio sends the telemetry command.

= Request location of radio
Select this option to request a GPS position of the radio after it sends
the telemetry command.

= Click Apply to apply settings to selected inputs.

Digital Outputs tab

Telemetry 21 X

Telemetry Type:  MOTOTREO

Profile Name: Telemetry #1

Common  Digital Inputs  Digital Outputs

D Name Commane d
Vot VIO1: High level High level
vioz VI02: Low level Low level
Vo3 VIO3: High level High level
Vo4 V104 Toggle Toggle level

: vios 2
Name: [
Commarnd d: High level A
Apply
= Add =(Remove

cancel

e Click Add to add a VIO (Virtual Configured PIN) to the profile:
= ID
Select the VIO in the dropdown list to set its parameters;
* Name
Specify a name for the VIO to be displayed in the Dispatch Console.
= Command
Specify a signal level for the command to send to the selected VIO.

= Click Apply to apply settings to selected outputs.

6.4.13 Text Messages

On the Text Messages configuration page, you can configure settings for Text
Messages.

6.4.13.1 Group Text Messages

This is a default text message profile that is used to send text messages to
radio groups.

e Click Group Text Messages in the Administration pane.
¢ Inthe Text Messages configuration pane, click Edit.
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¢ Inthe dialog box that opens, change the desired parameters.
For a description of the profile parameters, see section 6.4.13.2, Adding
Text Message Profile.

6.4.13.2 Adding Text Message Profile
e Go to Administration (1), Text Messages (2), and click Add (3):

File View Map Tools Help

Administration Text Messages configuration B

22 virtual Modbus Devices ~
57 1P Cameras
{58 Aiarm Management
=L Telemetry
{8 Racio Groups Telemetry

& ﬁm‘"‘“‘agss\_ [ Add 5 Edit | Bk Delete
{5 Group Text Messages 2 =

- (51 Radio Statuses Y

Profile Type: MOTOTRBO
(1Y voice Dispatch Data protocol M1 Proprietary
Text Message format ‘Sender and Text
140

‘Spit long message inte muliple messages:  No
essages Profile X

3

@ Location Tracking

4F 0b Ticketing

nnngmnaa:mn
[ Text Messages

-
§ voxssacotng (o 1o |
1

MOTOTREQ |+

[MoTOTRED

[1] retemetry Ve
P——

[ Connected &3 B B4 B | 8 Administrator | [ Licensed to: demo Demo License @ Activer

¢ Inthe Text Messages Profile dialog box, specify the following
parameters:

= Profile type
From the drop-down list, select one the two items:

e MOTOTRBO
Select if the radio itself is used to send/receive messages.

e Mobile Messenger (BT Accessory)
Select if the Bluetooth Communicator is used together with the

radio to send/receive messages.

= Profile name
Enter a name for the text profile.

= Click OK.
Text Messages #1 x

Profile Type: MOTOTREO
Profile Name: |Text Messages #1
Data protocol: ‘MSI Proprietary j
Route type: [Requiar E
Text Message format: ‘Sander and Text j
Custom format: [{sender} |{Text:

Maximum message length: 140 El: chars

[ 5plit long message into multiple messages

e
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¢ Inthe Text Messages Profile dialog box, specify the following
parameters:

= Profile Name
Enter a name for the profile.

= Data protocol
From the drop-down list, select one of the two items:

e MSI Proprietary
Select if the radio is equipped with a display and supports the new
Text Messaging service.

¢ DMR Standard
Select if the radio is equipped with a display and supports DMR
Compatible text messages.

= Route type
From the drop-down list, select one of the three items:

e Regular
Select this type to receive messages on the radio.

e Option Board
Select this type to receive messages on the radio's option board.

¢ Non-IP Peripheral
Select if the radio is connected to a PC via a USB port.

= Text Message format
From the drop-down list, select one of the pre-defined formats for text
messages, or select the Custom format.

= Custom Format
Enter your own format for text messages in this box if you have
selected 'Custom' from the list above. The Custom Format will default
to {Sender} | {Text}. There are four choices: {Sender}, {Text}, {Date},
and {Time}. Another example would be: {Date} | {Time} | {Text}.

= Maximum message length
Enter the maximum number of characters that TRBOnet will send per
text message. The recipient of the text message may not be able to
receive the maximum number of characters due to its design
limitations. Therefore, it may only display a partial text message.

= Split long message into multiple messages
Select this option to allow single messages to be split into multiple
messages based on the Max. message length setting.

6.4.14 Request To Talk

This section describes how to configure the Request-To-Talk parameters.
e Go to Administration (1), Request To Talk (2).
e Inthe Request To Talk pane, click the Edit button.
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e Inthe dialog box that opens, specify the following parameters:

Request To Talk >

General | Notifications

{+ Show RTT notifications in a pop-up window

Actions: Accept, Select PTT, Queue, Reject j
" Add RTT to queue automatically
I¥ show notification in the Windows tray

I¥ Apply RTT theme to PTT Box

Callback destination: |Private Call j
" Mark RTT as processed after dispatcher returns call

¥ Mark RTT as processed after successful callback

" Don't automatically mark RTT as processed

¥ Automatically delete RTT records after processing

Expiration imeout: |30 El: minutes

Cancel

= Show RTT notifications in a pop-up window
Choose this option so that Request to Talk messages will pop up over
the application window.

Request To Talk
Radio 235

CE
The Request To Talk has been received

Accept Queue Reject

e Actions
In the drop-down list, select the buttons that will be available in the
pop-up box. If necessary, modify the button captions.

|Accept, Select PTT, Queue, Reject |—-
Caption Action
E Respond to RTT
v |SelectPTT Select the PTT box for a responze
v | Queue Queus RTT
[~ |Hide Hide RTT for time
v |Reject Reject RTT
[ |cancel Cancel RTT j
x| 4

e The button captioned Accept means that an incoming RTT will be
immediately responded by the dispatcher.

e The button captioned Select PTT means that an incoming RTT will
not be responded to immediately. Instead, a dedicated PTT box
(Private Call, Group Call, or All Call, depending on what is chosen as
the callback destination) will be selected as the default PTT box, and
the callback transmission will start as soon as the external PTT
button is pressed.
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e The button captioned Queue means that an incoming RTT will be
queued and can be processed later.

e The button captioned Hide means that an incoming RTT will be
hidden for the dispatcher for the time period selected from the
drop-down list. Note that the RTT will be displayed for all other
dispatchers.

e The button captioned Reject means that an incoming RTT will be
rejected by the dispatcher and displayed for all other dispatchers.

e The button captioned Cancel means that an incoming RTT will be
rejected and not displayed for all other dispatchers.

= Add RTT to queue automatically
Choose this option so that all incoming requests to talk will be
automatically queued and can be processed later (see Activity Monitor
Panel, Requests To Talk tab).

= Show notification in the Windows tray
Select this option so that a notification will be displayed in the Windows
tray when a Request to Talk arrives.

= Apply RTT theme to PTT box
Select this option so that a special color theme (pink background, by
default) will be applied to the associated PTT box when a Request to
Talk arrives.

= Callback destination
From the drop-down list, select where to transmit when answering to a
request to call. You can select either Private Call, Home Group, Active
Group, All Call, or one of the registered Radio Groups.

Note: If the Home Group is selected, and the Home Group is
not specified for the radio that initiated a Request to
Talk, then the response to this Request to Talk will be
made as an All Call.

= Choose one of the following three options:

e Mark RTT as processed after dispatcher returns call
Choosing this option means that a Request to Talk will be
considered processed after a dispatcher makes the return call.

e Mark RTT as processed after successful callback
Choosing this option means that a Request to Talk will be
considered processed only after the radio has responded to the
return call.

e Don’t automatically mark RTT as processed
Choosing this option means that a Request to Talk will be
considered processed only after a dispatcher manually marks it as
processed.
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= Automatically delete RTT records after processing
Select this option to automatically delete RTT records after they are
processed.

= Expiration timeout
Enter the time, in minutes, during which unanswered requests to talk
will be stored.

On the Notifications tab, specify the following parameters:

Request To Talk X
General | Notifications

¥ send notifications to caller
% Autodetect notification type
" Send text messages
" Send voice messages

Text message notifications:

Queued: |Ca|| queued

Rejected: |Ca|| rejected

Mot available: |Dispat-:her is unavailable

Cancsl

= Send notifications to caller
Select this checkbox to notify the radio when a request is rejected,
queued, or the dispatcher is unavailable.

e Choose one of the buttons below to specify the way the radio is
notified.

v" Autodetect notification type
Choose this option button so that the type of notification will be
selected automatically depending on whether or not the Text
Messages Service is enabled on the radio.

v Send text messages
Choose this option button to send text notifications to the radio.

v Send voice messages
Choose this option button to send voice notifications to the radio.

¢ In the Text message notifications boxes, enter the corresponding
text notifications. These texts will be used when sending text
notifications to the radio.

6.4.15 Radio Statuses

In TRBOnet Dispatch Console, you can configure different profiles for the radio
statuses that are received from or sent to the radios.
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e Go to Administration, Radio Statuses. You can see the default Radio
Status profile settings in the Radio Statuses pane.

To add a Radio Status profile, click the Add button, and in the dialog that
opens, specify the required statuses to be received from the radios (Receive
tab) and sent to the radios (Send tab).

6.4.16 Location Profile

The Location Profile feature allows configuring different profiles of location
update settings for built-in GPS receiver. Location Profile overrides default
location trigger configuration in Server settings. For example, fire emergency
service has a number of departments in a city and needs to monitor current
position of radio subscribers (firemen). The administrator can create multiple
separate location profiles with different location tracking settings for each
department.

Note: The Location Profile feature is available for MOTOTRBO
Generation II radios, firmware version 2.4 or later.

e Go to Administration (1), Location Profile (2). You can see the default
Location Profile settings (3) in the Location Profile pane.

File View Map Tools Help

Administration Location Profile &)
Ly Telemetry ~ <
(] Text Messages [\2 1: e fee [ @ [ntercom @@
% Request To Tk 2 [ Mrepcote +1: ot +1 [31][3] [@] ) | B Repeater +1: 5ot 52 (][] [@] )
[ER] Locatio =L Add =) Edit Delete
[ " Profile type: MOTOTREO
+.[7 Mobile Client Profile (TREGnet Commu rofile type:
[ Teltonka Profile
5 Torke i Channel type: Non-scheduled (Regular GPS over Voice or Data Rever Channel)
Channel prorty: Wixed Mode
T Postioning mode: iBeacon Indoor/Otdoor
GPS data Latiude. Longtude, Diection, Speed, Precision
{Beacon dta No
g Location Tracking
Fast GPS on Connect Plus systems: No
@ Job Ticketing Periodic updates: Interval 30.0sec
Distance-based updates Distance 1000 meters, update interval 10 sec
Ej Route Management On emergency Yes
[] Text Messages
ﬁ' Voice Recording

C% Reports
Event Viewer
3

L% Administration

[ Connected &3 B B B B4 | 8 Administrator | [ Licensed to: demo (Walt) (Demo License) @ Active~

1

There is a default Location Profile that the administrator can use and edit.
The administrator can do the following:

1. Use default location profile.

2. Create a custom location profile: Add button.

3. Edit a profile: Edit button.

Note: In the default profile, the Name and Description
cannot be changed.
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6.4.16.1

6.4 Administration

Adding Location Profile
In the Location Profile pane, click the Add button.

Location Profile x
Profile type: MOTOTRBO [+
Profie name:

. F5 5000
Location Profile #4 | Extended device

= Profile type
Select the Profile type (MOTOTRBO, FS 500, or Extended device).

* Profile name
Enter the name of the profile.

In the Location Profile dialog box that opens, click the General tab.

Lecation Profile (MOTOTRBO) X
General | |Location Updates | Management
Name: ‘Lucahun Profile #1
Description: |
Channel type: [Mon-scheduied (Regular GPS aver Vaice or Dat... -]
Channel priority: [ixea Mode (recommended) -
Protocol type: [LrrP (Location Request and Response Protocal) -|
Positioning mode:  [Beacon Indoor Outdaor B
v GPs data: |Laﬁb_|de, Longitude, Precision, Direction, Speed j
[ iBeacon data: |Ma]m + Minor J
1 =
I Fast GPS on Connect Plus systems
oK Cancel

Name
Specify a name for the location profile.

Description
Add a description for the location profile.

Channel type
From the drop-down list, select a radio channel for sending location data
to TRBOnet Server:

= Non-scheduled
This is a channel with regular GPS (Enhanced GPS not supported).

= Scheduled
This channel is available when the Enhanced GPS feature is configured
in the radio system.

= Non-scheduled with CSBK data
This channel allows using CSBK (Control Signaling Block) while
decoding.
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= Scheduled with CSBK data
This is a channel with Enhanced GPS, which allows using CSBK (Control
Signaling Block) while decoding.

Channel priority
From the drop-down list, select the channel that will be used by location
triggers when both LMR and broadband channels are available.

= Mixed Mode (Recommended)
Location triggers are used for broadband and LMR channel
simultaneously.

= Broadband Channel
Location triggers are used for the broadband channel if available, and
for the LMR channel if the broadband channel is not available.

= LMR Channel
Location triggers are used for the LMR channel if available, and for the
broadband if the LMR channel is not available.

Note: If you have entered the polling interval (Triggers tab,
Periodic trigger > Interval) that is not supported for
the selected channel, the closest larger value will be
used.

Protocol type
From the drop-down list, select the protocol with which to send GPS data.

= LRRP (Location Request and Response Protocol)
= LIP (Location Information Protocol)

Note: The LIP protocol is supported on IPSC systems only.

Positioning mode

This option determines which GPS coordinates to show on the map and
display in the radio's movement history when TRBOnet Server receives a
data packet containing both iBeacon and GPS data.

= jBeacon Indoor/Outdoor
The coordinates of the iBeacons will be positioned on the indoor and
outdoor maps.

Use case: When a person enters a building, the accuracy of
the GPS location reported by their radio is likely to
deteriorate. This may cause TRBOnet to show the
radio's location outside the building. Using
coordinates of iBeacons positioned on the floor
plan will prevent this from happening, and the
route travelled by the person will also be correct.
This is especially useful for reinforced concrete or
high-rise buildings.
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= iBeacon Indoor/GPS Outdoor
The coordinates of the iBeacons will be positioned on the indoor map
while the coordinates of the radio will be positioned on the outdoor
map.

Use case: This option is used to show the route travelled by
the person based on the GPS coordinates received
from their radio rather than from a detected
beacon, or when the speed and/or altitude of the
device are used for some purpose. The user's icon
will appear on the map twice, one icon will show
their actual GPS location, whereas the other icon
will appear over a detected beacon. Only iBeacon-
based location will be displayed on the floor plan.
When the radio's GPS coordinates become
unavailable, the user's icon will be displayed over
the detected beacon on both the map and the floor
plan.

= iBeacon Indoor/No Outdoor
Only iBeacon-based location tracking will be used, GPS coordinates of
radios and iBeacons will be ignored.

e GPS data
Select this option to enable the user to select what GPS readings to send
to TRBOnet Server. In the drop-down list, select which GPS data to include
in a packet.

e iBeacon data
Select this option to enable sending iBeacon data to TRBOnet Server. In
the drop-down list, select which iBeacon data to include in a packet:

= Major, Minor (included by default and cannot be disabled)

= UUID
iBeacon's Universally Unique Identifier

= TX Power, RSSI
The strength of the beacon's signal as seen on the receiving device.

e Number of iBeacons
Specify the number of the most recently detected iBeacons whose data
will be included in the data packet sent to TRBOnet.

6.4 Administration 239



neocom

©

software

Location Updates tab

Locatien Profile (MOTOTREQ) X

General | Location Updates | Management

[ Periodic updates

Interval: 3000 = second

¥ Distance-based updates

1000 3: meters
10 =] second

Distance:
Min interval:
¥ On emergency
[¥ Activate alarm mode for radios sending emergency updates
[~ GPIO-based updates
Inband location updates
[ On every voice transmission

[~ On emergency voice transmission

0K Cancel

Periodic updates

Select this option to set a periodic location trigger on a radio. The trigger
is a request to the radio to send its GPS and/or iBeacon data at the
specified time interval.

= Interval
Specify the location update interval, in seconds.

Distance-based updates
Select this option to allow receiving location updates by a distance:

= Distance
A radio will send location updates if the travelled distance exceeds a
specified distance from the last GPS point, in meters.

= Min. interval
A radio will send location updates no more than once within this time
interval, in seconds.

On emergency
Select this option so that a radio will send GPS and/or iBeacon data upon
entering the emergency mode.

= Activate alarm mode for radios sending emergency updates
Select this option if you want a Dispatch Console operator to see the
emergency status of a radio that transmitted location data.

GPIO-based updates
Select this option so that a radio will send GPS and/or iBeacon data upon
sending a Telemetry command.

Inband location updates

240

On every voice transmission
Select this option so that a radio will send GPS and/or iBeacon data every
time the PTT is pressed and held more than 5 seconds.
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e On emergency voice transmission
Select this option so that a radio will send GPS and/or iBeacon data every
time the PTT is pressed in the emergency mode.

Management tab

Locatien Profile (MOTOTREO) *

General | Location Updates | Management

|¥ Save GPS data to database

¥ Automatic error correction
Configure

I"" Location update settings are managed by dispatcher only
(recommended if Save LRRP is enabled in radio’s codeplug)

GPS restart by inactivity imeout: |10 El: minutes

0K Cancel

e Save GPS data to database
Select this option so that GPS data is saved in TRBOnet database.

e Automatic error correction
Select this option to enable automatic error correction to detect and
correct invalid GPS data.

Click the Configure link to specify the GPS parameters to be corrected:

Automatic error correction X

In some situations, speed and location values from the GPS receiver may
be erratic or unreliable. Use the settings below to apply automatic error
correction to the GPS data feeds.

Discard GPS data if

km/h

+ | Location accuracy worse than: 50 meters

I

| GPS time error greater than: 30 minutes

Coordinates have duplicates

Set speed to 0ifitis less than: 1] km/h

Defaults Cancel

Discard GPS data if

= Speed greater than
Select this option and enter the maximum possible speed of your
vehicles. As a result, the coordinates with speeds that exceed the
maximum limit will be discarded.

= Location accuracy worse than
Select this option and enter the largest distance for the accuracy of the
GPS receiver. As a result, the coordinates with distances that exceed
the maximum limit will be discarded.
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6.4.16.2

= GPS time error greater than
Select this option and enter the largest allowable time error, in
minutes. As a result, the coordinates with time errors that exceed the
maximum limit will be discarded.

= Coordinates have duplicates
Select this option to remove duplicate coordinates from the GPS data.

= Set speed to 0 if it is less than
Select this option and enter the low-speed threshold. Speeds below
this threshold will be considered as zero by the server.

e Location update settings are managed by dispatcher only
(recommended if Save LRRP is enabled in radio's codeplug)
Select this option so that Location updates can be started/stopped only
manually by the dispatcher.

= GPS restart by inactivity timeout
Enter the time interval that will be used by the server to send the GPS
Start Trigger request to the online subscriber radio if there has been

no GPS activity.

Applying Location Profile to a radio:

click Edit (3):

File View MWap Tools

Go to Administration (1), Radios (2), select the radio in the table, and

= Logical Groups a7 i [ Unregistered
1) radio Groups & Add Group | 5} Add Digital Radio =5 Add Range
T vevice Lets Rado Name Type Radio D
8 Rados v || @ tmtzso Telonika 1
< (® rado 235 Digitel Radio 235
® =3 TREONet Moblle 3333
(i voice Dispatch ® 2 TREOnet Moblle 4444
(® Rado 125 Dirital Radio 125
@ i & Add Group
=, Add Digital Radio
S 3ob Ticketing B, AddRange
. =, Add TREOnet Mobile
Ej Beuzblanzaement Z, Add TRBO.SOS
=l Add WoC Radia
[ Text tessages S, Add WAVE 5000
(2 resoris =l Add Teltonika
\p Repol 3
ﬂi Event Viewer ;; Delete
Unlink Teltonika I~

73] Radio Allocation

I_% Administration

Wi«| ([ Record Sof 5 kW W <

=L Add TREOnet Mobile 55 Add TREO.S0S | <0¢ Unlink Teltonika 2

MDCID
0

0
0
0

User's Extenson...| Radio Groups | Logical Groups ¥
Al
1

333

B Connected &3 & & B | 8 Administrator | [28 Licensed to: demo (Walt) (Demo License)
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Voice Dispatch 125 X

General | Logical Groups | Additional| SIP Account| Cameras | Teltonika |

Radio Name: 125 |

Radio ID: 125 | mpcip: 0

Radio Groups: Al ~[+]

Home Group: |CI eeeeee |+ ‘

Use icon: | @ Portzble Radios v+ -]

Extended Device:  |None ~ Test | A

Location Service

Location Source:  |Built-n GPS receiver |

Location Profile: |[Defau\t) |v ‘ + |

\ (Default)
| Location Profile #1
Telemetry Service

TLM Seurce: [Buittin Telemetry ~]

TLM Profile: pefauy ~[+]

Text Messages Service

TME Tuma: [atandard ~l
Hide Advanced Settings

Cance

= (Click the General tab, and from the Location Profile list select the
location profile to use for the radio.

= Select/clear the Location Enabled checkbox to enable/disable the
location trigger.

Note: The Location Profile is only applicable when the 'Built-in
GPS receiver' or 'Extended device' (if any) is selected in
the Location Source.

6.4.17 Mobile Client Profile (TRBOnet Mobile)

The Mobile Client Profile feature allows configuring different location profiles
that can be applied to the Mobile Client app running on a smartphone. For
information on how to register a TRBOnet Mobile app, see section 6.4.32.2
Adding TRBOnet Mobile. For more details on TRBOnet Mobile, refer to TRBOnet
Mobile User Guide.

¢ Go to Administration, Mobile Client Profile (TRBOnet Mobile).

You can see the default TRBOnet Mobile Profile settings in the Mobile
Client Profile pane.
6.4.17.1 Adding TRBOnet Mobile Profile
¢ Inthe Mobile Client Profile pane, click the Add button.

e Inthe Mobile Client Profile (TRBOnet Mobile) dialog box, specify the
following parameters:

= Profile Name
Enter a name for the mobile client profile.

= Available Modes
In the drop-down list, select/deselect the features that will be available
to the associated Mobile Client.
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Mobile Client Profile (TRBOnet Mobile) X

Profile Name: [ mRecnet Mobie £1

Client Type: [TRe0net Mabile

Ledled

Avaiable Modes:  |¥oice Calls, Text Messages, Location, Job Tickets

Calls | Location| Alarms| Channels| Extras|

Remote Monitor
Timeout: [o 2] seconas
Private Calls
Half-Duplex Calls
Full-Duplex Calls
Group Calls
Phone Calls
Allow Outgoing Calls

[] Record audio on PoC devices

[ Delete all previous recordings on PoC devices (this process cannat be reversed)

Defauts Cancal

e Click the Calls tab.

= Remote Monitor
If you select this option, the dispatcher will be able to activate the
mobile device's microphone in hidden mode.

Note: The Mobile Client app running on iOS 13 and later must
be in the foreground and the screen must be on for this
feature to work.

e Timeout
Specify the remote monitor duration, in seconds.

= Private Calls
Select this option to allow the Mobile Client app to make private calls.
In addition, you can select to allow:

e Half-Duplex Calls
e Full-Duplex Calls

= Group Calls
Select this option to allow the Mobile Client app to make group calls.

= Phone Calls
Select this option to allow the Mobile Client app to make and receive
phone calls.

= Allow Outgoing Calls
Select this option to allow the Mobile Client app to make outgoing
calls.

Note: If this option is cleared, the Mobile Client app will still be
able to send RTTs and respond to incoming radio calls
within the call hangtime.

= Record audio on PoC devices
Select this option to save audio recordings on mobile devices running
the Mobile Client app.
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= Delete all previous recordings on PoC devices
Select this option to delete all previous audio recordings from mobile
devices.

e Click the Location tab.

= Show locations of other devices
Select this option so that the Mobile Client app will receive locations of
other radios (mobile clients).

= Use GPS location
Select this option to enable sending GPS data to TRBOnet Server.

e Periodic interval
Specify the time interval, in seconds, that will be used to send GPS
location data.

o Emergency interval
Specify the time interval, in seconds, that will be used to send
emergency messages.

e Save GPS data to database
Select this option so that GPS data is saved in TRBOnet database.

e Automatic error correction
Select this option to enable automatic error correction to detect and
correct invalid GPS data. Click the Configure link and specify the
GPS parameters to be corrected.

= Use Indoor location
Select this option to enable sending iBeacon data to TRBOnet Server.

e Periodic interval
Specify the time interval, in seconds, used to send iBeacon location
data.

o Emergency interval
Specify the time interval, in seconds, that will be used to send
emergency messages.

¢ Number of iBeacons
Specify the number of the most recently detected iBeacons whose
data will be included in the data packet sent to TRBOnet.

e iBeacons filter
Click the Add link and enter the UUID of the beacons that will be
used by the mobile client.

Note: If you don't specify the iBeacon UUID, the Mobile Client
app running on an iOS device won't detect any
iBeacons.
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e Positioning mode
This option determines which GPS coordinates to show on the map
and display in the device's movement history when TRBOnet Server
receives a data packet containing both iBeacon and GPS data.

v iBeacon Indoor/Outdoor
The coordinates of the iBeacons will be positioned on the indoor
and outdoor maps.

v iBeacon Indoor/GPS Outdoor
The coordinates of the iBeacons will be positioned on the indoor
map while the coordinates of the device will be positioned on the
outdoor map.

v iBeacon Indoor/No Outdoor
Only iBeacon-based location tracking will be used, GPS
coordinates of devices and iBeacons will be ignored.

= Allow users to disable location services
Select this option so that users will be able to disable location services
on their Mobile Client apps. To disable location services on a Mobile
Client app, go to Settings > Power Saving > Position Accuracy > No
location and GPS.

e C(Click the Alarms tab.

= Emergency Button
Select this option so that the Mobile Client app will be able to send
Emergency Alarms to the Dispatch Console.

= Sensor Alerts
Select the desired sensor alert buttons (Man Down, No Movement,
Shake Detection) to be shown in the Mobile Client app.

= Show alarms from other devices
Select this option so that the Mobile Client app will receive alarms from
other radios (mobile clients).

= Allow users to enable or disable selected sensor alerts
Select this option so that the mobile app users will be able to enable or
disable selected sensor alerts.

Note: If this checkbox is cleared, the selected sensor alerts will
always be activated on mobile app devices and cannot
be deactivated by mobile app users.

e C(Click the Channels tab.
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Mobile Client Profile (TREOnet Mabile) x
Profile Hame: [iDefaui)
Cliert: Type: [TREcnet Mabile =
Availzble Modes:  [Voice Calls, Text Messages, Location, Job Tickets E|
Calls | Location | Alarms  Channels | Extras |
Home | Manitor | Name System Group
1, Q Al cal Intercom all Cal
2 @ Wl Edroup L1 CPL Group 11
qRadd g lnsert X Delete A Up  Dow
Allow users to change Home Group
Allow users to select channels to monitor
Defaults Cancel

= Inthe table, choose the Home Group channel on which the mobile app
will transmit if the user presses the PTT button (Home). You can also
check channels to be monitored (Monitor). To add/insert a channel
(Radio Group) to the table, click the Add/Insert link and specify the
Name, System and Group.

= Allow users to change Home Group
Select this option to allow users to change Home Group in their Mobile
Client apps.

= Allow users to select channels to monitor
Select this option to allow users to select the channels they can listen
to in their Mobile Client apps.

e C(Click the Extras tab.

= Battery Level
Select this option so that the smartphone's battery level will be sent to
the Dispatch Console.

Note: Mobile apps send the battery information as soon as
they are connected to TRBOnet. After successful
connection, mobile apps pass the battery level to the
server with every location update, voice transmission
and text message. Regardless of its activity, a mobile
app will update the battery charge level when it goes
down to 90%, 80%, 70%, 60%, 50%, 40%, 30%, 20%, 15%,
10%, 5%.

= Do Not Disturb
Select this option so that the DND mode will be enabled on the Mobile
Client app.

6.4.18 Mobile Client Profile (TRBO.SOS)

This section describes how to configure the profile for the TRBO.SOS
application running on a smartphone. For information on how to register a
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TRBO.SOS app, see section 6.4.32.3, Adding TRBO.SOS. For more details on
TRBO.SOS, refer to TRBO.SOS User Guide.

¢ Go to Administration, Mobile Client Profile (TRBO.SOS).
You can see the default TRBOnet SOS Profile settings in the Mobile Client
Profile (TRBO.SOS) pane.
6.4.18.1 Adding TRBO.SOS Profile
e Inthe Mobile Client Profile (TRBO.SOS) pane, click the Add button.

e Inthe Mobile Client Profile (TRBO.SOS) dialog box, specify the following
parameters:

¢ Profile Name
Enter a name for the TRBO.SOS profile.

e Click the Calls tab.

= Remote Monitor
If you select this option, the dispatcher will be able to activate the
device's microphone in hidden mode.

e Timeout
Specify the remote monitor duration, in seconds.

Note: The dispatcher won't be able to execute the
Remote Monitor command for TRBO.SOS apps running
in the background on iOS 13 and later.

e Click the Location tab.

= Use GPS location
Select this option to enable sending GPS data to TRBOnet Server.

¢ Periodic interval
Specify the time interval, in seconds, that will be used to send GPS
location data.

¢ Emergency interval
Specify the time interval, in seconds, that will be used to send
emergency messages.

e Save GPS data to database
Select this option so that GPS data is saved in TRBOnet database.

e Automatic error correction
Select this option to enable automatic error correction to detect and
correct invalid GPS data. Click the Configure link and specify the
GPS parameters to be corrected:
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e Click the TRBO.SOS tab.

Mobile Client Profile (TRBO.505) x

Profile Name: [ mBOnet s0s =1

Client Type: [meo.508 =

Avalable Modes:  [S05 Services -

Cals| Location TREO.SOS | alarms| Charmels | Extras|

Show Call button

Cal Action: [request To Talk -l

Call Destination:  [Home Group B

Callbutton Name:  [Request To Tak

Show Lone Worker button

Type C Severity
Wl FRE
Wl POLICE
vl A AID Information
| REPORT INCIDENT Message With Att.
vl EMERGENCY EMERGENCY

Defauts Cancel

= Show Call button
If you select this option, the PTT button will be available in TRBO.SOS.

e Call Action
From the drop-down list, select the action to be performed when the
PTT button is pressed: Request To Talk, TRBOnet Call, or Phone Call.
e Call Destination
From the drop-down list, select the call destination.

e Call button Name
Enter the name (label) of the PTT button.

= Show Lone Worker button
If you select this option, the Lone Worker button will appear in
TRBO.SOS. This will allow the TRBO.SOS user to start the Lone Worker
mode.

= Panic buttons
In the table below, specify the Type, Caption, Severity/Status, and
Custom Event for the additional button(s).

e C(Click the Alarms tab.

= Sensor Alerts
Select the desired sensor alert buttons (Man Down, No Movement,
Shake Detection) to be shown in the TRBO.SOS app.

e C(Click the Channels tab.

= Home Group
Select the home group (System and Group) for the PTT button.

e C(Click the Extras tab.

= Battery Level
Select this option so that the smartphone's battery level will be sent to
the Dispatch Console.
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6.4.19 Mobile Client Profile (TRBOnet Communicator)

This section describes how to configure the profile for the TRBOnet
Communicator application running on a smartphone. For more details on
TRBOnet Communicator, refer to TRBOnet Communicator User Guide.

File View Map Tools Help

Administration Mobile Client Profile (TRBOnet Communicator) =
3
s

eaners  [0][%:] [ B[ ]Fremen

Profile (TREOnet Mobile)

rgfile (TREONet Communicator)
ios
oups 2

@ Location Tracking

Mobile Client Profile (TRBOnet Communicaf tor)

= Profie Name: [efaity |

Client Type: [mecnet communicator =

Available Modes: [ Text Messages, Actans |

Actians |
nnnnn

[ o [rywe [ caption [severity/stats | custom event
1 Button Alarm Alarm Nene
z Button Warning Warnin

o

g Naone
o outors [T o |

# Job Ticketing

Ej Route Management

[ Text Messages

ﬂ' Voice Recording

() Reports

Event Viewer dhadd X Delete

* 3] Radio Allocation

e
2 /] s
izl Adminstotion A

[ Connected &3 B B B | & Administrator | (2R Licensed to: demo Demo License @ Active~

e Go to Administration (1) > Mobile Client Profile (TRBOnet
Communicator) (2).

e Inthe Mobile Client Profile (TRBOnet Communicator) pane, click Edit
(3).
¢ Inthe dialog box that opens, click the Add link.

e In the table below, specify the Type, Caption, Severity/Status, and Custom
Event for the button(s) you are adding.

e Once you have configured the profile, click OK.

6.4.20 Teltonika Profile

This section describes how to configure the profile for the Teltonika devices.

For information on how to register a Teltonika device, see section 6.4.32.5
Adding Teltonika. For more details on TRBOnet Teltonika, refer to TRBOnet
Teltonika User Guide.

e Go to Administration, Teltonika Profile.

You can see the default Teltonika Profile settings in the Teltonika Profile
pane.

¢ Inthe Teltonika Profile pane, click the Add button.
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Teltonika Profile

Profile Name: | Teltonika 250

iocahon ] Additional ]

Use GPS location

Periodic interval: 50 EI: seconds
Use Indoor location
Periodic interval: 30 3: seconds
Positioning mode: |iBEach Indoor fQutdoor j

oK

Cancel

= Use GPS location
Select this option to enable sending GPS data to TRBOnet Server.

Periodic interval
Specify the time interval, in seconds, that will be used to send GPS
location data.

= Use Indoor location
Select this option to enable sending iBeacon data to TRBOnet Server.

Periodic interval
Specify the time interval, in seconds, used to send iBeacon location
data.

Positioning mode

This option determines which GPS coordinates to show on the map
and display in the device's movement history when TRBOnet Server
receives a data packet containing both iBeacon and GPS data.

v iBeacon Indoor/Outdoor
The coordinates of the iBeacons will be positioned on the indoor
and outdoor maps.

v iBeacon Indoor/GPS Outdoor
The coordinates of the iBeacons will be positioned on the indoor
map while the coordinates of the device will be positioned on the
outdoor map.

v iBeacon Indoor/No Outdoor

Only iBeacon-based location tracking will be used, GPS
coordinates of devices and iBeacons will be ignored.

e C(lick the Additional tab.

Events

= Battery Level
Select this option so that the Teltonika device's battery level will be
sent to the Dispatch Console.
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Note: Teltonika devices send the battery information as soon
as they are connected to TRBOnet. After successful
connection, Teltonika devices pass the battery level to
the server with every location update. Regardless of the
device activity, the battery charge level will be logged
on TRBOnNet Server every time the level goes down to
90%, 80%, 70%, 60%, 50%, 40%, 30%, 20%, 15%, 10%, and
5%.

= Emergency Button
Select this option so that the Teltonika device will be able to send
Emergency Alarms to the Dispatch Console.

= Man Down
Select this option to send Man Down alerts to the Dispatch Console.

Location

= Save GPS data to database
Select this option so that GPS data is saved in TRBOnet database.

= Automatic error correction
Select this option to enable automatic error correction to detect and
correct invalid GPS data. Click the Configure link to specify the GPS
parameters to be corrected.

6.4.21 Tools
On the Tools page, you can find some useful tools.

6.4.21.1 Templates for Extended Messages
The Templates can be used for Extended Messages and Extended Notes.

The Extended Messages feature is a special function allowing users to send
detailed preconfigured templates containing necessary information to each
other with the help of the special TRBOnet Dispatch Console application.

This service has been created especially for clients who need to use more
detailed and structured messages in their work. If the standard messages are
not enough to contain all required information, you may use the Extended
Messages service.

e Go to Administration (1), Tools > Templates (2) to create a new
template:
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Templates

Siere ol e
EIERNOOE) (B

Preview

1

_—

T

W 4| 4 |Record1of1 b [w [«

[ 127001 &5 @ | § Administrator | [ Licensed to: demo Demo License

e Click Add From File (3) to add a template from a file.

Note: Before adding a template from a file, save the created
template to a custom directory.

e Click Add (4) to create a new template:

6.4 Administration

New Form
& [51])
(DataBindings)
AccessibleDescription
AccessibleName

AccessibleRole Defaut
AlowDrop False
Anchor Top, Left

] s . N
AutoCheck Tue
AutoElipsis False

2 AtoSize True
BackColor [ ControlLightLight
Backgroundimage 1 frone)
BackgoundimageLayout  Tie
CausesValidation Tue
CheckAign MiddeLeft
Checked False
CheckState Unchecked
ContextMenuStip (none)
Cursor Default
Dock None
Enabled Tue

FlatAppearance
FiatStyle Standard

Template ID: | 754e9751966-48c0-add7-679f1091920 | []
Genereate new.

Checked
Indicates whether the componert is in the checked state

oK

Name (1)

Specify a name for the template to display in the Dispatch Console (1).
Elements (2)

Select elements to add to the template. Drag and drop the selected
element to the desired place on the mail template box.

Template size (3)

Specify the template dimensions and background color.
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Select the directory where you saved the template and click OK to add the

Click an element on the template. On the right side of the Template
dialog box, you can see the selected element properties.
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For directions on how to send an extended message to a radio, see section
6.9.2.1, Send Extended Text Message to a Radio.

6.4.21.2 Indoor 2D Map Converter

TRBOnet Dispatch Console provides the Map Converter to use custom images
as Indoor 2D Floor plans. The tool allows converting images to the BMAP
format that is supported in Indoor Positioning.

e Click Administration (1), Tools > Indoor 2D Map Converter (2).

File View Map Tools Help

Administration Indoor 2D Map Converter ¢ ]4)

[ Mobile Client Profile {TREO.S0S) A
[ Mobile Client Profile (TREONet G Name:

[ Teltonika Profie Floorplan 1

£ Tools 2

Image:

ID:images\1st_fioor_plan.jpg
(@ scheduiers M Folder:

D:\images\Bmaps

Start

ﬁ Job Ticketing

[ﬂ Route Management

[ Text Messages

§ voice Recording

£5] Event Viewer / 1

L% Administration o~

[ Connected & B B B B B | & Administiator | [ Licensed to: demo (Walt) (Demo License) @ Active~

¢ Name
Specify a name for the new Indoor 2D Map.

e Image
Click the ellipsis (...) button and locate the image file (PNG, JPG, TIFF, GIS)
on your computer.

e Folder
Click the ellipsis (...) button and locate the folder where to save the
converted Indoor 2D map on your computer.

e Click Start to convert the image.
To use the converted map

e Click Location Tracking (1). On the Map menu, click Open New Map in
Tab (2):
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File View [Map | Tools Help

o —
= Save Online Map Data... =i
EREER e . OF ) () e
o [ e i Print (vEEED DEE) (R [ +][@] B & 9 i beacons
L A Ceocoding.. D[+ @] N PR Privete cal Dl 15 seer
B o 143 Coffee
> pen New Map in Tab
@ [ Fioar plan_ %] H(G Tea
- Fiter|@[@[Q[@] 7 @] showBeacons: a1 - [# DravingPanel] 7 71155 Map Otyects
¥I[&] Camera 1
i ] | 2 Custom Object -
|3 DeleteRoute on Google Eatth ﬁh\[l QEaa ‘ o i » (1 [) Hospital
i vaice Z . [ Poice
Show Radios on Google Estth 2 5 1
& [ Map Regions
3 ot rcong ey |- T
Camera 1 ailyevskly ¥ [ Map Routes
ﬁ Job Ticketing @20 111
Route Management
@ RFID Tracker 1
/o
e H
[ Text Sm P Lttuge: 59'5629.62" : Longhude: 30°1652.71" ||
ﬁ _ Recent Calls/Events ™= |
[ Playback [l Save- () Print | 11 Pause < Clear - i Reload | \[J Filter By Radio | = Grouping "\/ Auto Fiter (> Defautt Settings ’j‘
@ Reports Date Radio System Sender Redpient Message Details
5k 09.06.2017 14:43:57 Server Al Connection to 'Capadity Plus 'h... i‘
{5 event viewer 09.06.2017 12:43:30  CapactyPlus1  Admintrator i Dispateher ‘Adminitrator’call gr... Members: Administrator, 125
09.06.2017 12:40:06  CapacityPlus1 125 1 Radio'125' calls group "1 (00:08)  Members: 125
) _ 09.06.2017 12:39:55 Capacity Plus 1 Administrator 11 lls gr... Members: Administrator
09.06.2017 12:38:34 Capacity Plus 1 Administrator Police ispatcher calls gr... Members: Administrator h
14| <[ Record 1of305 v || ¢ »
@ Administration Recent CallsfEvents | RecentCals | RequestToTak | Rado State | Active Tasks | Active Routes | User Actvity | Beacons | BeaconEvents | TagList
617001 g3 B | § Administrstor | [ Licensed to demo | © active~
Select Map... X
Map Type: Beacon2D ~
Caption: | ‘

Available Maps

Name Path State
Floorplan 1 D:\Images\Bmaps‘Floorplan 1.bmap 0K

Add Edit Remove Cancel

e From the Map Type list box, select 'Beacon 2D".
e Click Add to and browse for the map you have converted.
e Click OK to open the Indoor map in the Map pane.

6.4.22 Schedulers

The dispatcher can create pre-defined schedules to be used as event sources in
Alarm management, for database backup, and in job ticket templates.
e Go to Administration (1), Schedulers (2).

e Inthe Schedulers pane, click Add (3).
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File View Map Tools Help

Administration edule &)
Z i~ * | I T e free [<J2) I Jintercom <)) I B3 vantenace Pl
e [ Jooles oo (BT [ Jow Plelel
o] (PRI " PRI Siat s el
Scheduler x

[Jaroup 20 el
e [ [Database backup | DEE]

DPHVEE c [ Recurrence Pattern

M EYYEY  Days of Week 10:00 3:

| | oneTime [ Thusday [ Friday I sawrday E.

shedl I™ sunday

1 Periodically

— \  monthly [ Mondsy [ Tuesdsy | Wednesday

3

[ Recurrence Range

Start: 5/21/2018 12:00 AM -
Stop <Maximum Date> -

1

/

RIRIRNEIEI IR

>
) Connected 73 B B B B | | Administrstor | [ Licensed to: demo Demo License | @ Active~

In the Scheduler dialog box, specify the following parameters:
= Name
Enter the name of the scheduler.

Recurrence Pattern

Choose one of the recurrence patterns for the scheduler:
= Days of Week
Specify the time and select the day(s) of the week.
= Monthly
Specify one of the following options:
¢ Specific Day
Specify the ordinal day of the month (in the range 1-31, or select
Last).
o Day of Week

Specify the week number in a month (in the range 1-4, or Last) and
select the day of the week.

= One time
Specify the date and time.

= Periodically
Specify the time interval, the repetition period (in
seconds/minutes/hours), and select the day(s) of the week.
Recurrence Range

= Start
Specify the start date/time.

= Stop
Specify the stop date/time.
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6.4.23 Disabled Radios

TRBOnNet Dispatch Console provides the Disable function that allows disabling
a radio even when the radio is offline. The system will disable an offline radio
as soon as it gets available.

Note: The dispatcher can disable a radio when they have
relevant Access Rights (for more details on adding and
editing dispatchers, see section 6.4.25, Dispatchers on

page 261).
e Go to Administration (1), Disabled Radios (2) to disable/enable selected
radio:
Disabled Radios
p 10 [1][«][e]
— - & 235 iﬂ::zi: ﬁasz
{4l Voice Dispatch
@Lﬂaﬁmtmﬁlﬁa 3 4
W Job Ticketing
Route Management
@ RFID Tracker
[] Text Messages
ﬁ Voice Recording
Event Viewer
1] Radio Allocation 1
F2 [(Remrdlnfz » | o] «
[ 127001 &9 B | § Administrator | [ Licensed to: demo Demo License @ Active~

e Click Disable Radio (3) and in the dialog box that appears:

Disable Radio X
_\.C'I.é Disable Radio

Radio: | @ 235 (Basi) 235

LefLed

Enable: |No auto-enabling

Reason:
Test|

Cocel

= Radio
From the drop-down list, select the radio to be disabled.

= Enable
Select the time period after which the radio will be enabled again.

= Reason
Enter the reason for disabling the radio.

= Click OK to disable the radio.
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Message 1 of 3 X
235
Repeater #1: Slot #1
Disabling
The command has been executed. 01-Nov-2016 17:48

Radio has been disabled

[] Do not show this message next time Show on map
Request Location

The Radio is added to the Disabled Radios list and is marked as Disabled
in the Voice Dispatch pane:

Voice Dispatch
BEE &KV @

=] & Online Dispatchers (1)
R Administrator

= |_U Firemen

[€.27%] 177 (Pete) 125

g‘ 235 (Basil) 235

| 11 Police

¢ Click Enable Radio (4) to enable selected radio.
e Select a radio from the drop-down list and specify the reason to enable.
e Click OK to enable the radio.

6.4.23.1 Kill Radio

The Kill Radio feature is available only when a Capacity Max system is used.

Note: This operation is not reversible. If you kill a radio unit, it will be
impossible to recover it.

6.4.24 Dispatcher Groups

The administrator can add, edit, and delete dispatcher groups in the system.
e Go to Administration (1), Dispatcher Groups (2).

File View Map Tools Help

Administration Dispatcher Groups CAE
{9 Schedulers A || [Ek Add| = Edit | Sk Delete | = Grouping ' Auto Filter @ Default Settings
~(3) Disabled Radios Name 4 |Radio D User’ Extension Desaription
= DG 1 64260
{81, Dispatchers \
Maintenance 60400 60400
+{Z] Email Groups
5= 55 Groups 2 ~ ||Sales 60500 60500
< >
(4=l voice Dispatch 3

@ Location Tracking

@ Job Ticketing
Route Management

[] Text Messages

ﬁ Voice Recording

Event Viewer /

o i
[ Connected &3 B B By B B | § Administrator | 8 Licensed to: demo (Walt) (Demo License) @ Active -

1

| «| <[ Record 10f 3 »|wm] « »

e Click Add (3) to add a dispatcher group.
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Dispatcher Group X

General Dispatch Group Call Request To Talk

Mame: |Maintenance

Description: |

Cancel

On the General tab, specify general parameters for the new dispatcher group.

e Name
Specify a name for the dispatcher group to display in the Dispatch

Console.

e Description
Add a description for the dispatcher group.

On the Dispatch Group Call tab, specify the following parameters:

Dispatcher Group X

General Dispatch Group Cal  Request To Tak

Radio ID: 139 -
Phone Call
User’s Extension: | 7396 |
User Name: |7395 |
User Password: | ==== = |

cance

e RadioID
Specify the Radio ID of the dispatcher group.

Phone Call

e User’s Extension
Enter the SIP extension number that will be used by the dispatcher group.
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User Name
Enter the SIP user name that will be used by the dispatcher group.

User Password
Enter the password for the dispatcher group to be authenticated by the
phone system.

On the Request to Talk tab, specify the parameters that will be used by radios
to request a call from the dispatcher group:

Dispatcher Group X
General Dispatch Group Call Request To Tak

Automatically by receiving Text Message from a radio

Message: |
Automatically by receiving Telemetry Command from a radio

VIO: 1 + Command: Any event -
Automatically by receiving DTMF command from a radio

Command: 139] #139%
[ automatically by receiving Status Message from a radio

Cancel

Automatically by receiving Text Message from a radio

Select this option to request a call from the dispatcher group when a
radio sends a predefined text message. If you select this option, specify a
brief text message in the Message box.

Automatically by receiving Telemetry Command from a radio
Select this option to request a call from the dispatcher group when a
radio sends a predefined telemetry command. If you select this option,
specify the VIO contact, and from the Command drop-down list, select
the signal level at which the user's radio should send the telemetry
command.

Automatically by receiving DTMF command from a radio

Select this option to request a call from the dispatcher group when a
radio sends the specified DTMF tones. If you select this option, specify a
DTMF combination without the # characters in the Command box.

Automatically by receiving Status Message from a radio

Select this option to request a call from the dispatcher group when a
radio sends the specified Status to TRBOnet Server, for instance, 1. If you
select this option, specify the Status.

Once you have added the dispatcher group to the system, the appropriate PTT
box will appear in the Radio Interface pane.
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6.4.25 Dispatchers

The administrator can add, edit, and delete dispatchers in the system.

e Go to Administration (1), Dispatchers (2) to work with dispatchers:

File View Map Tools Help

Registered Dispatchers BEE
oD st | W e [ oo
(2} Discbled Radios FGroup 10 i [[Jreguiar GGROUP
18 Dispatcher Groups :
Slat 1 rou
&, Dispatchers
g \ oroup 10 pEE EETE
g Users ~ Di Roles
= Logical Groups 5 Add|~| = Edit |  Delete | = Grouping "7 Aute Filter > Default Settings
v
- = 5y User Name' A Rale Display Name Radio ID User’s Extension Description
G Disp 1 Dispatcher Dispatcher 1 60100 60100
E‘é‘h Voice Dispatch T Disp2 Dispatcher Dispatcher 2 60200 60200
R wan Dispatcher ivan 25
% Location Tracking
& 208 Ticketing 3
;"] Route Management
[] Text Messages
ﬁ Voice Recording
o
2] Radio Allocation
| —1
o
14|« | 4 |Record 10F3 b [ we|mi] < ¥
[ Connected 53 B By b B L | § Administrator | [ Licensed to: dema Demo License | @ nctive-

e Click Add (3) to add a dispatcher.

e On the General tab, specify general parameters for the new dispatcher.

6.4 Administration

Dispatcher X

General  Permissions Systems Radio Groups Dispatcher Groups  Logical | * | *

Authentication: TREOnet Authentication

User Name: Disp 1

Password : | ““““ |
Repeat password: | ““““ |
Display Mame: |D\sp 1 |
Description:

Dispatcher Role: Dispatcher j

] Invisible to all other users
[ tnvisible to all except the assigned groups

[ Allow multiple simultaneous logons

Cancel

Authentication

Select the Authentication method from the drop-down list.

Select TRBOnet Authentication to log on as a user registered in
TRBOnet Dispatch Console Users list.

Select Windows Authentication to log on using the PC name. The
system automatically shows the PC name as User Name.

Note: The password is not required when Windows
Authentication is used.
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Note: For more details on user access to Allocation Console,
see section 6.4.28, Users (page 269).

= User Name
Specify a user name for the dispatcher registered in TRBOnet Dispatch
Console Users list.

= Password
Specify a password for the dispatcher.
e Display Name
Specify a name for the dispatcher to display in the Dispatch Console.

e Description
Add a description for the dispatcher.

o Dispatcher Role
Form the drop-down list, select the role of the dispatcher in the system
(Administrator or Dispatcher).

Note: In addition to the Administrator and Dispatcher roles,
you can also create custom dispatcher roles. To do this,
in the Dispatchers pane, click the Roles tab, and then
click Add.

e Invisible to all other users
Select this option to make the dispatcher invisible to other users.

¢ Invisible to all except the assigned groups
Select this option to make the dispatcher invisible to other users except
for users belonging to the same group of dispatchers.

¢ Allow multiple simultaneous logons
Select this option to allow the dispatcher to use multiple instances of
Dispatch Console simultaneously.

On the Permissions tab, select the available modules and specify the available
permissions for the dispatcher.
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On the Systems tab, specify the system(s) that will be available for the

Dispatcher X

General Permissions  Systems Radio Groups Dispatcher Groups  Logical | 4 | *

Available Modules: |[AII Modes) j =
Voice Dispatch Features
Enable Voice Dispatch

Intercom calls

Telephone calls

Allow outgeing private calls
[ view all voice recordings
Play voice recordings
Save voice recordings
Change control station channels
Change audio settings
Enable Tone and PTT
Send voice messages
View System Bridge

Enable System Bridge
Enable and disable patching

[] Enable and disable voice encryption
™1 Enahla =l Drasmntinn mada far - =1 e

dispatcher.

Note: The dispatcher will not be able to make and receive voice calls
over the radio channels of an unavailable system. The
corresponding PTT boxes will be hidden for the dispatcher.
However, radios' data (text messages, statuses, locations, etc.)

will be available to the dispatcher.

Dispatcher X
General Permissions  Systems  Radio Groups Dispatcher Groups  Logical | 4 | *

() All systems are available
(® Only selected systems are available

‘ System | ™
v CP1 v
[v |IPSC 1: Slot #1 [v
[v |IPSC 1: Slot £2 [v
[¥ | Mobile 1 v
[¥ | Teltonika v

Select Al Clear All

Cancel

e All systems are available
Choose this option to make all radio systems available for the dispatcher
to transmit and receive Voice.

6.4 Administration

Only selected systems are available
Choose this option and specify which radio systems will be available to

the dispatcher.
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= Select the checkbox in the left column to add the corresponding radio
system to the Radio Interface for the dispatcher.

= Select the checkbox in the TX column to allow the dispatcher to make
Voice calls using the corresponding radio system. When the checkbox
is cleared in the TX column, the dispatcher cannot use the
corresponding radio system to transmit voice and data.

On the Radio Groups tab, specify the radio groups that will be available for the
dispatcher.

Dispatcher x
General Permissions Systems Radio Groups  Dispatcher Groups  Logical | * | ¢

() all groups are avaiable
(® Only selected groups are avaiable

‘Group |TX

I~ Alcal I~
1 I~
[~ 22 I~
FEN e
Iv |Cleaners v
[v |Firemen v
Select Al Clear All

Cancel

e All groups are available
Choose this option to make all groups in the system available for the
dispatcher.

e Only selected groups are available
Choose this option and specify which radio groups will be available to the
dispatcher.

= Inthe list, select the groups to make them available for the dispatcher.

On the Logical Groups tab, select the logical groups that will be available for
the dispatcher.
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Dispatcher X

Permissions Systems Radio Groups  Dispatcher Groups Logical Groups [ 4 | *

() All groups are available
(® only selected groups are avaiable

MName Description
aflc =3
~ Cleaners
| Cleaners 1 Cleaning in Department 1
Cleaners 2 Cleaning in Department 2
~ Security
| Security 1 Security in Department 1
Security 2 Security in Department 2

Select Al Clear All

Cancel

On the Dispatch Call tab, specify Dispatch Call and SIP call settings for the

dispatcher:
Dispatcher X
Radio Groups ~ Dispatcher Groups  Logical Groups  Dispatch Call  RequestT/* | *
Radio ID: 61000 S
Phone Number: ‘ 123-4567 |
Email: ‘b\lly@gmai\.com |
Phone Call
User’s Extension: ‘6 1000 |
User Name: ‘61000 |
User Password: ‘Oouoo |
Dial Plan: ‘Fadora - |
Cancel
.
e Radio ID

Specify the Radio ID of the dispatcher.

e Phone number
Specify the dispatcher's phone number (additional data).

e Email
Specify the dispatcher's Email (additional data).

Phone Call

= User’s Extension
Enter the SIP extension number that will be used by the dispatcher.

= User Name
Enter the SIP user name that will be used by the dispatcher.
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= User Password
Enter the password for the dispatcher to be authenticated by the
phone system.

= Dial Plan
From the drop-down list, select the dial plan to use for the dispatcher.

On the Request to Talk tab, specify the parameters that will be used by radios
to request a call from the dispatcher:

Dispatcher X
Logical Groups  Dispatch Call Request To Talk  Reports

Automatically by receiving Text Message from a radio

Message: 60100 |

Automatically by receiving Telemetry Command from a radio

VIO: 1 3| Command:  |High level -
Automatically by receiving DTMF command from a radio
Command: 60100 #80100%

[ Automatically by receiving Status Message from a radio

Cancel

Automatically by receiving Text Message from a radio

Select this option to request a call from the dispatcher when a radio
sends a predefined text message. If you select this option, specify a brief
text message in the Message box.

Automatically by receiving Telemetry Command from a radio

Select this option to request a call from the dispatcher when a radio
sends a predefined telemetry command. If you select this option, specify
the VIO contact, and from the Command drop-down list, select the signal
level at which the user's radio should send the telemetry command.

Automatically by receiving DTMF command from a radio

Select this option to request a call from the dispatcher when a radio
sends the specified DTMF tones. If you select this option, specify a DTMF
combination without the # characters in the Command box.

Automatically by receiving Status Message from a radio

Select this option to request a call from the dispatcher when a radio
sends the specified Status to TRBOnet Server, for instance, 1. If you select
this option, specify the Status.

On the Reports tab, specify the reports that will be available to the dispatcher.
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Dispatcher X
Logical Groups  Dispatch Call  Request To Talk Reports ol I

() All reports are available
(® only selected reports are available

D General Information -

| [F) Registered Radios

E Current Reports

..... U Last Known Systems and Radios
U Presence and GPS Status
U Inactive Radios

..... N D Unregistered Radios

m System Reports

..... N D User Login History

..... O U System Bridge

..... [ ) channel Changes

[F) usage Statistics Reports

..... [ ) Messages

..... ) Radio Activity

----- D Online Radios (Summary)

----- ) Online Radios (Detailed) v

Select All - Clear Al

e All reports are available
Choose this option so that all the reports will be available to the
dispatcher.

¢ Only selected reports are available
Choose this option and in the list below select/deselect the reports to
include/exclude.

6.4.26 Email Groups

Email Groups are used in Alarm Management and Job Tickets configuration to
send emails to dedicated recipient groups.

e Go to Administration (1), Email Groups (2) to add/edit/delete email
groups in the system:

File View Map Tools Help

Administration a oup & |

) Telemetry ~

(5 Rodo Satuses Intercom [2][«][@] B % 1: Line free [«][@] B[ Jancal [+][@]
) eps Profile M Gow 10 [1][«][@] B M Group 20 [-0][«][@] 8 P Group 30 [2][«][@]

bV
2 Tools
(&) Disabled Radios [ Jprivate cal [][«][e]
&%, Dispatcher Groups
& Dispatchers 2
—

= s Graups v

=) Add =) Edit | =k Delete | = Grouping 7 AuteFilter ©» Defautt Settings
A Description Email List
querty @gmail.com, asdf@gmail.com
Region 1 Terminal 1 64@trbonet.com, 65@trbonet.com, 66@trbonet. com

41, Voice Dispatch

%Lmtimtm?hl]

W Job Ticketing
Route Management
@ RFID Tracker

[] Text Messages

ﬁ Voice Recording
Evtlltﬁt'ltr
/

P 1

1

14|« | < | Record 10f 2 » [ we[m] 4| »
3127001 &3 B | & Administrator | [8 Licensed to: demo Demo License | @ active~

e Click Add (3) to create an email group.
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Add/Edit Email Groups *
Name:; Terminal 1
Description: Region 1 Terminal 1|
Email fist: 64@trbonet.com

65@trbonet.com
66@trbonet.com

Add

=

Fi

a
i

OK Cancel

= Name
Specify a name for the email group.

= Description
Add a description for the email group.

= Email list
Click Add to add an email address to the Email list.

6.4.27 SMS Groups

SMS Groups are used in Alarm Management configuration to send SMS to
dedicated SMS recipient groups.

e Go to Administration (1), SMS Groups (2) to add/edit/delete SMS groups
in the system:

File View Map Tools Help

Administration aller Group AT

% Redo Sotzes * | I itercom <)) TS t: e free <o M Jaca Fil«le]
# Tools Mcow 10 [[«[2] ¥ M croup 20 [[«][@] B FGrowp 30 [«[@]

(4} Disabled Radios

&, Dispatcher Groups [ Jprivate Cal [2][<]

% E‘SDT?‘E'S % Add [} Edit | Ck Delete | = Grouping ‘7 Auto Fitter » Defautt Settings

mail Groups

sMs Group e 4| Description Phone Numbers

.= e

EE\ 2 + || Departyent 2. Regio 1Department 2 79117894561, 79217894561

i) Departméqt 3 Region 1Department 3 792112374567, 79111234567
{4l Voice Dispatch
% Location Tracking 3
& 30b Ticketing
Route Management
@ RFID Tracker
[] Text Messages
ﬁ Voice Recording
Event Viewer
[13] Radio Allocation 1
E Administration - —
| «| < |Record20f2 » [»mi] <] >
) 127001 £3 B Administrator | [ Licensed to: demo Demo License Active~
E]

e Click Add to create a new SMS group:
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Add/Edit SMS Groups X
Mame: Department 3
Description: Region 1 Department 3

Phone Numbers: 792112374567
79111234587

oK Cancel

* Name
Specify a name for the SMS group.

= Description
Add a description for the SMS group;

= Phone Numbers
Click Add to add a phone number to the SMS group.

6.4.28 Users

The administrator can add/edit/delete users in the system. In addition, the
dispatcher can export/import users (see section 6.3.4.3, Exporting/Importing

Objects).
e Go to Administration (1), Users (2) to add/edit/delete users in the
system.

File View Map Tools Help

e I
és:::::ra:‘r:ins N (EEED [1][<][@] I Z5 1 Line fres Carcal miEEE]
&, Dispatchers P crow 10 [1[«][@] N Flcrove 20 M crouw 30 [«
=il e cat Pielel
E'i =L Add [} Edit | T Delete | = Grouping 17 Auto Filter 2 Default Settings
i Logical Groups 2 [

] radio Groups Login Display Name SPID | Desaription
B Rados \ ||Basl Basi
Pete te 2401
(=l voice Dispatch

@mﬂmtr_hq 3 4

ﬁi Job Ticketing

Route Management
@ RFID Tracker

[] Text Messages

ﬁ Voice Recording

Event Viewer
(7] Radio Allocation 1
pp— ]
14| 44| « | Record 10F2 » [m[mi] 4| 3
127001 53 G | & Administrator | [8 Licensed to: demo Demo License | @ Active-

e Click either Add (3) to add a user to the system, or Edit (4) to edit the
selected user.

e On the General tab, set general parameters for the user:
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Add/Edit Radio User X

General | Radios | Management | SIP Account | Logical Groups | Custom Fields

Username: ‘Basﬂ |

Password: """

|
Repeat password: ‘ ooooo |
|

Display name: ‘Basil

Max number of radios: 1

Description: |

Image:

Load Image. ..

0K Cancel

* Login
Specify the login for the user.

= Password
Type in the individual password for the user.

= Display Name
Specify a name for the user to display in the Dispatch Console.

= Max number of radios
Select the maximum number of radios that the user can take.

= Description
Add a description for the user.

* Load Image
Click this button and browse for the photo or image to assign to the
user.

e On the Radios tab, specify the radios that will be available to the user.
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All radios

Choose this option to allow using all radios in the system.

Add/Edit Radio User X

General | Radios | Management | SIP Account | Logical Groups | Custom Fields

) all radios
(® selected radios
o -
® 44
@ sss5
v @ Radio 27
| (® Rradio 125
® Radio 146
(® Rado 155
® Radio 200
(® Rradio 215
® Rradio 230
(® Radio 235
(® Rradio 235
=

Selected: 2

<
11

OK Cancel

Selected radios
Choose this option and specify which radios will be available to the

user.

heocom
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On the Management tab, specify settings related to taking/returning
radios:

Add/Edit Radio User X

General | Radios = Management | SIP Account | Logical Groups | Custom Fields

[ Automatically return radio if it is offine

5

[ Allow DTMF management

I¥ Allow Text Messages management

Take radio: Bsil

Return radio: Bsilext

I allow Sign In { Sign Out management

I¥ allow beacon management
Major ID: 10 3:
Minor ID: 202

I send notification to radio after it is taken/returned
I Enable forced check-in

0K Cancel

Disable radio on return
Select this option so that a radio will be disabled after the users returns

It.

Automatically return radio if it is offline

Select this option so that a radio will be automatically returned if it is
offline for the specified time interval.
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e Timeout
Specify the offline timeout period, in minutes.

= Allow DTMF management
Select this option to allow taking/returning radios by sending the
specified DTMF tones.

e Take radio
Specify DTMF tones to be sent by the user to take a radio.

e Return radio
Specify DTMF tones to be sent by the user to return a radio.

= Allow Text Messages management
Select this option to allow taking/returning radios by sending specified
text messages.

e Take radio
Specify the text of the message to be sent by the user to take a
radio.

e Return radio
Specify the text of the message to be sent by the user to return a
radio.

= Allow Sign In / Sign Out management
Select this option to allow taking radios when the user signsinto a
radio.
e Sign-inID
Specify the password that the user enters to sign in when they take
a radio.

= Allow beacon management
Select this option and enter Major ID and Minor ID of the beacon that
will be used for taking and returning radios. When a radio
enters/leaves the range of the specified beacon, this radio will be
considered taken/returned by the user.

Note: This functionality is available only if the radio is
equipped with an option board.

= Send notification to radio after it is taken/returned
Select this option so that a notification is sent to a radio every time the
user takes or returns it.

= Enable forced check-in
This option affects the Radio Allocation module. If enabled, the user
will be able to return any radio, regardless of whether who has taken
the radio. For more details on the Radio Allocation module, refer to
TRBOnet Enterprise/PLUS Radio Allocation User Guide.

e On the SIP Account tab, specify a SIP Account for the user:
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Add/Edit Radio User X

General | Radios | Management | SIP Account | Logical Groups | Custom Fields

User’s Extension: | 2401 |

User Name: | 2401 |

User Password: | ------- |

Dial Plan: i > |

[ Block incoming phane calls
[ Block cutacing phone calls

0K Cancel

= User’s Extension
Enter the SIP extension number that will be used by the user.

= User Name
Enter the SIP user name that will be used by the user.

= User Password
Enter the password for the user to be authenticated by the phone
system.

= Dial Plan
From the drop-down list, select the dial plan to use for the user.

= Block incoming phone calls
Select this option to block all incoming SIP calls for the user.

= Block outgoing phone calls
Select this option to block all outgoing SIP calls for the user.

e On the Logical Groups tab, specify logical groups for the user:
= In the list of available groups, select desired group(s).

= For more information about logical groups, see section 6.4.29, Logical
Groups (page 273).
e On the Custom Fields tab, specify the desired values for the custom fields
(see section 6.4.6, Custom Fields).

6.4.29 Logical Groups

TRBOnNet Dispatch Console allows adding custom logical groups in addition to
radio groups. You can create groups and subgroups and then assign
radios/users/dispatchers to these groups.

e Go to Administration (1), Logical groups (2):

6.4 Administration 273



neocom
software

File View Mep Tools Help

Administration ogical Group & <)
é ;::‘t:‘::mm ~ | I wntercom ] G e fre CJaca @]
S, Disgatchers Flcow 10 oo (ErE ooE CETE el
Email Groups
5 s Groups [ JPrivate Call [][«]

%, Users B e |
=Emm Foo] B ] B oo |
2] Radio Groups =L Add as child 2 Description
§ Radios 2 v || b Add as root
H leaning Cleaning in Department 1
S ] Cleaning 2
Voice Dispatch

i =¥ security Groups for Security

F ) _ £ Security 1

Location Tracking L8 searity2

& 3ob Ticketing 3

Route Management

@ RFID Tracker

[ Text Messages

ﬁ Voice Recording

Event Viewer

[753] Radio Allocation 1

frp— "

127001 83 B | & Administrator | [ Licensed to: demo Demo License | @ active~

e Click Add (3) to add a logical group.
= Select Add as root to add a logical group as a root folder.
= Select Add as child to add a logical group as a child folder.

Group properties x
Name: Cleaners
Description: Cleaning in Department 1]
Extemal ID:
Cancel

= Specify a Name and Description for the logical group.
= Click OK to add the logical group.

To display logical groups, enable the Logical Group view:
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o

Voice Dispatch

NN
X

@ &

e tﬁ Online Dispatormastreee)
8 aministrator
& T cleaning
© T} Cleaning 1
(8 ® 125 (Pete) 125
F} Cleaning2
& F) securty
© T} securty1
[O)C] 235 Basin 235
T secunty2

Y} voice Dispatch

@Lmﬂmlmﬁ-j

& 30b Ticketing

nm::ﬂanagunmt

@ RFID Tracker

[] Text Messages

ﬁvﬁzﬂuﬂnﬁq

Ty—

All created logical groups are displayed in the list of radios.

6.4.30 Radio Groups
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e Go to Administration (1), Radio Group (2) to add/edit/delete Radio
Groups in the system.

File View Map Tools Help

Administration Radio

(&) Disabled Radios

&%, Dispatcher Groups
.. & Dispatchers

Email Groups

[ 53 Graups
g, s

EL Groups

@
) Rados

2

~

-

)y voice Dispatch

L.mﬁ-.rmd:i-g

& s0b Ticketing

m-.tzn-ngu_it

@ RFID Tracker

[] Text Messages

@ voice Recording

{5 Event viewer

Epe—

Pl

Intercom
Group 10
[JPrivate call

[2][«le]
[][«][e]
[« ]l@]

7 1: Line free

FI K

[Jancat [-0][+][@]

(v EETE

[1][<][0] il {gcroup 30 [2][<][e]

[ A |Radio D

police 0

1

/

Ik

Record 10f3 » | m [ « |

[ Add| =) Edit | =k Delete | = Grouping 7 Auto Filter 2 Default Settings
e

MDC / Sek-5 (Hex) Descriprion

5 Cleaning group
0

0

127001 & B | § Administrator | [28 Licensed to: dema Demo License

>
‘ @ Active~

e Click Add (3) to add a radio group to the system:
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Group Properties X

Name: Cleaners

Radio ID: 30 7| mpcip: 3

Description: Cleaning group

Use custom call tone

|#'| Load from file

% Play back message
[] use Broadcast mode for call {only for IPSC)

[[] Use Open Vaice Channel made for call {only for TPSC)

Cancel
= Name
Specify a name for the radio group in the system.
= Radio ID

Specify the Radio ID for the radio group used to identify messages
to/from the radio group.

= MDC / Select-5 / Quick Call I / Quick Call II
Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used
to identify and communicate with a target radio or group of radios
depending on the call type. Or, select Quick Call I/ Quick Call II
signaling system and specify the appropriate parameters.

= Description
Add a description for the radio group.

= Use custom call tone
Select this option and browse for the audio file (WAV) that will be used
as a custom tone when a group call is started by clicking the
Tone and PTT button in the group's PTT box (see section 6.5.2, PTT
Boxes).

= Use Broadcast mode for calls
Select this option so that a group call will be made in the Broadcast
mode. Receiving radios of this group call won’t be able to answer (talk
back) to this group call.

= Use Open Voice Channel mode for calls
Select this option so that a group call will be made in the Open Voice
Channel mode. All radios on the channel that are capable of receiving
OVCM calls will receive the group call rather than only the group
participants.
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Notes: The Broadcast and OVCM group calls are available on
IPSC systems only. To use the Broadcast and OVCM
group calls, the Use NAI Voice option must be enabled
for the repeater (see section 5.10.2, Adding a
MOTOTRBO Repeater).

6.4.31 Device Lists

The Device Lists are used to dynamically group radios based on current needs.

6.4.31.1 Adding List Templates
e Go to Administration (1), Device Lists (2).
e Inthe Device Lists pane, select the List Templates tab, and click Add (3).

File View Map Tools Help

Administration [Fl Device Lists
4, Users ~
1= Logical Groups
) Radio Groups
i) Device Lists
) Radios \ 2
1), voice Dispatch List Templates [ At |,/ (§) Rado 125 4
ENYTIE] £d? [, Del (@ Radio 155
|2+, Location Tracking — ® Rado 230 =
5 crow M@ Radio 235 b
e - @ Radio 235
@ job Ticketing Group 2 @ rodio 200
3 (® Radio 16500000
[:j Route Management
[] Text Messages
ﬂ Voice Recording
Cg Reports.
Selected: 3
5| Event viewer
@ F ]~ [i=
3] Radio Allocation
& . s
—~—
o e
#| 4| < |Record 10f2 » » |« »
[ Connected &3 B By B B B | & Administrator | [ Licensed to: demo Bemo License @ Active -

¢ Inthe List Properties dialog box, enter a name and description for the
list.

e Click the Radios tab (4), and select the radios (5) to include in the list.

6.4.31.2 Dynamic Regrouping

Note: The Dynamic Regrouping feature is available only for
Capacity MAX systems.
To assign radios to dynamic groups:

¢ Go to Administration, Device Lists.
In the Device Lists pane, select the Active Lists tab, and click Create.

Or:
e On the Tools menu, click Dynamic Regrouping.
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Dynamic Regrouping

Actior: [assion to dynamic radio group

Group; |Firemen

Group A [Firemen_

Radios WDy nnnnn Gruupsl
Mame

o

> [+ 5 Group 1

Active Group

In the Dynamic Regrouping dialog box, enter the following parameters:

= Action

From the list, select the action (Assign to, or Exclude from dynamic

group).
= Group

From the list, select the radio group to which to assign (or, from which

to exclude) radios.
= Group Alias

Enter an alias for the radio group.

= In the list below, expand the group and select the desired radios.

= (lick the Execute button.

6.4.32 Radios

The administrator can add/edit/delete radios in the system. In addition, the
dispatcher can export/import radios (see section 6.3.4.3, Exporting/Importing

Objects).

6.4.32.1

e Go to Administration (1), Radios (2).

Adding Digital Radio
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File View Map Tools Help

Administration Radios

&[]

(&, Dispatcher Groups A || Regis Unregistered
-2 Dispatchers Ak Add Group | 5 Add Digital Radie| =, Add Range | =% Add TREOnet Mobile =, Add TREO.50S =) Add WoC Radie =k Add WAVE 5000 | =) Edit 7
9 Emai Groups Rado Name Type Rado D MDCID User Extension/Login | Ratio Groups Logical Groups
o EMS Groups (@ Radio 235 Digital Rax 235 0 Cleaners
jsers
:@5 Logical Groups @ Radio 125 Digital Radio 125 0 Cleaners
. Rodo Groups @® Radio 100 Digital Radio 100 0 Cleaners
T Device Lists 2 ® 2222 TRBO.S0S 2222 0 2222
-8 — ® Rado 4444 TRBOnet Mobie 0 4
Y@ 333 TREONet Mobile 0 3333
< >
@ 5555 TRBOnet Mabile 0 5555
QE“:I Voice Dispatch
@ Location Tracking
@ Job Ticketing 3
m Route Management
[] Text Messages
ﬁ' Voice Recording
Cg Reports
Event Viewer / 1
Administration
@ /1««‘ Record 207 » ][ ¢ ’
[ Connected &3 B B Eb B | § Administrator | [E Licensed to: demo (Walt) (Demo License) 21| @ Active-

e Click Add Digital Radio (3) to add a new radio.
On the General tab, specify general settings for the radio:

e Radio Name

Digital Radio: Radio 125 X
General ]Lag\cal Groups] Addm‘anal] SIP Account] Camerasl Telhonikal
Radio Name: |
Radio ID: 125 =/| MDC ID: 0 5
Radio Groups: [an ~[+]
Home Group: ‘Claaners ~r |
Use icon: ‘@ Portable Radios v = |

Extended Device:  |None ~ Test | [l

Location Service

Location Source: ‘Built-in GPS receiver

Location Profile: ‘[Defau\t) e |

Location Enabled
Telemetry Service
TLM Source: ‘Built-in Telemetry “ |
TLM Profile: | (pefault) ~[+]
Text Messages Service
TME Tuma- [etandard vl v
Hide Advanced Settings

Cancel

Enter a descriptive name for the radio to display in the Dispatch Console.

e RadioID

Enter a Radio ID for the radio. This ID is used by other calling radios when
addressing the radio, for instance, when making a private call or sending
a text message.

e MDC / Select-5 / Quick Call I / Quick Call II
Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to
identify and communicate with a target radio or group of radios
depending on the call type. Or, select Quick Call I/ Quick Call II signaling
system and specify the appropriate parameters.

e Radio Groups
In the drop-down list, select a radio group(s) to which to assign the radio.
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Home Group
In the drop-down list, select a home group for the radio.

Use icon
From the drop-down list, select an icon for the radio.

Extended Device
From the drop-down list, select the option board type the radio is
equipped with.

Location Service

Location Source

= Built-in GPS receiver
Select if the radio has its own built-in GPS receiver to send GPS data.

= Not equipped with GPS receiver
Select if the radio cannot send GPS data.

= Extended device
Select if the radio is equipped with an option board.

Location Profile

From the drop-down list, select the default or preconfigured Location
Profile. For more details on Location Profiles, see section 6.4.16, Location
Profile (page 236).

* Location Enabled
Select/clear this checkbox to enable/disable the location trigger.

Telemetry Service

TLM Source

* Not equipped with Telemetry
Select if the radio cannot send Telemetry data.

* Built-in Telemetry
Select if the radio has its own built-in Telemetry.

= Extended device
Select if the radio is equipped with an option board.

TLM Profile
From the drop-down list, select the default or preconfigured Telemetry
Profile. For more details on Telemetry Profiles, see section 6.4.12

Telemetry (page 227).

Text Messages Service

TMS Source

= Not equipped with display
Select if the radio is not equipped with a display.

= Built-in Text Messages
Select if the radio has its own built-in Telemetry.
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e TMS Profile
From the drop-down list, select the default or preconfigured Text
Message Profile. For more details on Text Message Profiles, see section
6.4.13, Text Messages (page 230).

Job Tickets Service
e JTS Type
* None
Select if the radio is not equipped with a display.

= MSI Proprietary
Select if the radio is equipped with a display and supports the
Enhanced Job Ticket protocol.

= Text Messages
Select if the radio is equipped with a display and supports the legacy

Job Ticket protocol.
Radio Status Service

= RS Profile

From the drop-down list, select the default or preconfigured Radio
Status profile.

For more details on Radio Status profiles, see section 6.4.15, Radio
Statuses (page 235).

On the Logical Groups tab, specify logical groups for the radio:

Digital Radio: Radio 125 X
General Logical Groups ]Add\ﬁona\] SIP Account | Cameras | Teltonika |
Name Description
o o
v Cleaners
+| Cleaners 1 Cleaning in Department 1
Cleaners 2 Cleaning in Department 2
~ Security
+| Security 1 Security in Department 1
Security 2 Security in Department 2
Select Al Clear All
Cancel

e Inthe list of available groups, select desired group(s).
e For more information about logical groups, see section 6.4.29, Logical
Groups (page 273).

On the Additional tab, specify additional information about the radio
subscriber:
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Digital Radio: Radio 125

Load Image...

... Name

B rame

B Description
B Carmake
B Flate number
%, Fhone

B3 Email

General] Logical Groups  Additional ]SIP Accnunt] Cameras] Telh)nika]

Max speed: 60 3:

Route Color:

T | value

Hyundai

RAMBO 01

+7 911 123-4567
tester @gmail. com

Cancel

e Max speed

Specify the maximum speed allowed for the vehicle, in kilometers per
hour or in miles per hour, depending on the measurement system

specified in TRBOnet server.

e Route Color

Specify a color to display the route passed by the radio on the map.

e Load Image

Click this button and browse for the photo or image to assign to the

radio.

e In the table below, specify the desired values for the custom fields (see
section 6.4.6, Custom Fields).

Note: To automatically create and assign job tickets to the
radio (see section 6.4.5.18, HotSOS (Email)), there must
be present at least one field with the 'Email’ type.

On the SIP Account tab, specify a SIP Account for the radio:
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Digital Radio: Radic 125 X

General| Logical Groups | Additional SIP ACCOUHt]Camerasl Teltonika |

User’s Extension: |24Dl

User Mame: |24Dl

User Password: |uuu

Dial Plan: 4 iv

[ Block incoming phone calls
[ Block outgoing phone calls

Cancel

User’s Extension
Enter the SIP extension number that will be used by the radio.

User Name
Enter the SIP user name that will be used by the radio.

User Password
Enter the password for the authentication.

Dial Plan
From the drop-down list, select the dial plan to use for the radio.

Block incoming phone calls
Select this option to block all incoming SIP calls for the radio.

Block outgoing phone calls
Select this option to block all outgoing SIP calls for the radio.

On the Cameras tab, select the checkbox beside the camera that will be
associated with the radio:
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MName

[] Camera 2

| Disposal dump

Digital Radio: Radic 125

Generall Logical Groups | Additional | SIP Account Cameras |Te|tonika|

Description

Cancel

Note: You can also register a radio from under the Unregistered
tab. Just select a radio and click Register:

Unreier:

_-?}‘ Reglger | _-?( Delete™z Delete Al ‘

= Grouping 7 fuitn Filter (3' Default Settings

Radio I

35 \
36

% \
52

53

54

WD

o0 o0 o oo o

Last Active Radio System
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6.4.32.2 Adding TRBOnet Mobile

In addition to digital radios, you can create accounts for TRBOnet Mobile
Clients that can connect to your radio systems.

e Click Add TRBOnet Mobile.
In the TRBOnet Mobile dialog box, enter the following parameters:

TREOnet Mobile s

Gereral Logical Groups  Additional  Cameras

CRadio Namey  [5555 |
Clogne___ > [5555 |
Gassword:j |ooou. |

|

Password (repeat): | LTI

Radio 10 5555 =

CProfie: ) [TRBORst Mohile #1 v [+

Use icon: |® Portable Radios \/|

Corcel

= Radio Name
Enter a descriptive name for the Mobile Application user to display in
the Dispatch Console.

= Username
Enter the username for the Mobile Client app user.

= Password
Enter the password for the Mobile Client app user to be authenticated
by the TRBOnet system.

= Radio ID
Specify a Radio ID for the Mobile Client user. This ID is used by other
calling radios when addressing the Mobile Client user, for instance,
when making a private call or sending a text message.

= Profile
In the drop-down list, select the profile for the mobile client.
Or, click the plus button on the right to create a profile.

Note: For directions on how to create/edit a Mobile Client
Profile, see section 6.4.17.1, Adding TRBOnet Mobile
Profile.
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6.4.32.3

Adding TRBO.SOS

In addition, you can create accounts for TRBO.SOS applications that can

connect to your radio systems.
e Click Add TRBO.SOS.

In the TRBO.SOS dialog box, enter the following parameters:

TRBO.S0S

General Logical Groups  Additional  Cameras

*

[zzzz

Gug\n: D |2222

CPasswords ) [sesessnses

Password (repeat): | OOOOOOOOOO

Radio ID: 1

Chrofis: > [TRBOnet 505 #1

Use icon: |® Portable Radios

Cancel

= Radio Name

Enter the descriptive name of the TRBO.SOS user to display in the

Dispatch Console.
* Login

Enter the Login that will be used by the TRBO.SOS user. Note that this

is a case-sensitive value.

= Password

Enter the password for the authentication.

= Profile

Select the location profile for the mobile client. See section 6.4.18.1,

Adding TRBO.SOS Profile.
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If the WAVE 5000 Controller and/or WAVE OnCloud Gateway is connected, you
can add WAVE radios to your radio systems.

e Click Add WAVE 5000 or Add WoC Radio (depending on to which WAVE
system the radio is being added).

6.4 Administration

'WAVE 5000
General ]Lngltal Gmupsl Addmnna\] SIP Cal\] Camerasl
Radio Name: |Wave 145 |
(Radio ID: 145 2 W(Wave ID: |145 !
P y— Eremen s T
Home Group: |F\remen |+ |
Use icon: |® Portable Radios |+ = |
Extended Device:  |None Test ‘
Location Service
Location Source: |Bui|t-in GPS receiver ~ ‘
Location Profile: |(Defau|t) e ‘
Location Enabled
Telemetry Service
| +]
Text Messages Service
[ |
Hide Advanced Settings
cancel

In addition to Radio ID, the WAVE radio has the Wave ID parameter.

= Radio ID

Specify a Radio ID for the WAVE radio. This ID is used by other calling
radios when addressing the radio, for instance, when making a private
call or sending a text message.

= WAVEID

Enter the Wave ID that corresponds to the user registered in the WAVE

server's user database.
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Adding Teltonika device
You can also add Teltonika devices.
e C(Click Add Teltonika.

On the General tab, specify general settings for the Teltonika device:

Teltonika: tmt250

General  Logical Groups  Additional Cameras

s

¢ Radio Name: ) [mt2s0]

CIVEL: — [359633109461520

Radio ID: 3 >

Groﬁle: D |Te|b:|nika 250

Icon: |® Portable Radios

OK

CTMeHa

= Radio Name

Enter a name for the Teltonika device.

= IMEI

Enter the Teltonika device's IMEI number.

The IMEI number is on the barcode sticker next to the serial number.
You can also see the IMEI number in Teltonika Configurator.

= Radio ID
Enter the Radio ID of the device.

= Profile

Select the profile for the Teltonika device. See section 6.4.20, Teltonika

Profile.

To see the IMEI and Teltonika Profile columns in the table of registered
devices, right-click on the table header, and from the context menu select
Column Chooser. In the list of available columns, select the column and drag it

to the desired position in the table.
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Linking Teltonika device to Radio
To link a registered Teltonika device to the radio:
¢ Right-click the desired radio in the list of registered radios and from the

drop-down menu, select Edit (or, just double-click the desired radio in the
list of radios).

File View Map Tools Help

Administration Radios [

3= Logical Groups L Unregistered
1 Radio Groups 4 Add Group | = Add Digital Radie =} Add Range | = Add TRBOnet Mobile = Add TRBO.S0S Unlink Teltonika 2|
T Device Lists Radio Name Type Radio ID MDCID User's Extension... | Radio Groups | Logical Groups
B Rados o || @® mezso Teltonika 1 o ]
< > ® Radio 235 Digital Radio 235 0 11
® 3333 TREOnet Mobile 3333 0 3333
ELE"j Voice Dispatch ® 444 TRBCnet Mobile 4444 0 Eaal
@® Radio 125 Dinital Radin 125 0 1
2], Location Tracking Add Group
=l Add Digital Radio
& 30b Ticketing 2. AddRange
a =L Add TREOnet Mobile
D RouteHiosagesscat =l Add TRBO.S0S
=L Add WoC Radio
[ Text Messages 5, Add WAVE 5000
) =L Add Teltonika
(& Reports =
Event Viewer =k Delete
Unlink Teltonika
73] Radio Allocation
e
4[] <[ Record 50f 5 ¥ w|wi] ¢ »
[ Connected &3 B B Bh | § Administrator | 2 Licensed to: demo (Walt) (Demo License) @ Active -

¢ Inthe dialog box that opens, click the Teltonika tab.

Digital Radio: Radio 123 x
General | Logical Gruups] Additional | SIP Account | Cameras Teltonika 1
Device: [mt2s0 v[#]
Location Source: |Mixed mode “ |
Positioning mode: |From radio's Location Profile | w |
From radio's Location Profile
From Teltonika Profie |
omena

= Device
From the list, select the desired Teltonika device.

= Location Source
From the list, select the desired source of location data.

e Teltonika
Select this item to use only location data received from the Teltonika
device. In this case, location data received from the radio will be
ignored, that is, they won’t be recorded to the database and so
won’t be used in the reports.
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¢ Built-in GPS receiver (Radio)
Select this item to use only location data received from the radio. In
this case, location data received from the Teltonika device will be
ignored, that is, they won’t be recorded to the database and so
won't be used in the reports.

¢ Mixed mode

If this item is selected, location data received from both devices will
be used.

= Positioning mode
If Mixed mode is selected from the Location Source list, select from
where the Positioning mode will be taken (radio’s Location Profile or
Teltonika Profile).

Once you have linked the Teltonika device, it will be grayed out in the list of
registered devices.

Unlinking Teltonika device from Radio
To unlink the Teltonika device from the radio:

¢ Right-click the radio in the list of registered radios and from the drop-
down menu, select Unlink Teltonika (or, just click the Unlink Teltonika
button on the toolbar when the required radio is selected in the list).

File View Map Tools Help

Administration Radios
i= ups ~ < ie Unregistered
s

& Add Group | = Add Digital Radio =l Add Range | =} Add TRBOnet Mobile = Add TRBO.S0S Unlink Teltonika |

Radio Name Type Radio ID Mpc D User’s Extension. .| Radio Groups Logical Groups 7

® Radio 235 Digital Radio 235
® 333 TREOnetMoble 3333
| Veice Dispatch ® w4 TRBOnetMobile 4444

0
0
0
0

=} Add Digital Radio
@ Job Ticketing =, AddRange

3 =l Add TREOnet Mobile
[+ Route tanagement 5, Add TREG.50S

=l Add WoC Radio
BRNEEES 5, Add WAVE 5000

(2 Reports =, Add Teltonika
L Repo
= Edit
15] Event Viewer 2 Delete
0y
04
3] Radio Allocation
l% Administration
|« «| Record 5of 5 _» o] «
[ Connected #3 B B4 By | § Administrator | [ Licensed to: demo (Walt) (Demo License) @ Active~

6.5 Voice Dispatch

When on the Voice Dispatch tab is selected, the dispatcher can make radio and
phone calls, send text messages to radios and phone numbers, monitor recent
calls and events, radio status, active tasks and routes and view selected map.

6.5.1 Radio List
6.5.1.1 View Options

The toolbar in the upper part of the Radio List pane provides buttons to change
the appearance of the list:
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6.5 Voice Dispatch

oice Dispa
sl E e Y e

Radio, Dispatchers, Dispatcher Group, Radio Group, ... -

(=] 3){ Online Dispatchers (1) =

& aaministrator
() online, Indoar (0)

© () Online, GPS Fied (1)
(€3] Radio 27

=] O Online, No GPS (1)
@ Radio 235

© () ofiine (8)
(&) 4444

(%) Radio 125 5

Click to view radios by radio list.

Click @ to view radios by their statuses.

Yellow
A radio is online and enters the beacon coverage zone; has Indoor
positioning lock.

Note: When GPS location is available and the radio enters the
beacon coverage zone, the status will turn yellow from
green.

Blue
A radio is online; GPS data is not available.

Green

A radio is online; GPS data is available. This status is shown if the
server has received GPS data during the last 30 seconds (the time
interval is set in Location Profile > Periodic updates).

Gray
A radio is offline.

Click to view radios by radio groups.

Click to view radios by logical groups.

Click | , and select the radio list elements that will be displayed in the
Radio List pane.
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Voice Dispatch

SN E e A=
Radio, Dispatchers, Dispatcher Group, Radio Group, ... =
Type:

| Radio

| Dispatchers 1

| Dispatcher Group 2

| Radio Group

[ Logical Group
State:

| Online, Indoor

| Online, GPS Fixed

| Online, Mo GPS i 3

| OK | | Cancel

Click the arrow button (1).
Select the object types and the radio statuses (2) to filter radios.

For example, you may select to display only radios and radio groups
that are online and have fixed GPS signal.

Click OK (3) to apply filter settings.

e C(Click z , and from the drop-down list, select how to sort the radios in the
Radio List (Name, Radio ID, Status).

e Click o to open the Quick Actions dialog box to specify which quick
buttons to display in the Radio List pane.

Quick Actions X
Dispatcher Buttons
7 send Message 7] Request ToTak
7] Send Push Notification 7] Private Cal
7] Phone Cal
Radio Buttons
@] Find on Map ¥l Private Cal
7] Find on Google Earth 7] Phone / Ful-Duplex Call
7] Show Route ¥ Bend Message
(7 Show Route on Google Earth 7] Send Push Notification
] Google Streat View T Request To Tak
[F] set Device Location ] Disable/Enable Radie
7] Toggle Location Trigger 7] Track Radio
7] Remote Monitor 7] Check Presence
Radio Group Buttons
7] Send Message 7] Reset Location Trigger
7] Send Push Notification 7] Request To Tak
Logical Group Buttons
7 send Message 7] send Push Notification
‘Additional Options
7] Use Check Box Fitering ¥ Show Status of Location Trigger
Preview:
=] & User Group =
© D omy B
&[] [ Radio Group
£ 3
! (#) rado1 moeve

= Dispatcher Buttons
In this group, select the quick buttons to be displayed in the Radio List

for dispatchers.
Radio Buttons

In this group, select the quick buttons to be displayed in the Radio List

for radios.
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= Radio Groups Buttons

In this group, select the quick buttons to be displayed in the Radio List
for radio groups.

Logical Group Buttons

In this group, select the quick buttons to be displayed in the Radio List
for logical groups.

Note: For the preview, see the lower part of the Settings

dialog box.

Additional Options
e Use Check Box Filtering

Select this option to display checkboxes next to each radio and radio
group. Selecting/clearing a checkbox will display/hide the
corresponding radio/radio group on the map.

Show Status of Location Trigger
Select this option to display the Location trigger status for a radio in
the Radio List pane.

2 | |y Firemen

v Gray
A radio is offline.

v Blue + white dish
A radio sent ARS but didn't send GPS packets.

v" Blue + red dish
A radio sent ARS and GPS packets without GPS data, that is the
radio is out of GPS coverage.

v Green
A radio is fully online (has a GPS fix).

6.5.1.2 Quick Filter

Type in Radio ID or Radio name to filter the Radio List. Search results are
displayed in the Radio List pane:

6.5 Voice Dispatch

SR s VYR g
27|
|:| Online, Indoor (0}
© () Online, GPS Fixed (1)
(_) Online, No GPS (1)
() offiine (8)
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6.5.1.3 Radio Information Tooltip

The dispatcher can see the last received radio data in the Radio information
tooltip. Select a radio in the Radio List and hover the mouse pointer over it:

R 15
@E®
Capadity Plus #1 1

Orline by AR5 2
(i) Battery: 60% 3
% OnDuty 4

Lone Worker 5

12:44 PM 12:45PM
Cty Mal ©

Accepted £A09152 7
Accepted #A09155

GPS: 7/12/2018 6:24:36 PM
Speed: 1.9km/h

Altitude: Unknown 8
Region: Mo

Latitude: 59°56'27.85" N
Longitude:  30°15'47.71"E

7 Liniya Vasil'yevskogo Ostrova,

36, Sankt-Peterburg, Russia,
199178

The following information on the radio is displayed in this tooltip:
1. The current channel/radio system the radio is on.

2. The radio status (displayed only if the Show latest note in Unit
information details option is selected in the Advanced tab of the
Options dialog).

3. The current battery level, in percent (displayed only if the radio is
equipped with an option board).

4. The User Activity list the radio is assigned to, if a User Activity task is
activated.

5. The Lone Worker policy status, if a Lone Worker task is activated.

6. The route assigned to the selected radio, if a Route Management task is
activated for the selected radio.

7. The associated job tickets.
8. The current GPS data and current location data.
9. The current location resolved to address.

While this pop-up window is open, the dispatcher can do the following:
e Click B2 to request the presence of the radio in the radio network.
e Click ==Ito send a text message to the radio.
e Click &=! to request the radio's location.

6.5.1.4 Radio Shortcut Menu
To open the radio's shortcut menu, right-click a radio in the Radio List pane:

This shortcut menu contains the following items:
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e Check Presence
Choose this menu item to send a Radio Check command. If the radio is
online and is located in the coverage area, the dispatcher will see a
message like this:

Message 1 of 1 ot

1325
Repester #1: Siot #1
Checking Presence in Network

The command has been executed. 14-Nov-2016 17:49

F.adio is present in the network

Agent: Radio Networks

Radio System: Repeater #1: Slot #1 [ Peer 1002

[] Do not show this message next time Show on map

Reguest Location

e Private Call
Choose this menu item to initiate a Private PTT Call to the selected radio.

e Phone Call/ Full-Duplex Call
Choose this menu item to initiate a phone call (full-duplex call) to the
selected radio.

e Request to Talk
Choose this menu item to send a talk request to the selected radio.

e Request Location

Choose this menu item to request the location of the selected radio (for
radios with GPS module only).

e Send Message
Choose this menu item to send a text message to the selected radio (for
radios with display only).

= Inthe dialog box that appears, specify the radio/radio
group/dispatcher to send the text message to.

e Advanced > Remote Monitor (Open mic)
Choose this menu item to activate the radio microphone in hidden mode
(remote monitor duration - 30 sec.)

e Advanced > Change Location Update Settings
Choose this menu item to customize the Location Update settings. When
you reconnect to the Server or reassign a Location Profile to the radio,
temporary settings will be updated to the Location Profile settings.
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Change Location Update Settings X
3,3 Change Location Update Settings
102
(®) Restart location updates
(O Turn off location updates
() start location updates

[ change periodic update interval

canel

= Restart/Turn off/Start location updates
Choose which command to send to the radio.

= Change periodic update interval
Select this option and specify the new location update interval.

e Advanced > Enable Radio
Choose this menu item to enable the selected radio.

e Advanced > Disable Radio
Choose this menu item to disable the selected radio.

e Advanced > Exit from Emergency mode
Choose this menu item to cancel the Emergency mode on the selected
radio.

Note: This command is distinct from the Clear Alarm
command ("x" button on the Alarm box) which just
clears the radio's alarm status in the Dispatch Console.
Also note that this command is applicable when the
radio is used in Capacity MAX or DIMETRA Express
systems only.

e Advanced > Send Audio Record
Choose this menu item to send an audio record to the selected radio.

Record audio

Convert Text to Speech

|:_. Start ||i_| Cancel | | Load |‘|

= Click Start and start talking to the microphone.

Record audio

Convert Text to Speech

Lu Send ||L| Cancel | | Load |'|

= Click Send to send the recorded message to the radio.
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* You can also load your message from file, or from Saved Audio Files.
Just click the Load button.

= Or, you can send a text message converted to speech. Just click the
Convert Text to Speech link.

Convert Text to Speech X
Text:
Pete, get back at work j
=
Listen Cancel

e Advanced > Send Push Notification
Choose this menu item to send a push notification to the selected radio.

= In the dialog box that appears, specify the radio/radio group to send
the push notification to.

Note: This menu item appears only if the radio is a mobile
client app running on a smartphone.

e Advanced > Send Coordinates To
Choose this menu item to send the coordinates of the selected radio to

selected recipients.

Send Text Message x

Destination: Radio 235;

Templates: ~ B

Text: Radio 125 Latitude: 59°56'25.30" N; Longitude:
30°164764" E

Mtachments: ] Add File

Select Radios and Groups

Filter [235] 2

¥ 2 Radio 235
[ !31 Online Dispatchers

[ send copy as email

™ Send copy as SMS

[¥ Store and attempt to deliver if the user is offline
[ Confirmed Group Text

Hide Advanced Options SEND Cancel

= In the dialog box that appears, specify the radio/radio
group/dispatcher to send the coordinates to.

e Advanced > Send Email
Choose this menu item to send an Email message to the mailbox
associated with the selected radio.
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e Advanced > Shortcut - Private Call
Choose this menu item to assign a shortcut that will be used to make a
private call to the selected radio. When the prompt appears, press the
desired key or key combination.

Hot Key X

A‘r? Click for the combination to specify
& £ the Hot Key or Esc to reset

¢ Find on Google Earth
Choose this menu item to display the selected radio location on Google
Earth.

¢ Show Route on Google Earth
Choose this menu item to display a route traveled by the selected radio
on Google Earth for the specified time period.

Show Route

X

Radio: 125 (Pete) hd

From: | 15-ov-2015 0:00

Ta: |<Last known location =

Led Lo Lo

Colar: [ B 105, 105, 105

Optimize Route (group all nearest points)

Cancel

e Track Radio > Track in New Window
Choose this menu item to open a new Map window for the selected radio.

e Track Radio > Video Tracking in New Window
Choose this menu item to open a new window with the IP camera(s) that
will track the selected radio. The camera may be associated with the
selected radio and/or with the beacon(s) when the radio enters the range
of the beacon(s).

e Track Radio > Google Street View
Choose this menu item to open Google Street View with the latest
location and direction of the selected radio.

e Track Radio > Yandex Street View
Choose this menu item to open Yandex Panorama with the latest location
and direction of the selected radio.

e Set Location Profile
Click this menu item and select the location profile that will be associated
with the radio.

e Select Status Colors
Choose this menu item to select to set individual parameters for the radio
icons.
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Status Colors X

@ Offiine
@ onne, o aps
Online, GPS Fixed @ online, GPS Fixed
Online, Indoor @ Online, Indoor
Alarm 6 Alarm

4|+
Ve

Reset

Preview

Cifline Cnline Online (GPS) Online (Beacon) Ham

® ® @ ®

oK Cancel

= In the Status Colors dialog box, you can specify icons for the statuses
of the selected radio. Select icons from the drop-down list. To set a
custom color for the radio status icon, click the + button and select a
color in the uniform color palette. Click the - button to delete a custom
color.

= In the lower part of the dialog box, you can see the preview of the
icons.

= To set default icons for the selected radio, click the Reset button.

Set Radio Channel > Radio Active
Select/deselect this menu item to make the selected radio active/inactive.

Set Radio Channel > Channel
Select the radio channel over which to make calls to the selected radio.

Cameras >
Click this menu item and select a camera associated with the radio. As a
result, a new window with the camera view will open.

Set On Duty
Choose this menu item to assign the selected radio to the On Duty list.
See also section 6.4.5.7, User Activity (page 186).

6.5.2 PTT Boxes

The dispatcher can make voice calls from the Dispatch Console by using PTT
boxes:

6.5 Voice Dispatch
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/— Control Station #1 [=g @
Channel 1
All call

Session;

Sender:

R fTX

. /

The following options are available for the PTT box:
¢ Click the E4 button to make the channel the default PTT channel.

e Click the [=2] (Tone and PTT) button to start transmitting after a tone
sound.

e Click the [*] (Solo) button to mute all channels except this one.

e Click the <) (Mute) button to mute this channel.

Right-click on the selected PTT box to display the shortcut menu which contains
the following commands:

e Default PTT channel
Select this menu item to make the channel the default PTT channel.
e Shortcut
Choose this menu item to assign a shortcut that will be used to transmit
on this radio channel. When the prompt appears, press the desired key.
o Select External PTT
Select the external PTT device that will be associated with this PTT box.
¢ Select External Indicator
Select the external PTT indicator that will be associated with this PTT box.
e Add to New Group
Choose this menu item to add the channel/group associated with the
selected PTT box to the Patch box. When two or more channels/groups
are added to the Patch box, the dispatcher can click the Create link to
create a patch group for the selected channels/groups.
e Tone and PTT
Click this menu item to start transmitting after playing a tone sound.

¢ Mute this channel
Click to mute the selected channel.

e Mute all channels except this
Click to mute all channels except the selected one.

e Volume
Move the slider to specify the speaker volume level on the selected
channel/group.
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e Microphone
Move the slider to specify the microphone volume level on the selected
channel/group.

e Configure channel
Click this menu item and, in the dialog box that opens specify the
recorder, player, speaker, external PTT device, etc.

Slot 1 X

Defaults
Recorder: |Default j
Flayer: |Default j
Speaker: |Defau|t j
Volume: = +
External PTT: |Fnotswiu:h {Footswitch PTT) j
Indicator: |_Fnotswibch (RTS) j
Theme: |Defau|t j

Cancel

e Open Voice Channel Mode
This option is available for Private PTT Boxes. If you select this mode, all
radios on the channel that are capable of receiving OVCM calls will receive
this call rather than only the designated call recipient.

Notes: The OVCM calls are available on IPSC systems only. To
use the OVCM calls, the Use NAI Voice option must be
enabled for the repeater (see section 5.10.2, Adding a
MOTOTRBO Repeater).

e Select By Radio ID Mode
Select this mode to allow making calls by entering radio IDs from the PTT
box.

¢ Recipient
Select the call recipient for the PTT box.

e Terminate Transmission
Click this menu item to terminate the current transmission.

Note: The incoming transmission can also be interrupted and
terminated by clicking the Interrupt button in the PTT

box.
ff Slat 1 [+] [G_\
All Call ||

L=

Security

Sender:
@ Radsy 125
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6.5.3

6.5.3.1

¢ Reset
Click this menu item to reset connection to the selected channel/group.

e Minimize/Restore
Click to minimize/restore the PTT box size.

Voice Calls

The dispatcher can make the following types of calls:

e Private Call
This is an individual call from the Dispatch Console to a radio via the radio
channel.

o All Call
This is a call from the Dispatch Console to all radio groups registered in
the system.

e Group Call
This is a call from the Dispatch Console to a selected radio group
registered in the system.

e Intercom Call
This is a call from the Dispatch Console to other dispatchers. There are
three types of Intercom Call:

= Intercom Call to all dispatchers
= Group Intercom Call to a group of dispatchers
= Private Intercom Call to a selected dispatcher

e Phone Call
This is a call from the Dispatch Console to a selected phone number.

In addition, the dispatcher can send voice mails to offline radios.

Private calls

The dispatcher can make a call to any online radio registered in the system. To
make an individual call from the Dispatch Console to a selected radio via the
radio channel, do the following:

e Select the radio in the Radio List.

e Click the ® putton on the right.
Or:

¢ Right-click the radio in the Radio List.

e On the drop-down menu, click Private Call.
To terminate a private call, do the following:

e Click the PTT button on the PTT box.
Or:

e C(Click the 1T button in the Radio list.

6 TRBOnet Dispatch Console



TRBOnet Enterprise — User Manual @ Software

Note: You can also create a special PTT box for Private Calls. For
more details, see View > Configure PTT Boxes on page 112.

Full-Diplex calls

The dispatcher can also make full-duplex calls (phone calls) to online radios. To
make a full-duplex call from the Dispatch Console to a selected radio, do the
following:

e Select the radio in the Radio List.

e Click the A button on the right.
Or:

¢ Right-click the radio in the Radio List.

e On the drop-down menu, click Full-Duplex Call.
See also section 6.5.9, Phone Calls.

6.5.3.2 All calls

The dispatcher can make a call to all online radios registered in the system (for
example, in the case of alarm). To make a call from the Dispatch Console to all
radios registered in the system, do the following:

e From the drop-down list, select All Call.

/_D Repeater #1: Slot #2 @

All call

Firemen
Police:
Session;

Free channel

Sender:

L 1

RX JTX =

\_ o,

e C(Click the PTT button.

6.5.3.3 Group calls

To make a call from the Dispatch Console to a selected radio group registered
in the system, do the following:

e From the drop-down list, select a group.

(_ IP Site Connect: Slot #1 [

All call E
All call
Cleaners

Police

Free channel

RX JTX
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e Click the PTT button.

Note: You can also create a special PTT box for Group Calls. For more
details, see View > Configure PTT Boxes on page 112.

6.5.3.4 Intercom calls

The dispatcher can make calls to all dispatchers or to selected dispatchers in
the system. To make an Intercom Call to dispatchers, do the following:

e On the Intercom PTT box, from the drop-down list, select either All Call, or
a group of dispatchers, or an individual dispatcher.

Intercom IE‘

Free channel

@ N —

RX [ TX

. J

e Click the PTT button.

6.5.4 Predefined Voice Messages

The dispatcher can send predefined voice messages (recorded or voice
messages, or audio files) to a radio or a selected radio group:

Radio Interface

Radio Interface| Recent Cals/Events

Gormm  EoR CrEE—
(%) (® Raio 205 o

oL e Rews i

[P Repeater #1: Slot #2 [ =@ To: Selected Channels

All Call
@ Voice Message
Voice Message

Session

Free channel

[ Repeater #1: Slot #1 [EneE] =)

( All Call
@@ 235 (Basil)y

(#) Radio 200 & Session:
O raoon

(4 [ Rarin 202

Repeater #1: Slot #2 [i==a

- Recent Calls/Events
‘Route Management

I Playback (sl Save~ () Print | 11 Pause < Clear - & Reload | “[] Filter By Radio | = Grouping '/ Auto Filter » Default Settings || Details bl
. RFID Tracker Date | Radio System | Sender | Reapient | Message | Details | Hote |
= || @ i54ov-2016 15:43:52  Repeater #1: 5l... Dispatcher 1 125 Private Cal: Dispatcher Dispat... Members: Dispatcher 1, 125 ﬂ
Text Messages 3| 15-Nov-2016 13:28:52 235 Al Reset Geofencing Alarm

“Fe| 15Nov-2016 13:25:48 235 Al The Geofencing - Monitor Area...
Q . Hr 15Nov-2016 13:28:48 235 Al Radio left alowed region My z.

S| 15-Nov-2016 13:28:48 235 Al Radio left allowed region My z... hd
~ | o] 4| Record1ofs7e v |m|m| 4] »
75
Event Viewer Recent CallfEvents | RecentCals | Request toTak | Radio State | Active Tasks | Act [ ser ctvity | Map | Cameres

127001 &3 B @ | 8 Dispatcher 1 | [ Licensed to: demo Demo License | © Active-

¢ Inthe Queued Messages panel, click the Voice Message button.
¢ In the confirmation dialog box, click Yes.
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6.5.5 Patches

6.5.5.1 Predefined Patch

The Patch function allows configuring the network to redirect calls. A
predefined Patch can be created by the administrator only (see section 6.4.3.1
Radio Bridge) and a dispatcher cannot configure it. A predefined Patch is
displayed in the Patch panel by default. The Patch feature is intended to
combine different radio channels in a single group to make voice calls from a
dispatcher to radios and from radios to a dispatcher (for example, to connect a
dispatcher with the firemen and cleaners).

File View Map Tools Help

Voice Dispatch Radio Interface 15

= %I & | 7 3 & || Radionterface[ Teephony | Recentcals/events | Rados
Friday, March 13, 2020
@ redozr 3:24 pm
& () Online, No GPS (1) "
@ Redo235 [Japsc 1: Slot #1 [ [Japsc 1: Slot #2 [
& omne ) ceoners S N/
(® 333 PTT PTT Confiqure:
o Session: Sessi
=y Dispatch Group Cal Group Call Drag and Drop PTT Box
gop
— ! !
Sender: Sender:
e @ Administrator g Administrator B Rado oridoe
Bcketing - () TPSC 1: Slot #2
Firemen
/| Route Management RX[TX RX [TX IPSC 1: Slot #1
2 = 'h “E
Text Messages v
Recent Calls/Events &l
j Voice Recording [ Playback [ Savﬁ"g Print | Il Pause < Clear ~ i Reload | [ Filter By Radio | = Grouping "/ Aute Filter &> Default Settings
Date | Radio System | Sender | Recpient | Message | Detais Note |
@ Reports 13Mar-20 3:24:42PM  IPSC 1: Slot #1  Administrator Cleaners Dispatcher 'Administrator' calls group ... Units: Administrator -
13-Mar-20 3:24:42PM IPSC LiSlot #¥2  Administrator Firemen Dispatcher "Administrator’ calls group ... Units: Administrator
Event Viewer 3| 13Mar-20 3:24:24PM Server al Connection to 'TPSC 1" has been lost
13-Mar-20 3:24:21PM IPSC 1: Slot #1  Administrator Cleaners Dispatcher ‘Administrator’ calls group ... Units: Administrator
Radio Allocation 13Mar-20 3:24:21PM  IPSC 1:Slot #2  Administrator Firemen Dispatcher 'Administrator’ calls group ', Units: Administrator
13-Mar-2 2:24-11PM p1 Riadin 735 1 Radin Radin 738" ralls arnun '11° 0003 | Inits: Radin 235 A
[ Reora Lat 13 5[« | »
Administration - ;
Recent CalsfEvents | Recent Calls | Requests ToTak || Rado State || Active Tasks | | user Actty | Map | Cameras
&) Connected &3 B B4 B} B | @ Administrstor | [ Licensed to: demo (Walt) Demo License | @ Active-

6.5.5.2 Custom Patch

The dispatcher can create a custom Patch to connect selected PTT boxes (for
example, the Emergency and Firemen radio groups). In addition, you can
connect analogue and digital radios via a Patch.

Voice Dispatch Radio Interface ﬂ
SRl 78 & |

o
& () Online, No GPS (1) Configure
1

@ Radio 27
(1Y} voice Dispatch
=
l Location Tracking
f Job Ticketing
1PSC 1: Slot #1

ree chann ree chann
l Route Management Cleaners

[intercom

[ pispatcher Group 1 =
freeh ) X Dispatcher Group
h ree channel 7 IPSC 1: Slot #1
PTT Create

Dispatcher Group 1

[ Firemen - Cleaners
(orT | IPSC 1: Slot #2
o Firemen

Recent Calls/Events
j Voice Recording EF) Playback [H Save“@ Print | 11 Pause < Clear v &3 Reload | ‘[ Filter By Radi rouping "/ Auto Filter & Default Settings
Date |Radio System | sender |Recpient [ Message | petais Note [
@ Reports 4§ 13-Mar-20 5:26:19 PM Server Al Connection to TPSC 1' has been lost -
% 13-Mar-20 5:24:43 PM Server Al Connection to TPSC 1' has been lost
:F Event Viewer $B 13-Mar-20 5:23:22PM Server Al Connection to TPSC 1 has been lost
% 13-Mar-20 5:21:55PM Server Al Connection to TPSC 1' has been lost
ic S 13-Mar-20 5:20:25PM Server Al Connection to TPSC 1' has been lost
Radio Allocation
B ammeon DM cewer . Crnartinn tn TPSC 1 has hasn st =
i/ ¢¢| 4| Record 1of215 > [m|m «| »
E Recent Call/Events | Recent Calls | Requests ToTalk | Radio State | Active Tasks | || User Activity | Map | Comeras
[ Connected £3 B B B} Bb | & Administistor | [ Licensed to: demo (Wat) Demo License | @ nctive~

1. In the Radio Interface pane, click the desired PTT boxes and drag and
drop them, one after another, to the empty Patch box (1).
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2. Click the Create link (2) to create a custom Patch.

Note: Until you click the Create link, this patch will remain as
a temporary patch that will be deleted after you
reconnect to TRBOnet Server or restart TRBOnet
Dispatch Console.

As a result, the new patch will be added to the Patch panel.
= Click the Activate button (1) to activate the patch.

= (Click the checkbox on the left (2) to make the patch selected (default)
so that the external PTT button can be used to start transmission.

File View Map Tools Help

Voice Dispatch Radio Interface &)
= @ By 74 #R Radio Interface| Telephony | Recent Cals/Events | Radios
e x] Quick Commands [x] |~
[®] oniine, GPs Fixed
© () Online, No GPS (1) Configure
@ Radio27 Intercom 1] =] Dispatcher Group 1 Bl (el [ A Ppatch X
- E Free channel E Free channel 2
1 - "
daj M) Al Call Dispatcher Group 1 /1
@ R ) [Jrpsc 1: siot #1 B EE | Owscisiotz2 HEE@ @(m Bl &
IPSC 1: Slot #1
# ) Free channel Free channel
Jab Ticketing Cleaners
Intercom
Clearers alcal Dispatcher Group 1
T
(Dﬁrnup " & @1 (D Group 22 m @] [] [#] Firemen - Cleaners
[] Text Messages _ —_— v PSC 1: Slot #2 v

Recent Calls/Events &l
ﬂ Voice Recording I Playback [l Save~ | Ch Print | 11 Pause f Clear ~ '3 Reload | ‘([ Filter By Radio | = Grouping '/ Auto Filter & Default Settings g
Date Radio System | Sender Recipient Message Details Note
@ Reports $ 13-Mar-20 5:43:13PM Server All Connection to 'IPSC 1' has been lost -
B 13-Mar-20 5:41:48 PM Server Al Connection to 'IPSC 1' has been lost
Event Viewer 3B 13Mar-20 5:40:28 FM Server Al Connection to TPSC I has been lost
$ 13-Mar-20 5:39:05PM Server All Connectior 'IPSC 1" has been lost
@ Radio Allocation S8 13-Mar-20 5:37:42PM Server all Connection to 'IPSC 1" has been lost
4R 13NN 53013 PM Al Fannertian tn 'TPC 1 has heen lnst &
W[4 4] Record10f227 » W M 4 >
E Administration fecent Calls/Events | RecentCalls | RequestsToTak | RadioState | ActiveTasks | ActveRoutes  UserActivity Msp  Cameras
[ Connected &3 B B B B | & Administrator | [ Licensed to: demo (Walt) Demo License @ Active~

6.5.6 Quick Commands

The dispatcher can create Quick Commands (Text Messages, Send Telemetry,
Request Location, Send Voice Message, and some other commands) and
display the Quick Commands panel in the Radio Interface pane. With these
commands, the dispatcher can quickly send Text Message, Telemetry, Location
Request, Voice Message, and some other commands to a radio by clicking the
appropriate Quick Command button.

To configure the Quick Commands panel, do the following:

e Make sure Show Quick Commands Panel (2) is selected under the View

menu.

e On the Quick Commands panel, click the Configure link (3).
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File [ View | Map Tools Help
i[v] Show Navigation
Show Modules

Configure PTT Boxes...

Configure Active Calls Panel...

Customize Hot Keys..
Add Radio Interface Page...
Delete Radio Interface Page
Show Channel Selector Box
Audio Message Library...
Extended PTT Boxes

Large PTT Boxes

Medium PTT Boxes

Small PTT Boxes

Custom PTT Bfxes

1

ive Calls Panel

Radio Interface

Recent Calk/Events

Firemen

P Cleaners

Cleaners

Free channel

‘ Recent Cal

LR Fl_m F
ol cted Channels

Voice Message

Drag and Drap FTT Bax hers to
create new group

8 playback [ Save~ (b print | 11 Pause < # Clear + 5 Reload | [ Filter By Radio | = Grouping /' Auto Filter

heocom
software

L Date |Radio Syst... Sender  |Redpient | Message | Details | Note |
SnalEcphooyliet 3% 16-Nov-2016 10:22:05 Server Al Comnection to Repeat... -
Show Extended Messages Tab 15MNov-2016 18:26:36  Repeater... Dispatcher 1 Firemen Dispatcher Dispatcher... Members: Dispatcher 1
Show Radios Tab 15Nov-2016 18:26:28  Repeater ... Dispatcher 1 Cleaners  Dispatcher Dispatcher... Members: Dispatcher 1
e 15Nov-2016 18:26:21  Repeater... Dispatcher 1 Fremen  Dispatcher Dispatcher... Members: Dispatcher 1
15Nov-2016 18:06:12  Repeater .. Disoatcher 1 Cleaners  Disoatcher Disoatcher... Members: Dispatcher 1 hd
| 4|« Record1ofeze v | mm[4] »
L R Recent Cals/Events | RecentCalls | RequesttoTak | RadioState | ActiveTasks | Act | User Activity  Map | Cameras

127001 &8 B, B | 8 Dispatcher1 | [ Licensed to: demo Demo License

| @ Acive-

¢ In the Configure Quick Commands dialog box, click the Create link.

6.5 Voice Dispatch

Name

Specify a name for the quick command. This name will be displayed as
the button name in the Quick Commands panel.

6.5.6.1 Send Text Message

Cuick Command

Name: [rest

Command
Command: ISend Text Message
Message: IThis is a test|

~ Send to Radio Group
' Send to Radio
Recipient:

L@ 12
V@ 125
V@ 235
1@ 555
O@ 3333
ImIGEE
[1(#) 5555

Selected: 2

(2[5

(=[]
o ]

Command

From the drop-down list, select Send Text Message.

Message

Enter the text of the message.

Send to Radio
Choose this option to send a predefined text message to individual
radios registered in the system. In the Recipient box, select target

radios.
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Send to Radio Group
Choose this option to send the text message to radio groups
registered in the system. In the Recipient box, select target groups.

6.5.6.2 Send Telemetry

Quick Command *
MName: |Test
Command
Command: ‘Send Telemetry ﬂ
VIO: VIO 1 | Command: High level -
" Send to Radio Group
f* Send to Radio
Recipient:
® 13 -
V@ 125
V@ 235
® 555
@ 3333
®
(#) 5555
Selected: 2
& a VilMES
Conce
Command
From the drop-down list, select Send Telemetry.
VIO

Specify a VIO to which to send a telemetry command.

Command
From the drop-down list, select a telemetry command for the selected
VIO.

Send to Radio Group
Choose this option to send the telemetry command to radio groups
registered in the system. In the Recipient box, select target groups.

Send to Radio
Choose this option to send the telemetry command to individual radios
registered in the system. In the Recipient box, select target radios.
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6.5.6.3 Request Location

Cuick Command X

MName: |L0cah‘on of 125 and 235

Command

Command: ‘Request Location ﬂ

Recipient

® 13
M@ 125
W@ 235

@ 555

® 3333

@ 2442

@ 5555

(® Radio 300

(® Rradio 333

(# radio 3562

Selected: 2

rlfln] w[-[=]-

= Command
From the drop-down list, select Request Location.

= Recipient
Select radios to which to send a location request.

6.5.6.4 Send Voice Message

Quick Command x
Mame: |We are on firg|
Command
Command: ‘Send Vaice Message ﬂ

|| Load from file
_2 Record message
@, play back message

Call Type Channel Call Target
Group Call 'JEIJ Capadity Plus #1  Firemen -

of Add % Remove
Priority: |Normal ﬂ

= Command
From the drop-down list, select Send Voice Message.

* Load from file
Click this link and locate the audio file on your PC.

= Record Message
Click this link to record a new voice message.

6.5 Voice Dispatch
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Play back message
Click this link to play back the voice message.

Specify Call Type, Channel, and Call Target for a voice message.

Note: To send a Voice Message to a subscriber from the
phone book, click the ellipsis (...) button in the Call
Target column and select a contact from the phone
book.

Priority

From the drop-down list, select the priority with which the voice
message will be sent/queued. If this priority is higher than that of the
current transmission, which is, in turn, allowed to be interrupted, the
current transmission will be interrupted and the voice message will be
sent instead.

6.5.6.5 Send Signaling

Cuick Command X

Mame: |5|gna| 1

Command

Command: ‘Send Signaling

Radio System: ‘Capacity’ Plus #1

Target: ‘Firemen

Lefledle] Led

Type: [custom
Freq.2 (Hz)

Duration (ms) Pause (ms)

o Add Delete MoveUp & Move Down

Cancel

Command
From the drop-down list, select Send Signaling.

Radio System
From the drop-down list, select the radio system.

Target

From the drop-down list, select the target group to which the signal
will be sent.

Type

From the drop-down list, select the signaling system type (Quick Call [,
Quick Call II, DTMF, or Custom).

If the Custom type is selected, specify the Frequency 1, Frequency 2,
Duration, and Pause for the signal to be sent.
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Control Station

Cuick Command

MName: |Command to Control Station

Command

Command: ‘Send command to Control Station

Control Station Command

PINS SET OM

PING SET OM

PING SET OFF
PING PULSE

opAdd X Delete

Cancel

= Command

o

heocom
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From the drop-down list, select Send command to Control Station.

= Click Add

e Control Station

From the drop-down list, select the Swift Agent connected to

TRBOnNet Server.

¢ Command

From the drop-down list, select the PIN number and its value.

6.5.6.7 Request To Talk

Quick Command

MName: |R'I'I' 1

Command

Command: ‘Request To Talk

" send to Radio Group
¥ Send to Radio

Recipient:

® 13
W@ 125

® 235

@ ss5

@ 3333

® #+

@ 5555

® Rradio 300

e NPT

Selected: 1

| bdhdE

111
4

Cancel

= Command

From the drop-down list, select Request To Talk.

6.5 Voice Dispatch
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= Send to Radio Group
Choose this option to send the request to talk to radio groups
registered in the system. In the Recipient box, select target groups.

= Send to Radio
Choose this option to send the request to talk to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.6.8 Custom Event

= Command

From the drop-down list, select Custom Event.
= EventID

Specify the event ID.

6.5.6.9 Send Swift Command

Quick Command X
Mame: |5wif‘t 1
Command
Command: ‘Send Swift Command j
Swift Command: ‘Swiﬂ: Command 1 j
n=
0=
% send to Radio Group
" Send to Radio
Recipient:
System Group
Capacity Plus #1 Firemen j
o Add 3 Delete
oK Cancel

= Command
From the drop-down list, select Send Swift Command.

= Swift Command
From the drop-down list, select the appropriate Swift command.
Enter the required parameters, if any.

= Send to Radio Group
Choose this option to send the Swift command to radio groups
registered in the system. In the Recipient box, select target groups.
= Send to Radio
Choose this option to send the Swift command to individual radios
registered in the system. In the Recipient box, select target radios.
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6.5.6.10

Send Push Notification

Cuick Command X

Name: |Send Push

Command  view

Command: |Send Push Notification

€] 14

Subject: |Inf0

q "

Message: |Chet:k connection to J service
¥, Warning

{* Send to Dispatcher Group A Alarm

" Send to Radio

Redpient:

| Dispatcher Group 1
Dispatcher Group 2

gy
m]

Cancel

Command
From the drop-down list, select Send Push Notification.

Subject
Enter the subject of the notification. Click the button on the right, and
select the message severity (Information, Warning, or Alarm).

Message
Enter the notification message to be displayed.

Send to Dispatcher Group

Choose this option to send the push notification to dispatcher groups
registered in the system. In the Recipient box, select target dispatcher
groups.

Send to Radio
Choose this option to send the push notification to individual radios
registered in the system. In the Recipient box, select target radios.

6.5.7 Pre-recorded Messages

This feature enables dispatchers to send audio messages even if the channel is
currently busy. The dispatcher records a message to be sent to a busy channel
and then TRBOnet automatically forwards this message as soon as the channel
becomes available:

6.5 Voice Dispatch
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File View Map Teols Help
i Radio Interface

e & Online Dispatchers
£ Dispatcher 1

3, Groupt

© ) Cleaners
() Radio 200
(#) (D Radio 201

eeeeee

— Clearers

5] Playback [l Save~ () Print || 11 Pause ¥ Clear - 'Si Reload | “\F Fitter By Radio | = Grouping |7 Auto Filter

B =0
To: Selected Channels
(D e
Voice

Drag and Drop PTT Box here to
create new group

SB 16-Nov-2016 10:22:05 Server Al

|44 4 | Record 679 0F 678 ¢ [ | ] « |

Date 4| Radio Syst... | Sender |Redpient | Message | Details | Note |
15-Nov-2016 18:26:23  Repeater ... Dispatcher i Cleaners Dispatcher Dispatcher... Members: Dispatcher 1
15-Nov-2016 18:26:36  Repeater ... Dispatcher 1 Firemen D\spahd’\ev ‘Dispatcher... Members: Dispatcher 1

ection to Repeat.

Recent Calls/Events | RecentCals | RequesttoTak | RadoState | Active Tasks | Active Routes User Activity | Mep | Cameras

127001 &3 B B | & Dispatcher 1 | (8 Licensed to: demo Demo License

‘ @ Active~

To queue an audio message for delivery to the selected recipients, first record
a message by clicking the Record button. Alternatively, you can select a WAV
audio file from any storage location, or select a prerecorded message from the

library.
6.5.7.1 Select Audio File

e Click File > Open Audio File and browse for the audio file on the local PC.

To: Selected Cl

Open Aud\o Fil

€

Audio Message Library

Voice Message

6.5.7.2 Audio Message Library

You can select an audio file from the Voice Message templates.

e Click File > Audio Message Library.

Saved Audio Files

5F Add X Remove [ Filter | Shortcut

| Filename | Description Severity Shortcut Visibility

Alarm Tone Alarm Hidden
»  Bobby.mp3 Information

Daigy.waw Information

Send |

[ o< 1]

Cancel |

e Select an audio file in the list and click OK to use this file as a queued

Voice Message.

6 TRBOnet Dispatch Console



TRBOnet Enterprise — User Manual @ Software

6.5.7.3 Record Audio File
You can record a voice message that can be sent to selected radios.

¢ Click Record > Record audio to open the recording tool:

Record audio

Convert Text to Speech

= Click Start and start talking to the microphone.

Record audio

00:17

._,_,,L._.‘\_.._,._..1.,«.,|l|\||,1L ,}ﬁ\\ﬁ;n,‘L.-.,‘.,;.,jf._,‘\-._‘t\,,._._.____._.__..___._

Convert Text to Speech

= Click Stop to stop recording the message.

Convert Text to Speech
|u Send ||i_| Cancel | |H Save |‘|

= Click Send to send the recorded message immediately.

= (Click Save > Save as file to save the recorded file as an audio file on
the PC.

Or:

= (Click Save > Save as Saved Audio File to add the recorded file to a list
of the Saved Audio Files.

6.5.8 Activity Monitor Panel

While in this panel, the dispatcher can perform a wide range of tasks, including:
e Monitoring and listening to recent calls and viewing system events
e Monitoring selected radio status
e Monitoring active tasks for selected radio
e Monitoring active routes for selected radio
e Enabling and disabling User Activity monitoring
e Displaying selected map in a compact view mode
e Monitoring cameras connected to Dispatch Console

6.5.8.1 Recent Calls/Events

In the Recent Calls/Events tab, the dispatcher can monitor recent Server
events, view and listen to recent calls.
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File View Map Tools Help

Voice Dispatch Radio Interface
Sl 7K Radio Interface | Telephony
Y =) clock X
@ [, Online Dispatchers (1) Thursday, September 30,
Administrator = 1 1 : 16
2 = - AM
() Online, Indoor ~
i ~
(@ online, GPS Fixed S Quick Commands (%]
¢ Dispatcher Group 2 B EE Y S contact pisler =)
© @ onne rosrs@
@ us ) Dispatcher Group 2 .
@ Radio 125 ¢
& () offine (19) Session:
Free o
('] voice Dispatch
Send
|5, Location Tracking
- i i d © @
& 30 Ticketing ecent Calls/Events - |
I Playback Il Save~ (D Print | 1 Pause <3 Clear - @ Reload | ) Add Note »
7] Route Management Date System | Sender Destnation Note
97y s0sep2t 10126 A P Rado 125 22 =
s B2t AN CP1 Rado 125 11
= |lpg oseptanizaoam o1 Radio 125 22
ﬁ Voice Recording 30Sep211:12:39AM  CP1 Radio 125 11 Talkers: Radio
© 30Sep211L:12:11AM  Mobie . Radio 125 Talkers: 4444, Radio
ey @ 30Sep211:10:52AM Moblet a4 Radio 125 Takers:
© 305021 0STA7AM Moblel A Adminstrator r (00:... Takers:
Event Vi 30S5ep-2110:57:27AM  CP1 Administrator 22 Takers
& ent: Viewer 30521 10:57:20AM  CPL Admiistrator 11 Talkers
B [0 30-5ep-2110:57:00 M 1ntercom  Administrator Al Talkers: Administrator
]:_‘ askaileaon @ 305ep-2110:56:10AM  Mobike 1 . Radio 125 Takkers: Radio =
= | | 4| Record2of 13 x| ¢
i) Adminstration Recent Cals Events | Requests To Tak | Radostate | ActveTasks | ActveRoutes | User Actity | Map | Cameras Y,
[ Connected @ b B B | § Acministrator | B Licensed to: demo (Walt) (Demo License) @ Active-

Voice Recording
Play back selected call(s)
e Select the voice call recording you want to play back and click the
B Playback| 1 1ton on the left of the toolbar.
The Audio player box will appear.

F8 Audic player >

Duration:
Left:

Position

[T Pausem i/ | Playersy s Open

All call from dispatcher "Administrator’ {00:03)

=]
m
i

= Click the Play button to play back the recording.
Click the Pause button to make a pause.
Click the Stop button to finish playing back the recording.
Click the Open button to select a new audio file to play back.

Note: You can play back multiple recordings in a row. Use the CTRL
and/or SHIFT keys to select multiple recordings you want to

play back. Then click the B Playback| b ytton,

Save selected call(s)

e Select the voice call recording (or multiple recordings, with the help of
CTRL/SHIFT keys) you want to save as an audio file.
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Click Save > Save Selection as Individual Files to save selected

recordings in separate files.
Or
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¢ Click Save > Save Selection as Single File to save selected recordings in a

single file.

e Inthe Save As or Browse For Folder dialog box, browse for the folder

where you want to save the file(s).

Recent Calls/Events Toolbar

[ Playback |zl Save~ () Print | Il Pause ¥ Clear » ‘& Reload | [F Filter By Radie | = Grouping 7 Auto Filter & Default Settings | " Details | [ Show Motes

Click the Pause button to pause updating the Recent Calls/Events log.

Click the Clear button to clear the Recent Calls/Events log records.
Click the Reload button to reload all log records.

"l Add Note Add Message

Click the Filter By Radio button to filter log records by a selected radio/radio
group. In the Radio List pane (the upper-left-pane of the main window), select a
radio or radio group. The Recent Calls and Events for a selected radio will only

be displayed in the Recent Calls/Events pane.

Click the Grouping button to group log records. Select the column you want to

group log records by. Drag and drop the selected column header to the

Grouping field.

Click the Auto Filter button to set a filter for the recent calls and events. You
can filter the Recent Calls/Events list by any parameter. For example, to filter
the list by a selected Sender, select the Sender column (1), and start typing the

sender name (2).

% Details ||[[7] Show Notes [ Add Note

T Auto Filter
etal

Date Desaription Details Note
o o 0 o
505ep-21 1512146 AN o
05ep-21 1512196 AN o
05ep21 15:12:40 AN o
05ep-21 1531235 AM &a
205ep-22 10558 AM o
4]« Record 0o 5 [ ¢
| Edit Filter

Recent Calls/Events | Requests TaTak | Radio State | ActiveTasks | ActiveRoutes | User Activity | Map | Cameras

Click the Default Settings button to apply default settings to all log records.

Click the Details button to see voice call participants:

Recent Calls Events g
[ Playback [l Save~|h Print | 1 Pause < Clear - i Reload | [ Filter By Radio | = Grouping "\ Auto Filter || 4 Details Show Notes | Add Note

0a System Sender Destination

Detals

30-Sep-21 111246 AM  CP1 Radio 125 2 125 called ‘27 (00:0% Takers: Radio 125
30-Sep-2111:1246AM CP1 Radio 125 11 125 called '11' (0867) Takers: Radio 125, Administrator
0Sep211uIZ0AN P Rado2s 2 Talkers: Rado 125
30-5ep21 1L1239AM  CP1 Radio 125 1 Takers: Radio 125

© 30-Sep21 LLIX1LAM  Mobie 1 244 Radio 125 Takers: 4444, Radio 125
@ 05ep211n10:52AM  Moble 1 pr Rodio 125 rakers

© 30-5ep-21 L0iSTi47AM  Mobie 1 Eaal Administrator Takers:

30-Sep-21 10:57:27AM  CP1 Administrator 22 Takers

30-Sep-21 10:57:20 AM  CP1 Administrator 11 Takers: Admi

[ 2-sep21 10:57.00 M Tntercom Administrator Al alers: Admi

© 05ep2110:55:10AM  Moble 1 Lo Radio 125 Private Cal: 4444 caled Radio 125' (00:26) Takers: Radio

|| 4] Record0of 13 »|mm| ¢

Recent CallsEvents | Requests To Takk | Radio State | Actve Tasks | Active Routes | User Actvity | Map | Cameras

Click the Show Notes button to enable the Note column. All notes added by
the administrator and dispatchers for the recent calls and events will be shown

6.5 Voice Dispatch
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in the Notes column. So, you can mark recent calls and events to later find
them by notes.

Click the Add Note button to add a note for the selected recording and/or
event. The notes will be displayed in the Recent Calls/Events log if the
Show Notes button stays pressed.

Click the Add Event button to add an event to the Recent Calls/Events log.

Add User Event X
Destination: | Al j
Severity: ® Information -

Description: Test] B

= Destination
Select either All or an individual dispatcher if you want to see the
message.

= Severity
Select the severity level to inform dispatchers about the level of
importance.

= Description
Enter the event description.

= Click OK.
As a result, the event will be added to the Recent Calls/Events pane.

6.5.8.2 Recent Calls

Note: The Recent Calls tab is not displayed in the Active Monitor
panel by default. To view this tab, go to View > Additional
Tabs, and select the Recent Calls item.

On the Recent Calls tab, the dispatcher can see and configure the latest Voice
calls, including Private, Group, and Intercom calls:

Recent Calls

Types: 1 Private | 4 Group QAII Call <F Clear 7 Filter

Most Recent Call aller Call Number Actions

-] 27.04.2017 12:1 1 3 5 13888
e All call Group Call Private Call
4 L calls:1 1 2 * Calls:3 & Calls:1
S 27.06.2017 12019 27.04.2017 12:18 27.04.2017 12:18

+| 27.04.2017 12:03 235 1 13L&

Recent CallsfEvents  RecentCalls  RequestToTalk — Radio State | Active Tasks  Active Routes | User Activity Map =~ Cameras

e Click the Private button (1) to display the latest Private calls.
e Click the Group button (2) to display the latest Group calls.

e Click the All Call button (3) to display all call types, including Intercom
calls.
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In a Call Box, you can see the number of calls and the last call date and time:

&~ Alcall
& X calls:1
& 2014-07-07 14:02:47

Click the A button to start a Private call to the Sender-Radio (Radio is
displayed in the Sender column).

Click the ) button to mark the calls as viewed.

Click the %%/ button to clear the recent call history.

6.5.8.3 Requests To Talk

On the Requests To Talk tab, the dispatcher can see Missed Calls and Requests
To Talk:

Requests To Talk ™" |
Call Types: | @ Missed Call | fll RequestTo Talk | Wiews | [ Table 52 Tiles ¥ Clear

= Grouping [ Filter @ Default Settings | [Sb Options

First Call Waiting Time | Call Type Sender Target Queued By Last call Count
: 10-how-20 2:19 PM 01:01 fl Request Ta Talk b Wl AAMMHMCTDATOR  AAMHHHCTRATOD 10-Mov-20 2:19 PM 3 PR AR 4

W44 | Recorddof 1k Pebk| 4 »

Recent Calls/Events | RecentCalls | Requests ToTalk  Radio State  Active Tasks | Ackive Routes | User Activity | Map  Cameras

Call Types

View

Click the Missed Call button to display Missed Calls.
Click the Request to Talk button to display Requests To Talk.

Click the Table button to display calls/requests in a table view.
Click the Tiles button to display calls/requests as a set of tiles.
Click the Clear button to clear all the records.

Click the Filter button to set a filter for the records. You can filter the
records by any parameter. For example, to filter by the caller select the
Caller column, click in the empty row and start typing the caller name.

Click the Options button to specify options related to Request to Talk:

For a description of the Request-To-Talk options, see section 6.4.14
Request To Talk.

From within the Request To Talk table, you can do the following:

6.5 Voice Dispatch

Click the : button to start a private call to the call request sender.

Click the Finish (! A ) button to mark the RTT as processed and remove it
from the table.

Click the Reject (! %)) button to reject the RTT for the dispatcher. Note
that the RTT will keep showing to other dispatchers.
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e Click the Menu (¥ ) button and from the drop-down list select one of
the following commands:

= Click the Forward (E) command to redirect the RTT to a different
dispatcher/ dispatch group.

= Click the Hide (&2) command to hide the RTT for the dispatcher for the
time period selected from the drop-down list. Note that the RTT will
keep showing to other dispatchers.

= (Click the Cancel (Q) command to reject the RTT for all dispatchers.
6.5.8.4 Radio Status

On the Radio Status tab, the dispatcher can see the log of radio statuses for

the radio selected in the Radio List pane (the upper-left-pane of the main
window):

Radio Status

125 (Pete) Show Notes || Add Mote | . Add Message

@a=p Date Dispatcher a|state
EE)DS::ED'UIV“ Slot #2 17-Nov-2016 11:35:22 Reset Geofencing Alarm -
| 17Nov-2016 11:35:15 Ge ate: 17-Nov-2016 11:35:15; Latitude: 59°56'22.78'N; Longitud...
GPS: 17-Nov-2016 11:35:15 :
peed 0.4k Nov-2016 11:35:15 Rax Route 1

Alftude:  Unknown 17-Nov-2016 11:35:15 Rai Route 1
Latitude:  59°5627.78N 16-Nov-2016 10:34:20 Radio Online
Longitude:  30°16'47.08°N 15Nov-2016 18:47:22 Radio Offine

15-Nov-2016 14:01:27 Radio Online

15-Nov-2016 14:00:25 Radio Online

15-Nov-2016 11:28:26 Radio Online

Recent Calls/Events | RecentCalls | RequesttoTak | Racio Status ActiveTasks | ActiveRoutes | User Activity | Map | Cameras

In the Radio Status pane, the dispatcher can do the following:

Click the Show Notes button to enable the Note column. All notes added by
the administrator and dispatchers for the radio status records will be shown in

the Notes column. So, you can mark radio status records to later find them by
notes.

Click the Add Note button to add a note for the selected radio status record.

The notes will be displayed in the Recent Calls/Events log if the Show Notes
mode enabled:

Click the Add Message button to add a message for dispatchers to the Radio
Status log.

6.5.8.5 Active Tasks

On the Active Tasks tab, the dispatcher can monitor all active tasks for the
selected radio (for example, Lone Worker, Active Routes, and other tasks).

Wl Stop | = Grouping "/ Auto Filter ©» Default Settings

Task Radio State

Lone Worker 1 125 (Pete) 12:01 12:31

Timer 235 (Basil) 0.00:28:16 - Timer started.

##| ¢ | Record 10f2 b | p|p] 4

Recent Calls/Events | RecentCalls | RequesttoTalk  Radio State | Active Tasks | ActiveRoutes | User Activity | Map | Cameras

The dispatcher can manage active tasks as follows:
Click the Stop button to stop executing the selected task.
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Click the Grouping button to group the tasks. Select the column you want to
group tasks by. Drag and drop the selected column header to the Grouping

field.

Click the Auto Filter button to set a filter for the active tasks. You can filter the
tasks by any parameter. For example, to filter by selected radio select the

Radio column, and start typing the radio name.

Click the Default Settings button to apply default settings to all active tasks.

6.5.8.6 Active Routes

On the Active Routes tab, the dispatcher can monitor all active routes.

» start | 11 Pause Wl Stop | =% Edit 4 Export~ | = Grouping "7 Auto Filter (2 Default Settings
Name Route

¥ Route 1 00:01 1221 1221 10:00 1040

235 (Basil) I+

17-Nov-201612:20 Paint 1 Paint 2 Cofee Fradep

Wi 4| {|Record1of1 » b |Mi| 4
Recent Calls/Events | RecentCalls | RequesttoTalk | Radio State | ActiveTasks | ActiveRoutes | User Activity | Map | Cameras

The dispatcher can manually set statuses for route checkpoints. To do this,
right-click a route point and from the drop-down menu, select the desired

status.
= Waiting
The checkpoint is waiting to be attended.
= Attended

The checkpoint has been attended on time.
= Unattended
The checkpoint hasn't been attended on time.

=  Alarm
The checkpoint is in Alarm mode.
= Note

Click this item to add a note to the selected checkpoint. The note will be
displayed in the pop-up window that appears when hovering the mouse

pointer over the checkpoint.

6.5.8.7 User Activity

e Click the User Activity tab to monitor the activity of radio users:

7 Disable the User Activity monitering | =} Configure...

Off Duty A Time On Duty A Time User Activity £1 A[Tme
@® 111 - @ 235 13:15:01 @ 125 13:15:09

S
(@) Readio 200
(® Radio 201
(® radio 202
(@) Radio 203

(&) Radio 204
(@ D2t e

Recent Calls/Events | RecentCalls | Requestto Tal | Radio State | Active Tasks | Active Routes | User Activity | Map | Cameras

e Click the Configure button to configure the User Activity list:

6.5 Voice Dispatch
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6.5.8.8 Map

On the Map tab of the Activity Monitor panel, you can monitor location of
radios on the map and simultaneously perform all available actions in the
Radio Interface pane (make voice calls, send messages, disable and enable
selected radios, and other actions):

) G iz | Fiten @ @] @] 17 | showseacans: a1 o Ruler i\ FindonMap -y, ¢ Drawing Panel | | Route - <& Geofencing il Coverage Map || Select Map & Gongle Earth
g
4
)

s

Walt. o
235 (Basil) =
. 125 (Pete) %
Recent Calls/Events  RecentCalls ReguesttoTak RadioState ActiveTasks ActiveRoutes  User Activity Map Cameras

g
5

%
itude: 59°56'27.56"N; Longttude: 30°1631.91"E

For more details on map options, see section 6.6, Location Tracking (page 325).

6.5.8.9 Cameras

On the Cameras tab of the Activity Monitor panel, you can monitor cameras
connected to Dispatch Console.

Cameras w
i Add -

Camera 2 j

ICamera 1 j

E
04-27-2017 TP 15:22:02
Camera 02|

7-2017 4TB 15:22:02
a 01 =

1

......

Close Close

Recent Calls/Events | RecentCalls | RequestToTalk | Radio State | Active Tasks =~ Active Routes  User Activity = Map = Cameras

e Click the Add button and select a camera to be displayed on the tab.

Note: You can add up to four cameras to the Cameras tab
view.

6.5.9 Phone Calls

The Phone Connect feature allows making calls from phones to radios and vice
versa.

The phone system must be previously configured by your TRBOnet
administrator.

6.5.9.1 Phone Calls from/to Dispatch Console
To make a phone call from the Dispatch Console:
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@ Contact Dialer 2 E‘ @

[Iret: 2400 ¥ ~
3 *ﬂ |||\ Menu || <n

Line 1 |\ Line 2 |||| Line 3 ||
‘I Line 4 |||\ Line 5 |||| Line & ||
‘I 1 |||\ 2 |||| 3 ||
‘I 4 |||\ 5 |||| 6 ||
‘I 7 |||\ 8 |||| g ||
‘I e, |||\ a |||| # ||

. J

e In the Contact Dialer box, select the Line (1), enter the phone number (2)

and click the ‘L’ (3) button.

Terminate a phone call

e In the Contact Dialer box, click the |"'='_'| button.
Select a destination from Contacts

e Inthe Contact Dialer box, click the ellipsis (...) button on the right of the
dial string.

e Inthe Call Destination dialog box that opens select the desired contact
and click Call.

Answer an incoming call

(\_i‘ Contact Dialer E‘ @
[watt =
‘ ~n ”\ Menu |||| Lol ||

I Line 1 Il\ Line 2 |||| Line 3 ||

‘I Line 4 |||\ Line 5 |||| Line & ||

i ——

e Inthe Contact Dialer box, click the Bl (3) button.
Forward a call

e Whilein a call, click Menu > Manage Call.

(\_:2 Contact Dialer E‘ @

[Tel: 2400 *

Menu ||| oY .|

Hold Call

Manage Call...

RL) Contacts...
1 |i 1'|Tr
s )
| S|
i 0

I:

Line 1

‘I Line 4

i

4

7

[
# || w | o || of
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¢ Inthe Call dialog box that opens, select the desired contact and click

Forward.

The Forward Call dialog box opens.

Forward Call

®4444
00:11

Call in Progress

oK Conference Cancel

Create a conference call

When the second call is established, click OK.

and add participants

e While in a call, click Menu > Manage Call.

¢ Inthe Call dialog box that opens, click Conference.

¢ In the Conference dialog box that opens, click Add.

Confe

erence X
[—— @l [e
[IElznhunv Telephony @

2 xminiﬂrzlcr 3 Disp 1
Add Bt Close

¢ Inthe Add to Conference dialog box that opens, select the desired

contact and click Call.

o

[ Radio

<4 Phone

8 pispatcher @ 45

}R Disp. Group | 4B Dispatcher Group 1

4444
Radio GroUp | 7 Eugens
73 ulia Lopes

7 Favorites

j 7% Viadimir Gorbachev =~
call Cancel

Add to Conference

Specify text to searh

& wi Dispatchers

% Dispatcher Group 2
g

3 Kirill Vavanow

7 Timofey Kozhevnikov
3 User Test

s

e When the second call is established, click OK.

6 TRBOnet Dispatch Console




TRBOnet Enterprise — User Manual @ Software

Add to Conference X

®4444
00:14

Call in Progress

6.5.9.2 Making Phone Calls from Radios

6.6

Make a DTMF call

Note: Only 1.07.02 and higher firmware version for all radios
equipped with dialing keyboard support DTMF.

To make a DTMF call, do the following:

= Press the PTT button on a portable radio and hold it.

= While holding the PTT button, dial a phone number and press # (For
example, 0079521112233#).

= Release the PTT button. The server will automatically initiate a phone call.

Call by sending Text Message
To make a phone call, send a text message with the text PrefixN where:
e Prefix - is a short text to define the special text message (for example,
sip:);
e N -the phone number.

For example, to initiate a call to a phone subscriber "123 456 7890", the
following text message must be sent to TRBOnet Server: "sip:1234567890".

Terminate a call
To terminate the call, press the PTT button and then press # twice on the radio.

Location Tracking

In the Location Tracking tab, the dispatcher can monitor selected radio
location on supported maps, open different maps in separate tabs and toggle
between map tabs:
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File View Mop Tools Help

ion Tracking

1R[]

Map
B & XV 2 =1m;emm []«df@] -@ 1:Line free [«][ 2 =ﬂl cal [[[2] &
(£)© Radio 204 Qe vH Bes o DEE) (/I EE, EEE [[l@] B -7 i seacons

3 [ @@ Beer
o [ Aremen o Clrerecal D<ol @

W@ Coffee

@O m Qv  BING_ROAD B @ Tea
El ™ 125 (Pt :\ 63 S} 5% < | Filter: ()| @| 7 | ShowBeacons: Al v | 4 Ruler (X Find onMap~ || &[4 [/ Map Objects
@ o) E o S v.. [ [ abiding place
®D 222 < ] % %, I [ Frre cep

v (#) @ 235 (Basil)
(#) Radio 200

% “IE % 7 (3] Hospital No2
= Hospital No2 %
Z

[ [E police department ...

Cl -] [ Map Regions
e &9 =7 iy zone
oF =¥ [ Map Routes

{145 voice Dispatch =
(&
& e ¥l 3 Route 1
@ Location Tracking A
. ) - Vasil'yevskiy iéland e
W Job Ticketing wa N R $0- >
%, Andrews 0 -
125 (Pete) °£_Cattiedral o £
& 100m 235 (Basil) ° L
g e
Route Management 5, | Lottude: 59°5623.98'N: Longiude: 30°1634.85'E
© Recent Calls/Events ™|
]| RFID Tracker - — -
[ playback i Save~ () Print | 11 Pause < Clear - i Reload | [ Filter By Radio | = Grouping '/ Auto Filter ©» Default Settings
[=] Text Messages Date Radio System | Sender Recipient Message Details Note
E‘n 18-Nov-2016 10:41:45  CapadtyPLUS Server 235 The Route 1is finished -
17-Nov-2016 20:51:23  CapadtyPLUS 345 125 Private Call: Dispatcher '34...  Members: 345, 125
@ voice Recording L] pacty =
o 17-Nov-2016 20:51:16  CapadityPLUS 125 345 Private Call: Subscriber '125... Members: 125
P o 17-Nov-2016 20:50:44  CapacityPLUS 456 125 Private Cal: Dispatcher '45. Members: 456, 125
Event Viewer .
L @ 17Nov-2016 20:50:32  CopacityPLUS 456 125 Private Cal: Dispatcher '45... Members: 456, 125 -
e | «| Record 10f392 > [m|m] < »
5] Radio Atlocation Recent Calls/Events | RecentCalls | Requestto Tak | Radio State | Active Tasks | Active Routes | User Activity | Beacons | Beacon Events | TagList
(127001 &3 B | & 345 | [ Licensed to: demo Demo License @ Active-

The main user interface elements are as follows:
Radio List pane

2. Voice panel

3. Map panel

4. Objects panel

5. Activity Monitor panel

While in the Activity Monitor panel, the dispatcher can perform a wide
range of tasks, including:

= Monitoring and listening to recent calls and viewing system events
= Monitoring selected radio status

= Monitoring active tasks for selected radio

= Monitoring active routes for selected radio

= Enabling and disabling User Activity monitoring

= Monitor beacons and beacon events.

6.6.1 Objects
On the Objects panel, the dispatcher can view and enable/disable the following
objects:
e Beacons - all beacons connected to the system.

e Map Objects - all manually created map objects and predefined objects
created with the Map Drawing toolbar.

e Map Regions - all map regions created with the Map Drawing toolbar
(use the Add Polygon tool to create a map region).

e Map Routes - all map routes created with the Map Drawing toolbar (use
the Draw Route tool to create a map route).
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6.6.1.1

6.6.1.2

6.6.1.3

In addition, the dispatcher can export and import these objects (see section
6.3.4.3, Exporting/Importing Objects).

Beacons

TRBOnet Dispatch Software provides the Indoor Positioning feature to
monitor the location of radios inside a building where no GPS signal is
available. This feature requires additional hardware (the beacons spread
around the building and the option boards in radios). A radio user will be
displayed on the indoor floor plan when the radio enters the beacon coverage
area. The beacon icon on the map displays the number of radios that are
currently in the beacon coverage area.

File View Map Tools Help

Location Tracking Map |8 |<0]EB] oviects |
=k &V 4 BING_ROAD X' scheme X| E
il [5G Tea + | Show Beacons:  All v | Show Info: B
- 2 = — = 5]
& [ Firemen 5 | 3
[ Fror ) o prai “ [ age
@®s vs © 1_ DO ofee 2
&
v = et Tea0)] | : i G re
PP e S oo 1. /- |G O ep Objects
I O[=] camera 1
| Voice Dispatch : [} / - \J 0] (] Hospital
I ™~ \‘ 1 & el
% Location Tracking =% ‘ [ [ Map Reg
dl | \\w: 9 [ Map Route
@ Job Ticketing v | @30 111
I Gl \ /
Eﬂ Route Management e ! A4l 1/
I ‘ [ Coffee (1 L
]| RFID Tracke v @235 \ 1
o) /
RS Beasons g
ﬁ osce Show: |Al || 7 AutaFiiter @ Default Settings
Name Desaription Radios Previous Detection
(a Reports i Tea 08.06.2017 14:53:58
S
() Coffee 235 08.06.2017 14:55:18
15 event viewer {9 Beer Beer tap 08.06.2017 14:53:34
mmmmmmm
[_3'! Radio Allocation Recent Cals/Events | Recent Calls | RequestToTak | Radio State || Active Tasks | Active Routes | User Activity  Beacons | BeaconEvents | TaglList
127001 &3 & | § Administrator | [28 Licensed to: demo @ Active-

Beacons are displayed on the building floor plan (1) and in the list of beacons
(2) in the Objects panel. When a radio comes into the range of a beacon, they
both are highlighted in yellow on the floor plan/map (3).

For more details on beacons, see section 6.13, Beacons (page 368)

Map Objects

The dispatcher can create custom and predefined map objects using the
Drawing Panel. The dispatcher can attach 2D or 3D floor plans for Indoor
Positioning.

For more details on creating map objects, see section 6.6.2.8, Drawing Panel
(page 330).

Map Regions

The dispatcher can create map regions that can be used for Geofencing rules.
The map Regions can be created manually on the map (click any point on the

map to select it as a region border) or, the dispatcher can add map points by

GPS coordinates to create a region.

For more details on creating map regions, see section Draw a Polygonal Region

(page 330).
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6.6.1.4 Map Routes

6.6.2

The dispatcher can create routes on the map that can be used for Geofencing
rules.

For more details on creating map routes, see section Draw a Route (page 333).

Map Tools
The Map toolb